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Chapter 1: Introduction and 
Initial Setup
From front desk to operatory, Dentrix Enterprise provides profitable integration solutions for managing a 
variety of information, including patient demographics, clinical details, and production analyses. Dentrix 
Enterprise can boost staff productivity, enhance professionalism, increase collections, help keep your chairs 
full, and improve your bottom line.

This chapter covers the following topics about the various Dentrix Enterprise modules and the basic steps to 
set up and begin using the program in your office:
•	 Dentrix Enterprise Overview

•	 Opening Dentrix Enterprise Modules

•	 National Configuration Settings

•	 Setting Up Clinics

•	 Setting Up Clinic Resources

•	 Setting Up the Appointment Book

•	 Setting Up the Ledger

•	 Setting Up Continuing Care Types

•	 Setting Up Fee Schedules

•	 Editing Procedure Codes 

•	 Setting Up Multi-codes

•	 Customizing Practice Definitions

•	 Setting Up Practice Defaults

•	 Setting Up Auto Chart Numbering

•	 Setting Up Default Printers

•	 Setting Up Passwords

•	 Setting Up Program Preferences

Before setting up your Dentrix Electronic Dental Record (EDR), it is important to understand the 
relationship between RPMS and Dentrix.  An interface has been installed that allows information to flow or 
be “pushed” from one program to the other.  RPMS will push each patient’s demographics ONLY (name, 
address, birth date, SS#, and so on) into Dentrix.

If dental staff enter a change of address into Dentrix it will not be saved because the demographic information 
DOES NOT flow from Dentrix back into RPMS.  Once that new information is entered into RPMS, 
however, within seconds, the new information will be displayed in Dentrix because it will automatically flow 
over to Dentrix from RPMS.

At this time,  the only information that is pushed from Dentrix over to RPMS are the completed procedures 
done in the Patient Chart—the “coding” is sent for billing purposes from the work done in the Patient Chart.
RPMS > Patient Information > Dentrix
Dentrix > Completed ADA and IHS Procedures in Patient Chart > RPMS
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Dentrix Enterprise Overview
The following five main modules of Dentrix Enterprise each manage specific types of information:

•	 Family File – The Family File module can help you enter and manage patient information, such as a 
patient’s name, address, employer, insurance information, notes, and continuing care (recall or recare).

•	 Patient Chart – The Patient Chart module can help you enter and manage the clinical information for 
your patients. In the Patient Chart, you can chart existing, completed, and recommended procedures. 
Additionally, you can keep extensive and detailed notes regarding patient care.

•	 Ledger – Dentrix Enterprise automatically posts procedures completed in the Patient Chart in the Ledger, 
where patient accounts are managed. The Ledger contains a record of all financial transactions entered 
into Dentrix Enterprise, including charges, payments, and adjustments. You can create claims and pre-
treatment estimates from the Ledger. The Ledger also provides you with information concerning patient 
portions versus insurance portions, deductibles owed, and payment arrangements.

•	 Office Manager – The Office Manager offers useful, customizable reports and lists (reports are also 
available from the DXOne Reporting module). The Office Manager works with Microsoft Word to 
help you create effective, professional-looking letters: welcome letters, congratulatory letters, thank-
you notes, a variety of appointment and continuing care reminders, progress reports, and collection 
notices. Additionally, the Office Manager contains a set of utilities that you can use to customize Dentrix 
Enterprise to fit your needs.

•	 Appointment Book – The Appointment Book module can help you maximize production by using 
visual, goal-oriented scheduling. In the Appointment Book, you can make changes to scheduled 
appointments easily and reschedule appointments by clicking and dragging them. Convenient toolbars 
and flip tabs help you navigate through the Appointment Book, search for open times, organize 
appointments and notes, record broken appointments, and print route slips. Also, you can clearly see the 
times when a clinic is closed and when a provider is unavailable.

In addition to the five main modules, Dentrix Enterprise also includes the following components and features:

•	 Treatment Planner – The Treatment Planner can help you provide patients with easy-to-understand 
treatment options.

•	 Perio Chart – With the Perio module, you can record periodontal measurements, such as plaque, pocket 
depth, and bleeding.

•	 Quick Letters – Dentrix Enterprise works with Microsoft Word to help you quickly create a letter for a 
patient. You can choose from over forty pre-defined letter templates for your practice correspondence or 
create your own.

•	 Quick Labels – With Quick Labels, you can quickly print a variety of labels for a patient.

•	 Continuing Care – Continuing Care can help you monitor your patients’ on-going dental care.

•	 Send Message – With the Send Message feature, you can create and send email messages for patients 
from within Dentrix Enterprise.

•	 Patient Questionnaire – The Patient Questionnaire module can store information from new patient 
forms, health history updates, and other forms used in your office to collect information from patients.

•	 Prescriptions – The Prescriptions module can help you quickly create prescriptions and accurately track 
medicines prescribed to your patients.

•	 Office Journal – Like a journal of your daily activities, the Office Journal has two main functions: to keep 
a record of past events and remind you of events in the future.
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•	 Document Center – The Document Center can help you create a truly paperless office. You can scan, 
capture, and import documents (such as patient medical and dental history, proof of income, insurance 
cards, patient letters, EOBs, and referral letters) or images (such as patient pictures and X-rays). You can 
then  attach these documents to patients, providers, insurance carriers, and referral sources, or you can 
print or email them.

•	 Collections Manager – The Collections Manager can help you increase your practice’s revenue by 
decreasing your accounts receivable. Based on criteria you select, the Collections Manager displays a list 
of accounts that need to be contacted. From this list, you have access to all the necessary information 
when contacting an account, including an aged balance, payment information, Office Journal entries, and 
insurance estimates.

•	 Patient Alerts – Patient alerts are customizable alerts that you can attach to a patient or family when you 
want a message to appear whenever you access information about that patient or family, according to 
criteria you specify.

•	 Medical Alerts – You can access medical alerts from the Family File, Patient Chart, and Treatment 
Planner. When a patient has a health condition requiring attention, the medical alerts icon in those 
modules and on the patient’s appointment (in the Appointment Book) is red. You can then click the icon 
to view a list of the patient’s medical alerts.

The following products and packages are available as add-ons or integrated technologies for Dentrix 
Enterprise:

•	 eClaims – With eClaims, you can send insurance claims electronically so that your office can receive 
payment in a more timely manner. If your claim cannot be sent to the payor electronically, it will be 
printed to paper and mailed within 24 hours.

•	 QuickBill – With QuickBill, you can generate billing statements without having to print a page, stuff 
an envelope, or lick a stamp. Instead, QuickBill sends statements to a clearinghouse where they are 
professionally printed, folded, and mailed.

•	 Guru – Guru is a patient education software program that integrates with Dentrix Enterprise through the 
Patient Chart.

•	 Image – Image (developed by Dexis) integrates with Dentrix Enterprise, to capture digital, intraoral 
images, and radiographs.

•	 Voice – Voice allows you to enter data in both the Patient and Perio Charts using voice recognition 
technology.

•	 DentriXlink – DentriXlink acts as a bridge between Dentrix Enterprise and other clinical technologies, 
such as digital X-rays. With DentriXlink, you can open a supported third-party program and pass patient 
information to that program.
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Opening Dentrix Enterprise Modules
There are three ways to open a Dentrix Enterprise module:

•	 The Windows Start menu – After you install Dentrix Enterprise, a DXONE folder will appear in your 
All Programs list on the Windows Start menu.

Click the name of the module you want to open.

Note: If you select a module other than the Office Manager, the Office Manager will open behind the 
module you selected to open. The Office Manager must remain open if you want to have any other 
module open.

•	 A shortcut icon on the Windows Desktop – You can create a shortcut on the Windows Desktop for the 
Office Manager.

Double-click it to open the Office Manager module (open another module from there, if needed).

•	 Another Dentrix Enterprise module – Once you have opened the Office Manager, you can open other 
modules from the File menu or the toolbar (for example, the Treatment Planner module includes a 
Dentrix Enterprise Modules toolbar).

Clicking the first buttons on this toolbar will start the Chart, Family File, Ledger, Appointment Book, 
and Office Manager, respectively.

Dentrix Enterprise will keep the current patient active when you open another module. For example, if 
you are working in a patient’s Ledger and open the Family File from the Ledger, information for the same 
patient appears in the Family File, and the patient name appears on the Family File window’s title bar.
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National Configuration Settings
The Indian Health Service (IHS) National Configuration meeting was held September 15 – 17, 2009, at 
the Henry Schein Practice Solutions (HSPS) building in American Fork, UT.  Representatives from HSPS, 
Science Applications International Corporation (SAIC), and IHS met to decide upon a national configuration 
to be used for installation at future clinics as a part of the IHS EDR project.  The national configuration 
established a suggested pattern for installation, while also allowing for some decisions to be made by the 
local clinic being installed.  The purpose of this section is to list the standards established by the national 
configuration, as well as to establish those settings that will be decided by the local clinic.

The standardized configurations listed in this document have been set up in the default database that is 
installed at all installations of Indian Health Clinics that are participating in the IHS EDR Project. You will 
refer back to these configuration settings as your site is set up with Dentrix.

National Settings
•	 Within the clinical notes feature of the Dentrix chart there is an option to use an “approve” button to lock 

a clinical note.  This approval will lock the note so that the original note cannot be edited.  It will allow 
for appended notes, but not an edit of the actual note that existed when the “approve” button is utilized.

Those in attendance at the National Configuration meeting decided that this button needs to be enabled 
through the global settings utility that is used when a clinic is installed with Dentrix Enterprise.

•	 In regards to password security settings, it was decided that the security rights settings that are used in 
RPMS should be followed in the installation of Dentrix Enterprise:

•	 A new password must be established every 90 days.

•	 A user cannot use any password that has been used as one of the user’s previous 6 pass-words.

•	 The password must be “strong”, meaning at least 8 characters in length, consisting of a combination 
of upper case letters, lower case letters, numbers and special characters.

•	 After three attempts, the user is to be locked out for an automatic stay of 1 hour.  Another user with 
appropriate permissions may unlock the user sooner than the one hour.

•	 Another setting to be established in the Global Setting utility at the time of installation is the enabling of 
the Medical History Review option.  This option will enable a window that will pop up the first time each 
day that a patient’s record is accessed through the Patient Chart.

•	 In the Appointment Book, it was decided to create a standard list of definitions to be used as 
Appointment Statuses.  This list is not comprehensive, allowing the local clinic to customize the list to 
meet the needs of the clinic.

The appointment statuses that were added to the National Configuration are as follows, including the 
colors to be assigned:

•	 Confirmed

•	 Left Message

•	 Unable to Contact

•	 Patient Here

•	 ER/Walk In

•	 Special Needs

•	 Dark Blue

•	 Light Blue

•	 Brown

•	 Green

•	 Red

•	 Orange



6    Chapter 1: Introduction and Initial Setup

Dentrix Enterprise 8.0.5 User’s Guide

•	 As Initial Reasons used for scheduling appointments, also found in the Definitions area of the Office 
Manager, the following procedures were decided upon:
•	 New Patient

•	 Comprehensive Exam

•	 Pano

•	 4 Bitewings

•	 2 Bitewings

•	 FMX

•	 Prophy

•	 Child Prophy

•	 Fluoride

•	 Oral Hygiene Instructions

•	 Periodic Exam

•	 Limited Exam

•	 Under 3 Exam

•	 Consult

•	 Office Visit (Follow Up)

•	 Palliative Tx

•	 Perio Maintenance Therapy

•	 Also found in the Appointment Book is the Continuing Care List.

It was decided to include the following standard lists as a part of the National Configuration:

•	 Last month of patients who were due for treatment but never seen.

•	 Last 3 months of patients who were due for treatment but never seen.

•	 Last 6 months of patients who were due for treatment but never seen.

•	 All patients that have been due for treatment but never seen.

•	 The list of available continuing care types that can be tracked automatically by Dentrix Enterprise is to 
include the following:

•	 Space Maintainer to be tracked at every 6 months and attached to ADA codes D1510 and D1515.

•	 High Risk Caries to be tracked at every 3 months.  The attached code is to be determined.

•	 Oral Path to be tracked at every 1 month.  The attached code is to be determined.

•	 Hygiene is to be tracked at every 6 months and attached to ADA codes D1110, D1120, and D4910.

•	 Ortho is to be tracked at every 1 month and attached to ADA code D8670.

•	 In the Procedure Code Setup area of the Office Manager, the only change to be established on the 
national level is the op site(treatment area) for ADA code D0220 and D0230 is to be set to tooth, thereby 
requiring a tooth number.
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•	 In the Letter Merge area of Dentrix Enterprise there will be templates included that will provide Post Op 
instructions for the following codes and letter names:

•	 SSC

•	 Dental Surgery

•	 Simple Extraction

•	 Pedodontic Extraction

•	 Trauma

•	 Dentures

•	 Pulpotomy

•	 Sinus Opening

•	 Excuse Letter

sscpost.doc

surgery.doc

simpext.doc

pedoext.doc

trauma1.doc

denture.doc

pulppop.doc

sinusop.doc

excslip.doc

•	 It was decided that Prescriptions will continue to be entered as they currently are, meaning that they will 
be entered through the EHR. 

•	 It was decided to include the following as Allergies within the Definitions:
•	 Latex

•	 Penicillin

•	 Amoxicillin

•	 Clyndamycin

•	 Sulfa

•	 Ibuprofen

•	 Local Anesthetic

•	 Tylenol/Acetaminophen

•	 Aspirin

•	 Codeine

•	 Hydrocodone

•	 Iodine

•	 Erythromycin

•	 Tetracycline

•	 See Notes

•	 It was decided to include the following as Medical Alerts (in addition to those already included in the 
installation):

•	 Bisphosphonates

•	 Auto Immune Disorders

•	 Hepatitis C

•	 In the Patient Chart, it was decided to use the following color scheme to represent the associated 
treatment type:

•	 Treatment Plan

•	 Completed

•	 Existing

•	 Existing Other

•	 Conditions

Red

Blue

Blue

Blue

Black
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•	 Also in the Patient Chart, it was decided to establish 21 of the 24 Quick Procedure Buttons.

The following codes and icons are used:

•	 0000 1st Visit This Fiscal Year (10/1)
•	 0190 All Subsequent Visits
•	 D1110 Adult Prophy
•	 D1120 Child Prophy
•	 D0274 4 BWX
•	 D0272 2 BWX
•	 D7140 Tooth Extraction, erupted/uncomplicated
•	 D0330 Panorex
•	 9990 Treatment Plan Completed
•	 D1206 Fluoride Varnish
•	 D2140 Amalgam Restoration (use for anterior and posterior, any number of surfaces)
•	 D2391 Comp/Resin Restoration (use for anterior/posterior, any number of surfaces)
•	 D2940 Sedative Filling
•	 D1330 OHI
•	 D9110 Palliative Treatment
•	 D2930 Stainless Steel Crown
•	 D2750 Porcelain Fused to High Noble Crown
•	 D3310 RCT – any area of the mouth
•	 D3220 Pulpotomy
•	 D1351 Sealant
•	 D0220 Periapical X-ray, first one
•	 Site Decision The clinic can decide which code and icon to use
•	 Site Decision The clinic can decide which code and icon to use
•	 Site Decision The clinic can decide which code and icon to use
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•	 Within the Password Setup, it was agreed to include five employee password templates that would be used 
to base the assignment of password rights for all other employees.  These five templates will be assigned to 
“users” with the following names and roles:

•	 FD Template		  Front Desk

•	 DA Template		  Dental Assistant

•	 Prov Template		  Dentist

•	 FA Template		  Full Access

•	 RDH Template		  Dental Hygienist

The rights assigned to each are as follows:

Security Option FD DA Prov FA RDH
Appointment Day Notes, Modify X X X X X
Appointment Lists X X X X X
Appointment Views, Add New X X
Appointment Views, Delete X X
Appointment Views, Edit X X
Appointments, Break X X X X X
Appointments, Delete X X X X X
Appointments, Edit X X X X X
Appointments, Open X X X X X
Appointments, Purge X
Appointments, Schedule New X X X X X
Appointments, Set Complete X
Appointments, Setup Clinic X
Appointments, Setup Providers O X
Appointments, Setup Schedule O X
Approval Status X X X X X
Appt Lists, View All Clinics X X X X X
ApptBook, Change Prov Color X X
ApptBook, Copy View X X
ApptBook, Copy Views to Users X X
ApptBook, Remove Prov X X
Auto Chart Number Setup Set up to not assign
Batch Processor, Delete Reports X X
Batch Processor, Print/Display Reports X X X X X
Billing/Payment Agreement, Modify X X
Chart Setup X
Chart, Open X X X X X
Clinic Admin X
Clinic ID Change X
Clinic Resource Setup O X
Clinical Notes, Append X X X
Clinical Notes, Approve X X X
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Security Option FD DA Prov FA RDH
Clinical Notes, Delete X X X
Clinical Notes, Modify O X X X
Collections Manager, Open X
Completed Procedures, Delete X X X X
Completed Procedures, Edit X X X X
Completed Procedures, Enter X X X X X
Conditions / Diagnosis, Delete X X X X
Conditions / Diagnosis, Edit X X X X
Conditions / Diagnosis, Enter X X X X
Continuing Care, Clear Patients X X X X X
Continuing Care, Edit Patients X X X X X
Continuing Care, Open X X X X X
Continuing Care, Setup X
Credit Adjustment, Delete X
Credit Adjustment, Edit X
Credit Adjustment, Enter X
Customize Toolbars X
Database Mode Setup X
Debit Adjustment, Delete X
Debit Adjustment, Edit X
Debit Adjustment, Enter X
Dunning Messages, Modify X
DXOne Report, Launch X X X X
Employers, Add New/Edit Info
Existing Procedures, Delete X X X X
Existing Procedures, Edit X X X X
Existing Procedures, Enter X X X X
Family File, Open X X X X X
Fast Checkout X
Fee Schedule, Setup X
Guarantor Notes, Modify X
Guarantor Payment, Delete X
Guarantor Payment, Edit X
Guarantor Payment, Enter X
Image, Open X X X X X
Ins Payments, Delete X
Ins Payments, Edit X
Ins Payments, Enter X
Insurance Claims, Create New X
Insurance Claims, Delete X
Insurance Claims, Edit X
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Security Option FD DA Prov FA RDH
Insurance Claims, Open X
Insurance Coverage, Modify X
Insurance Payment Tables, Modify X
Insurance Plans, Add New/Edit Info X X
LC/FC, Delete X
LC/FC, Edit X
LC/FC, Enter X
Ledger + History X
Ledger Setup X
Ledger, Open X
Ledger, Open Treatment Plan X
Letters, Add New X X X X X
Letters, Birthday X
Letters, Collection X
Letters, Continuing Care X X X X X
Letters, Delete X
Letters, Edit X X X X X
Letters, Inactive Patient X
Letters, Misc. X X X X X
Letters, Referral X X X X X
Letters, Welcome X X X X X
Medical Alerts, Edit X X X X X
Medical Alerts, View X X X X X
Medical Consultation X X X X
Month End - Charges X
Month End - Payment Plan X
Month End - Update X
More Info / Family Appointment List X X X X X
Multi-Clinics, Purge Appt X
Multi-Codes Setup X
Office Journal, Add En-tries X X X X X
Office Journal, Delete Entries X X X X X
Office Journal, Edit Entries X X X X X
Office Journal, Open X X X X X
Office Manager, Open X X X X X
Office, Report Multiple Clinics X
Password Administration X
Password, Multi-Clinic X
Patient Alerts, Modify X X X X X
Patient Notes, Modify X X X X X
Patient Notes, View X X X X X
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Security Option FD DA Prov FA RDH
Patient Prescriptions, Delete X
Patient Prescriptions, New X
Patient Prescriptions, Open X
Patient Questionnaire Setup X
Patient Questionnaire, Edit X
Patient Questionnaire, New X
Patient Questionnaire, Open X
Patient Quick Letters X X X X X
Patient Referrals, Delete X X X X X
Patient Referrals, Open X X X X X
Patients, Add New
Patients, Archive
Patients, Delete
Patients, Edit Family Relations
Patients, Edit Information X X X X X
Payment Agreement Types, Setup X
Payment Plans, Add New / Edit Info X
Perio Chart, Open X X X X X
Practice Definitions Setup X
Practice Preferences Setup X
Prescriptions Setup X
Prescriptions, View X
Presenter, Open X X X X X
Print Appointment Book Views X X X X X
Print Billing Statements X
Print Charts or Progress Notes X X X X
Print Continuing Care Lists X X X X X
Print Day Sheets X
Print Day Sheets, MTD/YTD X
Print Future Due Payment Plans X
Print Insurance Aging Reports X
Print Insurance Claims X
Print Office Journal Reports X X X X X
Print Patient Notes X X X X X
Print Patient Prescriptions X
Print Patient Questionnaire X
Print Payment Agreements X
Print Perio Chart Letters or Charts X X X X X
Print Route Slips X X X X X
Print Treatment Plans X X X X X
Procedure Code Setup X
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Security Option FD DA Prov FA RDH
Procedure-Instructor, Enter / Edit X
Providers, Inactivate X
Purge Insurance / Employers X
Referral Analysis, Open X X X X X
Referrals, Add New/Edit Info X X X X X
RVU, Auto Changes X
Sched Reports, Delete Any X
Sched Reports, Print/View Any X
Send Electronic Billing X
Send Electronic Claims X
Suspended Credits, Apply X
Treatment Plan, Delete O X X O
Treatment Plan, Edit O X X O
Treatment Plan, Enter O X X O
Trojan, Import X
User Self Setup X X X X X
View All Operatories X X X X X
View All Patients X X X X X
View All Providers X X X X X

*Any option listed with an O in the box is to be left for the local clinic to decide.

Local Settings
As a part of the National Configuration Meeting, it was decided that there were aspects of the software setup 
that should be left to the local clinic for decision making, including the following:

•	 Production Types

•	 Appointment Checklist

•	 Appointment Book time increments

•	 Multi-codes

•	 Approval Status for Treatment Plans

•	 Appointment Types

•	 Billing Types

•	 Medications

The local clinics are also to have the ability to add to any of the lists of standardized configurations to make 
the software apply more effectively to the local clinic. 
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Setting Up Clinics
You can add and edit clinic information for all clinics in Dentrix Enterprise. Set up clinics prior to setting up 
providers. You must be in the Central clinic to set up a clinic. The Central clinic provides access to all setup 
features. Configuring clinic information from one computer affects all computers running Dentrix Enterprise 
on the network.

To add or edit a clinic

1.	 While logged on to the Central clinic, in the Office Manager, 
from the Maintenance menu, point to Practice Setup, and 
then click Enterprise Setup.

The Enterprise Setup dialog 
box appears.

2.	 Select your clinic (for example, 
“MESA IHC”), and then click 
Edit.

The Clinic Information dialog 
box appears.

3.	 Enter the following clinic 
information:

General tab

•	 Descriptive ID – Type an ID that is four to 11 characters 
in length (the maximum depends on a certain global 
setting). Valid characters include A-Z, a-z, 0-9, and 
a hyphen (-). This ID is used to reference the clinic 
throughout Dentrix Enterprise and on reports.

•	 Financial Number – Type the account number for the 
clinic’s financial institution.

•	 Merchant ID – Type the ID used by the clinic for 
processing credit card payments.

•	 Clinic TIN – Type the Tax Identification number of the 
clinic.

•	 Entity ID Code – Type the code used to identify the 
entity for the clinic.

•	 Title – Type the name of the clinic.

•	 Address – Type the clinic’s address, the phone number 
and extension of the contact person in the clinic (if 
applicable), and the clinic’s fax number.

1

OR

2

23

4
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Settings tab

•	 Administrative Contact – Click the search button  to 
select the business contact at the clinic. Only providers 
who have been entered into Dentrix Enterprise and who 
have a 10-digit phone number are available for selection.

•	 Bank Deposit Number – To have the clinic’s bank 
account number print on deposit slips, type the 
appropriate number.

•	 Show/Hide/Mask SSN – Select one of the following 
options:

•	 Use Central Clinic Option – The setting will be the 
same as that for the Central clinic.

•	 Show Completely – Shows the entire Social Security 
number throughout Dentrix Enterprise.

•	 Hide Completely – Hides the Social Security 
number. All fields that display Social Security number 
will be blank except in dialog boxes where the 
number is entered or edited (for example, the Patient 
Information dialog box).

•	 Mask Completely – Masks all digits of the Social 
Security number.

•	 Mask All But Last Four – Masks all but the last four digits of the Social Security number.

For a comprehensive explanation of where the Social Security numbers will be shown, hidden, or 
masked throughout Dentrix Enterprise, see the “Enterprise Setup” topic in the Dentrix Enterprise Help.

•	 Fiscal year’s beginning month (1-12) – Type the number of the month that your fiscal year begins. 
The default value is 1 (January).

•	 Billing Statements – Select the option that corresponds to the information you want to appear on 
billing statements:

•	 Use Central Office Info on Statements – To print the name and address of the Central clinic on 
a statement sent to a patient of this clinic.

•	 Use Clinic Info on Statements – To print this clinic’s name and address on a statement sent to a 
patient of this clinic.

•	 Use Provider Info on Statements – To print the name and address of the patient’s primary 
provider on a statement sent to a patient of this clinic.

•	 Change Provider Completion Options – If the completing provider for procedures is often not the 
same as the treatment-planning provider, you can change the provider for those procedures and have 
that provider be the default for any procedures completed for a selected patient or for all patients. To 
enable the completing provider override feature, select Override Provider For All Transactions, and 
then select one of the following options:

•	 Per Patient – The specified provider will be used for completed procedures being posted for a 
given patient until you select another provider or patient.

•	 Per Session – The specified provider will be used for completed procedures being posted for all 
patients until you select another provider or close all Dentrix Enterprise modules.

•	 Change Fee Schedule Rounding Option – Select the default rounding option for automatic fee 
schedule changes. This setting is available only if you are logged in to the Central clinic.

•	 Clinical Note Naming – To have the default name of a new clinical note (“Note#”) changed to the 
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category and name of the template that was used to create the note (if multiple templates were used 
to create the clinical note, the category and name of the first template used is used), select this check 
box. This setting is available only if you are logged in to the Central clinic. This setting affects all 
clinics.

Optional Settings tab (Central clinic only)

•	 Automatic Log Off

•	 Enable Automatic Log Off – To have users logged 
off of Dentrix Enterprise after a specified length 
of idle time, select this check box. Type the length 
of Idle Time, in minutes, that is allowed before a 
user is logged off the program. Dentrix Enterprise 
is considered to be idle while there are no mouse 
movements or keyboard strokes in any Dentrix 
Enterprise module on the computer to which a user 
is logged on except for the DXOne Report Manager, 
DXPrint, and DXOne Reporting processes, which 
are used for reports. However, if a report is being 
run, and the user is logged off automatically, the 
generation of the report is canceled.

•	 Enable Warning Messages – To have a warning 
message appear before users are logged off 
automatically, select this check box. In the Display 
field, type the length of time, in seconds, that you 
want the warning message to appear before a user is 
logged off automatically. The message will present the 
options to the user to continue working in Dentrix 
Enterprise without being logged off or to log off 
immediately. If the message is ignored, after the 
specified number of seconds, the user is logged off 
automatically.

•	 Additional Settings

•	 Enable Patient Access Logging – To enable the tracking of emergency access to patient 
information for users without sufficient rights, select the check box. When accessing a patient 
record multiple times the same way (in the same module, at the same clinic, on the same date, 
and by the same user) within the number of minutes specified in the Minutes between identical 
records field, Dentrix Enterprise will create only one entry for the Patient Information Accessed 
Report. In this field, type a value from 5 to 1440 (180 or above is recommended).

•	 Enable Patient Print Logging – Select this check box to enable the tracking of the following: 
when reports that contain patient information are generated; when patient records are accessed; 
additions, deletions, and modifications of patient information; and when patient health 
information is exported to a patient’s portal. This audit information appears on the Audit - 
Combined Report.

•	 Patient Birthdate/Age on Title Bar – To have the birth date and age of a patient selected in 
a patient-specific module (except for the Family File) appear on the title bar of that module’s 
window, select this option.

•	 Copy to Clinical Notes

•	 Patient Health Assessment – To have a clinical note created automatically each time a health 
assessment for a patient is recorded, select this check box.
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•	 Prescriptions – To have a clinical note created automatically each time a prescription is entered 
for a patient, select this check box.

•	 Medical Alerts – To have a clinical note created automatically each time a medical alert is entered 
for a patient, select this check box.

•	 Appointment Book “Late Appt” Tracking – To allow the time from the scheduled time of 
appointments to the arrival time of the corresponding patients to be monitored by Dentrix Enterprise 
(for the Appointment Statistics Report), select this check box. Then, set up the following options:

•	 Appt Status to Watch for – Select the status appointments will have before the corresponding 
patient arrives. Dentrix Enterprise will begin monitoring a patient’s visit when the specified status 
is selected for his or her appointment from the Appointment Information dialog box.

•	 Minutes before patient is considered LATE – A patient will be considered late for his or her 
appointment when the specified number of minutes has elapsed from the time of the scheduled 
appointment until the status your office uses to indicate a patient has arrived is selected for that 
appointment. If a patient is late for his or her appointment, the Late Appt check box is selected 
in the Appointment Information dialog box, and a red dot appears in the upper-right corner of 
the appointment on the schedule.

•	 Patient Education

•	 Use Spanish patient education if patient’s preferred language is Spanish – With this check 
box selected, and if a patient’s language preference is Spanish (in the Patient Information 
dialog box, under Demographics, Spanish is selected as the Language), when the Patient 
Education dialog box appears for that patient, the Spanish option is selected; otherwise, English 
is the default selection. Having the Spanish option selected allows you to Search Online with 
MedlinePlus for patient education resources in Spanish.

•	 Use description for finding patient education – Select this check box to have the description 
instead of the code (such as SNOMED) be used when you do either of the following:

•	 Click the Patient Education button  in the Medical Alerts dialog box (or Patient 
Prescription dialog box) to search for patient education resources online with MedlinePlus 
for a selected problem, medication (or prescription), or allergy.

•	 Click Search Online in the Patient Education dialog box, which you can open from a 
patient-specific module (such as the Family File), to search for patient education resources online 
with MedlinePlus for a problem, medication, or lab that match the search criteria that you enter.

•	 Family File Settings

•	 Require Patient Email Address – Select this check box to require that an email address be 
entered for each patient in the Family File. If a patient declines to provide an email address, that 
can be specified instead of entering an email address.

•	 Require Referral for New Patients – Select this check box to require that a referral source be 
selected when a new patient record is created in the Family File.
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Subscriptions tab

•	 Outcome – If you have purchased a subscription for 
this feature (Quintiles is the third-party provider of the 
Outcome service), click Setup Outcome to enable and set 
up Outcome.

•	 ePrescribe – If you have purchased a subscription for 
this feature (AllScripts is the third-party provider of the 
ePrescribe service), click Setup ePrescribe to enable and 
set up ePrescribe.

•	 Updox – If you have purchased a subscription for this 
feature (UpDox is the third-party provider of the Patient 
Portal service), click Setup Updox to enable and set up 
Patient Portal.

•	 Meaningful Use – If you have purchased a subscription 
for this feature, click Setup Meaningful Use to enable 
and set up Meaningful Use.

4.	 Click OK.

For comprehensive information about setting up Outcome, 
ePrescribe, Patient Portal, and Meaningful Use, see the “Changing 
clinic information” topic in the Dentrix Enterprise Help.



Chapter 1: Introduction and Initial Setup    19

Dentrix Enterprise 8.0.5 User’s Guide

Setting Up Clinic Resources
You can edit your clinic information, operatory IDs, provider information, and staff information.

To access the Clinic Resource Setup

•	 For any clinic

1.	 While logged on to the Central clinic, in the Office 
Manager, from the Maintenance menu, point to Practice 
Setup, and then click 
Enterprise Setup.

The Enterprise Setup dialog 
box appears.

2.	 Select the clinic that you want 
to edit.

3.	 Under Clinic Information, 
click Clinic Resource Setup.

The Clinic Resource Setup 
dialog box appears.

•	 For the clinic that you are logged on to

In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Clinic Resource Setup. The Clinic 
Resource Setup dialog box appears.

The sections that follow explain about setting up clinic resources.

1

2

3
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Changing Clinic Information
You can edit a clinic’s information as needed.

To edit a clinic’s information

1.	 In the Clinic Resource Setup dialog box, 
under Clinic Information, click Edit.

The Clinic Information 
dialog box appears.

2.	 Change the clinic 
information as needed. 
For information about 
the available options, see 
“Setting Up Clinics” in 
this chapter.

3.	 Click OK.

Setting Up Operatories
An operatory is a room, chair, or other location where treatment is performed in your office. Appointments 
are scheduled by operatory on any given day.

To add or edit an operatory

1.	 In the Clinic Resource Setup dialog box, 
under Operatories, do one of the following:

•	 Click New to add an operatory.

•	 Select an existing operatory, and then click 
Edit to edit that operatory.

The Operatory Information dialog box 
appears.

2.	 Type the following information:

•	 ID – The unique ID for the operatory.

•	 Operatory Title – The title to use for the 
operatory instead of the ID when printing 
the Operatory Appointment List.

3.	 Click OK.

1
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Setting Up Providers
Each individual that provides billable treatment to patients is considered a provider in Dentrix Enterprise.

 During the initial push of information, all doctors (primary providers) will be moved into Dentrix from 
RPMS. This initial information will need to be edited so that Dentrix contains appropriate User lD’s, logon 
information, site address, NPI numbers, and so forth.

Hygienists do not get pushed over from RPMS. There will be one “place holder” hygienist in the Dentrix 
Clinic Setup that can be tweaked to contain a dental hygienist’s information. Additional hygienists can be 
added and mapped into Dentrix allowing that production to move back to RPMS under the Dental Chief ’s 
Dentrix lD for billing purposes.

Important: To add a primary provider not listed in Dentrix Enterprrise, you MUST have that provider set up 
in RPMS first, and then call Dentrix Technical Support to have a technician “map” the provider in RPMS to 
Dentrix Enterprise. After that, the new doctor can be pushed to Dentrix Enterprise.

To edit a provider

1.	 In the Clinic Resource Setup dialog box, 
under Provider(s), select an existing provider, 
and then click Edit to edit that provider’s 
information.

The Provider Information dialog box appears.

Tip: If you want to view providers that have 
been inactivated in addition to the active 
providers listed, select List Inactive at the 
bottom of the Clinic Resource Setup dialog 
box.

2.	 Enter or change the following 
information:

•	 Name – Type the provider’s 
Last name, First name, and MI 
(middle initial).

•	 ID – This ID is pre-populated 
with the provider’s NPI number 
Change the ID to something 
more descriptive (for example, 
DRWROBERTS, for Dr. Wesley 
Roberts; and HYMJONES, 
for Mary Jones, RDH). Type a 
unique ID for the provider. The 
ID must be 4 to 10 characters 
in length. You can use letters, 
numbers, and hyphens (-).

Note: Provider IDs are used 
throughout Dentrix Enterprise. 
Whenever a provider is displayed 
or printed, it is usually only the 
provider ID that is seen.

1
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•	 Title – Type the provider’s title, such as DDS, DMD, or RDH.

•	 Non-Person – If this provider is an entity, such as a corporation or association, select this check box.

•	 Specialty – Select the appropriate specialty for the provider.

•	 Address – Type the business address of the provider. This address will be used on all correspondences 
to patients, referrals, insurance carriers, and so forth. Also, type the provider’s E-Mail address.

•	 Phone – Type the business phone number and extension (if applicable) of the provider.

•	 Class – Select the class for the provider: Primary, for primary care providers, such as dentists; or 
Secondary, for secondary care providers, such as hygienists.

•	 Insurance Claim Options – To avoid having to sign each printed insurance claim, select Print 
Provider’s Signature Using, and then select Signature on File or Provider’s Name. If you want to 
use the clinic TIN on insurance claims, select Use Clinic TIN.

•	 Log On User ID – If you are adding a new provider, type the ID that this provider will use to access 
Dentrix Enterprise.

•	 Password – In the User Password field, type the password that this provider will use to access 
Dentrix Enterprise. Enter the same password in the Confirm Password field.

Important: The password must be at least 8 (for standard users) or 15 (for administrative users) 
characters in length and meet the following requirements: have at least one uppercase letter, have 
at least one lowercase letter, have at least one number, and have at least one special character (for 
example, #, %, or &).

•	 Fee Schedule – If this provider will use a different fee schedule from the default fee schedule, click 
the search button , and then select the appropriate fee schedule.

•	 RVU Schedule – To associate an RVU schedule with this provider, click the search button , and 
then select the appropriate RVU schedule.

•	 Clinic – Click the search button , and then select the clinic where the provider works.

•	 TIN – If the clinic Tax Identification number (TIN) will be used by the provider (Use Clinic Tin is 
selected under Insurance Claim Options), the field displays “<CLINIC>.” Click the Tin # search 
button , and then add, edit, or remove the TIN of any clinics as needed. You must have at least 
one TIN entered.

•	 SS # – Type the provider’s Social Security number. This number will appear on insurance claims.

•	 State ID #, State, and State Expiration Date – Type the provider’s state license number, the state 
where that license was issued, and the expiration date of that license. The state ID will appear on 
insurance claims.

•	 DEA #, License Expiration, and Schedule – Type the provider’s DEA number and the date that 
DEA license expires, and select the classes of medication that the provider can prescribe. The DEA 
number can be used with specialized insurance claims.

•	 Additional IDs – Enter any of the following IDs, which can be used with specialized claims: 
Medicaid #, NPI, Blue Cross/Blue Shield ID # (you must select one or the other), Provider #, 
Office #, Other ID #, and UPIN#.

3.	 Click OK.

For information about adding other IDs through the Provider ID Setup, see the “Setting up provider IDs for 
dental insurance” topic in the Dentrix Enterprise Help. For information about setting up the provider to use 
ePrescribe, see “Editing and disabling/enabling ePrescribe user accounts” in the “Adding, editing, inactivating, 
and reactivating providers” topic in the Dentrix Enterprise Help.
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Inactivating Providers
You cannot delete providers. When a provider no longer works at a clinic, you can inactivate that provider. 
Inactivated providers are not available for selection throughout Dentrix Enterprise wherever providers can be 
selected except when setting up options for reports. New procedures and treatment plans cannot be posted for 
inactivated providers. New prescriptions and payment plans cannot be entered for an inactive provider. Also, 
existing treatment-planned procedures associated with an inactivated provider cannot be set complete.

To inactivate a provider

In the Clinic Resource Setup dialog box, under Provider(s), select the provider who you want to inactivate, 
and then click Inactivate.
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Setting Up Staff
Staff members are employees who have not been entered as providers and who will use Dentrix Enterprise.

To add a staff member or edit a staff member’s information

1.	 In the Clinic Resource Setup dialog box, 
under Staff, do one of the following:

•	 Click New to add a staff member.

•	 Select an existing staff member, and then 
click Edit to edit his or her information.

The Staff Information dialog box appears.

2.	 Enter or change the following information:

•	 Log On User ID – Enter or edit the ID 
that this staff member will use to access 
Dentrix Enterprise.

•	 Password – In the User Password field, 
type the password that this staff member 
will use to access Dentrix Enterprise. 
Enter the same password in the Confirm 
Password field.

Important: The password must be at 
least 8 (for standard users) or 15 (for 
administrative users) characters in length 
and meet the following requirements: have at least one 
uppercase letter, have at least one lowercase letter, have at 
least one number, and have at least one special character 
(for example, #, %, or &).

•	 Clinic – Click the search button , and then select the 
clinic where the staff member works.

•	 Name – Type the staff member’s full name.

•	 ID – Type a unique ID for the staff member. The ID 
must be 4 to 10 characters in length. You can use letters, 
numbers, and hyphens (-).

•	 Title – Type the staff member’s position (for example, 
receptionist or office manager).

•	 Address – Type the staff member’s home address.

•	 Phone – Type the staff member’s home phone number and extension (if applicable).

•	 E-Mail – Type the staff member’s email address.

•	 SS # – Type the staff member’s Social Security number.

3.	 Click OK.

Inactivating Staff
Staff cannot be deleted. When a staff member no longer works at a clinic, you can inactivate that staff member.

To inactivate a staff member

In the Clinic Resource Setup dialog box, under Staff, select the staff member who you want to inactivate, 
and then click Inactivate.

1
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Setting Up the Appointment Book
You can customize several features of the Appointment Book to meet the needs of your practice. These options 
can be set up and/or changed at any time without affecting data already entered. However, for consistency, 
you should set them up before you begin using Dentrix Enterprise.

This section covers the following topics about setting up the Appointment Book:
•	 Setting Up Views •	 Setting Up an Operatory
•	 Setting Up a Clinic •	 Setting Up Flip Tabs
•	 Setting Up a Provider

Setting Up Views
Views allow you to see the Appointment Book in various ways; for example, you can have one view for when 
you are in the operatory and a different one for when you are at the front desk. For each view, you specify 
which providers, operatories, hours, and patient details are shown in the Appointment Book.

You can have up to 111 different views for the Appointment Book on any given computer in the office unless 
a certain global setting is enabled; in which case, you can have an unlimited number of views.

To add or edit a view

1.	 In the Appointment Book, click View on the menu bar.

The Select View dialog box appears.

2.	 Do one of the following:

•	 Click New to add a new view.

•	 Select an existing view, and then click Edit to 
edit that view.

The Edit View dialog box appears.

3.	 Set up the following options:

•	 Appt. View Name – Type a name for the view.

•	 Short-cut key to view – Select the shortcut key 
that you want to use to access the view.

•	 Clinic – Select the clinic that you want to view.

•	 Selected Providers – Click Modify List to select 
the providers for the view.

•	 Selected Operatories – Click Modify List to 
select the operatories for the view.

•	 View Options – Select any of the following:

•	 View Amount – To have the scheduled 
production amount for the day, week, or 
month appear.

•	 View Appt. Notes – To view a note symbol 
on any appointment with an appointment 
note.

•	 View Alerts – To view a red plus sign on any appointment for a patient with medical alerts.

•	 View Provider Columns – To view the colored provider bar.
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•	 Select Days – Select the days of the week that the office is normally open. The week and month views 
will show only the selected days.

•	 Month Time View – For the month view, Dentrix Enterprise requires that a start and end time be 
entered. Type the earliest hour that you will see patients in the Start Hr field. Type the latest hour 
that appointments will last in the End Hr field. Click am or pm for both fields.

•	 Appointment Display Info – Depending on the length of an appointment, up to nine lines of 
information can be displayed on the face of an appointment. For each Line, select the information 
you want to have displayed on that line, or select [None] to leave that line blank.

Tip: On average, appointments will probably display 2 – 4 lines, so assign the most important items 
to the first lines. Also, make sure the appointment information to be displayed is HIPAA compliant.

•	 Default View – Select this check box to have this view be your default for the current clinic.

4.	 Click OK.

Setting Up a Clinic
You can customize your practice hours, certain appointment defaults, and the time block size used throughout 
the program. Any changes will affect all your computers that have Dentrix Enterprise installed.

To set up a clinic

1.	 In the Appointment Book, from the Setup menu, click Clinic Setup.

The Clinic Appointment Book Setup dialog box appears.

2.	 Select a Clinic.

3.	 Set up the following options for the selected clinic:

•	 Default Schedule – Select the check box next to 
each day of the week the clinic is normally open. 
Also, you can break each day into three time ranges. 
To set the working hours for any day, click the day’s 
search button , and then enter the start and end 
times of each range that you want for that day.

•	 Time Block Size – You can schedule your 
appointments in 5-minute, 10-minute, 
15-minute, 20-minute, or 30-minute intervals. 
Select the time block size option that fits the 
scheduling needs of your practice.

Important: Time block size is used when setting 
up procedure codes to indicate how long a procedure will take to complete. Dentrix Enterprise stores 
this information in units, not actual time; as a result, changing the time block size can change your 
procedure time settings for a procedure. For example, if your original procedure used 10-minute time 
blocks, then a procedure that requires 60 minutes would be entered as six units. If you change the 
time block size to 15 minutes, the procedure still has six units, but now, instead of being 60 minutes, 
the procedure will default to 90 minutes.

•	 View Time at Right – To have the time column appear on the right side of the window in addition 
to the left side, select this check box.

4.	 Click OK.

For a comprehensive explanation about all the available options for clinics, see the “Setting up a clinic” topic 
in the Dentrix Enterprise Help.
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Setting Up a Provider
You can customize work hours, colors, and aliases for each provider in your office. Any changes will affect all 
your computers that have Dentrix Enterprise installed.

Note: You can set up providers in more than one clinic. When setting up the provider’s default schedule, 
Dentrix Enterprise will warn you if the scheduled hours overlap in other clinics.

To set up a provider

1.	 In the Appointment Book, from the Setup menu, click Provider 
Setup.

The Provider Setup dialog box appears.

2.	 Select a Clinic.

3.	 Select a Provider.

4.	 Click Setup. The Provider Setup dialog box appears.

5.	 Set up the following options for the selected provider:

•	 Default Schedule – Select the check box next to 
each day of the week that the provider normally 
works. Also, you can break each day into three 
time ranges. To set the working hours for any 
day, click the day’s search button , and then 
enter the start and end times of each range that 
you want for that day.

•	 Provider Color – All appointments scheduled 
with that provider will use the designated 
color as the background for the appointment 
information. To assign the provider a unique 
color, click the colored button, and then choose 
the desired color.

Tip: Appointment information text is displayed in black, so choose a light color for the provider’s color 
that contrasts with the black text.

6.	 Click OK.

For information about setting up provider time blocks, see “Setting Up Perfect Day Scheduling Time Blocks” 
in Chapter 3: Appointment Book.
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Setting Up an Operatory
You can customize available hours for each operatory in your office. Set up the operatories for each clinic 
separately. Any changes will affect all your computers that have Dentrix Enterprise installed.

To set up an operatory

1.	 While viewing the operatories for a clinic in the Appointment 
Book (the view does not have to be displaying all operatories), from 
the Setup menu, click Operatory Setup.

The Operatory Setup dialog box appears.

2.	 Select the operatory for which you want to set the available time 
and days.

3.	 Click Setup.

The Operatory Setup dialog box appears.

4.	 Select the check box next to each day of the week the operatory is 
normally used. Also, you can break each day into three time ranges. 
To set the available hours for each selected day, click the day’s search 
button . In the Set Time Limits dialog box, enter the start time 
and end time of each range you want for that day, and then click OK.

5.	 Click OK

Setting Up Flip Tabs
Acting as a bookmark, a flip tab allows you to jump forward or backward several days, weeks, or months 
in the Appointment Book, according to a user-defined length of time, such as seven days, two weeks, or six 
months. No flip tabs are set up with the initial installation of Dentrix Enterprise.

Flip tabs are workstation-specific and must be set up on each workstation individually. You can have up to 
four flip tabs per computer.

To set up a flip tab

1.	 In the Appointment Book, from the Setup menu, click Flip Tabs 
Setup.

The Flip Tabs Setup dialog box appears.

2.	 Click the Day View, Week View, or 
Month View tab to set up flip tabs for the 
corresponding Appointment Book view.

3.	 For each flip tab you want to create, set up 
the following options:

•	 Description – Type a short description 
for the flip tab (for example, “1 Week” 
or “6 Months”).

•	 Text Color – Click the colored button 
to assign a color to the text description 
of the flip tab.
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•	 Type – Select the type of flip tab:

•	 Absolute – Absolute requires that an actual calendar Date, such as 09/07/2012, be specified.

Note: An “Absolute” tab will always jump to the specified date in the Appointment Book.

•	 Relative – Relative requires that a number of Days, Weeks, or Months (depends on the flip tab) 
be specified.

Note: A “Relative” tab will jump to a date relative to the current system date or currently 
displayed date. For example, if today’s date is January 1st, a relative tab set to move you seven 
days forward relative to today will move you to January 8th, and then, if clicked again, the tab 
leaves you on the 8th. However, a relative tab set to move you seven days forward relative to the 
displayed date, will move you to the 8th, and then, if clicked again, the tab will move you to the 
15th (another seven days ahead).

•	 Direction – For a relative flip tab, select a direction option: Forward, to go forward by the specified 
number of days, weeks, or months in the Appointment Book; or Backward, to go backward by the 
specified number of days, weeks, or months.

•	 Relative to – For a relative flip tab, select whether the book should move you relative to the current 
date or relative to the date currently being displayed.

4.	 Click OK.
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Setting Up the Ledger
There are several features of the Ledger that you can customize to meet the needs of your practice. You can 
set up or change these at any time without affecting data already entered. However, for consistency sake, it is 
a good idea to set them up before you begin using the system. This section covers the following topics about 
setting up the Ledger:

•	 Setting Up Checkout Options

•	 Setting Up Automatic Credit Allocation Options

•	 Setting Up Direct Print Options

Setting Up Checkout Options
In most offices, there are typically three tasks that are completed as a patient checks out after a visit. The 
Fast Checkout button  combines these three tasks. With the click of a button you can collect a payment, 
generate an insurance claim, and print a receipt.

To customize the Fast Checkout button

1.	 In the Ledger, from the File menu, click Set 
Checkout Options.

The Checkout Options dialog box appears.

2.	 Select the task options you want to complete 
when the Fast Checkout button is clicked:

•	 Enter Guarantor Payment – To post a 
payment to the Ledger.

•	 Create Insurance Claim – To generate an insurance 
claim. Also, select whether you want to send the claim 
to the batch processor in the Office Manager or print 
the claim immediately.

•	 Walkout – To print a receipt for the patient. Also, 
select whether you want to send the report to the batch 
processor in the Office Manager or print the report 
immediately.

•	 Always Show Checkout Options – If the tasks you perform as a patient leaves vary, you can select 
this option so that the Checkout Options dialog box will appear each time the Fast Checkout 
button is clicked, thus allowing you to select the options you need for each patient individually.

3.	 Click OK.
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Setting Up Automatic Credit Allocation 
Options
Dentrix Enterprise can automatically apply suspended credits and post automatic adjustments for re-allocating 
credits according to selections you make.

To set up the options for automatic credit allocation

1.	 In the Ledger, from the File menu, click Set Auto 
Credit Allocation Options.

The Set Automatic Credit Allocation Options 
dialog box appears.

2.	 Set up the following options:

•	 Automatic Suspended Credit Allocation Options

•	 Automatically Allocate Suspended Credits 
when Applicable – To have Dentrix Enterprise 
automatically allocate any suspended credits to 
all charges that have a remaining balance. This 
will apply all applicable suspended credits to all 
applicable charges, not just the recently posted 
charges.

•	 Do Not Automatically Allocate Suspended 
Credits – To have Dentrix Enterprise not 
automatically allocate any suspended credits.

•	 Automatic Insurance Payment Adjustment Options

•	 Credit Adjustment Type – Click the search 
button  to select the adjustment type that you 
want Dentrix Enterprise to use for the credit 
adjustment to offset a charge adjustment when a 
leftover insurance payment amount needs to be 
allocated automatically.

•	 Automatically Allocate – Select Use Automatic Suspended Credit Allocation Options to 
default to the selection made for Automatic Suspended Credit Allocation Options when 
entering insurance credit adjustments, or select Flag Adjustment “Do not automatically 
allocate” to have Dentrix Enterprise not allocate the insurance credit adjustment automatically 
regardless of selection for Automatic Suspended Credit Allocation Options.

•	 Charge Adjustment Type – Click the search button  to select the adjustment type that you 
want to use for the charge adjustment when a leftover insurance payment amount needs to be 
automatically allocated.

•	 Itemize Automatic Adjustments for Billing Statements – To have Dentrix Enterprise itemize 
automatic adjustments on billing statements.

Note: It is recommended that you leave this check box clear because the automatic adjustments 
will always be offsetting adjustments, so they will not affect an account balance and can be 
confusing if included on billing statements.

•	 Adjustment Type for Negative Payments

•	 Enable Automatic Adjustments for Insurance Payments – To allow negative insurance 
payments to be posted for claims, select this option.
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•	 Auto-post Refund adjustments to replace negative payments – To allow negative insurance 
payments to be posted for claims, select this option. A negative payment will appear as a charge 
adjustment on the Ledger. Next, select the Charge Adjustment Type you want to have used as the 
charge adjustment that automatically replaces a negative insurance payment.

Tip: You may need to add a new adjustment type in Practice Definitions for this charge 
adjustment. 

•	 Electronic EOB Options

•	 Default Provider for Non-Itemized eEOB Charges – Select which provider will be attached 
to a charge adjustment if an adjustment claim in an eEOB is not itemized. The provider can be 
the patient’s primary provider (Prov1 from Family File), the pay-to provider on the claim, the 
rendering provider on the claim, or the billing provider on the claim.

•	 Copy Electronic EOBs to Document Center – If you want electronic EOBs imported into 
Dentrix Enterprise to be copied to the Document Center, select this check box.

3.	 Click OK.

Setting Up Direct Print Options
You can print insurance claims and several reports from the Ledger: walkout statements, billing statements, 
and a family ledger report. A button for each of these reports is located on the toolbar. With the direct print 
options, you can indicate whether the report should be printed immediately or sent to the batch processor in 
the Office Manager, where you can print it at a later time.

To set up direct print options

1.	 In the Ledger, from the File menu, click Direct 
Print Options.

The Direct Print Options dialog box appears.

2.	 For each report, select whether you want the 
report to go directly to your printer or to be sent 
to the Batch Processor.

Tip: If your office will be sending claims 
electronically, click Batch for insurance claims, so all 
insurance claims generated during the day will be sent to 
the Batch Processor and can be transmitted simultaneously 
at the end of the day.

3.	 Click OK.
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Setting Up Continuing Care Types
You can add or edit the default continuing care types that you assign to patients to help you track ongoing 
patient care (recall or recare).

To add or edit a continuing care type

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup > Continuing Care, and then click Continuing 
Care Setup.

The Continuing Care Setup dialog box 
appears.

2.	 Do one of the following:

•	 Click New to add a continuing care type.

•	 Select an existing continuing care type, 
and then click Edit to edit that type.

The New Continuing Care Type or Edit 
Continuing Care Type dialog box appears.

3.	 Set up the following options:

•	 Type – Type an abbreviated name for 
this type of continuing care in all capital 
letters.

•	 Description – Type a more complete description of this continuing care type. This description will be 
used on continuing care reminder cards, so pay 
special attention to spelling, punctuation, and so 
forth.

•	 Interval – The interval indicates how often 
the patient should be recalled for treatment or 
follow-up. Specify the number of days, weeks, 
months, or years for the interval. Select +1 Day 
to prevent insurance billing problems if the 
carrier has strict interval requirements.

•	 Provider – If you want the provider of 
continuing care appointments to be the 
patient’s primary provider by default, click 
Prov1. If you want the provider of continuing 
care appointments to be the patient’s assigned 
secondary provider, click prov2.

•	 Default Appt. Time – To enter the amount of time this patient will need for appointments with this 
continuing care type attached, select Time?. Drag the slider to set the number of units, and then set 
up the time pattern for each unit (chair time , assistant’s time , or provider’s time ) to help you 
make use of all operatories when scheduling appointments and maximize your productivity.

4.	 Click OK.
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Setting Up Fee Schedules
You can add or edit fee schedules to specify the fees that you charge for each procedure. You can have up to 
99,999 fee schedules.

To add or edit a fee schedule

1.	 In the Office Manager, from the Maintenance menu, point 
to Practice Setup, and then click Fee Schedule Setup. (This 
option is available only if you are logged in to the Central 
clinic.)

The Fee Schedule Maintenance dialog box appears.

Tip: To search for a fee schedule, begin typing the name of a 
fee schedule in the Find Fee Schedule field. Continue typing 
as needed to narrow down the list.

2.	 Do one of the following:

•	 Add – To add a fee schedule, click New. Proceed to step 
3.

•	 Edit – To edit a fee schedule, select that fee schedule, and then click Edit. Skip step 3.

The New Fee Schedule dialog box appears.

3.	 Set up the following options:

•	 Fee Schedule Name – The name of the fee schedule.

•	 New Fee Schedule Options – Select one of the following 
options:

•	 Start with Blank Fee Schedule – To begin with a fee 
schedule with zeros for all the amounts.

•	 Copy From Fee Schedule – To use an existing fee 
schedule as the basis or as-is for this new fee schedule. 
Select the desired fee schedule from the list.

Note: You can change any of the amounts as needed later on.

•	 New Fee Schedule Position – Select one of the following options:

•	 Use Fee Schedule – To use the first available ID number for this new fee schedule.

•	 Select Fee Schedule Position – To use the ID number of an existing fee schedule for this new fee 
schedule. Select the desired ID number from the list.

•	 Define New Number – To specify the ID number for this new fee schedule.

Tip: Overwriting an existing fee schedule affects all patients, providers, and insurance carriers with 
that existing fee schedule attached. To view the number of patients, providers, and/or insurance 
carriers that the fee schedule is attached to, click Attachments in the Fee Schedule Maintenance 
dialog box.

4.	 Click OK.

The View/Edit Fee Schedule dialog box appears.
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5.	 Do any of the following:

•	 Change the Fee Schedule Name.

•	 To replace all the amounts in this fee schedule 
with those from another fee schedule, click 
Copy From, and then search for and select 
the desired fee schedule.

•	 To change a procedure code’s amount (as 
displayed in the BEFORE column), click 
that procedure code’s fee in the AFTER 
column, and then type the new amount. The 
background color of the AFTER cell changes 
to yellow, and the Difference between the 
original and the new fee appears with a 
green background (for an increase) or a red 
background (for a decrease). Repeat this 
process as needed to change other amounts.

Tip: To help you quickly find a procedure code, begin typing a procedure code in the Find 
Procedure Code field. The first matching code is selected.

•	 To change all amounts to zeros, click Clear, click Clear only the fee amounts, and then click Yes.

•	 To change all amounts to zeros and clear the Fee Schedule Name field, click Clear, click Clear the 
name and fee amounts, and then click Yes.

6.	 Click Save.

For a comprehensive explanation of fee schedules, see the “Fee Schedule Maintenance” topics in the Dentrix 
Enterprise Help.
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Editing Procedure Codes
Many tasks and transactions in a dental office are linked to an ADA Procedure Code. Dentrix Enterprise 
comes with all of the procedures listed in American Dental Association Code on Dental Procedures and 
Nomenclature. Edit, or at least review, the following information for the procedure codes you use in your 
office: fees, procedure time, and attached continuing care.

To edit a procedure code

1.	 In the Office Manager, from the Maintenance menu, point 
to Practice Setup, and then click Procedure Code Setup.

The Procedure Code Setup dialog box appears.

2.	 Select a Procedure Code Category. All procedure 
codes associated with that category appear in the list 
box to the right.

3.	 Select a procedure code, and then click Edit.

The Procedure Code Editor - Existing dialog box 
appears.

4.	 Set up the following options:

•	 Auto Continuing Care – When 
a procedure with a continuing 
care type attached to is completed, 
Dentrix Enterprise automatically 
adds the continuing care type to 
the patient and/or updates that 
patient’s continuing care due date. 
Click the search button  to select 
a continuing care type for this 
procedure.

•	 Procedure Time – To enter the 
number of Appointment Book units 
this procedure takes to perform, 
click the search button . Drag 
the slider to set the number of units, 
and then set up the time pattern for 
each unit (chair time , assistant’s 
time , or provider’s time ) to 
help you make use of all operatories when scheduling appointments and maximize your productivity.

•	 Fee Schedule – No fees are pre-assigned with the initial install of Dentrix Enterprise. To change the 
fees for a procedure, select the fee for the fee schedule that you want to change, and then click Edit 
Fee. The fee in a field next to the name of the fee schedule can now be edited. Next, type the dollar 
amount you want to charge, and then press Enter to save the change or Tab to move down to the next 
fee schedule. Repeat this process for all fees that you want to change.

Tip: The practice’s usual, customary, and reasonable (UCR) fees should be the first fee schedule.

5.	 Click Save.

For a comprehensive explanation of all the options available for procedure codes, see the “Adding and editing 
ADA-CDT dental codes” topic in the Dentrix Enterprise Help.
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Setting Up Multi-codes
A multi-code allows you to post several procedures simultaneously. A multi-code is a group of procedure codes 
that are typically recommended, scheduled, or completed at the same time.

To add or edit a multi-code

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Multi-Code Setup.

The Multi-Code List dialog box appears.

2.	 Do one of the following:

•	 Click New to add a multi-code.

•	 Select an existing multi-code, and then click Edit to 
edit that code.

The Multi-Code Editor dialog box appears.

3.	 Set up the following options:

•	 Description – Type a description for the multi-code.

•	 Multi-Code – Dentrix Enterprise automatically assigns 
“xx” as the first two characters of a multi-code. Type 
three additional alphanumeric characters to represent 
the code that will be used to identify the multi-code 
when posting.

•	 Abbrev. Desc. – Type an abbreviated description of the 
multi-code.

•	 Type – If the multi-code will post a bridge, select 
Bridge; otherwise, select Standard.

•	 Procedure Codes – To add a procedure code to 
the multi-code, click Add. In the Add Code dialog 
box, type an ADA procedure code, or click the 
search button  to select a procedure code. If the 
procedure code selected requires the entry of additional 
information, additional options appear in the lower-
right corner of the Add Code dialog box so that you 
can pre-define a surface(s), a quadrant, or a sextant. 
Then, click OK.

Important: A multi-code may consist of one or 
more procedures that require additional treatment 
information to be entered, such as a tooth number. 
Multi-codes that require additional information will be flagged with an asterisk (*) in the list box. The 
additional information must be supplied when posting the multi-code.

4.	 Click OK.
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Customizing Practice Definitions
Dentrix Enterprise provides several “practice definitions” and allows user-definable entries for each. These 
practice definitions, in addition to other features, can help you customize Dentrix Enterprise for your specific 
needs.

You can add and edit practice definitions.

Important: Before you customize definitions, read the following recommendations carefully:

•	 Customize definitions that have not yet been assigned to patients in order to avoid potential problems.

•	 Dentrix Enterprise assigns the definition number to a patient, not the customizable description. 
Modifying the text description of a definition will change that definition for all patients to whom the 
definition has been assigned. For example, if patients are assigned medical alert 13 “hay fever,” and it is 
changed to “pregnancy,” those patients will still have medical alert 13, but it will now show as “pregnancy” 
in their file.

•	 Before deleting a definition, try changing the existing description to a new, more useful description. 
Deleting a definition can lead to data corruption. For example, if the appointment status 4 “Patient 
has Arrived” will not be used in your office, you can change it to a more useful definition such as, “Left 
Message.”

•	 With the exception of medical alerts, definitions are listed in numerical order. As a result, the first 
definition serves as a default selection for most definition types. Be sure to make the most commonly used 
definition the first definition in the list.

To customize a practice definition

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Definitions.

The Practice Definitions dialog box appears.

2.	 Select a 
Definition Type 
to add or edit 
definitions for 
that type.

3.	 Do one of the 
following:

•	 To add a new 
definition, 
for some 
definitions, 
select and 
replace the 
existing ID (if relevant) and Definition Text with a new ID and description, and then click Add. For 
other definitions, click Add to set up the necessary options.

•	 To edit a definition, for some definitions, select that definition, replace the existing Definition Text, 
and then click Change. For other definitions, select the definition, and then click Change to modify 
the options.

For comprehensive details about customizing each definition type, see the “Practice Definitions” topic and its 
subtopics in the Dentrix Enterprise Help.
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Setting Up Practice Defaults
When entering patient information or performing certain tasks, the process of having to choose a provider 
or operatory can be redundant. Dentrix Enterprise allows you to set a default provider, billing type, chart 
provider, insurance claim providers, and billing statement. Changing the practice defaults affects only the 
computer from which you are changing the defaults. You can change the practice defaults at any time.

To set up the practice defaults

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Practice Defaults.

The Practice Defaults dialog box appears.

2.	 Set up the following defaults:

General tab

•	 Default Provider – The provider selected will be the primary provider assigned to each new head-of-
house. If you want to remove a selection, delete the text.

•	 Default Chart Provider – The provider selected will be the default provider when charting 
procedures for the patient. Click Patient’s Prov1 to have the patient’s primary provider act as this 
default, or click the Specific Provider search button  to select a provider.

By default, the Provider from Selected Appointment check box is clear. Select this check box if 
you want to keep the provider for a selected appointment in the Appointment Book as the provider 
for charting when you open the Patient Chart from the Appointment Book (by clicking the Patient 
Chart module button or by clicking Chart 
from the File menu) with an appointment 
selected. If an appointment is not selected 
in the Appointment Book when the Patient 
Chart is opened, the default Patient Chart 
provider will be the selected patient’s 
Provider 1 or the provider you specify, 
regardless of whether or not the Provider 
from Selected Appointment check box is 
selected.

•	 Default Billing Type – The billing type 
selected will be the billing type given to 
each new head-of-house.

•	 Default Billing Statement – The billing 
statement selected will be the form used 
when printing billing statements.
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Claim Providers tab – You can set up the  
default insurance claim providers for each 
clinic. Each clinic can have its own defaults. 
Also, Dentrix Enterprise can handle exceptions 
for various insurance plans as needed, so you 
don’t have to change the defaults each time you 
want to create claims for certain insurance 
carriers.

You set up templates to handle the default 
providers for claims. Each clinic can have a 
“main” template and any number of “exception” 
templates (which may vary based on the 
insurance plan). The Central clinic’s defaults 
are used for all clinics that do not have a main 
template.

•	 Add – While logged in to any clinic, you 
can set up templates for Central or any 
other clinic. To add a template, do the 
following:

a.	 Select a Clinic.

b.	 Click Add.

c.	 Set up the following options as needed:

•	 Claim Provider Template Name – The name for the template. Template names within a 
clinic must be unique, but templates with the same name can exist in multiple clinics.

•	 Billing Provider – The provider will be the provider printed on claims.

Select one of the following:

•	 Provider of Procedures – To use the provider applied to procedures.

•	 Patient’s Prov1 – To use a patient’s primary provider selected in the Family File.

•	 Specific Provider – To always have a specific provider listed and then click the search 
button  to select the appropriate provider. If you want to override the name in the 
database, select Name to use for Provider; and then click the search button  to select 
a provider name, or type a name in the field.

•	 Rendering Provider – The provider selected will be the provider that performs the services 
being billed on a claim.

Select one of the following:

•	 Provider of Procedures – To use the provider applied to procedures.

•	 Patient’s Prov 1 – To use a patient’s primary provider selected in the Family File.

•	 Specific Provider – To always have a specific provider listed and then click the search 
button  to select the appropriate provider. The rendering provider specified for a claim 
will only be used for electronic claims.

•	 Pay-To Provider – The provider selected will be the provider whose name appears in the pay 
to provider section of a claim.

Select one of the following:

•	 Claim Provider of Procedures – To use the provider applied to procedures.

•	 Patient’s Prov 1 – To use a patient’s primary provider selected in the Family File.
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•	 Specific Provider – To always have a specific provider listed and then click the search 
button  to select the desired provider. If you want to override the name in the 
database, select Name to use for Provider; and then click the search button  to select 
a provider name, or type a name in the field.

•	 Insurance Plan Exceptions (For a main template)

•	 Add exceptions after you have added your main template and the necessary exception 
templates for the selected clinic. To add an exception for a plan that does not use this 
template, click the Insurance plan search button  to select the insurance plan that 
you want to associate with this exception. Then, click Add.

•	 Remove exceptions that are no longer valid or that were added my mistake. To remove 
an exception, select that exception, and then click Remove. On the confirmation 
message that appears, click Yes. The exception is removed not the associated insurance 
plan or template.

Note: Any exceptions that you add to an exception template are ignored when claims are 
created. Only exceptions for a main template are used for claims.

d.	 Click Save.

•	 Delete – To delete a template, do the following:

a.	 Select a Clinic.

b.	 Under Claim Provider Templates, select a template, and then click Delete.

c.	 On the confirmation message that appears, click Yes.

•	 Select Template – Select the main template (the default or primary template) for the selected clinic. 
By default, the first template you add is the main one, but you can make any template the main one 
as needed. To specify the main template, select a template under Claim Provider Templates, and 
then click Select Template. The main template’s name is preceded by an asterisk (*) in the Claim 
Provider Templates list box.

•	 Copy – Copy a template to the same or a different clinic with a different name. Exceptions, if 
any, from the original template are not copied because each clinic can have its own unique set of 
templates. To copy a template, do the following:

a.	 Select a Clinic.

b.	 Select a template, and then click Copy. The Copy Claim Provider Template dialog box appears.

c.	 Click the New Template Clinic search button  to select the clinic where you want the new 
template to be added.

d.	 Type a name for the template in the New Template Name field (it can be the same as the original 
if you are copying the template to a different clinic than the original’s).

e.	 Click OK.

f.	 Click OK on the message that appears.
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eClaims Override tab – For each clinic, do the  
following:

a.	 Select a Clinic.

b.	 Set up the following options for the clinic:

•	 Name and IDs – Specify the provider 
whose name and provider IDs you want to 
use for the billing provider’s name and IDs 
on claims submitted electronically.

•	 Address and Phone – Specify the provider 
whose address and phone number you want 
to use for the billing provider’s address 
and phone number on claims submitted 
electronically:

3.	 Click OK to save the changes.

For comprehensive information about all the practice defaults, see the “Practice Defaults” topic in the Dentrix 
Enterprise Help.

Setting Up Auto Chart Numbering
You can set up Dentrix Enterprise to generate chart numbers for your patients automatically (MSSQL databases 
only). By using this feature, you can eliminate duplicate chart numbers and speed data entry for new patients.

Note: If your office uses the HL7 interface to connect Dentrix Enterprise with a medical practice management 
system (PMS), chart numbers will likely be generated in the medical PMS and transferred to Dentrix Enterprise.

To set up auto chart numbering

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Auto Chart Number Setup.

The Automatic Chart Numbering Setup dialog box appears.

2.	 Select an automatic chart numbering option:

•	 Numeric – To assign numeric chart numbers to all new patients.

•	 Alpha/Numeric – To assign an alphanumeric chart number to all new 
patients. The chart number will be the initial two characters of the 
patient’s last name and then a unique numeric ID (for example John 
Smith might be assigned SM0001).

•	 None – Not to use chart numbers in your office or to assign chart 
numbers manually.

3.	 From the Select Minimum Length list, select the minimum length for automatically-generated chart numbers.

4.	 Click OK.
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Setting Up Default Printers
You can set up a default printer for printing from the Office Manager and other areas throughout Dentrix 
Enterprise. However, before printing from the Office Manager or other modules, the printer to which you 
want to print must first be selected.

To select a default printer

1.	 In the Office Manager, from the File menu, click Setup 
Printer.

The DXONE Printer Selection dialog box appears.

2.	 Under Select Printer Area, select the area of Dentrix 
Enterprise to which you want to assign a default printer:

•	 Office Manager Printer – To print reports from the 
Office Manager module.

•	 Chart Printer – To print from the Patient Chart module.

•	 Label Printer – To print labels.

•	 Document Center Printer – To print documents from 
the Document Center module.

•	 Prescriptions – To print prescriptions from the 
Prescriptions module.

•	 Perio Printer – To print periodontal examinations from 
the Perio module.

•	 Presenter Printer – To print treatment plan presentations from the Treatment Planer module.

3.	 In the list box of printers, select the printer that will be used to print from the selected area.

4.	 Click OK.

Setting Up Passwords
Passwords in Dentrix Enterprise serve many different functions. First, you can use passwords to prevent an 
unauthorized person from performing certain sensitive tasks, such as changing information, deleting transactions, 
and accessing financial information. Second, you can have the extra security of flagging certain operations to 
require additional user verification—the password must be re-entered—to perform those operations.

In Dentrix Enterprise, each user is assigned “rights” to the tasks they need to complete. Dentrix Enterprise 
then allows access to each password-protected operation, according to the security rights assigned to the 
logged-on user. If a user does not have rights to perform a certain function, they cannot access that particular 
area of the program or perform that particular task.

Assigned rights are clinic-specific. Each user will need to be given rights for each clinic to which they have access.

Note: It is recommended that the doctor read this section carefully and be aware of who is given “Password 
Administration” rights in the office.

This section covers the following topics on setting up passwords:
•	 Password Requirements
•	 Assigning Security Rights
•	 Setting Up Secure Passwords
•	 Assigning User Verification to Tasks
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Password Requirements
The passwords for user accounts must adhere to the following criteria:

•	 Complexity – The password must be at least 8 (for standard users) or 15 (for administrative users) 
characters in length and meet the following requirements: have at least one uppercase letter, have at least 
one lowercase letter, have at least one number, and have at least one special character (for example, #, %, 
or &).

•	 Changes – When the password is changed, at least 75% of the characters must be different in the new 
password than in the old password.

•	 Storage and transmittal – Passwords must encrypted when being stored or transmitted.

•	 Expiration – A password can be valid for one to up to 60 days. Then, it expires and must be changed.

•	 Reuse – When changing a password, any of a given user’s previous six passwords cannot be reused.

•	 Temporary passwords – A temporary password can be provided for a given user to log on to a system, 
but a permanent password must be created by the user immediately upon logging on.
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Assigning Security Rights
When assigning user rights, keep in mind which tasks each individual performs. Some rights are directly 
related to others. Assign rights to only those individuals who will have a need to perform that operation.

To assign security rights to users

1.	 In the Office Manager, do one of the following:

•	 From the Maintenance menu, point to Practice Setup > 
Passwords, and then click Setup Users for Passwords.

•	 From the Clinic Resource Setup dialog box, click 
Password Setup.

The Password Administration - Setup 
Users dialog box appears.

2.	 If necessary, select the clinic for which you 
want to set up user rights. All users for 
that clinic appear in the list box.

3.	 Select a User ID from the list of available 
provider(s) and staff. The User Name and 
User ID appear in the upper-right corner 
of the dialog box.

4.	 To change or create a password, click 
Change Password. In the Change 
Password dialog box, type a password in 
the New Password field, re-type the same 
password in the Confirm Password field, 
and then click OK.

These password fields cannot be left 
blank. The password must be 7 to 11 
characters in length and meet three of 
the following four requirements: have at 
least one uppercase letter, have at least one 
lowercase letter, have at least one number, 
and have at least one special character (for 
example, #, %, or &).

Important: Assign the user a password that will not be forgotten. It is recommended that the password 
for the password administrator(s) (the person(s) with “Password Administration” rights) be written down 
and placed in a secure location.

5.	 When first opened, the security options list is “collapsed,” thus hiding the detailed security options for 
each category. To expand the list and view all security options, click Expand List. You can also click the 
plus (+) sign next to any category to see the rights for that category.

6.	 Select the security options to which you want the selected user to have rights. Or, you can copy rights 
from another user to this user; see step 7.

Important: Dentrix Enterprise requires you to set up at least one user with “Password Administration” 
rights (by selecting the Password Administration check box in the Administration category). 
Dentrix Enterprise will not allow you to exit this dialog box until at least one user is given Password 
Administration rights.
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7.	 If different users will have the same security rights selected, or if a user works at more than one clinic, you 
can save time by copying the rights to different users and clinics:

•	 Copy Rights From Other User – Click 
this button to copy rights from a specific 
user to the selected user. In the Password 
Administration - Copy Rights From 
Other Users dialog box, select the user 
from whom you want to copy rights. 
If the user has rights at more than the 
current clinic, you can select the desired 
clinic(s) and then click the right arrow 
button to move them to the right list box. 
Next, click Copy from Clinic: (Current) 
or Copy from ALL selected clinics.

•	 Copy Rights To Other Clinics – Click 
this button to copy the selected user’s 
rights to other clinics. In the Password 
Administration - Copy rights from 
current clinic dialog box, select the 
clinic(s) to which you want to copy rights, 
and then click the right arrow button to 
move the clinic(s) to the right list box. 
Next, click OK.

•	 Copy Rights To Other Users – Click 
this button to copy the selected user’s 
rights to other users. In the Password 
Administration - Copy rights to other 
users dialog box, select the user(s) to 
whom you want to copy rights, and then 
click the right arrow button to move the 
user(s) to the right list box. Next, click 
OK.

8.	 After the rights have been set up for the selected user, click Save, or select the next user. On the message 
that appears and prompts you to save the changes, click Yes.

9.	 Repeat steps 3 – 8 for the other users that need passwords and/or rights assigned, and then click Close.

If you haven’t saved the changes for the currently selected user, on the message that appears and prompts 
you to save the changes, click Yes.

For a comprehensive list of all security options and their corresponding descriptions, see the “Security rights 
list” topic in the Dentrix Enterprise Help.
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Setting Up Secure Passwords
A clinic can set up a time interval that forces users to change their passwords regularly. For instance, an office 
may want to enforce a change of password every three months. In conjunction with this, your office can set a 
requirement that users cannot reuse any of their previous passwords.

To set up secure user passwords

1.	 While logged on to the Central clinic, in the Office Manager, 
from the Maintenance menu, point to Practice Setup > 
Passwords, and then click Secure User Password Setup.

The Secure User Password Setup dialog box appears.

2.	 Set up the following options:

•	 Password Expiration – If you want passwords to expire 
so that users have to change their passwords after a 
certain length of time, click Expiration, and then select 
a password expiration date in days. If you want users 
to be forewarned of a pending password change, check 
Warn, and then select the days before the expiration date 
that you want the notification to appear. If you do not 
want passwords to expire (users will never have to change 
passwords), click No Expiration.

•	 Set Security Defaults

•	 Lock user out for – To select how many logon 
attempts a user has before that user is locked out of 
the system for a specific period of time, check this 
option, select the time interval for which a user will be 
locked out in minutes, and select the number of logon 
attempts users have.

Note: When a user is locked out, an administrator can reset any and all locked out users.

•	 Do not allow use of the past – If you want to prevent users from reusing a specific number of 
old passwords, check this option, and then select how many previous passwords you want to 
block.

3.	 Click Save.
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Assigning User Verification to Tasks
Once a user has logged on to Dentrix Enterprise, the user may perform all tasks to which they have rights. 
There can be certain situations for which additional protection is desired. In these cases, the security options 
can be flagged to “Verify User Before Access.” With this security flag enabled for a task, users will be prompted 
to re-enter a user name and password when attempting to perform that task.

Tip: Consider how frequently the security task is performed before assigning the “Verify Users Before Access” 
flag. This flag will always prompt users to enter their passwords before they can continue working; a lot of 
interruptions might not be worth the added security.

To assign user verification

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup > Passwords, and then click Setup Practice for 
Passwords.

The Password - Setup Practice dialog box appears.

2.	 Select one or more tasks.

3.	 Click Verify User Before Access.

The selected tasks are flagged and moved to the bottom of the list. 
An asterisk (*) appears before a security option that is flagged to 
require re-entry of a password every time users attempt to perform 
that task.

4.	 Click OK.
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Setting Up Program Preferences
You can customize Dentrix Enterprise to the way your practice works. Each computer can have different 
preference settings.

To set up preferences

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Preferences.

The Preferences dialog box appears.

2.	 On the General Options tab, set up the following preferences:

•	 Find Appointment Time Defaults – Set 
the defaults for the Find Appointment 
Time button in the Appointment Book. 
Select the Block size in minutes and an 
Appt Length. Select All Operatories 
Selected to search all operatories and/or 
Sort by Operatory ID to sort the results 
by operatory ID. Select whether to search 
by the current Appointment Book view or 
by the current clinic.

•	 Apply to Charges for’ Default – To have 
charges default to the family of the selected 
patient when making a payment or credit 
adjustment, click Family. Or, to have 
charges default to whomever’s account is being viewed in the Ledger, click Ledger View.

3.	 On the Print Options tab, set up the following preferences:

•	 Use ADA Codes in Descriptions – 
To have ADA codes print with their 
descriptions, select this check box.

•	 Provider ID Column for Statements – To 
have the provider ID printed next to each 
transaction description on walkouts and 
billing statements, select this check box.

•	 No Insurance Flag(*) on Statements – To 
remove the text “*Indicates this procedure 
has been billed to Insurance” from billing 
statements, select this check box.

•	 Verify Billing Statements to Send – To 
preview billing statements before printing 
them or sending then electronically, select this check box.

•	 Sort Claim by ID – To print procedures on insurance claims in the order the procedures were posted 
in the Patient Chart or Ledger, select this check box.

•	 Sort Pretreatment by ID – To print procedures on pre-estimate claims in the order the procedures 
were posted in Patient Chart or Ledger, select this check box.

4.	 Click OK.
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Chapter 2: Family File
The Family File stores and displays important patient information, such as a patient’s name, address, phone 
number, medical alerts, birth date, insurance coverage, employer, and referral information. Dentrix Enterprise 
organizes patients by family in the Family File.

This chapter covers the following topics about using the Family File:

•	 Using the Family File Window

•	 Selecting a Patient

•	 Adding Families and Patients

•	 Working with Employers

•	 Working with Insurance

•	 Assigning Continuing Care

•	 Working with Patient Notes

•	 Working with Referrals

•	 Assigning Medical Alerts

•	 Archiving Patients

•	 Editing Family Relations

•	 Merging Patients
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Using the Family File Window
This section covers the following topics to help you understand how to use the Family File window:

•	 Using the Family File Blocks

•	 Using the Family Member List

•	 Using the Family File Toolbar

Using the Family File Blocks
The Family File window contains several boxes, called “blocks,” that display information. By double-clicking 
any of these blocks, you can enter, edit, or delete corresponding patient information.

Patient Information 
Block

Medical Alerts Block Continuing 
Care Block

Insurance 
Information Block

Patient Notes 
Block

Employer Block

Referral BlocksBilling and Payment 
Agreement Block

Note: From the Billing and Payment Agreement block in the Family File, you can change a family’s billing 
type, set up payment agreements, and manage guarantor notes. These functions are discussed in Chapter 7: 
Ledger.

Using the Family Member List
The Family Member List displays all members of the family. Double-click a family member to quickly access 
that family member’s information in the Family File.
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Using the Family File Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Family File are explained in the following table.

Click the Select Patient button to select a patient whose record you want to view in the Family File.

Click the Add New Family Member button to create a patient record in the family currently being 
viewed in the Family File.
If the patient currently being viewed in the Family File has referred any patients to your practice, 
click the Referral Analysis button to monitor referrals or enter gratuities.
Click the Patient Notes Report button to print patient notes and other types of notes in Dentrix 
Enterprise for the patient currently being viewed in the Family File.
Click the Patient Alerts button to enter or manage the alerts for the patient currently being viewed 
in the Family File.
Click the Clinical Notes button to manage clinical notes regarding the treatments for the patient 
currently being viewed in the Family File.
Click the Patient Referrals button to enter or manage referrals to and from your practice for the 
patient currently being viewed in the Family File.

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Family File toolbar” 
topic in the Dentrix Enterprise Help.

Selecting a Patient
To view or edit a patient’s information in the Family File (or any other patient-specific module), you must 
select the patient. By default, you search for patients by lastname; however, you can search for patients using 
other information, such as first name, a home phone number, chart number, or Social Security number.

Note: When you first install Dentrix Enterprise, no patients are in the database. Patient information must be 
entered manually or through an electronic data conversion.

To select a patient

1.	 From the File menu, click Patient.

The Select Patient dialog box appears.

2.	 Type all or the first few letters of 
the patient’s last name in the Enter 
Name field, and then click the search 
button  to view a list of patients 
that match the search criteria.

Tip: If you open this dialog box 
from the Family File, to include 
archived patients in your search, 
select Include Archived Patients.

3.	 Select the name of the patient.

4.	 Click OK.
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Adding Families and Patients
This section covers the following topics about how to add patient records into Dentrix Enterprise:

•	 Viewing Patient Records

•	 Adding Family Members

•	 Adding a New Patient with an Appointment

Viewing Patient Records
The Family Files stores patient records by family. A family in Dentrix Enterprise must hve at least one person, 
the head-of-house (guarantor), even if that person is not a patient. When you register a patient in RPMS, the 
patient and corresponding demographics are pushed to Dentrix Enterprise. If you want to add a patient in 
Dentrix Enterprise, contact Dentrix Technical Support.

Important: The current functionality of an HL7 interface is to transfer data from a “host” system (RPMS) 
to a “secondary” system (Dentrix Enterprise). This means that any changes to some patient demographic 
fields you make in Dentrix Enterprise may be overridden the next time the HL7 interface is processed and an 
update message comes across.
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Adding Family Members
Since all patients in Dentrix Enterprise come from RPMS, the only time you may need to add a family 
member to a family is for insurance purposes. Dentrix Enterprise allows you to enter up to 18 family 
members per family.

To add a family member

1.	 With the appropriate family account being viewed in the Family File, from 
the File menu, click Add New Family Member.

The Patient Information 
dialog box appears.

2.	 The last name, primary 
provider, home phone 
number, address, and 
email address of the 
head-of-house are already 
entered for this patient. 
However, you can change 
any of that information 
as needed and enter 
the rest of the patient’s 
information.

3.	 Click OK.
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Adding a New Patient with an Appointment
You can create a Family File record for a new patient who has an appointment in the Appointment Book. This 
functionality can help prevent the re-entry of a person’s name and address when creating a Family File record.

To add a new patient with an appointment

1.	 Once the patient 
has been registered 
in RPMS and 
pushed across to 
Dentrix Enterprise, 
double-click the new 
patient’s appointment 
in the Appointment 
Book  You can 
identify a new-
patient appointment 
by the “NP” that 
appears before the 
person’s name on the 
appointment.

Important: All demographics for the patient come from RPMS. Do not add a patient or change patient 
information in Dentrix Enterprise.

2.	 Click Change Pat, and then select the patient. 

3.	 Click OK.

You can now post treatment for this patient.

1

2



Chapter 2: Family File     57

Dentrix Enterprise 8.0.5 User’s Guide

Working with Employers
This section covers the following topics about how to manage patients’ employers:

•	 Assigning Employers

•	 Changing an Employer

Assigning Employers
From the Family File, you can assign an employer to a patient or add a new employer and assign it to a 
patient.

Tip: Dentrix Enterprise stores all employers and their corresponding information entered from the Family 
File or Office Manager. When you assign an employer that has never been entered into Dentrix Enterprise to 
a patient, you must enter all the employer’s information; however, the next time you need to assign that same 
employer to a patient, you can choose the employer from a list instead of having to re-enter all the employer’s 
information again.

To assign an employer to a patient

1.	 In the Family File, with a patient selected, double-click the 
Employer block.

The Employer Information dialog box appears.

2.	 Type the first few characters of the employer’s name in the 
Employer Name field, and then click the search button .

The Select Employer dialog box appears so that you can verify 
that the employer does not already exist in Dentrix 
Enterprise.

3.	 Do one of the following:

•	 If the employer 
already exists, 
select it, and 
then click OK 
to display that 
employer’s 
information in 
the Employer 
Information 
dialog box 
appears.

•	 If the patient’s employer does not already 
exist, click Cancel to return to the 
Employer Information dialog box, and 
then type the employer’s name, address, and 
phone number.

4.	 Click OK.

For information about adding an employer from 
the Office Manager, see the “Adding and editing 
employers” topic in the Dentrix Enterprise Help.
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Changing an Employer
When a patient changes employers, or a patient’s current employer changes its name, address, and/or phone 
number, Dentrix Enterprise lets you change that information. Any changes you make to an employer’s 
information affects other patients who have that same employer.

To change the employer assigned to a patient

1.	 In the Family File, with a patient selected, double-
click the Employer block.

The Employer Information dialog box appears.

2.	 Do one of the following:

•	 If the patient has a new employer, click Clear, 
and then select or enter a different employer 
as explained in “Assigning Employers” in this 
chapter.

•	 If the patient’s current employer has changed 
its name, address, or phone number, make any 
necessary changes.

3.	 Click OK.

If you have changed the information in any field (not 
just selected or entered a new employer), a message 
appears and states that the changes to this employer 
will affect the employer information for all patients 
with this employer. To confirm you want to make the 
change to all the relevant patients, click OK.

Working with Insurance
Whenever a new family member is entered, he or she is automatically given the same insurance coverage as the 
head-of-house, but a different insurance plan can be attached to the patient or head-of-house at any time. This 
section covers the following topics about how to add and remove dental insurance for a patient or head-of-
house:

•	 Assigning Dental Insurance to a Subscriber

•	 Assigning Dental Insurance to a Non-subscriber

•	 Changing Dental Insurance Carrier Information

•	 Assigning Coverage Tables

•	 Clearing Dental Insurance Coverage
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Assigning Dental Insurance to a Subscriber
Before you can assign dental insurance to a patient who is not the insurance plan subscriber, you must assign 
insurance to the subscriber in the family. If the subscriber is not a patient, add the subscriber to the family as a 
non-patient.

To assign dental insurance to a subscriber

1.	 In the Family File, with a patient selected, double-click the 
Insurance Information block.

The Insurance Information dialog box appears.

2.	 From the Coverage Order list, select the type of coverage you 
want to add to the subscriber: Primary, Secondary, Tertiary, or 
Quaternary.

3.	 If the subscriber’s name is not in the 
Subscriber field, click the search button . 
In the Select Primary Subscriber dialog box, 
click Current Patient to make the patient 
currently being viewed in the Family File 
the subscriber and return to the Insurance 
Information dialog box.

4.	 To find out if the carrier already 
exists in Dentrix Enterprise, 
click the Carrier search button 

. In the Select Dental 
Insurance Plan dialog box, 
type the first few characters of 
the carrier’s name (you can also 
search by employer, group plan, 
or group number), and then 
click the search button  to 
view a list of all the carriers that 
match your search criteria.

Important: Always search for an insurance plan before adding it as a new plan in Dentrix Enterprise to 
avoid creating duplicates of an insurance plan.

5.	 Do one of the following:

•	 If the carrier already exists, select it, and then click OK to return to the Insurance Information 
dialog box.

•	 If the carrier does not already exist, click New Insurance Plan to add the insurance plan and return 
to the Insurance Information dialog box. For an explanation about setting up the options for a new 
insurance plan, see “Changing Dental Insurance Carrier Information” in this chapter.
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7

6

6.	 Set up the following options:

•	 Subscriber Id # – The subscriber’s Social Security number is automatically entered as the subscriber 
ID number, but you can change it.

Important: If this field is left blank, any insurance information you enter will not be saved and 
attached to the subscriber.

•	 Signature on File – If you want the words “Signature on File” to print on insurance claims for the 
subscriber to authorize the release of information, select Release of Information. If you want to 
authorize payments directly to the provider instead of the subscriber, select Assignment of Benefits.

Important: If your office accepts assignment of benefits from insurance carriers, you must select the 
Assignment of Benefits check box; if you do not, insurance checks will be mailed to the subscriber, 
not the office.

•	 Relation to Subscriber – Make sure Self is selected to indicate that the current patient is the 
subscriber.

7.	 Click OK.
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Assigning Dental Insurance to a Non-
subscriber
Before assigning insurance to patients who are not insurance subscribers, make sure that the insurance plan 
has been assigned to the subscriber, and the subscriber for the insurance plan is part of the same family as the 
patient to whom you are assigning the insurance plan.

To assign dental insurance to a non-subscriber

1.	 In the Family File, with a patient selected, double-click the 
Insurance Information block.

The Insurance Information dialog box appears.

2.	 From the Coverage Order list, select the type of coverage you 
want to add to the patient: Primary, Secondary, Tertiary, or 
Quaternary.

3.	 If the subscriber’s name is not in the Subscriber field, click the 
search button  to select the appropriate subscriber.

Important: The insurance carrier for the selected subscriber appears in the Carrier field. If you change the 
carrier for the selected subscriber, the change will affect all other family members under this subscriber.

4.	 Set up the following options:

•	 Subscriber Id # – The subscriber’s Social 
Security number is automatically entered 
as the subscriber ID number, but you can 
change it.

Important: If this field is left blank, any 
insurance information you enter will not be 
saved and attached to the subscriber.

•	 Signature on File – If you want the words 
“Signature on File” to print on insurance 
claims for the subscriber to authorize the 
release of information, select Release of 
Information. If you want to authorize 
payments directly to the provider instead 
of the subscriber, select Assignment of 
Benefits.

Important: If your office accepts assignment 
of benefits from insurance carriers, you must 
select the Assignment of Benefits check 
box; if you do not, insurance checks will be mailed to the subscriber, not the office.

•	 Relation to Subscriber – Make sure the patient’s relation to the subscriber is correct: Spouse, Child, 
or Other.

5.	 Click OK.
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Changing Dental Insurance Carrier 
Information
You can change information for a dental insurance carrier at any time. You can edit this information from the 
Family File or Office Manager.

To change insurance carrier information

1.	 In the Family File, with a patient selected, double-click the 
Insurance Information block.

The Insurance Information dialog box appears.

2.	 From the Coverage Order list, select the type of coverage you 
want to edit: Primary, Secondary, Tertiary, or Quaternary.

3.	 Click Insurance Data.

The Dental Insurance Plan Information 
dialog box appears.

4.	 Change any of the following options as needed:

•	 Carrier Name – Type the insurance carrier’s name.

•	 Group Plan – Type the group plan name.

Tip: If you do not have a group plan name, type the employer name as the group plan name; this will 
assist you later on when you are assigning previously entered insurances to patients.
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•	 Employer – Click the search button  to select the employer that administers the group plan.

•	 Contact Information – Type the address where insurance claims are to be mailed for this carrier. 
Also, type the contact phone number and extension (if applicable), and the contact person.

•	 Group # – Type the group number for this plan.

•	 Benefit Renewal – Type the month that the yearly insurance benefits renew for the insured patients.

•	 Claim Format – The claim format defaults to the first claim format listed in Practice Definitions, but 
you can select a different one if applicable.

•	 Fee Schedule – Click the search button  to select a fee schedule to attach to this insurance carrier.

Note: If a fee schedule is attached to the insurance carrier, it will be used instead of the fee schedule 
attached to the patient’s primary provider. However, if a fee schedule is selected for the patient, that 
fee schedule will be used instead of the one attached to the insurance carrier.

•	 RVU Schedule – Click the search button  to select an RVU fee schedule to attach to this 
insurance carrier.

•	 Payor ID – Type the payor ID that is to be used with electronic claims, or click the search button  
to find and select a payor ID.

•	 Auto Adjustment – Choose from the following automatic adjustment options:

•	 No Adjustment – If you do not want an automatic adjustment posted for this insurance carrier.

•	 Write Off Estimated Insurance Portion – To automatically make an adjustment for the 
estimated insurance portion in the Ledger.

Select the credit adjustment type you want to use for the adjustment.

•	 If you want to post an adjustment after a claim is created, click Post when Claim Created. 
This option should be used if claims will always be created for the insurance. Select Receive 
Claim to change the claim status to “Received” with a zero payment after the adjustment 
is made. If Receive Claim is selected, you can set up further actions you want to occur 
automatically after a claim is received – Send to Batch, Applying Ins. Portions to 
Maximums, and Apply deductibles based on expected Patient Portion.

•	 If you want to post an adjustment when a procedure is completed, click Post when 
Procedure Completed. This option should be used if no claims will be created for the 
insurance. With this option selected, any changes made to the coverage table after the 
procedure has been set complete will not be reflected in the adjustment.

•	 Use Insurance Fee to Calculate – To have the adjustment calculated using the following 
formula: Provider or patient fee schedule amount - Insurance fee schedule amount = 
Adjustment amount.

The following will happen with this option selected:

•	 If the patient has been assigned a fee schedule in the Family File, an adjustment will be 
posted that equals the difference between the patient fee schedule amount and the insurance 
fee schedule amount.

•	 If the patient does not have a fee schedule assigned to him or her, the patient’s primary 
provider’s assigned fee schedule will be used. An adjustment will be posted that equals the 
difference between the provider’s fee schedule and the insurance fee schedule amount. To use 
this option, a fee schedule must be selected for the insurance carrier.

Select the credit adjustment type that you want to use for the adjustment:

•	 If you want to post the adjustment using this calculation when the claim has been received, 
click Post when Claim is Paid.
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•	 If you want to post the adjustment using the formula previously mentioned when a 
procedure is set complete, Post when Procedure completed. Select Create/Receive Claim 
to have the following occur automatically: create a claim, post the adjustment, and then 
change the status of the claim to “Received” with a zero payment. If Create/Receive Claim 
is selected, you can set up further actions you want to occur automatically after a claim is 
received: Send to Batch and Apply deductibles based on expected Patient Portion.

•	 Rate Code Options – Some insurance companies (usually state Medicaid) pay a practice a set dollar 
amount per visit no matter how many or how few procedures were performed on a patient during 
that visit. The “rate code,” also known as an “encounter code” or “visit code,” is a procedure code that 
tells the insurance company how much that amount is. You can choose to include and under what 
conditions to include an encounter, rate, or visit code on a claim:

a.	 Select Send Rate Code with Claim, and then click the search button  to select the 
appropriate code.

b.	 Under Send Rate Code With, select one of the following options:

•	 The Total of All Procedures – The selected rate code will be used as the first procedure on 
the claim (printed or electronic), and the amount of the rate code will be the sum of all the 
procedures on the claim.

The fee used for this calculation will be the default fee schedule (with the ID number “1”) for the 
billing provider for the claim. This is the same fee schedule that is used for an “F” claim format.

•	 Practice’s Rate – The selected rate code will be used as the first procedure on the claim 
(printed or electronic), and the amount of the rate code will be the rate entered in the field. 
By default, the field has the insurance plan’s fee schedule, but you can change it to specify the 
rate code that you want to be used on the claim.

•	 No Amount – The selected rate code will be used as the first procedure on the claim (printed 
or electronic), but the amount or charge on the claim for the rate code will be blank.

c.	 From the Send Procedure Codes list, select one of the following options:

•	 With A Zero (0.00) Dollar Amount – The procedures will be listed after the rate code on 
the insurance claim (printed or electronic) with a zero dollar amount (0.00).

•	 With The Procedure’s Fee – The procedures will be listed after the rate code on the 
insurance claim (printed or electronic) with each procedure’s fee as the amount charged.

•	 No Amount – The procedures will be listed after the rate code on the insurance claim 
(printed or electronic) with each procedure’s charged amount being blank.

•	 Do Not Send Procedures – Only the rate code will be listed on the insurance claim (printed 
or electronic).

d.	 If you want the rate code to be posted in the Ledger, select Post Rate Code to Ledger. The rate 
code will not appear in the Patient Chart. The fee shown in the Ledger will be the same fee that 
appears on the claim.

Important: The fee schedules for the procedure code(s) and rate code on the claim must not 
conflict or double the account balance in the Ledger.

Notes:

•	 Since the rate code has to be medically crossed coded to be placed on a medical claim, Dentrix 
Enterprise will post the rate code and automatically edit the rate code to select the appropriate 
AMA CPT and ICD-9-CM diagnostic code (with the installation of Dentrix Enterprise, a 
“Rate Code” has been added to the AMA CPT list and ICD-9-CM diagnostic code list) as long 
as the rate procedure code is cross coded with the AMA CPT “Rate Code” and ICD-9-CM 
“Rate Code”.
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•	 The AMA CPT “Rate Code” and ICD-9-CM “Rate Code” tied to the procedure rate code 
will not appear on the claim (printed or electronic).

•	 If the AMA CPT “Rate Code” and ICD-9-CM “Rate Code” tied to the procedure rate code 
are deleted, the rate code option for the claim will not work properly, and you will have to 
cross code the rate code again.

5.	 Click OK to save the insurance plan and return to the Insurance Information dialog box.

6.	 Click OK.

If the carrier information has been changed for an insurance plan that is attached to at least one other 
family member (subscriber or non-subscriber), a dialog box appears so that you can choose whether to 
apply the changes to all other subscribers who have the same insurance plan, which will in turn affect the 
family members of the those subscribers, or to have the change affect only the current subscriber and add 
the changed plan as new insurance plan without changing the original plan.

Assigning Coverage Tables
Most insurance companies provide the patient with a schedule of benefits, which declares the maximum 
annual benefits for the individual and entire family. The schedule of benefits also states the deductible 
amounts, plan maximums, and the percentage of the usual and customary fee that the insurance company will 
pay.

You can add this information to an insurance plan as a coverage table. A coverage table helps you create 
treatment plan estimates that accurately reflect the benefits paid by an insurance carrier.

To assign or edit an insurance plan’s coverage table

1.	 In the Family File, with a patient selected, double-click the 
Insurance Information block.

The Insurance Information dialog box appears.

2.	 From the Coverage Order list, select the type of coverage you 
want to edit: Primary, Secondary, Tertiary, or Quaternary.

3.	 Click Coverage Table.

The Insurance Coverage dialog box appears.
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4.	 Set up the following options:

•	 Deductible – Each range of procedure codes in your coverage table can be assigned its own 
deductible type. The following types of deductibles are available:

•	 Standard (S) – Used for most insurance coverage tables.

•	 Preventive (P) – Used if an insurance carrier’s coverage has a separate deductible for preventive/
diagnostic procedures.

•	 Other (O) – Used if an insurance carrier’s coverage has a separate deductible for specific 
procedures other than preventive/diagnostic.

For each type of deductible, you can type the following:

•	 Lifetime Individual – Used for insurance carriers that require subscribers to pay one deductible 
for the life of the policy for the patient.

•	 Annual Individual – Used for insurance carriers that require patients to pay a deductible amount 
each benefit year.

•	 Annual Family – Used for insurance carriers that require a maximum deductible amount for the 
entire family each benefit year.

Tip: When Dentrix Enterprise calculates the patient’s portion of charges, the appropriate deductible 
amounts will be added to the patient’s payment due amount. This figure will be displayed in the 
Ledger as the Est. Patient Portion.

•	 Maximum Benefit – Type maximum amount of benefits that will be paid by the insurance carrier for 
the Individual patient and Family annually.

•	 Coverage Table – A coverage table allows you to group several procedures into ranges and assign 
the percentage the insurance will pay. When a new insurance plan is created, Dentrix Enterprise 
automatically assigns it the first standard coverage table.

Tip: If you do not have or know the insurance company’s schedule of benefits, as insurance payments 
and estimates are made, you will be given the option in the Ledger to automatically update a payment 
table for the insurance plan, storing what the insurance company actually paid for a procedure. 
Insurance estimate calculations will reflect the payment table amounts whenever possible, making 
your estimates very accurate.

There are two things to keep in mind when modifying a coverage table. First, you must use the ADA 
procedure codes. Second, you may not overlap the beginning (or ending) procedure code of any given 
range with the ending (or beginning) procedure code in another range.

Do the following to modify the coverage table:

a.	 Select a code range.

b.	 Change any of the following values:

•	 Beg Proc – The beginning procedure code in the range.

•	 End Proc – The ending procedure code in the range. If you are assigning only one procedure 
to a range, type that procedure code as the Beg Proc and leave the End Proc field blank. The 
field will automatically be filled in with the beginning procedure code.

•	 Category – The name you assign to represent the range of procedure codes.

•	 Cov % – The percentage the insurance plan will pay for all of the procedures in the range.

•	 Ded – The deductible type for the range of procedure codes.
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•	 Co-Pay – If you are setting up a capitation plan, type the patient’s co-pay amount.

•	 Pre Est? – If the insurance company requires you to submit a pre-treatment estimate for a 
procedure in the range, select this option.

c.	 Do one of the following:

•	 To add the modified range to the coverage table as a new range, click Add.

•	 To apply the changes to the selected range, click Change.

d.	 Repeat steps a – c for any other ranges you want to add or modify.

•	 Co-Payment Calculations for Ins Portion – If the plan requires that specific co-pay amounts be 
paid by the patient for each procedure, select this check box, and then select the method that will be 
used to calculate the amount the insurance company will pay:

•	 Total Fee x Coverage %

•	 (Total Fee - Co-Pay) x Cov %

•	 (Total Fee x Cov%) - Co-Pay

Important: If the plan you are setting up is not a capitation type plan with specific co-payment 
amounts for each procedure, do not select the Co-Payment Calculation for Ins Portion box.

5.	 Click OK to save the coverage table and return to the Insurance Information dialog box.

When a message appears, click OK to confirm that you want to apply the changes you have made to all 
patients who have this insurance carrier.

6.	 Click OK.
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Clearing Dental Insurance Coverage
To move a patient from one family to another, you must first clear that patient’s insurance information. Also, 
to switch a patient’s primary and secondary coverage, you must first clear that patient’s primary and secondary 
insurance.

To clear a patient’s insurance coverage

1.	 In the Family File, with a patient selected, double-click the 
Insurance Information block.

The Insurance Information dialog box appears.

2.	 From the Coverage Order list, select the type of coverage you 
want to remove: Primary, Secondary, Tertiary, or Quaternary.

3.	 Click Clear Coverage.

4.	 Click OK.
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Assigning Continuing Care
You can manage the continuing care (recall or recare) attached to each patient from the Family File. If a 
patient has had a completed procedure posted in the Ledger or Patient Chart, and that procedure already 
has a continuing care flag assigned to it (for example, prophy), the appropriate continuing care type will 
automatically be assigned to that patient. However, you can assign a continuing care type to a patient 
manually and even customize the settings to meet that patient’s needs.

To assign a continuing care type to a patient

1.	 In the Family File, with a patient selected, double-
click the Continuing Care block.

The Patient Continuing Care dialog box appears.

2.	 Select the continuing care type you want to set.

Note: If the selected continuing care type is already 
set for the patient, the Date column for the 
continuing care type contains a date, and the 
Set button is labeled “Edit.”

3.	 Click Set.

The Set Continuing Care dialog box appears.

4.	 Customize the following options as needed:

•	 Due Date – To set the interval for the 
patient’s recall, click the search button 

. Change the Interval to reflect 
the amount of time that should elapse 
between the patient’s recall visits, and 
select +1 Day to prevent insurance 
billing problems if the carrier has strict 
interval requirements.

•	 Status – To assign a continuing care status 
to the patient, select the appropriate status. 
Statuses are used primarily when generating 
continuing care lists.

•	 Provider – To have the default provider of 
continuing care appointments be the patient’s 
primary provider, select Prov1; or, to have it be 
the patient’s secondary provider, select Prov2.

•	 Default Appt. Time – To enter the amount 
of time this patient will need for appointments 
with this continuing care type attached, select 
Time?. Drag the slider to set the number of 
units, and then set up the time pattern for each unit (chair time , assistant’s time , or provider’s time ) 
to help you make use of all operatories when scheduling appointments and maximize your productivity.

5.	 Click OK.

For comprehensive details about all the options available when assigning continuing care types, see the 
“Assigning continuing care” topic in the Dentrix Enterprise Help. Also, for more information about setting 
up continuing care types and their default settings, see “Setting Up Continuing Care Types” in Chapter 1: 
Introduction and Initial Setup.
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Working with Patient Notes
Patient notes apply only to an individual patient, and you can view, add, and edit them from the Family File. 
This section covers the following topics about how to use patient notes in the Family File:

•	 Viewing and Hiding Patient Notes

•	 Adding and Editing Patient Notes

•	 Generating the Patient Notes Report

Viewing and Hiding Patient Notes
When Dentrix Enterprise is initially started, notes are hidden by default. Thereafter, whenever a patient is 
displayed in the Family File, the notes will be viewed or hidden, depending on the state of the previously 
selected patient’s notes.

To view and hide patient notes

If the notes are being hidden, you can view the notes 
by clicking View. (When you click View, the button 
label changes to “Hide.”)

If the notes contain confidential information, it is 
recommended that you hide the notes by clicking 
Hide after each time the notes are viewed. (When 
you click Hide, the button label changes to “View.”)

Note: If no notes have been entered for the patient, the block displays “No Note,” and the View/Hide option 
is not available.

Adding and Editing Patient Notes
You can add notes to an individual patient’s record. Also, you can edit those notes at any time.

To add or edit notes for a patient

1.	 In the Family File, with a patient selected, double-click the 
Patient Notes block.

The Patient Note dialog box appears.

2.	 Type the patient’s hobbies, interests, financial arrangements, or 
any other notes useful to your practice. A patient note is 
limited to 4,000 characters.

Tip: If you want to delete the patient notes for this 
patient, click Clear. The notes will not be deleted until 
you click OK, so if you click Clear accidentally, you can 
restore the notes to how they were before you opened the 
dialog box by clicking Cancel instead of OK.

3.	 Click OK.
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Generating the Patient Notes Report
You can generate a report of all notes entered for a patient from the Family File. You can also run this report 
from the Office Manager.

To print the Patient Notes Report

1.	 In the Family File, with a patient selected, from the File menu, click 
Print Patient Notes.

The Patient Notes Report dialog box appears.

2.	 Set up the following options:

•	 Filters – You can include notes for the current patient or a range of patients and for only guarantors. 
If you run the report for a range of patients, you can further filter the report by patients’ providers 
and/or billing types.

•	 Note Types – Select the types of notes you want to include on the report:
•	 Patient Alert Notes – Notes entered in the Patient Alert system. You can also specify a date range 

to include notes that were entered within that time period.
•	 Perio Exam Notes – Notes entered in the Perio Clinical Notes dialog box (which is accessed 

from the Diagnostics menu in the Perio Chart). You can also specify a date range to include 
notes that were entered within that time period.

•	 Appointment Notes – Notes attached to appointments. You can also specify a date range to 
include notes that were entered within that time period.

•	 Patient Notes – Notes entered in the Patient Notes block of the Family File.
•	 Medical Alerts – Medical alerts for patients.
•	 Continuing Care Notes – Motivational notes added from the Set (or Edit) Continuing Care 

dialog box.
•	 Insurance Claim Notes – Notes entered for insurance claims.
•	 Payment Plan Notes – Notes attached to a future due payment plan set up for the patient.
•	 Guarantor Note – Guarantor note entered in the Ledger.
•	 Guarantor Statement Note – Guarantor billing statement note entered in the Ledger.

Tip: If you want the selected note types to be selected the next time you run the report, click Save As 
Default.

3.	 Click Send to batch or Print.
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Working with Referrals
Dentrix Enterprise provides two types of referral sources (“Referred by” referral types) that you can attach to 
patients who have been referred to your practice: Referred by Patient and Referred by Doctor/Other. Also, 
Dentrix Enterprise provides a “Referred to” referral type that you can attach to patients to help you keep track 
of those patients who have been referred out to another doctor or specialist.

This section covers the following topics about patient referrals and referrals out to specialists:

•	 Entering Patient Referrals

•	 Entering Doctor/Specialist Referrals

•	 Sending Correspondence to Referrals

Entering Patient Referrals
In the Family File, you can enter information about the patient who referred another patient to your practice.

To enter a patient referral

1.	 In the Family File, with a patient selected, double-click the 
Referred By block.

The Patient Referrals 
dialog box appears.

2.	 Next to the Referred 
By list box, click Add 
Referral.

The Select Referral 
Type dialog box appears.

3.	 Select Patient, and then click 
OK.

The Select Patient dialog box 
appears.

4.	 Select the person who referred 
the patient.

Tip: If you cannot find the 
referring patient’s name, first 
check the spelling; then, if you 
still cannot locate the patient’s 
name, he or she has not been 
entered in the Family File yet, 
or the referring party is not one of your patients and must be 
entered as a non-patient referral (Referred by Doctor/Other).

5.	 To change the date the patient was referred to your practice or to 
change the provider to associate with this referral, with the referring 
patient selected in the Referred By list box, click Edit. In the dialog 
box that appears, type the correct date in the Patient Referred-By 
Date field, and then click OK.

For more information on referral sources, clearing referrals, and referral 
analysis, see the “Working with referrals” topic and its subtopics in the 
Dentrix Enterprise Help.
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Entering Doctor/Specialist Referrals
In the Family File, you can enter the information about the specialist to whom you referred a patient.

To enter a referral to a doctor/specialist

1.	 In the Family File, with a patient selected, double-click the 
Referred To block.

The Patient Referrals dialog box appears.

2.	 Next to the Referred To list 
box, click Add Referral.

The Select Referred To 
dialog box appears.

3.	 Initially, all doctors/
specialists are listed. To 
narrow the search, type the 
first few characters of the 
doctor/specialist’s name in 
the Enter Name for Search 
field, and then click the 
search button  to view the 
doctors/specialists that begin 
with those letters.

Tip: If the doctor/specialist 
is not listed, click New to 
add the doctor/specialist. 
In the Referred To Information dialog box, type the referral 
information, and then click OK.

4.	 Select the doctor/specialist.

5.	 Set up any of the following options:

•	 Provider – Click the search button   to select the provider 
that you want to associate with this referral.

•	 Patient Referred-To Date – By default, the current date is 
entered, but you can change it to reflect the correct date that 
the patient was referred out to the doctor/specialist.

•	 Scheduled Date – Type the date of the patient’s next 
scheduled appointment, relating to this referral, at your 
office.

•	 Reason for Referral – Type any notes regarding the purpose 
of this referral.

6.	 Do one of the following:

•	 Click OK to return to the Patient Referrals dialog box. Ignore the steps that follow.

•	 Click Edit to edit the referral information. Proceed to the next step.
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7.	 In the Referral To Information dialog box, edit any of the following referral information as needed:

•	 Name – The doctor/specialist’s name, title (if 
applicable), specialty, and salutation (for letters you 
send to the doctor/specialist).

•	 Address – The address, email address, and contact 
numbers for the doctor/specialist.

•	 Notes – Any notes or useful information regarding 
the doctor/specialist.

8.	 Click OK to save the changes and return to the Referred 
To dialog box.

9.	 Click OK to return to the Patient Referrals dialog box.

Sending Correspondence to Referrals
You can quickly send correspondence to a referral.

To send correspondence to a referral

1.	 In the Family File, with a patient selected, double-click the 
Referred By or Referred To block.

The Patient Referrals dialog box appears.

2.	 Select the referral you want 
to correspond with.

3.	 Click any of the following 
buttons:

•	 Send Email – To 
compose and send an 
email message to the 
referral.

•	 Print Label – To print 
a single address label for 
the referral.

•	 Quick Letters – To 
quickly print a letter for 
the referral. In the Quick 
Letters dialog box, select 
the appropriate letter, 
and then click Print.
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Assigning Medical Alerts
You can add alerts for medical conditions, medications, and allergies to a patient’s account. You can customize 
the list of available medical conditions, medications, and allergies in Practice Definitions. For information 
about setting up medical alerts, see the “Customizing Medical Alerts” topic in the Dentrix Enterprise Help.

To add a medical alert to a patient

1.	 In the Family File, with a patient selected, double-click the Medical Alerts 
block, or click the button in that block.

The Medical Alerts dialog box appears. Any existing medical alerts, 
medications, and/or allergies are listed.

Note: You can also view a patient’s medical alerts from the Patient Chart, the 
Treatment Planner, and Appointment Book.

2.	 Click the New Medical Alert button .

The New Patient 
Medical Alert dialog 
box appears.

3.	 Select whether you 
want to add a 
Medical Alert, 
Medication, or 
Allergy to the patient, 
and then click the 
Select Alert search 
button  to select a 
medical alert, 
medication, or allergy.

4.	 Click OK.

For comprehensive information about all the available options, see the “Assigning medical alerts” topic in the 
Dentrix Enterprise Help.
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Archiving Patients
If an individual is deceased or there is no possibility that he or she will be seen in your office again, you can 
archive that patient in Dentrix Enterprise. You cannot post new procedures or treatment plans, set treatment-
planned procedures complete, create new prescriptions, create a new payment plan, or schedule appointments 
for archived patients.

Archiving patients simplifies your patient database and makes patient selection faster and easier. Before 
archiving patients, keep in mind the following:

•	 Patients with future due payment plans or outstanding insurance claims cannot be archived.

•	 Guarantors cannot be archived until all other family members have been archived.

•	 Guarantors cannot be archived if they have a payment agreement or a balance.

Important: Although you can reactivate an archived patient, archiving a patient should be considered a 
permanent action, as this will significantly change that patient’s data in the database, and some data will not 
be able to be easily restored later.

To archive a patient

You can archive a patient from the Family File by changing that patient’s status to “Archived.” For information 
on changing a patient’s status, see “Viewing Patient Records” in this chapter.

Tip: An archived patient appears in the Family Member List of the Family File with an “<A>” preceding 
the name, on the View menu of the Ledger with “(Archived)” proceeding the name, on the Appointment 
Information dialog box title bar with an “<A>” preceding the name, and on the Ledger, Office Journal, and 
Document Center title bars with an “<A>” preceding the name.

Editing Family Relations
In the Family File, you can change the head-of-house, delete a patient, delete a family, and combine or 
separate families. For detailed information on completing these tasks, refer to the Dentrix Enterprise Help.

Merging Patients
You can merge two patient records (family members or not) into one patient record, using specified criteria, 
such as last name, birth date, and gender. This functionality is helpful for removing duplicate patients in 
Dentrix Enterprise as a result of a data conversion from another dental practice management software to 
Dentrix Enterprise. Duplication of patients can also occur when a patient is entered manually without 
verifying that the patient already exists in Dentrix Enterprise or if you have an HL7 interface (used for 
communication between Dentrix Enterprise and your medical software) and a patient record is entered 
manually into Dentrix Enterprise and your medical software.

Important:

•	 Do not have either of the patients you are going to merge selected in any Dentrix Enterprise module on 
any computer on the network except in the Family File on the computer from which will perform the 
merge.

•	 Both patients you merge must have an active or non-patient status, or you can merge a patient with a 
non-patient status into an active patient record; however, you cannot merge a patient with an active status 
into a non-patient record.
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To merge patients

1.	 In the Family File, with a patient selected, from the Edit menu, click 
Merge Patients.

The Merge Patients dialog box appears.

2.	 If necessary, click the Primary Patient Info search 
button  to select the primary patient. This is the 
patient record you want to keep and into which 
you want the secondary patient’s information to be 
transferred.

3.	 Click the Secondary Patient Info search button 
 to select the secondary patient. This is the 

patient record you do not want to keep.

If the secondary patient is a guarantor, that 
patient’s information will be merged into the 
primary patient’s account, and all family members 
of the secondary patient will be moved to family 
of the primary patient. If the secondary patient is 
not a guarantor, that patient information will be 
merged into the primary patient’s account.

4.	 To set up the merge criteria, click Advanced. In 
the Advanced Merge Patients Criteria dialog box, 
select the patient information that must match 
for both the primary and secondary patient for 
Dentrix Enterprise to perform the merge: Last 
Name, First Name, Gender, Date of Birth, Zip, Social Security #, City, State, E-Mail, Home Phone 
#, and/or Work Phone #. Then, click OK.

5.	 Click Merge. On the confirmation message that appears, click Yes.
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Chapter 3: Appointment Book
The Dentrix Enterprise Appointment Book was created to facilitate “productivity scheduling.” Convenient 
toolbars and exclusive flip tabs help you navigate through the schedule, search for open times, organize 
appointments and notes, and handle all the common tasks you need to perform throughout the day. You can 
schedule appointments, record broken appointments, and print route slips.

This chapter covers the following topics:

•	 Using the Appointment Book Window

•	 Changing a Clinic’s Schedule

•	 Changing a Provider’s Schedule

•	 Changing an Operatory’s Schedule

•	 Switching Between Views

•	 Finding Open Appointment Times

•	 Scheduling Appointments

•	 Scheduling “New Patient” Appointments

•	 Scheduling Events

•	 Managing Appointment Book Lists

•	 Managing Appointments

•	 Managing Events

•	 Generating Appointment Book Reports

•	 Working with Notes in the Appointment Book

•	 Using Perfect Day Scheduling
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Using the Appointment Book Window
The Appointment Book is divided into the menu bar, calendar, time bar, provider color bar, date bar, 
operatory ID, toolbar, navigation buttons, pin board, day view, week view, month view, and flip tabs.

Calendar Provider Color Bar Date Bar Operatory IDTime Bar

Navigation
Buttons

Pin Board

Day View

Week View

Month View

Flip Tabs

This section covers the following topics to help you understand how to use the Family File window:

•	 Using the Appointment Book Toolbar

•	 Using the Month Calendar

•	 Understanding the Time Bar

•	 Understanding Provider Colors

•	 Understanding Operatory IDs

•	 Understanding Appointments

•	 Using the Navigation Buttons

•	 Using the Day View

•	 Using the Week View

•	 Using the Month View

•	 Using the Pin Board

•	 Using the Flip Tabs
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Using the Appointment Book Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Appointment Book are explained in the following table.
Click the Schedule Appointment button to choose the patient for whom you want to schedule an 
appointment, and then enter the appointment information.
Click the Find New Appointment Time button to find an available appointment time by entering 
search criteria.
Click the Locate Appointment button to choose a patient so that you can locate any existing 
appointments for that patient.
With an appointment selected, click the Break Appointment button to remove the appointment 
from the schedule and place it on the Unscheduled List.
Click the Set Complete button to post the scheduled treatment for the selected appointment as 
complete to the Ledger and Patient Chart.

Click the Print Route slip button to print a route slip for the selected appointment.

Click the Delete Appointment button to delete the selected appointment.

 
Click the Perfect Day Scheduling button to turn Perfect Day Scheduling on and off. If the button 
has red and blue rectangles, this feature is turned on. If the button does not have red and blue 
rectangles, this feature is turned off. Perfect Day Scheduling must be turned on to see the Perfect Day 
Scheduling time blocks.

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Appointment Book 
toolbar” topic in the Dentrix Enterprise Help.

Using the Month Calendar
Click the Calendar button to open a monthly calendar. From the calendar you can view 
production goals, scheduled production, and actual production, making it easy to quickly evaluate 
your progress in meeting production objectives.

The following options are available:

•	 Click the double left and right arrow 
buttons to navigate to the desired month.

•	 Click Scheduled Production on the menu 
bar to view scheduled production for each 
day.

Totals for Scheduled, Production, and New 
Patients are displayed at the bottom of the 
calendar.

•	 Click a date square to go to that date in the 
Appointment Book.
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Understanding the Time Bar
The time bar on the left and right sides of the Appointment Book splits up hour intervals into 
your selected time block size. The red bar indicates the current time of day. For information about 
changing the time block size, see “Setting Up a Clinic” in Chapter 1: Introduction and Initial 
Setup.

Understanding Provider Colors
You can assign a unique color to each treatment provider in your office. These colors will be used to 
flag each appointment so that you can tell which provider the patient is seeing by the color of the 
appointment.

On the left side of the Appointment Book, Dentrix Enterprise displays a color column for each 
selected provider. A colored block in that column indicates that the provider is scheduled to be 
working on a patient during the blocked time.

For example, in the blue column you see a blue block from 9:00 a.m. to 9:50 a.m., indicating that the “blue” 
provider will be involved with a patient during that time. If a provider has been double-booked, the color 
block will display white with stripes in the color assigned to the provider. If the provider column is gray, this 
indicates that the provider is not available at the selected time.

For information about changing provider colors, see “Setting Up a Provider” in Chapter 1: Introduction and 
Initial Setup.

Understanding Operatory IDs
The Appointment Book displays a column for each operatory added to Dentrix Enterprise.  

Operatories are displayed in alphabetical order using operatory IDs. There is a limit of 10 operatories per 
Appointment Book view. For information about views, see “Setting Up Views” in Chapter 1: Introduction 
and Initial Setup.

Understanding Appointments
Each time an appointment is scheduled, it appears in the appropriate operatory column, using the appropriate 
color for the assigned provider, for the amount of time scheduled. Depending on the length of the 
appointment, Dentrix Enterprise will display up to nine lines of 
customizable information, including Name, Appointment Reason, Home 
Phone, Work Phone, Provider, Production Amount, Appointment Type, 
Staff, Chart Number, and Preferred Name.

In addition, a red cross on the appointment indicates that the patient has 
a Medical Alert. Similarly, a blue musical note indicates that the patient 
has a note attached to the appointment. And, a green “V” indicates that 
the patient’s insurance eligibility date is within 30 days.
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Using the Navigation Buttons
The navigation buttons are used to move from day to day in the Appointment Book. Click the 
left arrow button to move back one day. Click the right arrow to move forward one day. Click 
the circle button to quickly return the current system date.

The navigation buttons function differently for views other than the day view: if you are displaying the week 
view, the navigation buttons will move you forward or backward a week at a time; if you are displaying the 
month view, the navigation buttons will move you forward or backward a month at a time.

Using the Day View
Opening the Appointment Book in the day view allows you to see detailed information pertaining 
to an individual day and its scheduled appointments. You can schedule appointments by double-
clicking at an available time. If you are on the week or month view, click the Day View button to 
switch to the day view.

Using the Week View
A time-saver when looking for an available appointment time, the week view allows you to see a 
week’s worth of appointments at one time. Click the Week View button to switch to the week view. 
The week view displays large columns for each day of your work week. Each day column is further 
divided into operatory columns that show provider color blocks, which indicate appointments that 
have already been scheduled, making it easy to see free scheduling opportunities. To schedule an 
appointment, double-click at an available time.

Tip: To see details about an appointment, while pressing the Shift key on your keyboard, right-click the 
appointment. A pop-up box appears and displays the patient name, appointment reason, phone number, 
provider, appointment date and time, and status.

Using the Month View
If your schedule is packed weeks in advance, then the month view will make finding a free 
appointment time much easier. Click the Month View button to display an entire month’s worth 
of appointment times for each provider. On the left side of the Appointment Book, each provider 
is listed by ID and in color for each work day in the month. On the top of the Appointment Book, 
the time of day is shown. To view the appointments on a particular day, click in that date’s row to 
move to that date in the day view.

Note: Only appointments that have been scheduled using provider time (“X”s will appear on the left side of 
each appointment) appear in the month view. See “Scheduling Appointments” in this chapter.
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Using the Pin Board
Similar to a real pin board, you can use the Appointment Book to temporarily store appointment or event 
information until you can find a new appointment or event time. You can have multiple appointments and 
events on the pin board at any given time.

Dragging an appointment to the pin board Dragging an event to the pin board

Using the Flip Tabs
Acting as a bookmark, a flip tab allows you to jump forward (or backward) several days, weeks, or 
months in the Appointment Book, according to a user-defined length of time, such as seven days, 
two weeks, or six months. No flip tabs are set up with the initial installation of Dentrix Enterprise. 
For information about defining flip tabs, see “Setting Up Flip Tabs” in this chapter.

Changing a Clinic’s Schedule
From time to time, you will need to change the hours your office is open for a particular date (for example, 
for vacations and holidays). Dentrix Enterprise allows you to change your working hours for a single day or to 
close the office completely on a single day. Changing the hours of operation for a day or closing the office on 
a day does not make changes to any previously scheduled appointments. For example, if you have scheduled 
patients for March 5th, and then you close March 5th, those patients remain scheduled on March 5th.

To change a clinic’s schedule

1.	 In the Appointment Book, from the Setup menu, click Clinic 
Schedule.

The Schedule Calendar for Clinic dialog box appears.

2.	 Click the double left or right arrows to navigate to the correct 
month, and then select the day you want to close or open the office.

3.	 From the Office Closed menu, click one of the following options:

•	 Close Office on selected date – Closes the office on the 
selected day. The cell for that day will become light-gray. 
You can close the office for yearly holidays that do not occur 
on the same day of the month every year (for example, 
Thanksgiving).

•	 Open Office – Opens the office on the selected day that was 
previously closed.

•	 Set Yearly Holiday on selected day – Closes the office 
on the selected day. The cell for that day will become a pink color. When closing the office for a 
holiday, be sure to do so for holidays that fall on the same day of the month every year (for example, 
Christmas is always on December 25).

•	 Delete Holiday – Open the office on the selected day that was previously closed for a yearly holiday.

4.	 Click Close.
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Changing a Provider’s Schedule
Occasionally, you may need to change the hours a particular provider is available. In Dentrix Enterprise, 
you can change a single provider’s hours for one day or to schedule the provider out of the office for one day. 
Changing a provider’s hours for a day or scheduling a provider out of the office on a certain day does not 
make changes to any previously scheduled appointments. For example, if you have scheduled patients for 
March 5th and then set a vacation day for a provider who has patients on March 5th, those patients remain 
scheduled on March 5th.

To change a provider’s schedule

1.	 In the Appointment Book, from the Setup menu, click Provider 
Setup.

The Provider Setup dialog box appears.

2.	 Select a Clinic.

3.	 Select the provider for which you want to set a schedule. 

4.	 Click Schedule.

The Schedule Calendar for dialog box appears.

5.	 Click the double left or right arrows to 
navigate to the correct month, and then select 
the day you want to set as a vacation day.

6.	 From the Option menu, click one of the 
following options:

•	 Set Vacation on selected date – Indicates 
that the provider will be out of the office 
on vacation on the selected day. The cell 
for that day will become a purple color.

•	 Delete Vacation day – Removes 
the provider’s vacation day that was 
previously set.

•	 Reset Hours to default on selected 
date – Returns the selected day to the 
provider’s default work day for that day of the week

7.	 Click Close to return to the Provider Setup dialog box.

8.	 Click Close.
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Changing an Operatory’s Schedule
Occasionally, you may need to change the hours a particular operatory is available. In Dentrix Enterprise, you 
can change a single operatory’s hours for one day. This does not make changes to any previously scheduled 
appointments or events. For example, if you have scheduled patients for March 5th and then change 
an operatory’s hours, and that operatory has patients scheduled on March 5th outside of the operatory’s 
availability, those patients remain scheduled on March 5th.

To change an operatory’s schedule

1.	 While viewing the operatories for a clinic in the Appointment 
Book (the view does not have to include all operatories), from the 
Setup menu, click Operatory Setup.

The Operatory Setup dialog box appears.

2.	 Select the operatory for which you want to set the available time 
and days.

3.	 Click Schedule.

The Schedule Calendar for dialog box appears for the selected operatory.

4.	 Click the double left or right arrows to 
navigate to the correct month, and then 
double-click the day to change the hours 
for the selected operatory on that date.

5.	 If you want to return the selected day to the 
operatory’s default availability, click Reset 
Hours for Selected Date on the menu bar.

6.	 Click Close to return to the Operatory 
Setup dialog box.

7.	 Click Close.
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Switching Between Views
You can quickly switch between views by pressing the function keys on your keyboard (F1, F2, F3, and so 
forth) that correspond to the shortcut keys assigned to the views that have been set up.

For information about adding and editing views, see “Setting Up Views” in Chapter 1: Introduction and 
Initial Setup.

Alternately, to switch to another view

1.	 In the Appointment Book, click View on the menu bar.

The Select View dialog box appears.

2.	 Select the view you want to use.

3.	 Click Select.

1

32

Finding Open Appointment Times
Dentrix Enterprise provides you with multiple ways to search for an available appointment time as explained 
in the following topics:

•	 Manually Finding an Appointment Time

•	 Using the Find Appointment Tool

Manually Finding an Appointment Time
Dentrix Enterprise provides the following features to help you search for an available appointment slot manually:

•	 Day view – For information about this feature, see “Using the Day View” in this chapter.

•	 Week view – For information about this feature, see “Using the Week View” in this chapter.

•	 Month view – For information about this feature, see “Using the Month View” in this chapter.

•	 Month calendar – For information about this feature, see “Using the Month Calendar” in this chapter.

•	 Flip tabs – For information about this feature, see “Using the Flip Tabs” in this chapter.
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Using the Find Appointment Tool
When patients with very specific scheduling requirements call to make an appointment, it can be a very 
complicated process to find a free time that meets both the office’s and patient’s needs manually. By using the 
find appointment tool, you can enter a number of criteria and then have Dentrix Enterprise find the first free 
time that meets those requirements.

To search for an available appointment time

1.	 In the Appointment Book, from the File menu, click Find New 
Appointment Time.

The Find New Appointment 
Time dialog box appears.

2.	 You can search by over seven 
different criteria but are only 
required to specify the following:

•	 Select Provider(s) – Select 
the provider(s) for whom 
you want to search.

•	 Start Date – Type the date 
from which you want to 
start searching in the field, 
or click the search button 

 to select the date.

To advance the start date 
by a certain time interval, 
click a time option (Day(s), 
Week(s), or Month(s)), and then click the number of that interval to advance. For example, if you 
want to look for an appointment starting in six months, click Month(s) and then 6 to advance the 
starting date forward six months.

Tip: As needed, you can further refine your search by operatory, days of the week, providers/operatories 
in a specific view or for the current clinic, and a time range. Also, to have only the first available operatory 
for the search times found be listed, select No Duplicate Operatory Times.

3.	 Click Search/View.

The Available Appointment Times dialog box appears and 
lists the first 10 available times that match your search criteria.

4.	 Select the time you want to see, and then click View. The 
Appointment Book displays the selected date in the schedule 
and outlines the selected time. To see the next search result on 
the schedule with the selected time outlined, click View Next.

Tip: If none of the 10 displayed times will work, click More 
to list the next 10 available times. Then, repeat step 4 to keep 
looking for an open appointment time that will work.

5.	 If you find a time you want to use, click Select; otherwise, 
click Cancel to change your search criteria.

For comprehensive details about all the search options available, see the “Using the Find Appointment Tool” 
topic in the Dentrix Enterprise Help.
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Scheduling Appointments
Dentrix Enterprise provides the flexibility to schedule appointments using a variety of methods. Scheduling an 
appointment can be as simple or detailed as you want it to be, but do not confuse flexibility with complexity.

To schedule an appointment

1.	 In the Appointment Book, locate an available time on the schedule as 
explained in “Finding Open Appointment Times” in this chapter, and then 
double-click in the desired 
operatory at the appropriate date 
and time.

The Select Patient dialog box 
appears.

2.	 Search for and select a patient.

The New Appointment 
Information dialog box appears.

3.	 The Provider field defaults to 
the patient’s primary provider. If 
necessary, click the search button 

 to select another provider for 
the appointment.

4.	 If the patient is being seen for a 
continuing care reason, to attach 
continuing care to the appointment, 
click the Continuing Care 
Attached search button . In the 
Patient Pending Continuing Care 
dialog box, select the appropriate 
continuing care types, and then click 
OK.

5.	 Select a reason for the appointment, 
using any of the following methods:

•	 Initial – If the patient is being 
seen for work that would be 
done on an initial visit, such 
as an exam or cleaning, click 
Initial. In the Select Initial 
Reasons dialog box, select the 
reasons for the appointment, 
and then click OK.
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•	 Tx – If the patient is being seen for work that was previously treatment-planned, click Tx. In the 
Treatment Plan dialog box, select the reasons for the appointment, and then click Close.

Tip: To add to the treatment plans listed in the Treatment Plan dialog box, click New TX.

•	 Misc – If the patient is being seen for treatment that has not been treatment-planned, click Misc. In 
the Procedure Codes dialog box, select a procedure code, and then click OK.

6.	 Set up the following options:

•	 Desc – Dentrix Enterprise adds a description according to the selected appointment reasons, but you 
can edit it.

•	 Length – Dentrix Enterprise assigns a length of time to the appointment according to the selected 
appointment reasons. Verify that the appointment length is correct. To change the length of time 
needed to complete the procedures, click the search button . In the Appointment Time Pattern 
dialog box, drag the slider to set the number of units, and then set up the time pattern for each unit 
(chair time , assistant’s time , or provider’s time ).

•	 Amount – Dentrix Enterprise calculates the amount based on what procedures will be performed 
during the appointment, but you can change it.

•	 Status – To indicate what the last contact with the patient was, select a status. For information on 
setting up statuses, see “Customizing Practice Definitions” in Chapter 1: Introduction and Initial 
Setup.

•	 Schedule – Select one of the following options to categorize the appointment:

•	 FIXED – The patient has an inflexible schedule and can only be seen at the scheduled time.

•	 OPEN – The patient is willing to change the date and time of the appointment if necessary.

•	 ASAP – The patient wants to be seen earlier if an appointment time becomes available.

•	 Type – If you are using Perfect Day Scheduling, select an appointment type. For an explanation of 
Perfect Day Scheduling and appointment types, see “Using Perfect Day Scheduling” in this chapter.

7.	 If necessary, type a Note for clarification or to record other details about the appointment.

8.	 Click OK.

For a comprehensive description of all the options available for scheduling appointments, see the “Scheduling 
- comprehensive” topic in the Dentrix Enterprise Help.
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1

Scheduling “New Patient” 
Appointments
You can schedule an appointment for a patient who has not been previously seen at the office. A patient is 
considered to be new if the person does not have a Family File record.

To schedule a new patient appointment

1.	 In the Appointment Book, locate an available time on the schedule as 
explained in “Finding Open Appointment Times” in this chapter, and then 
double-click in the desired operatory at the 
appropriate date and time.

The Select Patient dialog box appears.

2.	 Click New Pat.

The Enter New Patient Information dialog 
box appears.

3.	 Enter the following information:

•	 Name – Type the patient’s last name, first 
name, and middle initial.

•	 Phone – Type the patient’s home phone 
number.

•	 Address – If desired, type the patient’s 
address.

•	 Referred By – If the patient was referred to your office, 
click the search button  to select the referral source.

4.	 Click OK.

The New Appointment Information dialog box appears.

5.	 Set up the appointment 
options as explained in 
“Scheduling Appointments” 
in this chapter.

6.	 Click OK.
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Scheduling Events
You can schedule an event (a non-patient “appointment”) to block out time or close an operatory in the 
Appointment Book for a day or up to one year. Events can include such items as staff meetings, vacation 
schedules, or holidays. You can set up an event to repeat at regular intervals (a series). Also, you can easily 
move an event to the pin board to reschedule it.

To schedule an event or a series of events

1.	 In Appointment Book, from the File menu, click Schedule Event.

The Schedule Event dialog box appears.

2.	 Set up the following options:

•	 Event Time – Enter a Start and an End time if 
the event will only last part of the day, or select 
Close Operatory (All Day Event) if the event 
will last the entire day.

•	 Event Days – Enter a Start and an End date 
(up to a year away) for the event. Then, under 
Select Days of the Week, select the day(s) that 
the event will occur within the specified date 
range.

•	 Operatories – Select the operatory or operatories 
for which you want to schedule the event. 
You cannot schedule an event that overlaps a 
scheduled appointment or another event.

•	 Description – Type a description for the event 
or series. To have the description centered 
horizontally at the top of the event block, select 
Center Description on Scheduled Event.

•	 Event Color – Click the button to choose a 
color for the event.

Tip: Select a light color to contrast with the black text of the event description and note.

•	 Notes – Type any notes that apply to the event.

Important: If you create a repeating event, be aware that if you want to delete the whole series, you must 
delete each event in that series one at a time.

3.	 Click OK.

Tip: If Dentrix Enterprise could not 
create events that are part of a series 
because those events overlapped with 
an existing appointment or event, a log 
file appears for your reference. You can 
correct the conflicts and then schedule 
events to match those in the series you 
created previously.
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Managing Appointment Book Lists
Failed or canceled appointments can cost a dental office thousands of dollars a year in lost production time. 
Dentrix Enterprise helps you avoid that missed revenue by providing you with several types of appointment 
lists that can be used to fill open blocks of time in your schedule. This section covers the following topics 
about how to use these lists:

•	 Using the Appointment List

•	 Using the ASAP List

•	 Using the Open List

•	 Using the Unscheduled List

Using the Appointment List
The Appointment List displays all appointments scheduled in the Appointment Book for a selected date. 
As a useful tool to confirm appointments, the Appointment List displays the time, status, name of patient, 
provider, operatory, reason, length, and patient phone number for the appointment.

To use the Appointment List

1.	 In the Appointment Book, from the Appt Lists menu, point to 
Appt List, and then click Current Clinic to view appointments for 
the clinic currently being viewed or All Clinics to view 
appointments for all clinics.

The Appointment List View dialog box appears.

2.	 Make your provider and operatory selections to filter the 
appointments in the list, and then click OK.

The Appointment List window appears.

3.	 Perform any of the following functions:

•	 Double-click – To see more 
information regarding an 
appointment or to make changes 
to an appointment, double-click 
the line of that appointment. The 
Appointment Information dialog 
box appears.

•	 Calendar – To change days being viewed for the Appointment List, on the menu bar, click Calendar.

•	 View – To filter the appointments in the list by provider or operatory, on the menu bar, click View.

•	 Appt – To break the selected appointment (move it to the Unscheduled List) or delete it, from the 
Appt menu, click the appropriate option.

•	 Status – When confirming a selected appointment, from the Status menu, click the appropriate 
status type to indicate the last contact with the patient.

•	 Office Journal – With an appointment selected, on the menu bar, click Office Journal to open the 
corresponding patient’s Office Journal.
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Using the ASAP List
Many times patients call wanting an appointment sooner than your next available time. In these situations, it 
can be useful to offer to call the patient if an appointment time becomes available. With Dentrix Enterprise, 
you can flag scheduled appointments as ASAP (As Soon As Possible).

Once an appointment has been flagged as ASAP, it appears on the ASAP List. This satisfies the patient’s 
request for a sooner appointment, while benefiting the office at the same time, by providing a list of patients 
who can fill holes in an otherwise full schedule.

In addition to providing you with names of patients who can fill open appointment times, the interactive 
nature of the ASAP List makes it simple to contact a patient and then create or move an appointment as 
needed.

To use the ASAP List

1.	 In the Appointment Book, from the Appt Lists menu, point to 
ASAP List, and then click Current Clinic to view 
appointments for the clinic currently being viewed or All 
Clinics to view appointments for all clinics.

The ASAP List View dialog box appears.

2.	 Make your provider, operatory, and day span selections to 
filter the appointments in the list, and then click OK.

The ASAP List window appears.

3.	 Perform any of the following functions:

•	 Double-click – To see more 
information regarding an 
appointment or to make changes 
to an appointment, double-click 
the line of that appointment. The 
Appointment Information dialog 
box appears.

•	 Calendar – To change the start date 
of the ASAP List view range, on the menu bar, click Calendar.

•	 View – To filter the appointments in the list by provider or operatory and/or specify how many days 
worth of appointments into the future to display, on the menu bar, click View.

•	 Appt – To delete the selected appointment, from the Appt menu, click the appropriate option.

•	 Status – When confirming a selected appointment, from the Status menu, click the appropriate 
status type to indicate the last contact with the patient.

•	 Office Journal – With an appointment selected, on the menu bar, click Office Journal to open the 
corresponding patient’s Office Journal.
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Using the Open List
When a patient calls to cancel at the last minute, the office must either scramble to find a patient willing 
to come in on short notice or else lose valuable production. The Open List can help you quickly fill those 
available slots by providing you with a list of scheduled patients who have more flexible schedules and may be 
willing to come in at the last minute.

In addition to providing you with names of patients who can fill open appointment times, the interactive 
nature of the Open List makes it simple to contact a patient and then create or move an appointment as 
needed.

To use the Open List

1.	 In the Appointment Book, from the Appt Lists menu, point to 
ASAP List, and then click Current Clinic to view appointments for 
the clinic currently being viewed or All Clinics to view 
appointments for all clinics.

The ASAP List View dialog box appears.

2.	 Make your provider, operatory, and day span selections to 
filter the appointments in the list; under Type of Search, 
select Open; and then click OK.

The Open List window appears.

3.	 Perform any of the following functions:

•	 Double-click – To see more 
information regarding an 
appointment or to make changes 
to an appointment, double-click 
the line of that appointment. The 
Appointment Information dialog 
box appears.

•	 Calendar – To change the start date of the Open List view range, on the menu bar, click Calendar.

•	 View – To filter the appointments in the list by provider or operatory and/or specify how many days 
worth of appointments into the future to display, on the menu bar, click View.

•	 Appt – To delete the selected appointment, from the Appt menu, click the appropriate option.

•	 Status – When confirming a selected appointment, from the Status menu, click the appropriate 
status type to indicate the last contact with the patient.

•	 Office Journal – With an appointment selected, on the menu bar, click Office Journal to open the 
corresponding patient’s Office Journal.
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Using the Unscheduled List
The Unscheduled List provides you with an easy way to view broken or wait/will call appointments.

To use the Unscheduled List

1.	 In the Appointment Book, from the Appt Lists menu, point to 
Unscheduled List, and then click Current Clinic to view 
appointments for the clinic currently being viewed or All Clinics to 
view appointments for all clinics.

The Unscheduled List View dialog box appears.

2.	 Make your provider selections to filter the appointments in the list, 
and then click OK.

The Unscheduled List window appears.

3.	 Perform any of the following 
functions

•	 Double-click – To see more 
information regarding an 
appointment or to make 
changes to an appointment, 
double-click the line of 
that appointment. The 
Appointment Information 
dialog box appears.

•	 View – To filter the 
appointments in the list by provider, on the menu bar, click View.

•	 Appt – To delete the selected appointment, from the Appt menu, click the appropriate option.

•	 Status – When confirming a selected appointment, from the Status menu, click the appropriate 
status type to indicate the last contact with the patient.

•	 Office Journal – With an appointment selected, on the menu bar, click Office Journal to open the 
corresponding patient’s Office Journal.
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Managing Appointments
Scheduling an appointment is only the first step in using an integrated electronic scheduling system. Dentrix 
Enterprise makes it easy to quickly manage scheduling tasks such as rescheduling, breaking appointments, 
confirming appointments, and even posting scheduled work once it is completed. This section will guide you 
through completing the following 10 appointment management tasks:

•	 Editing Appointments

•	 Locating Existing Appointments

•	 Moving Appointments

•	 Breaking or Canceling Appointments

•	 Rescheduling Broken or Canceled Appointments

•	 Posting Scheduled Work

•	 Deleting Appointments

•	 Working with “New Patient” Appointments

Editing Appointments
You change any information pertaining to an appointment (provider, reasons, time, notes, and so forth).

To quickly change an appointment length

If you want to quickly change the length of an appointment, 
click the lower-right corner of the appointment, and then drag 
up or down until the desired length is reached. While you are 
dragging, a small box is displayed that shows the length, in 
minutes, of the appointment.

To edit an appointment

1.	 In the Appointment Book, double-click an appointment.

The Appointment Information dialog box appears.

2.	 Make any necessary changes. For 
comprehensive details about all the 
options in the Appointment Information 
dialog box, see the “Scheduling - 
comprehensive” topic in the Dentrix 
Enterprise Help.

3.	 Click OK.

1

2

3



98     Chapter 3: Appointment Book

Dentrix Enterprise 8.0.5 User’s Guide

Locating Existing Appointments
You have several options for finding existing appointments:

•	 From the Appointment Book

1.	 In the Appointment Book, from the File menu, click Locate 
Existing Appointment.

The Select Patient dialog box appears.

2.	 Search for and select a patient.

3.	 Click View Appt.

The Appointments for dialog box appears.

4.	 Click Current to 
view appointments 
only at the clinic 
to which you are 
currently logged 
on or All to view 
appointments for 
all clinics.

5.	 Select the 
appointment that 
you want to view or edit.

6.	 Click Locate appt to go to the selected 
appointment in the Appointment Book, or 
click Edit appt to open the Appointment Information dialog box for the selected appointment.

•	 By right-clicking an appointment

1.	 To find other appointments a patient has, with one of that patient’s 
appointments selected in the 
Appointment Book, right-
click that appointment, and 
then click Other 
Appointments. The Family 
Appointment List dialog 
box appears.

Tip: This dialog box also 
displays appointments for 
other family members of 
the selected patient. You 
can select a different family 
member to view that patient’s 
scheduled appointments.

2.	 Select the appointment you want to view.

3.	 Click View Appt to go to the selected appointment in the Appointment Book.
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•	 From any module

1.	 In any module, except the Office Manager, from the File menu, 
click Patient. The Select Patient dialog box 
appears.

2.	 Search for a patient, and select that patient’s 
name.

3.	 Click More Patient Information. The 
More Information dialog box appears.

The list box at the bottom displays any 
scheduled appointments for the patient.

Tip: This dialog box also 
displays appointments 
for other family 
members of the selected 
patient. You can select a 
different family member 
to view that patient’s 
scheduled appointments.

4.	 Select the appointment 
you want to view.

5.	 Click Select to go to the 
selected appointment in 
the Appointment Book.
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Moving Appointments
Whether a patient needs to reschedule or the office needs to lighten the schedule, from time to time you will 
need to move an appointment to a new date or time:

•	 On the same date – In the Appointment Book, click and drag the appointment to a new time and/or 
operatory. On the confirmation message that appears,  
click OK.

•	 To a different date

1.	 In the Appointment Book, click and drag the 
appointment to the pin board.

Tip: To return an appointment on the pin 
board to its original date and time, from the 
File menu, click Refresh.

2.	 Once you find a new date and time for the 
appointment, click and drag the appointment 
to the desired spot on the schedule. On the 
confirmation message that appears, click OK.

•	 By double-clicking an appointment

1.	 If you know the exact date and time to which you want to move an 
appointment, in the Appointment 
Book, double-click the 
appointment you want to move. 
The Appointment Information 
dialog box appears.

2.	 Type the new Date and Time, and 
if necessary, select the desired Op.

3.	 Click OK.

Tip: To move multiple appointments to the pin board, from the Move to Pinboard menu, click one of the 
following options:

•	 All Appts for Displayed Date – To move all the appointments scheduled on the date being displayed.

•	 Family Appts for Displayed Date – To move all the appointments for all patients in the same family 
with appointments on the date being displayed.

•	 Provider’s Appts for Displayed Date – To move all the appointments with the same provider as the 
selected appointment.

•	 Operatory Appts for Displayed Date – To move all the appointments in the same operatory as the 
selected appointment.
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Breaking or Canceling Appointments
When a patient calls and cancels an appointment, to prevent these broken appointments from being 
forgotten, Dentrix Enterprise moves them to the Unscheduled List, where they can be reviewed on a regular 
basis. Also, when you try to schedule an appointment for a patient with a broken appointment, Dentrix 
Enterprise displays a message that states that the patient has a broken appointment and prompts you to 
reschedule it.

To move an appointment to the Unscheduled List

1.	 Code/complete the canceled or broken appointment.

2.	 In the Appointment Book, select the appointment, and then click the Patient Chart button on the 
toolbar to open the Patient Chart module.

3.	 Verify that the provider with whom the patient was scheduled is displayed on the title bar of the Patient 
Chart window. If the correct provider is shown, skip step 4.

4.	 If you need to change the provider being displayed in the Patient Chart, from the File menu, click 
Change Provider to open the Select Provider dialog box. Select the correct provider, and then click OK.

5.	 Click the IHS - Other procedure code category button to open the Select Procedure Code dialog box. 
Select the broken or canceled appointment code, and then click OK.
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6.	 Click Comp to complete the code. The code and description are displayed in the progress notes, and the 
code will be sent to RPMS like any other completed code.

7.	 Update the appointment note:

8.	 Double-click a patient’s appointment to open the Appointment Information dialog box.
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9.	 Under Notes, click Insert Dateline, and then type the reason for the broken or canceled appointment. Be 
sure to add your initials at the end of the note.

10.	Also, as part of the note, type the number of times this appointment has been missed and the next date 
the patient is allowed to be seen.

11.	Click OK to save the note. The information in the note will stay with this appointment, for your 
reference, when you reschedule the patient.

12.	Move the appointment to the Unscheduled List: 

•	 Using the Wait/Will Call Method – When a cancellation is made with advanced notice or you must 
reschedule the appointment, use this method to move the appointment to the Unscheduled List:

a.	 Double-click a patient’s appointment to open the Appointment Information dialog box.

b.	 Click  Wait/Will Call to move the appointment to the Unscheduled List.

The number of missed appointments for the patient is increased by one in the Family File.
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•	 Using the Break Appointment Method – For no shows, last-minute cancelations with short 
notice, and patients arriving too late to be seen, use this method to move the appointment to the 
Unscheduled List:

a.	 Select a patient’s appointment on the schedule, and then click the Break Appointment button 
on the toolbar; or right-click the appointment, and then click Break Appointment.

b.	 On the confirmation message that appears, click Yes to move the appointment to the 
Unscheduled List. This appointment will not be shown anywhere in the Appointment Book 
except on the Unscheduled List.

The number of missed appointments for the patient is increased by one in the Family File, and 
the date for the last missed appointment is updated to reflect the date this appointment was 
broken.
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Rescheduling Broken or Canceled 
Appointments
You can reschedule a broken or canceled appointment using the following two methods:

•	 From the Unscheduled List

1.	 In the Appointment Book, from the Appt. Lists menu, point to Unscheduled List, and then click 
Current Clinic or All Clinics to open the Unscheduled List window.

2.	 Double-click an unscheduled appointment you want to schedule to open the Appointment 
Information dialog box. The information from the original appointment, including the notes, is 
displayed.

3.	 Click Pin Board to place the appointment on the pin board in the Appointment Book.

4.	 To schedule the appointment, navigate to a date in the Appointment Book, and then drag the 
appointment from the pin board to the operatory and time slot where you want to schedule the 
appointment.
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•	 From the Family Appointment List

1.	 In the Appointment Book, navigate to a date, and then double-click in the operatory and time slot 
where you want to schedule an appointment to open the Select Patient dialog box. Select a patient 
with an unscheduled appointment.

2.	 On the message that appears and states that the patient has unscheduled or broken appointments, 
click Yes (always click Yes when this message appears) to open the Family Appointment List dialog 
box.

3.	 For the selected patient, in the middle list box, select the “<Unscheduled Appt>” item, and then click 
View Appt. to open the Appointment Information dialog box.

4.	 Click Pin Board to place the appointment on the pin board in the Appointment Book.
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5.	 To schedule the appointment, drag the appointment from the pin board to the operatory and time 
slot where you want to schedule the appointment.
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Deleting Appointments
You can permanently delete an appointment from the Appointment Book.

To delete an appointment

1.	 In the Appointment Book, select the appointment you want to delete.

2.	 From the File menu, click Delete Appointment. On the confirmation message that appears, click Yes.

Working with “New Patient” Appointments
An “NP” to the left of the patient’s name indicates that the appointment is a new patient appointment, and 
the patient’s information has been temporarily added to Dentrix Enterprise.

To find a new patient appointment

Since the patient does not yet have a Family File record, to locate the new patient appointment, use the Locate 
Existing Appointment feature of the Appointment Book as explained in “Locating Existing Appointments” in 
this chapter.

To create a Family File record for a new patient

For information on how to create a Family File record for a new patient who has an appointment in the 
Appointment Book, see “Adding a New Patient with an Appointment” in Chapter 2: Family File.

Managing Events
Scheduling an event is only part of using an integrated electronic scheduling system. Dentrix Enterprise makes 
it easy to quickly manage event tasks such as rescheduling, editing, and deleting events. This section covers the 
following topics about event management tasks:

•	 Rescheduling Events Using the Pin Board

•	 Editing Events

•	 Deleting Events

Rescheduling Events Using the Pin Board
You can drag a partial-day or all-day event to the pin 
board as a means to reschedule the event. A copy of the 
event will appear as an event icon on the pin board. To 
reschedule that pin board event, drag the icon to the 
desired date, time, and operatory.
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Editing Events
You can edit an event’s details at any time. If the event is part of a series (an event that repeats at regular 
intervals), only the occurrence you are editing is affected.

To edit an event

1.	 In the Appointment Book, double-click the event you want to edit, and then click Edit 
Event.

The Edit Event dialog box appears.

2.	 Edit the various event options as needed. For 
information on setting up event options, see 
“Scheduling Events” in this chapter.

3.	 Click OK.
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Deleting Events
You can delete a single event or an event that is part of a series. You cannot delete a whole series of events at 
one time; you must delete each occurrence separately.

To delete an event

1.	 In the Appointment Book, double-click the event you want to delete.

The Edit Event dialog box appears.

2.	 Click Delete. On the confirmation message that appears, click Yes.
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Generating Appointment Book 
Reports
There are two reports that can be printed directly from the Appointment Book:

•	 Appointment Book View Report

•	 Route slip

Appointment Book View Report
The Appointment Book View Report shows your daily schedule.

To print the Appointment Book View Report

1.	 In the Appointment Book, from the File menu, click Print 
Appointment Book View.

The Select View dialog box appears.

2.	 The current view in the Appointment Book 
determines the default settings for the report, but you 
can change any of the following options as needed:

•	 Select Provider(s) – Select up to 10 providers to 
include on the report.

•	 Select Op(s) – Select up to 10 operatories to 
include on the report.

•	 Date – By default, the current date is used as the 
date for which the schedule will be printed, but 
you can type a new date in the Date field or click 
the search button  to select a date.

•	 Appointment Display Info – Depending on 
the length of an appointment, up to nine lines 
of information can be displayed on the face of an appointment. For each Line, select the information 
you want to have displayed on that line, or select [None] to leave that line blank.

•	 View Options – Select any of the following:

•	 Print Amount – To print the scheduled production amount for the day, week, or month.

•	 Print Appt Colors – To print in color if you are using a color printer instead of in grayscale.

•	 Print Day Note – To print the Appointment Book day note for the date being printed.

•	 Print Perfect Day – To print the perfect Day Scheduling time blocks.

•	 Print Time at Right – To include the time bar on the right side of the appointments in addition 
to the time bar along the left side.

•	 Time View – Type the earliest hour of appointments that you want to print in the Start Hr field. 
Type the latest hour of appointments that you want to print in the End Hr field. Click am or pm 
for both fields.

3.	 If you want to save the current settings for the next time you print the Appointment Book View, click 
Save Print View. Only one Appointment Book View per computer can be saved.

4.	 Click Print to print the report to the default printer for the Office Manager, or click Batch to send the 
report to the Batch Processor in the Office Manager.
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Route slip
The route slip provides up-to-date, comprehensive information for a patient. You can use the route slip as a 
reminder of medical alerts, patient notes, collection information, and so forth for patients being seen that day.

To print a single route slip for a patient

1.	 In the Appointment Book, select an appointment.

2.	 From the File menu, click Print Route Slip.

The Print Route Slip dialog box appears.

3.	 Click Print to send the route slip to the default printer for the 
Office Manager, or click Batch to send the route slip to the Batch 
Processor in the Office Manager.

Tip: To generate route slips for all scheduled patients, in the Office Manager, from 
the Reports menu, point to Lists, and then click Daily Appointment List. Set 
up the options, making sure the Patient Route Slips check box selected, and then 
click OK. For more information, see the “Daily Appointment List” topic in the 
Dentrix Enterprise Help.
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Working with Notes in the 
Appointment Book
You can attach important information directly to an appointment or date. This section covers the following 
topics on Appointment Book notes:

•	 Adding Appointment Notes

•	 Adding Appointment Book Day Notes

Adding Appointment Notes
Appointment notes are attached directly to an appointment and usually reference special situations the office 
should be aware of before a patient is seen.

To add an appointment note

1.	 In the Appointment Book, double-click an appointment.

The Appointment Information dialog box appears.

2.	 Type a new note or change an existing 
note in the Notes field. Click Insert 
Dateline to date stamp the note.

Tip: To insert a blank line or start a new 
line, while pressing the Ctrl key, press 
the Enter key.

3.	 Click OK.

The appointment now as a blue 
musical note in the upper-right corner, 
indicating that the appointment has a 
note.
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Adding Appointment Book Day Notes
An Appointment Book day note can be created for each day of the year and is generally used as a reminder 
for a specific date (for example, to order supplies, to call a school about a hygiene class, or to attend a dental 
society meeting).

To add an Appointment Book day note

1.	 In the Appointment Book, click the Note icon located in the upper-left corner 
of the schedule.

The Appointment Book Note dialog box appears.

2.	 Type a note or reminder for the day.

3.	 Click OK.

The Note icon is now has a yellow background, 
indicating that the day has a note.
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Using Perfect Day Scheduling
Many practice management consultants advocate a strategy of scheduling a day that consists of just the right 
balance of high production, medium production, and low production procedures. Dentrix Enterprise helps 
you achieve that perfect balance by allowing you to reserve certain times during the day by blocking those 
times for the scheduling of specific procedure types (for example, crowns or exams).

This section covers the following topics about setting up and using Perfect Day Scheduling:

•	 Customizing Appointment Types

•	 Customizing Procedure Codes

•	 Setting Up Perfect Day Scheduling Time Blocks

•	 Activating Perfect Day Scheduling

•	 Finding an Available Time Block

Customizing Appointment Types
The initial installation of Dentrix Enterprise includes four appointment types: General, High Production, 
Medium Production, Low Production. If necessary, you can delete or change these type and add more (up to 
a total of 10) in Practice Definitions. For information about setting up appointment types, see the “Practice 
Definitions” and “Customizing Appointment Types” topics in the Dentrix Enterprise Help.
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Customizing Procedure Codes
Each procedure code in Dentrix Enterprise can be assigned a default appointment type. Once a type has been 
properly designated for a procedure, Dentrix Enterprise automatically assigns the correct appointment type to 
any appointments scheduled using that procedure code. When you schedule an appointment in a Perfect Day 
Scheduling time block, Dentrix Enterprise verifies that the appointment’s type matches the type permitted for 
that reserved time block.

To edit a procedure code

1.	 In the Office Manager, from the Maintenance menu, point 
to Practice Setup, and then click Procedure Code Setup.

The Procedure Code Setup dialog box appears.

2.	 Select a Procedure Code Category. All procedure 
codes associated with that category appear in the list 
box to the right.

3.	 Select a procedure code, and then click Edit.

The Procedure Code Editor - Existing dialog box 
appears.

4.	 Select an Appointment Type.

5.	 Click Save.
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Setting Up Perfect Day Scheduling Time 
Blocks
You can set up Perfect Day Scheduling time blocks for each provider.

To set up a time block

1.	 In the Appointment Book, from the Setup menu, click Provider 
Setup.

The Provider Setup dialog box appears.

2.	 Select a Clinic.

3.	 Select the provider for which you want to set a time block.

4.	 Click Setup.

The Provider Setup dialog box appears.

5.	 Under Set Time Blocks, click Add to add a 
new time block.

The Block Settings dialog box appears.

6.	 Set up the following options:

•	 Time Block Name – Type a short 
description of the block’s purpose (for 
example, “Crowns” or “Exams”).

•	 Color – Click the color button to the right 
of the Time Block Name field to choose a 
color to represent the time block.

•	 Week Days – Select the days of the week 
for which you want to set the time block. 
Then, for each selected day, click the Start and End search 
buttons  to set the time range:

•	 Assigned Op – Select the operatory where the types of 
procedures for this time block are performed.

•	 Block Appt Type – Select the appointment type you want to 
assign to this time block.

7.	 Click OK to return to the Provider Setup dialog box.

8.	 Click OK.
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Activating Perfect Day Scheduling
To display the Perfect Day Scheduling time blocks in the Appointment Book, you must activate Perfect Day 
Scheduling. If Perfect Day has not been activated, the defined time blocks do not appear in the Appointment 
Book, and no warning will appear if anyone tries to schedule appointments during reserved time blocks.

To activate Perfect Day Scheduling

From the File menu, click Perfect Day Scheduling. If the Perfect Day Scheduling menu option has a check 
mark next to it, the feature is already activated.

Once Perfect Day Scheduling has been activated, Dentrix Enterprise will display the defined provider time 
blocks in the Appointment Book. When you schedule an appointment in a defined time block, Dentrix 
Enterprise will check both the provider and the appointment type to verify that the provider and appointment 
type match what is allowed for that time block. If either the provider or the appointment type do not 
match, a warning message appears and asks if you want to override the time block setting and schedule the 
appointment.

To move a time block

Individual time blocks can be moved within their respective operatory by dragging the time block to the 
desired time.

To resize a time block

You can increase or decrease the size of the time block by clicking the bottom border of the time block and 
dragging up or down.

Finding an Available Time Block
You can locate the first available blocked time for the type of appointment you are scheduling.

To find the first available time block

1.	 In the Appointment Book, from the File menu, click Find New 
Appointment Time.

The Find New Appointment Time dialog box appears.

2.	 Set up your search criteria as 
explained in “Using the Find 
Appointment Tool” in this 
chapter. Additionally, if you 
have Perfect Day Scheduling 
time blocks set up, to set the 
time block search options 
under Select Time Block, 
select Search By Time Block, 
select whether to search by the 
Provider or Operatory block 
type, and then select the desired 
time blocks.

3.	 Click Search/View to see the 
available times that match your 
search criteria. For information 
about previewing and selecting a time slot and scheduling the appointment, see “Using the Find 
Appointment Tool” in this chapter.
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Chapter 4: Patient Chart
The Dentrix Enterprise Patient Chart can be used for entering and maintaining clinical records for your 
patients. Its complete chair-side integration makes it the perfect tool to simplify record keeping while giving 
you opportunity to take advantage of the newest technical innovations in dentistry. The Patient Chart module 
consists of the following:

•	 Patient Chart – The Patient Chart provides a quick and easy way to enter existing, recommended, and 
completed treatment or conditions. Dentrix Enterprise uses standard, easy-to-recognize textbook charting 
symbols. Treatment is color coded so that with a single glance at the patient’s graphic chart, you can tell 
whether a procedure is a condition, existing, treatment-planned, or completed.

•	 Clinical notes – You can use clinical notes to document and track patient care. These notes can be 
attached to a patient as a clinical record. Dentrix Enterprise provides several template options (including 
customizable templates) to help make entering notes a simple process.

•	 Treatment Planner – You can use the Treatment Planner to help explain and demonstrate proposed 
treatment to patients. The Treatment Planner can be opened from the Patient Chart and the Ledger. For 
more information about the Treatment Planner, see Chapter 6: Treatment Planner.

•	 Perio Chart – Using customizable script settings, you can enter periodontal treatment information 
quickly and completely in the Perio Chart. Information can be displayed graphically in the Perio Chart, 
making it possible for patients to visually understand perio data. The Perio Chart also provides a variety 
of letters for you to generate correspondence quickly for patients, referring dentists, and insurance 
consultants. For more information about the Perio Chart, see Chapter 5: Perio Chart.

This chapter covers the following topics:

•	 Using the Patient Chart window

•	 Clearing the Patient Chart

•	 Changing the Provider for a Charting Session

•	 Entering Treatment

•	 Editing Treatment

•	 Deleting Treatment

•	 Invalidating Procedures in History

•	 Changing the Displayed Dentition

•	 Setting the Default Dentition

•	 Entering and Editing Procedure Notes

•	 Working with Clinical Notes

•	 Printing from the Patient Chart
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Using the Patient Chart window
The Patient Chart window consists of the menu bar, toolbar, graphical chart, procedure buttons, procedure 
code category buttons, status buttons, and progress notes.

Graphical Chart

Procedure Buttons Procedure Code Category Buttons

Status Buttons

Progress Notes

This section covers the following topics to help you understand how to use the Patient Chart window:

•	 Using the Patient Chart Toolbar

•	 Using the Graphical Chart

•	 Using the Procedure Buttons

•	 Using the Procedure Code Category Buttons

•	 Using the Status Buttons

•	 Using the Progress Notes Panel
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Using the Patient Chart Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Patient Chart are explained in the following table.
Click the DentriXlink button to open third-party software, such as a digital X-ray or imaging 
program, that has been installed and set up to work with Dentrix Enterprise.
Click the Select Patient button to select a patient whose record you want to view in the Patient 
Chart.

Click the Print Dental Chart button to print the patient chart for the selected patient.

Click the Work Chart button to display the work chart view.

Click the Full Screen Chart button to display the full screen chart view.

Click the Progress Notes button to expand the Progress Notes panel to fill the Patient Chart 
window.

Click the Treatment Planner button to open the Treatment Planner module.

Click the Perio Chart button to open the Perio Chart module.

Click the Clinical Notes button to display any clinical notes for the selected patient.

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Patient Chart toolbar” 
topic in the Dentrix Enterprise Help.
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Using the Graphical Chart
The graphical chart visually depicts the condition of the patient’s mouth. Treatment is shown on the chart 
using textbook charting symbols. In addition, treatment is color-coded to indicate the status of the treatment. 
For example, completed work can be displayed in blue while recommended treatment can be displayed in red.

Permanent Primary

In the graphical chart, you can select the teeth you want 
to post treatment to by clicking the appropriate teeth. 
Selected teeth have a dotted box around each one.

Tip: To deselect teeth, click each tooth you want to 
deselect to remove the dotted box, or click Clear below 
the procedure buttons.

Using the Procedure Buttons
You can select the treatment to post with the procedure buttons. The 24 procedure buttons 
collectively represent the most common procedures performed in an operatory. Each user-
definable button can represent a single ADA Procedure Code, Dental Diagnostic Code, 
multi-code, or condition.
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Using the Procedure Code Category Buttons
You can select treatment to post from the procedure code category buttons.

Each of the procedure code category buttons opens a Select Procedure Code dialog 
box that displays a list of specific procedure codes 
for that category. For example, exam and X-ray 
codes are accessed from the Diagnostic category 
since those are diagnostic procedures.

Using the Status Buttons
The status buttons and fields are used to specify the type of treatment being posted. Once posted, a treatment 
appears in the Progress Notes panel and is painted on the graphical chart (if a charting symbol is used in 
conjunction with the posted procedure) in the color assigned to that status.

The status buttons consist of the following options:

•	 Existing Other – The EO button is used when entering existing work performed by a provider outside of 
your practice. (Used almost exclusively when charting existing work for new patients).

•	 Existing – The Ex button is used when entering existing work performed by a provider within your 
practice. (Used almost exclusively when charting past work done by your office).

•	 Treatment Plan – The Tx button is used to enter recommended treatment for a patient.

•	 Completed – The Comp button is used when entering completed work and conditions for a patient.

•	 Auto-State – This button is used to quickly assign several procedures the same status. After clicking the 
Auto-State button, the next button selected will remain selected until another procedure status buttons is 
selected. While the auto-state is turned off, the button has a plus sign (+). While the auto-state is turned 
on, the button remains depressed and has a minus sign (-).

Important: If you do not turn off the auto-state when you finish charting for a patient, whatever status 
was selected will remain selected for the next patient’s charting.

•	 Surfaces – This field shows the surfaces, if applicable, for the procedure being posted. You can type a 
surface(s) in the field (multiple surfaces must be separated by commas).

•	 Procedure Code – This field shows the procedure code being posted. You can type a procedure code in 
the field.

Tip: To clear the procedure code and treatment area(s) from the fields and deselect any tooth/teeth that are 
selected on the graphical chart, click Clear below the procedure buttons.
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Using the Progress Notes Panel
Progress notes centralize documentation and exam information to help you quickly review a patient’s history. 
If you are viewing the work chart view, the Progress Notes panel is located below the graphical chart. Progress 
notes are displayed in chronological order.

Each time a procedure, exam, condition, treatment plan, referral, or clinical note is posted in the Patient 
Chart, Dentrix Enterprise adds a line to the progress notes. For each item recorded in the progress notes, you 
will see the date the treatment 
was entered, treatment areas (if 
applicable), the procedure code, 
provider, a description, treatment 
status, treatment approval status, 
and the dollar amount associated 
with that procedure.

Notes:

•	 If a procedure has a note attached to it, a double arrow (>>) is visible to the right of the description.

•	 If a procedures has a referral attached to it, an “R” is added to the beginning of the treatment status.

You can use the controls on the Progress Notes panel to work with the items in the progress notes. The 
following table explains each control.

Click the Set Complete button to mark the selected treatment-planned 
procedures as completed.

Click the Delete button to remove the selected treatment-planned or existing 
procedures from the Patient Chart.

Click the Print Progress Notes with Chart button to print the progress notes 
and graphical chart currently being viewed.

Select the check boxes that correspond to what you want to have show in the progress 
notes: treatment-planned procedures, completed procedures, existing and existing other 
work, conditions, perio exams, procedures notes, and/or clinical notes.

Note: The next time the Patient Chart is opened, those same options will be used as the 
default view settings. Each computer on your office network can have different settings, 
and each Dentrix Enterprise user can have different settings on any given computer.

Clearing the Patient Chart
To protect the privacy of an individual patient, it may be wise to display a blank chart in your operatories 
while waiting for patients to arrive.

To display a blank chart

In the Patient Chart, from the File menu, click Clear Patient.

No patient information is displayed in the Patient Chart until another patient is selected.
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Changing the Provider for a Charting 
Session
By default, Dentrix Enterprise assigns all treatment posted in the Patient Chart during a patient’s charting 
session according to the default chart provider setting in the Practice Defaults dialog box. However, you can 
select a different provider for the current charting session. All procedures posted during the current charting 
session will be assigned to the selected provider. The next time a patient is selected, work will automatically 
default back to the default chart provider.

To change the provider for a charting session

1.	 In the Patient Chart, with a patient selected, from the File menu, click 
Change Provider. The Select Provider dialog box appears.

2.	 Select the provider to whom all work posted 
during this session should be assigned.

Tip: You can sort the provider list by clicking 
on each header (ID, Name, or Status).

3.	 Click OK.

4.	 Post treatment for the patient.

You can change the provider for an individual 
procedure by editing it after it has been 
posted.

1

2

3

Entering Treatment
This section covers the following topics on how to chart treatment in the Patient Chart:

•	 Charting Treatment with Procedure Code Category Buttons

•	 Charting Treatment with the Auto-State Button

•	 Charting Supernumerary Teeth
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Charting Treatment with Procedure Code 
Category Buttons
You can chart treatment with procedure code category buttons if the procedure for the treatment you want 
to enter is not assigned to a procedure button but is assigned to a procedure code category button. For 
information about charting treatment with procedure buttons, see the “Charting treatment with procedure 
buttons” topic in the Dentrix Enterprise Help.

To chart treatment with a procedure code category button

1.	 In the Patient Chart, with a patient selected, if the treatment you are entering requires a tooth number, 
select the appropriate tooth/teeth in the graphical chart.

2.	 To select a procedure, 
click a procedure 
code category 
button. In the Select 
Procedure Code 
dialog box, select the 
appropriate procedure 
code, and then click 
OK.

Note: Procedures 
are only available on 
the Procedure Code 
Categories panel if 
those procedures have 
been assigned to a procedure code category other than “None” and set 
up to be shown in the Patient Chart from the Procedure Code Editor 
dialog box. For details about setting up procedure codes, see “Editing 
Procedure Codes” in Chapter 1: Introduction and Initial Setup.

3.	 Click the appropriate status button for the procedure being entered. For an explanation of each status, see 
“Using the Status Buttons” in this chapter.

4.	 If the selected procedure requires additional treatment information (surfaces, quadrants, sextants, or 
arches), the Surface Selection, Quadrant Selection, Sextant Selection, or Arch Selection dialog box 
appears. To specify the appropriate treatment area(s), select all 
surface, quadrant, sextant, or arch check boxes that apply; for 
surfaces only, click Add; and then click OK.

Dentrix Enterprise posts the procedure to the selected teeth. 
The procedure is added to the graphical chart (if a charting 
symbol is used in conjunction with the posted procedure) and 
the progress notes.

Note: All completed work posted in the Patient Chart is 
automatically posted to the Ledger, and the appropriate charges 
are listed on the patient’s account. Similarly, all treatment-planned 
work is automatically posted to the Ledger-Treatment Plan.

1
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Charting Treatment with the Auto-State 
Button
In most offices, charting is entered in order by treatment status. For example, during a new patient exam, the 
treatment provider might first chart existing work and conditions. Once existing work has been charted, the 
provider might then enter work that needs to be completed (treatment-planned). Finally, work completed that 
day will be entered.

To make charting in this manner easier, Dentrix Enterprise provides the Auto-State button. To save you the 
extra step of entering the status for each procedure individually, the Auto-State button keeps the status button 
of the type of treatment you are charting selected and assigns that status to procedures entered.

To chart treatment with the Auto-State button

1.	 In the Patient Chart, with a patient selected, click the Auto-State button (+).

2.	 Leave the Tx button 
is selected, or click 
the status button 
that corresponds to 
the type of work you 
want to chart.

Note: The selected 
status button will 
remain selected until 
another procedure 
status buttons is 
selected.

3.	 If the treatment you 
are entering requires a tooth number, select the 
appropriate teeth in the graphical chart.

4.	 To select a procedure:, click a procedure code category button. 
In the Select Procedure Code dialog box, select the appropriate 
procedure code, and then click OK.

5.	 If the selected procedure requires additional treatment information (surfaces, quadrants, sextants, or 
arches), the Surface Selection, Quadrant Selection, Sextant Selection, or Arch Selection dialog box 
appears. To specify the appropriate treatment area(s), select all 
surface, quadrant, sextant, or arch check boxes that apply; for 
surfaces only, click Add; and then click OK.

6.	 Once you have posted all work for the selected status, click a 
different status button to enter work for that status, or click 
the Auto-State button (-) to turn off auto-state for the status 
buttons.

3
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Charting Supernumerary Teeth
Because it is not possible to select a supernumerary tooth in the graphical chart, it is necessary to post the 
procedure to the nearest tooth and then edit the posted procedure with the appropriate supernumerary tooth 
number, based on the following ADA recommendations:

•	 Permanent Teeth – Add 50 to the tooth number nearest the supernumerary tooth (for example, 1 = 51, 2 
= 52, 3 = 53, and 32 = 82).

•	 Primary Teeth – Add an “S” to the tooth letter nearest the supernumerary tooth (for example, A = AS, B 
= BS, C = CS, and T = TS).

Editing Treatment
After treatment has been entered into the Patient Chart, you can make changes to the procedure, as needed. 
For an IHS-completed procedure, do not edit the procedure; delete it, and then re-enter it.

Important:

•	 To provide security and protect the integrity of your patient data, Dentrix Enterprise locks out changes to 
procedures once they have been moved into history. (Procedures are moved into history when the Month 
End Update utility is run.) Procedures in history cannot be edited or deleted. For information about how 
to remove a procedure in history from the Patient Chart by invalidating that procedure, see “Invalidating 
Procedures in History” in this chapter.

•	 Procedures attached to an insurance claim cannot be edited until the claim has been deleted. For 
information about deleting an insurance claim, see “Deleting Dental Insurance Claims” in Chapter 7: 
Ledger. After the corresponding claim has been deleted, the procedure can be edited.

To edit treatment

1.	 In the Patient Chart, with a patient selected, 
from the Progress Notes panel, double-click the 
treatment item you want to change.

The Edit or Delete Procedure dialog 
box appears.

2.	 Make any necessary changes:

•	 Date – To change the date 
assigned to a procedure, click in 
the field, delete the existing date, 
and then type the correct date.

•	 Clinic – To change the clinic, click 
the search button  to select the 
correct clinic.

•	 Procedure – To change the 
procedure code, click in the field, 
delete the existing code, and then 
type the correct code; or click the 
search button  to select the 
correct code.

1
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•	 Treatment area – Change the treatment area (if applicable): for a tooth, edit the Tooth number; for 
a surface, click the Surface search button  to select the correct surface; for a quadrant, click the 
Quadrant search button  to select the correct quadrant; for a sextant, click the Sextant search button 

 to select the correct sextant; for an arch, click the Arch search button  to select the correct arch.

•	 Amount – To change the amount charged for the procedure, click in the field, delete the existing 
amount, and then type the correct amount.

•	 Provider – To change the provider attached to the procedure, click the search button  to select the 
correct provider.

•	 Notes – If a default note has been associated with this procedure, the note text appears automatically. 
Make any necessary changes to the note.

•	 Related Referral – To add a related referral to the procedure, click the search button , select 
Referred To Doctor or Referred By Doctor/Other, click OK, select the appropriate referral source, 
and then click OK.

3.	 Click OK.

Deleting Treatment
You can delete completed, treatment-planned, or existing procedures that were posted incorrectly unless the 
procedure is in history or attached to a claim. You can also delete conditions.

To delete a completed, treatment-planned, or existing procedure

1.	 In the Patient Chart, with a patient selected, on 
the Progress Notes panel, double-click the 
completed, treatment-planned, or existing 
procedure you want to delete.

The Edit or Delete Procedure dialog box 
appears.

2.	 Click Delete. On the confirmation message 
that appears, click OK.

1
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To delete treatment-planned or existing procedures

1.	 In the Patient Chart, with a patient selected, on the Progress Notes panel, click the treatment-planned or 
existing procedure you want to delete.

Tip: To select 
multiple 
procedures, while 
pressing the Ctrl 
key on your 
keyboard, click 
each procedure.

2.	 Click the Delete 
button  next to 
the progress notes. 
On the confirmation message that appears, click OK.

Invalidating Procedures in History
Dentrix Enterprise locks out changes to a transaction once the transaction has been moved to history (when 
the month is closed). Posting errors in the Ledger should be corrected using an adjustment. However, the 
Patient Chart serves as a clinical record of patient care and needs to be completely accurate. Errors in the 
Patient Chart should be corrected to reflect the actual care given.

To address the differences in record keeping between these two modules, Dentrix Enterprise allows you to 
invalidate a procedure in history if a posting error is discovered. Invalidating a procedure removes it from the 
Patient Chart but leaves it in the Ledger.

To invalidate a procedure

1.	 In the Patient Chart, with a patient selected, on 
the Progress Notes panel, double-click the 
history procedure you want to invalidate.

The Validate/Invalidate Procedure in 
History dialog box appears.

2.	 Under Validate/Invalidate Procedure, 
click Invalidate Procedure.

3.	 Click OK.

Dentrix Enterprise removes the procedure 
from the Patient Chart. In the Ledger, 
a plus sign (+) appears in front of that 
procedure’s description to indicate that the 
procedure has been invalidated.

Important: Post the procedure again, 
using the correct information, except for 
the charge amount; make that 0 because 
the account has already been billed for 
the procedure. Also, make sure the date of 
the procedure is the same as the date the 
procedure was originally posted.

1
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Changing the Displayed Dentition
You can change the graphical chart to display primary, permanent, or mixed dentition on a patient-by-patient 
basis.

To change the dentition being displayed in the graphical chart

1.	 In the Patient Chart, with a patient selected, if you are changing the dentition for certain teeth, select 
those teeth. If you are changing the dentition for all teeth, you do not have to select any teeth.

2.	 From the Prim/Perm menu, click one of the following options:

•	 Change All – Reverses the primary/permanent state for all teeth. For example, if all teeth have been 
changed to primary and the Change All option is clicked, all the teeth in the mouth will change to 
permanent.

•	 Change Selected – Reverses the primary/permanent state for the selected teeth in the graphical chart.

Setting the Default Dentition
You can indicate whether you want the Patient Chart to open with primary or permanent dentition that is 
being displayed in the graphical chart for all patients by default.

To set the default dentition

In the Patient Chart, with a patient selected, from the Prim/Perm menu, click one of the following options 
(the option with the check mark is the default dentition currently being used):

•	 Default to Permanent – Changes all the teeth in the graphical chart to permanent dentition. Also, every 
time you open the Patient Chart, the graphical chart will display all permanent teeth, even if you select a 
patient that does not have any permanent teeth or that has mixed dentition.

•	 Default to Primary – Changes all the teeth in the graphical chart to primary dentition. Also, every time 
you open the Patient Chart, the graphical chart will display all primary teeth, even if you select a patient 
that does not have any primary teeth or that has mixed dentition.

Then, on a patient-by-patient basis, you can change the dentition as explained in “Changing the Displayed 
Dentition” on this page.
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Entering and Editing Procedure 
Notes
You can attach default notes to a procedure for documentation and reference purposes so that each time a 
procedure with a default note is posted, the note is attached automatically to that procedure. These notes can 
also be added manually during posting or at a later time. Once the note has been added, the clinician reviews 
the note and makes any small changes that pertain to the specific patient. You can edit procedure notes 
attached to a posted procedure at any time if the procedure is not in history.

To enter or edit a procedure note

1.	 In the Patient Chart, with a patient selected, on 
the Progress Notes panel, double-click the 
procedure for which you want to add a note.

The Edit or Delete Procedure dialog box 
appears.

2.	 In the Notes field, make any necessary 
changes to the note, or type a new note.

3.	 Click OK.

A double right arrow appears next to the 
procedure’s description on the Progress 
Note panel to indicate that the procedure 
has a note attached.

Tip: You can review procedure notes by 
double-clicking a procedure; or, from the 
View menu, point to Progress Notes, and 
then click Expand Notes.
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Working with Clinical Notes
Keeping accurate and thorough documentation of each procedure performed in the dental office is an essential 
part of clinical dentistry. In Dentrix Enterprise, you can enter a clinical note to store information about a 
patient’s exam and treatment that are not specific to a procedure.

Tip: You can access a patient’s clinical notes from not only the Patient Chart but the Ledger and Family File.

This section covers the following topics about clinical notes:

•	 Adding Clinical Notes

•	 Adding Clinical Notes Using Templates

•	 Editing Clinical Notes

•	 Adding an Addendum to a Clinical Note

•	 Printing Clinical Notes

•	 Signing Clinical Notes

Adding Clinical Notes
The clinical notes are arranged by date, note number, and then page. You can have as many notes as you want, 
with a maximum of 10 pages per note.

To add a clinical note

1.	 In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes.

The Clinical Notes window appears.

2.	 Click the New Clinical Note button . 

3.	 Type a note you want to attach to this 
patient regarding an exam or treatment 
given.

4.	 To add a page to the clinical note, with 
this note still selected in the left pane, 
click the New Clinical Note Page 
button . In the Change Date and 
Time dialog box, leave the current 
system time entered, or type a different 
time; and then click OK.

5.	 To assign a different clinic than the 
currently selected clinic for the clinical note, click the Change Clinic for Selected Note button  to 
open the Select Clinic dialog box and select the appropriate clinic.

6.	 Click the Save Clinical Note button .

Tip: If you need to add additional information to the selected clinical note at a later date and time, click 
the Insert Date/Time button , and then begin typing the note; although, if the note is locked, you 
cannot change a clinical note, but you can add an addendum.
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Adding Clinical Notes Using Templates
Using clinical note templates as a guide when collecting patient information, you can enter clinical notes for a 
patient in an orderly manner.

To add a clinical note using a template

1.	 In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes.

The Clinical Notes window appears.

2.	 Click the New Clinical Note button .

3.	 In the template pane (on the right), expand a category to view the list of available templates for that 
category by clicking the plus sign (+) next to the category name, and then double-click the template you 
want to use.

Tip: If a clinical note page is not selected when you choose a template, a new clinical note will be added. 
So, to add a template to an existing note, make sure the appropriate page of that clinical note is selected.

4.	 Respond to the prompts associated with the template, if applicable. The template text and any responses 
you entered appear in the note field.

5.	 Click the Save Clinical Note button .

For more information about clinical note templates, see the “Creating clinical note templates,” “Creating 
clinical note prompts,” and “Setting up clinical note template categories” topics in the Dentrix Enterprise 
Help.
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Editing Clinical Notes
You can edit a clinical note that has not been moved into history after the month-end process, that has not 
been signed, or that has not been locked.

To edit a clinical note

1.	 In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes.

The Clinical Notes window appears.

2.	 Expand the 
appropriate date 
category in the left 
pane, and then 
select the page of 
the clinical note you 
want to edit.

3.	 If you are adding to 
the note at a date 
other than when 
the clinical note was 
originally entered, 
click at the end of 
the text, press Enter, and then click the Insert Date/Time button  to insert a date and time stamp.

4.	 Add to, change, or remove a part of the clinical note as needed.

5.	 To assign a different clinic than the currently selected clinic for the clinical note, click the Change Clinic 
for Selected Note button  to open the Select Clinic dialog box and select the appropriate clinic.

6.	 Click the Save Clinical Note button .
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Adding an Addendum to a Clinical Note
You cannot edit a locked clinical note (a note that has been moved into history after the month-end process, 
has been signed or approved, or has been locked automatically). However, you can add an addendum to a 
clinical note that has been locked.

To add an addendum to a clinical note

1.	 In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes.

The Clinical Notes window appears.

2.	 Expand the appropriate 
date category in the left 
pane, and then select the 
page of the clinical note 
to which you want to 
add an addendum.

3.	 Click the New 
Addendum button .

The New Addendum 
dialog box appears.

4.	 Type the text of the 
addendum.

5.	 If necessary, click the Select Provider 
button  and/or Select Clinic button 

 to select the provider and/or clinic 
you want to attach to the addendum.

6.	 Click OK. On the confirmation 
message that appears, click Yes.
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Printing Clinical Notes
From the Clinical Notes window, you can print all clinical notes within a certain date range for the current 
patient and/or all members of that patient’s family. For instructions on how to print the Clinical Notes Report 
from the DXOne Reporting module, see “List Reports” in Chapter 9: DXOne Reporting.

To print clinical notes

1.	 In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes.

The Clinical Notes window appears.

2.	 Click the Print button .

The Print Clinical Notes dialog 
box appears.

3.	 Set up the following options:

•	 Select Date Range – Click 
Date Range, and then type 
a range in the From and 
To fields; or, click Relative 
Date Range, and then select 
a range. The clinical notes 
within that date range will 
appear on the report.

Tip: Using a relative date 
range is recommended if 
you are saving your report 
settings as the default so that 
you do not have to manually 
type a date range each time 
you run the report.

•	 Patient Selection – Select whether you want to include clinical notes for the patient currently 
selected or for the current patient and anyone else in that person’s family.

•	 Report Type Selection – Select whether you want to include all clinical notes, clinical notes that have 
already been approved or signed, or clinical notes that have not been approved or signed.

•	 Clinic Selection – Click the search button  to select the clinic(s) you want to include on the 
report, or leave All selected to include all clinics.

•	 Provider/Staff Selection – Click the search button  to select the provider(s) you want to include 
on the report, or leave All selected to include all providers.

4.	 To save the current settings for the next time you run the report, click Save as Default.

5.	 Click OK to preview the report.
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Signing Clinical Notes
A provider can digitally sign a clinical note to indicate his or her approval of the note. Signing a clinical locks 
it to prevent changes from being made to the text and to prevent the note from being deleted; however, a 
signed or locked note can be appended to.

Tip: You can sign multiple clinical notes at once from the Office Manager.

To sign a clinical note

1.	 In the Patient Chart, with a patient selected, from the File menu, click 
Clinical Notes.

The Clinical Notes window appears.

2.	 Expand the appropriate date 
category in the left pane, and 
then select the page of clinical 
note to want to sign.

3.	 Click the Sign Clinical 
Note button .

The Approval Verification 
dialog box appears.

4.	 Type your User ID and 
Password, and then click OK.

The Sign Clinical Note dialog 
box appears.

5.	 In the signature box, sign your 
name using a mouse, light pen, finger on a touch 
screen, or stylus on a writing tablet.

Tip: If you need to clear the signature to re-sign, 
click Clear, and then re-sign.

6.	 Click OK.

When a signature has been added to the clinical 
note, a “Signed on [date]” stamp is added to the end of the clinical note.

Note: If you select a clinical note that has been signed, the Sign Clinical Note button  changes to the 
Signature button . To view a signature for the selected clinical note, click the Signature button.

Printing from the Patient Chart
You can print the following from the Patient Chart:

•	 Patient’s Chart

•	 Patient’s Progress Notes and Chart

•	 Referral Recap Report

•	 Referral Slip

1

2

3

4

5

6



Chapter 4: Patient Chart     139

Dentrix Enterprise 8.0.5 User’s Guide

Patient’s Chart
You can print a patient’s dental chart.

To print a patient’s chart

1.	 In the Patient Chart, with a patient selected, from 
the File menu, click Print Dental Chart. The Print 
Options dialog box appears.

2.	 Select the desired print option(s):

•	 Print Todays Work – To print completed work 
posted on the current system date.

•	 Print Treatment Plan –  To print treatment-planned work 
that was posted on the current system date. Then, to include 
a list of treatment-planned work and the billed amount, 
patient portion, and insurance portion of each, select Print TP 
Estimate Detail.

•	 Print Chart as Displayed – To include the graphical chart.

•	 Print Selected Images – To include patient images if you are 
using Image. You can also include notes and/or annotations.

3.	 Click OK.

Patient’s Progress Notes and Chart
You can print the progress notes and graphical chart as they are currently being viewed in the Patient Chart.

Tip : If you want to print the progress notes without the graphical chart, switch to the progress notes view in 
the Patient Chart, and then complete the steps that follow. For instruction on how to switch the Patient Chart 
view, see the “Working with views” topic  in the Dentrix Enterprise Help.

To print the progress notes with the chart

1.	 In the Patient Chart, with a patient selected, from 
the File menu, click Print Progress Notes With 
Chart. The Print Progress Notes with Chart dialog 
box appears.

2.	 Set up the following options:

•	 Note Range – To print all displayed progress 
notes, select All Progress Notes; or, to print notes specific to 
a certain date range, select Date Range, and then type a date 
range.

•	 Print Procedure Amounts – To include amounts for 
procedures that appear on the report.

3.	 Click OK.
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Referral Recap Report
The Referral Recap Report shows any completed work within a specified date range that has been flagged as 
“Referred By Doctor.” Treatment-planned work that has been referred to the practice by the same provider is 
also included. For information about attaching a referral to a procedure, see the “Editing treatment” topic in 
the Dentrix Enterprise Help.

To print a referral recap

1.	 In the Patient Chart, with a patient selected, from 
the File menu, point to Print Referral, and then 
click Referral Recap. The Print Referral Recap 
dialog box appears.

2.	 Under Completed Work Date Range, type the date 
range for the completed referred procedures you 
want to print. Only procedures that were completed 
within the specified date range and are flagged as “RC” (Referred 
Completed) will be included on the report.

3.	 Type any necessary Additional Notes that you want to have print 
on the report.

4.	 Click Print to send the report to the Patient Chart printer or 
Batch to send the report to the Batch Processor.

Referral Slip
You can print a referral slip for patients to give to the doctor they are being referred to. All procedures that 
have been flagged as “RTP” (Referred Treatment Planned procedure) and are within the specified date range 
will be included on the slip. The referral slip will also include the patient, provider, and referral’s information, 
as well as any notes you have entered. For information about attaching a referral to a procedure, see the 
“Editing treatment” topic in the Dentrix Enterprise Help.

To print a referral slip

1.	 In the Patient Chart, with a patient selected, from 
the File menu, point to Print Referral, and then 
click Referral Slip. The Print Referral Slip dialog 
box appears.

2.	 Under Date Range, type the date range for the 
referred procedures you want to print. Only 
procedures that fall within the specified date 
range and are flagged as “RTP” (Referred Treatment Planned 
procedure) will be included on the referral slip.

3.	 Type any necessary Additional Notes that you want to have 
printed on the slip.

4.	 Click Print to send the slip to the Patient Chart printer or Batch 
to send the slip to the Batch Processor.
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Chapter 5: Perio Chart
The Dentrix Enterprise Perio Chart is a clinical tool that allows you to record mobility, furcation grades, 
plaque, calculus, bone loss, pocket depths, bleeding and suppuration points, gingival margins, CAL levels, and 
MGJ measurements. Automatic calculation formulas allow you to expedite the charting process by eliminating 
the need to measure multiple indicators.

Once entered, you can view data numerically or graphically. Also, you can print custom reports, charts, and 
letters for an insurance consultant or the referring dental professional.

This chapter covers the following topics:

•	 Opening the Perio Chart Window

•	 Using the Perio Chart Window

•	 Entering New Perio Exams

•	 Viewing Perio Exams

•	 Changing the Perio Exam View

•	 Comparing Perio Exams

•	 Printing Perio Chart Reports

Opening the Perio Chart Window
You can open the Perio Chart from the Patient Chart.

To open the Perio Chart

In the Patient Chart, with a patient selected, from the Options menu, click Perio.

Tip: If the selected patient does not have an exam, the Perio icon on the Patient Chart toolbar is gray . If 
the selected patient has an existing exam, the icon is blue .

The Perio Chart opens and displays the data for the last exam performed (if one exists) or displays a blank data 
chart for you to start a new exam.
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Using the Perio Chart Window
The Perio Chart window is divided into the following areas: the data chart, tooth indicator controls, 
navigation controls, and data entry controls.

Data chart Tooth indicator controls

Navigation controls Data entry controls

This section covers the following topics about how to use the Perio Chart window:

•	 Using the Data Chart

•	 Using the Tooth Indicator Controls

•	 Using the Navigation Controls

•	 Using the Data Entry Controls

Using the Data Chart
You can use the data chart to input and display all 
periodontal data relevant to the current perio exam in a 
numerical format. The column that extends down the left 
side of the data chart indicates each measurement type.

The following list provides an explanation of the abbreviations used in the left column:

•	 T# (Tooth Number) – Indicates the tooth number to which the displayed information belongs.

•	 PD (Pocket Depth) – Indicates the depth of the periodontal pocket in millimeters.

•	 Bld (Bleeding) – A red oval in this row indicates a bleeding point.

•	 Sup (Suppuration) – A yellow oval indicates suppuration (infection) at that site.

•	 GM (Gingival Margin) – Indicates the gingival margin (recession) measurement in millimeters.

•	 CAL (Clinical Attachment Level) – Indicates the CAL measurement in millimeters.

•	 MGJ (Mucogingival Junction) – Indicates the MGJ measurement in millimeters.
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•	 FG (Furcation Grade) – Indicates the furcation involvement for the tooth.

•	 TC (Tooth Code) – Indicates special conditions relevant to the tooth. Conditions can include the 
following: C for crown, P for pontic, I for implant, U for unerupted, M for missing, ID for impacted 
distal, and IM for impacted mesial.

•	 PMB (Plaque, Mobility, and Bone Loss) – Indicates plaque, mobility, and bone loss measurements 
specific to the tooth.

The shading within the data chart has special significance:

•	 Yellow areas – Represent measurements taken from the facial (buccal) side of the tooth.

•	 Blue areas – Represent measurements taken from the lingual side of the tooth.

•	 White areas – Represent measurements that correspond to the tooth in general.

Within the yellow and blue areas, you can input six measurements (three on the facial side and three on the 
lingual side) for each tooth.

Using the Tooth Indicator Controls
The tooth indicator controls provide options for inputting data specific to a 
selected tooth. The information input through the  tooth indicator controls 
is displayed in the white areas of the data chart. From the tooth indicator 
controls, you can input mobility, furcation grade, plaque, and bone loss. In 
addition, you can reference the tooth number currently selected and a text 
description of any codes associated with that tooth (for example, a crown, 
pontic, or implant).

The following list explains the function of each control:

•	 Tooth # – This field references the current tooth being charted.

•	 Mobility – Click the desired mobility classification. The number appears in the center placement of the 
PMB line on the data chart.

•	 Tooth Code – This field displays applicable condition information about the tooth.

•	 Furcation Grade – Click the search button  to open the Furcation Grade dialog box, which displays 
the furcation grades relevant to the selected tooth. Select the appropriate furcation, and then click OK.

•	 Plaque – From the list, select the appropriate plaque classification. A corresponding number appears in 
the left placement of the PMB line on the data chart.

•	 Bone Loss – From the list, select the appropriate bone loss classification. A corresponding number 
appears in the right placement of the PMB line on the data chart.



144     Chapter 5: Perio Chart

Dentrix Enterprise 8.0.5 User’s Guide

Using the Navigation Controls
For quick entry of perio exam data and to facilitate different charting styles, the Perio Chart allows you 
to set up a “paths” and “scripts” to indicate the tooth order, site to site movement on each tooth, and the 
measurement to be taken (for example, PD, GM, or CAL) at each site. For information about setting up 
charting paths and scripts, see the “Customizing perio entry settings” topic in the Dentrix Enterprise Help.

The navigation controls work in conjunction with the script settings. The following list outlines the function 
of each control:

•	 Script – This box displays the tooth number of the current position of the active script. It is a reference 
point in case the script is overridden by a different selection, so you know where the script stopped and 
where to recommence.

•	 Left Arrow (<-) – Click this button to move from the current tooth to the previous tooth.

•	 Right Arrow (->) – Click this button to move from the current tooth to the next tooth.

•	 Arch – Click this button to switch between the upper and lower arch (or vice versa).

•	 Prev – Click this button to rewind the script from the current tooth to the previous tooth.

•	 Next – Click this button to advance the script from the current tooth to the next tooth in the script.

•	 Home – Click this button to return to the first tooth in the script.

Using the Data Entry Controls
The data entry controls allow you to input data specific 
to different sites on the selected tooth: pocket depths, 
bleeding and suppuration points, gingival margins, 
clinical attachment levels, and mucogingival junction 
measurements.

The following list outlines the function of each control:

•	 Facial/Lingual – Click this button to switch from the facial side to the lingual side of a tooth (or vice 
versa).

•	 Probing Depth – Enter the pocket depth measurements.

•	 B (Bleeding) – Click the “B” oval, or press “B” on your keyboard, to indicate a bleeding point on the 
tooth. A red oval that corresponds to the selected tooth and site appears on the data chart.

•	 S (Suppuration) – Click the “S” oval, or press “S” on your keyboard, to indicate an infection point on 
the tooth. A yellow oval that corresponds to the selected tooth and site appears on the data chart.

Tip: To add both suppuration and bleeding to the same tooth, while hold down the Ctrl key, press “B”.

•	 Gingival Margin – Enter the gingival margin measurements.

•	 Clinical Att. Level – Enter the clinical attachment level.

•	 MGJ – Enter the mucogingival junction measurements.

•	 0 – 9 – Click these buttons to enter charting measurements.



Chapter 5: Perio Chart     145

Dentrix Enterprise 8.0.5 User’s Guide

•	 1- – To enter a measurement that is greater than nine millimeters, click 1- button followed by the 
appropriate number (for example, to enter a pocket depth of 12 millimeters, click the 1- button followed 
by the 2 button). Measurements greater than nine millimeters appear as a greater than sign (>) on the 
data chart.

•	 + – To record a gingival margin that is above the CEJ, click the + button followed by the appropriate 
number. To indicate that the GM is a positive number, the number appears on the data chart as a white 
number in a black square.

•	 Nxt – Click this button to move from the current site to the next site of the script.

•	 Clear – Click this button to clear all entries on the current tooth.

•	 Left, Down, and Right Arrows (<-, v, ->) – Click these buttons to move around the data entry area 
(Probing Depth, B, S, Gingival Margin, Clinical Att. Level, and MGJ) without advancing to another 
tooth.

•	 Path – This button always displays the current path being used (for example, PBSL, PBSR, or none). 
To manually switch between paths while charting, click the button until the desired path appears on the 
button.

Entering New Perio Exams
Dentrix Enterprise offers a great deal of flexibility for entering data into a perio exam. You can enter only the 
most basic information, such as pocket depths. Or, if you want to do a more comprehensive exam, almost 
every perio classification and measurement is available to be charted and noted.

To enter perio measurements

1.	 In the Patient Chart, with a patient selected, from the Options menu, click 
Perio.

The Perio Chart opens.

Tip: If a patient has an 
existing perio exam, Dentrix 
Enterprise automatically 
opens the most recent exam 
as a reference. You can save 
time by entering only the 
measurements that have 
changed since the last exam.

2.	 To choose the script that 
matches your charting style, 
click Setup on the menu 
bar. To select the desired 
path, click the Path button 
until that path’s name 
appears on the button.

3.	 Enter perio measurements, 
following the selected path 
and script. To enter information not included in the script, use the controls located on the right side of 
the Perio Chart.
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The following list contains the keyboard commands that can be used if you prefer using the keyboard for 
data entry:

•	 Numeric key pad – Works the same as the number buttons on the data entry controls.

•	 Number keys – Work the same as the number buttons on the data entry controls.

•	 PAGE UP – Works the same as the Prev button on the data entry controls.

•	 PAGE DOWN – Works the same as the Next button on the data entry controls.

•	 HOME – Works the same as the Home button on the data entry controls.

•	 DELETE – Clears all entries in the current selection. Works the same as the Clear button on the data 
entry controls.

•	 Arrow keys – Works the same as the arrow buttons in the data entry controls.

•	 Asterisk (*) – Works the same as the Facial/Lingual button on the data entry controls. It toggles 
between the two surfaces of the selected tooth.

•	 ENTER – Advances the selection through the current script settings.

4.	 From the File menu, click Save Exam.

Viewing Perio Exams
Once an exam has been saved, it can be viewed at any time.

To view an existing exam

1.	 In the Perio Chart, from the File menu, click Open Existing 
Exam.

The Perio Chart Open dialog box appears.

2.	 Select the exam that you want to view.

3.	 Click OK.
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Changing the Perio Exam View
From the Perio Chart, you can view perio data in several different formats. This section covers the following 
view options:

•	 Viewing the Graphic Chart

•	 Viewing the Combined Graphic and Data Chart

•	 Viewing Quadrants

Viewing the Graphic Chart
Unlike the data chart, which displays perio data numerically, the Perio Chart’s graphic chart view displays 
numeric perio data in a graphical representation. You cannot add or change data while in the graphic chart 
view.

To view the graphic chart

In the Perio Chart, from the Options menu, click Graphic Chart.
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Viewing the Combined Graphic and Data 
Chart
In the Perio Chart, you can view a combination of the data chart and graphic chart. Numerical data appears 
above the graphic portion of the chart. You cannot add or change data while in the data and graphic chart view.

To view the combined graphic and date chart

In the Perio Chart, from the Options menu, click Combined Graphic & Data Chart.

Viewing Quadrants
You can enlarge a quadrant to view that area close up.

To zoom in on a quadrant

1.	 While viewing the data chart or graphic chart, click in the quadrant you want to view.

2.	 From the Options menu, click Quadrant Zoom.

3.	 If you want to zoom back out to see all quadrants or to select a different quadrant to zoom in on, while 
in the quadrant zoom mode, right-click anywhere in the window to zoom out so that all quadrants are 
being viewed in the graphic chart (the pointer changes to a magnifying glass), and then click the desired 
quadrant.

4.	 When you are finished using the quadrant zoom feature, from the Options menu, click Quadrant Zoom 
again to get out of the quadrant zoom mode.
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Comparing Perio Exams
To help you educate your patients regarding periodontal disease progression, you can compare up to four 
saved perio exams with the current exam.

To compare exams

1.	 In the Perio Chart, from the Options menu, click Exam Comparison.

The Perio Comparative Selections dialog box appears.

2.	 Under Compare, select the type of comparison 
that you want view:

•	 Probing Depths (Data) – To review 
a data comparison of probing depth 
measurements.

•	 Gingival Margin – To review a comparison 
of gingival margin measurements. Select 
whether to view a Graphic or Data 
representation.

•	 Clinical Attachment Level – To review a 
comparison of CALs. Select whether to view 
a Graphic or Data representation.

•	 Mobility – To review a data comparison of 
mobility measurements.

•	 Furcation Involvement – To review a data comparison of furcation grades.

3.	 Under Display, select what you want to display: MGJ Line, Bleeding, Suppuration, Mobility, or 
Furcation Involvement. These options are not available if Probing Depths (Data) is selected under 
Compare.

4.	 Under Select Comparison Exam, select the exams you want to compare to the current exam.

5.	 Click OK.
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Printing Perio Chart Reports
From the Perio Chart, you can print a variety of different charts and letters with periodontal exam 
information.

To print the Perio Chart reports

1.	 In the Perio Chart, while viewing the exam you want to 
print, from the File menu, click Print.

The Perio Print Selections dialog box appears.

2.	 Specify the letters and information you want to print:

•	 Letters – Select any of the following letters 
that you want to print (Microsoft Word 
must be installed):

•	 Insurance Consultant Letter – Prints a 
letter that can be sent as documentation 
of Perio disease diagnosis to an 
insurance carrier.

•	 Patient File – Prints a document that 
can be placed in the patient’s chart that 
documents the perio diagnosis for the 
selected exam.

•	 Patient Initial – Prints a letter that can be sent 
to the patient to remind him or her of perio diagnosis and to suggest home care aids.

•	 Patient Progress – Prints a follow-up letter that can be sent to provide an update for the patient 
on his or her perio status.

•	 Patient Completion – Prints a congratulatory letter that can be sent to a patient on the 
completion of his or her perio treatment. The letter contains several helpful reminders to aid the 
patient in maintaining perio health.

•	 Referring Dentist Initial – Prints a letter that can be sent as documentation of Perio disease 
diagnosis to the referring dentist.

•	 Referring Dentist Progress – Prints a letter that contains updated diagnostic information for the 
referring dentist.

•	 Referring Dentist Completion – Prints a letter that contains final diagnostic information and 
explains that the patient should be returning to the referring dentist for general dental care.

•	 Charts – Select any of the following perio chart information that you want to print:

•	 Data Chart – Prints the data chart.

•	 Pocket Depths Only – Prints the data chart but only includes pocket depths.

•	 Graphic Chart – Prints the graphic chart (will print in color if sent to a color printer).

•	 Combined Graphic & Data Chart – Prints the graphic and data chart (will print in color if sent 
to a color printer).

•	 Exam Comparison – Prints the exam comparison chart. This option is available only if you are 
viewing an exam comparison.

3.	 Click Print.
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Chapter 6: Treatment Planner
The Treatment Planner can help you provide your patients with easy-to-understand treatment options. When 
the Treatment Planner is opened for a selected patient, his or her entire treatment plan is used to create a 
default treatment plan case. You can set up additional cases and visits, and you can view detailed treatment 
and insurance information. Also, you can group procedures in a treatment plan case by visit or by case to 
provide patients with different treatment options.

This chapter covers the following topics:

•	 Opening the Treatment Planner

•	 Using the Treatment Planner Window

•	 Customizing Case Settings

•	 Selecting the Case Details to Display

•	 Working with Treatment Plan Cases

•	 Viewing Case Status History

•	 Adding Consent Forms to Cases

•	 Signing Consent Forms

•	 Editing and Deleting Procedures

•	 Posting Completed Procedures

•	 Updating Treatment Plan Fees

•	 Generating Treatment Planner Reports

Opening the Treatment Planner
You can open the Treatment Planner from the Patient Chart and Ledger.

To open the Treatment Planner

In the Patient Chart or Ledger, with a patient selected who has treatment-planned procedures, from the 
Options menu, click Treatment Planner.
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Using the Treatment Planner Window
The Treatment Planner window consists of a menu bar, toolbars, the Treatment Plan panel, the case details, 
and the graphical chart or progress notes.

Treatment Plan Panel Case Details Graphical Chart

This section covers the following topics on how to use the Treatment Planner window:

•	 Using the Treatment Planner Toolbar

•	 Using the Treatment Plan Panel
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Using the Treatment Planner Toolbar
The Treatment Planner includes toolbars with buttons you can click to access certain areas or features of 
Dentrix Enterprise.

The function of the buttons specific to the Treatment Planner are explained in the following table.

Click the Refresh button to update the data from other modules, such as the Ledger or Patient 
Chart.

Click the Update Treatment Plan Fees button to update the treatment plan fees manually to 
reflect any fee schedule changes.

 
Click the Primary Dental Insurance Notes button to view the primary dental insurance plan 
note for the primary dental insurance plan of the patient currently being viewed in the Treatment 
Planner. You also have buttons for secondary, tertiary, and quaternary dental insurance if the 
current patient has those particular types of insurance coverage.

Click the Insurance Benefits button to view a summary of the current patient’s insurance benefits. 
You also have the option to include all family members.

Click the Print button to print one of the Treatment Planner reports.

Click the Treatment Planner View button to select a Treatment Planner view.

Click the Copy Case Detail to Clipboard button to copy the case detail currently being displayed 
to the Windows Clipboard so that you can paste the information into a word processing program.

Click the Other Appointments button to view appointments that have been scheduled for the 
patient selected in the Treatment Planner and that patient’s family members.

For a comprehensive explanation of all the Treatment Planner toolbars, see the “Using the Treatment Planner 
toolbars” topic in the Dentrix Enterprise Help.
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Using the Treatment Plan Panel
From the Treatment Plan panel, you can assign treatment to cases, set the order of the visits, create alternate 
cases, view insurance estimates, add supporting information, view case history statuses, and set up the default 
settings and required consent forms for new cases.

The Treatment Plan panel consists of several sections that you can open by clicking the corresponding section 
button.

Section 
Buttons

      

Section 
Buttons

Note: If you resize the button area so that not all the buttons fit on the panel, a smaller version of any section 
button that does not fit on the panel in its full size appears at the bottom of the panel.

The following is a brief explanation of each section;

•	 Treatment Plan Case Setup – Open this section to assign treatment to cases, create and link alternate 
cases, set a recommended case, change the status of a case, set the severity level for a case, set the order of 
visits for a case, add and sign consent forms, complete procedures, and print Treatment Planner reports.

•	 Insurance/Case Amounts – Open this section to view insurance estimates, treatment plan case totals, 
insurance plan notes, and patient and family benefit details.

•	 Supporting Information – Open this section to add notes and consent forms to a case.

•	 Case Status History – Open this section to assign and view status changes for a case. You can also create a 
referral.

•	 Settings – Open this section to set the defaults for all new cases that are created and to manage consent 
forms.
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Customizing Case Settings
Before treatment planning a case, set up the case defaults. Changes made to the default case settings affect all 
other computers on your practice’s network, and the selected settings will be used for every new case that is 
created.

To customize case settings

In the Treatment Planner, on the Treatment Plan panel, from the Settings section, set up the following 
options:

•	 Default Settings for New Cases

•	 Estimate Expires – Select the default expiration date for all cases: 
“1 year from current date,” “3 months from current date,” “1 
month from current date,” “Beginning of next calendar year,” 
“Beginning of next fiscal year,” “Beginning of next month,” or 
“Prim. Ins. Benefit renewal month.”

•	 Default Case Note Template – Select the default that will be 
used to create case notes from a template. “[NONE]” is the only option that is available until another 
template has been set up. To add, modify, or delete a template, click Template Setup.

•	 Automatic Case Status Updates – Select the case statuses that you want to be added automatically to the 
case status history:

•	 Printed – A case will be updated with the “printed” status when the 
case is printed.

•	 Proposed – A case will be updated with the “proposed” status to 
present or propose the case to the patient.

Note: If you select a status, the status is automatically applied to the current case.

•	 Setup Consent Forms – Any existing consent forms that will be used for new cases appear in the list box. 
Do any of the following:

•	 New – To add a consent form, click New.

•	 Edit – To edit an existing consent form, select that consent form, 
and then click Edit.

•	 Delete – To delete a consent form, select that form, click Delete, 
and then click Yes to confirm the deletion.

•	 Select Procedure Information – To select what procedure 
information is allowed on consent forms by default, click Select 
Procedure Information.

•	 Select Electronic Signature Device – Select the device that will be used to sign cases at this 
computer.

Important: If you are using Terminal Services or Citrix on this computer to connect remotely to a 
computer with Dentrix Enterprise installed, an ePad will not work for signing consent forms from 
this computer.

For a comprehensive explanation of all the available case settings, see the “Customizing case settings” topic in 
the Dentrix Enterprise Help.
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Selecting the Case Details to Display
You can specify what, if any, procedure information you want to be displayed in the case details area.

To select the procedure information to display

1.	 In the Treatment Planner, from the View menu, click Procedure Information.

The Procedure Information dialog box appears.

1

2

3

2.	 Select the information you want to display in the case details. The case details will have a column for each 
information item that is selected.

3.	 Click OK.

Working with Treatment Plan Cases
Treatment-planned procedures can be grouped into a case. This section covers the following topics about 
treatment plan cases:

•	 Using the Treatment Plan Case Setup Section

•	 Creating New Cases

•	 Creating Alternate Cases

•	 Linking Alternate Cases

•	 Setting the Recommended Case

•	 Ordering Procedures by Visit
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Using the Treatment Plan Case Setup Section
The Treatment Plan Case Setup section 
on the Treatment Plan panel displays the 
treatment plan cases that have been created 
for a patient.

As you select a case in the list, the other 
sections (except for Settings) on the panel 
and the case details are updated to reflect 
the information for the selected case.

The function of each button on the section’s toolbar is explained in the following table.

Click the New Case button to create a new treatment plan case you can use to group treatment-
planned procedures.

Click the Delete Case button to delete the selected treatment plan case.

Click the Link Alternate Cases button to link alternate treatment plan cases together so that, 
when one of the cases is accepted, the others are automatically rejected. You can also set the 
recommended case.

Click the Update Case Status button to change the status of the selected treatment plan case.

Click the Set Case Severity button to specify a severity for the selected treatment plan case.

Click the consent forms button to add, sign, or view consent forms for the selected case. The 
appearance and functionality of the button varies depending on the status of the consent forms 
for the case:

There are no consent forms attached to the case. Click the No Consent Forms button to 
add consent forma to the selected case.

The case has at least one unsigned consent form. Click the Case Has Unsigned Consent 
Forms button to sign the consent forms.
The case has at least one consent form that is missing one of the two required signatures. 
Click the Consent Forms Missing Signature button to sign the consent forms.
All the consent forms for the case have been signed. Click the All Consent Forms Have 
Been Signed button to review the consent forms.

Click the Move Case Up button to move the selected case up one place in the list. Click the 
Move Case Down button to move the selected case down one place in the list.



158   Chapter 6:   Treatment Planner

Dentrix Enterprise 8.0.5 User’s Guide

Click the Print button to select a Treatment Planner report you want to print.

Click the Expand All button to view all the treatment-planned procedures for every case listed.

Click the Collapse All button to show only the name and date of every case listed.

You also have the following options at the bottom of the Treatment Plan Case Setup section:

•	 Include Completed Cases – Selecting this option includes completed treatment plan cases in the case list.

•	 Include Rejected Cases – Selecting this option includes rejected treatment plan cases in the case list.

•	 Create Visit – When procedures that have not been assigned a visit number are selected, clicking this 
button  creates a new visit that is given the next available number for the corresponding case.

•	 Delete Visit – When procedures that have been assigned a visit number are selected, clicking this button 
 deletes the visit from the corresponding case.

Creating New Cases
The Treatment Planner groups treatment-planned procedures by case. There is always a default treatment plan 
case, but you can create additional cases as needed.

To create a new case

1.	 In the Treatment Planner, on the Treatment Plan panel, 
from the Treatment Plan Case Setup section, click the 
New Case button . The new case appears in the case list.

2.	 Type a name for the case, and then press Enter to apply the 
name.

3.	 Select the procedures in the 
default case that need to be 
put in the new case (to select 
multiple procedures, while 
pressing the Ctrl key, click the procedures), and then click again and drag the selected procedures to the 
new case.

Tip: All treatment-planned procedures are automatically added to the default case (“Treatment Plan” is 
the name if it has not been renamed). If all the procedures in the default treatment plan case are part of 
the same case, you can rename the default case instead of creating a new case and moving the procedures.

3

1

2
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Creating Alternate Cases
Alternate cases can be created for the same set of treatment-planned procedures. Creating alternate cases 
provides patients with several treatment plan options. An alternate case is linked to the original case.

For example, a patient may need a tooth extraction and an implant or bridge. One treatment plan case can 
include the root canal and an implant. An alternate case can include a root canal and a bridge.

To create an alternate case

1.	 In the Treatment Planner, on the Treatment Plan panel, from 
the Treatment Plan Case Setup section, select the case for 
which you want to create an alternate case. Right-click that 
case, and then click Create Alternate Case.

The Create Alternate Case dialog box appears.

2.	 Verify that the case being displayed in the Create Alternate 
Case For list is the case for which an alternate case is 
being created.

Tip: The selected case is the case that will be flagged as the 
recommended case. If you do not want this case to be the 
recommended one, you can select a different case while in 
this dialog box, or you can change the recommended case 
later.

3.	 In the Name of Alternate Case text field, type a name for 
the alternate case.

4.	 Select the procedures you want to copy to the alternate 
case.

Tip: The procedures common to the alternate cases are 
procedures that must be treated regardless of which 
treatment plan is selected. For example, since a root canal therapy must be completed regardless of the 
type of restoration placed on the tooth, root canal therapy must be included in both cases.

5.	 Click OK.

1
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Linking Alternate Cases
When you create an alternate case, the alternate case is automatically linked to the original case. Also, if you 
have created cases that are all alternate cases for each other but are not linked, you can link them manually. 
You can link several treatment plan cases together if necessary; however, make sure each case is functioning as 
an alternate treatment plan being offered to a patient.

Additionally, linking cases can be beneficial for updating statuses. For example, if you apply an Accepted 
status to a case, the other linked cases are automatically given a Rejected status.

To link alternate cases

1.	 In the Treatment Planner, on the Treatment Plan panel, from 
the Treatment Plan Case Setup section, select a case that is 
already linked to another case, or select a case that you want to 
be the recommended case and link to another case. Right-click 
that case, and then click Link Alternate Cases.

The Linked Cases dialog box appears.

2.	 If you right-clicked a case that is not already linked, from 
the Recommended Case list, select the recommended 
case; otherwise, this list is unavailable and displays the 
recommended case you right-clicked or the recommended case for 
the case you right-clicked.

3.	 Select the cases you want to link. At least two cases must be 
selected.

4.	 Click OK.

Tip: Linked cases have link icons (  or ) after them. The 
background color of the icon varies, depending on how many sets 
of linked cases exist for the patient; for example, you could have 
two cases linked together and two other cases linked together, and 
the background color of the link icon for both of those sets will be different.

Setting the Recommended Case
The recommended case is the case that contains the recommended treatment plan. The recommended case 
can be changed after alternate cases have been created.

To set the recommended case

In the Treatment Planner, on the Treatment Plan panel, from the 
Treatment Plan Case Setup section, select the case you want to set 
as the recommended case. Right-click that case, and then click Set 
as Recommended Case. This option is unavailable if the case is 
not linked to an alternate case.

Tip: The link icon  after the case will become starred . The 
starred link icon after the prior recommended case becomes a 
normal link icon.

1
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Ordering Procedures by Visit
You can organize treatment-planned procedures within a case into visits when more than one visit will be 
required to complete the treatment plan. For example, a patient could have a root canal performed and a 
temporary crown placed on the first visit and then the final crown seated on another visit.

To order procedures by visit

1.	 In the Treatment Planner, on the Treatment Plan 
panel, from the Treatment Plan Case Setup section, 
expand the appropriate case by clicking the plus sign 
(+).

2.	 Select the procedures that will be completed in one 
visit (to select multiple, while pressing the Ctrl key, 
click each procedure). Next, right-click one of the selected 
procedures, and then click Create Visit. The visit number appears next 
to the procedures.

Repeat this step for all subsequent visits of the treatment plan. As visits are created, the number of the 
visit increases (1, 2, 3, and so forth).

1

2

Viewing Case Status History
As a case is created and modified, the Treatment Planner tracks the changes in status and provides a way for 
you to view those changes. After reviewing the status history of a case, you can update the case status.

To view and update the status history of a case

1.	 In the Treatment Planner, on the Treatment Plan panel, from 
the Treatment Plan Case Setup section, select a case.

2.	 Open the Case Status History section for the selected case, 
which is shown at the top of the section.

The Case Status History table displays the status history for 
the selected case, which includes the date of the change, the 
current status of the case, and any comments made at the 
time of that particular change.

3.	 If necessary, to update the status of the case, under Update 
Current Case Status, from the New Case Status list, select 
the appropriate status, and then click Update.

Tip: You can also update the status for a selected case by 
clicking the Update Case Status button  on the Treatment 
Plan Case Setup section’s toolbar.

1

2

3
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Adding Consent Forms to Cases
You can add consent forms to cases for a patient and provider to sign. You can set up consent forms from the 
Settings sections of the Treatment Plan panel.

To add a consent form to a case

1.	 In the Treatment Planner, on the Treatment Plan panel, from 
the Treatment Plan Case Setup section, select a case. Next, 
right-click the case, and then click Consent Forms. The 
Dentrix Consent Forms dialog box appears.

2.	 From the Select Consent Form list, select the form you want 
to add to the selected case.

3.	 Click Add.

The Consent Form dialog box appears.

4.	 Under Patient/Representative signature, the patient selected in 
the Treatment Planner is entered in the Name field but can be 
changed. Also, the Relationship to patient has “Self ” entered by 
default but can be changed (for example, you can type “Spouse” 
or “Parent” if the person signing the form is the patient’s spouse 
or parent). The name and relationship can be edited at a later 
time (for instance, when the consent form is going to be signed).

5.	 Under Practice signature, click the Name search button  to 
select the provider (primary or secondary) who will sign the form, 
or you can type the provider’s name in the field. The name can 
be entered at a later time (for instance, when the consent form is 
going to be signed).

Tip: The consent form can 
be signed by the patient and 
provider at a later time. Also, 
both signatures do not need to 
be acquired at the same time. 
For information about signing 
consent forms, see “Signing 
Consent Forms” in this chapter.

6.	 Click Save.

7.	 To print the consent form, click 
Print. You can print any consent 
form, signed or not.

1
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Signing Consent Forms
The patient and provider can electronically sign consent forms attached to a treatment plan case. Once a 
signature is added to a consent form and the form is saved, the signature cannot be removed. The consent 
form is considered locked once both parties have signed it (both parties do not have to sign on the same date).

To sign a consent form

1.	 In the Treatment Planner, from the Treatment Plan Case 
Setup section of the Treatment Plan panel, select a case that 
needs to be signed. Next, right-click the case, and then click 
Consent Forms.

The Dentrix Consent Forms dialog box appears.

2.	 Double-click the consent form you want to sign. The 
Consent Form dialog box appears.

3.	 Under Patient/Representative signature, if the 
correct patient is not already entered in the Name 
field, type the name of the person who will sign the 
form. Also,  if the correct Relationship to patient is 
not already entered, type a relationship (for example, 
“Self,” “Spouse,” or “Parent”). Then, have the patient or 
patient’s representative sign in the box using an input 
device.

Note: You can click Clear if the patient needs to re-sign. 
This button is unavailable if the consent form has been 
saved with a signature (even 
the slightest mark registers as a 
signature) or no signature has 
been added yet. Once the form is 
saved, the signature, name, and 
relationship cannot be changed.

4.	 Under Practice signature, if the 
correct provider is not already 
entered in the Name field, click 
the search button  to select 
the provider (primary or secondary) who will sign the form, or you can type the provider’s name in the 
field. Then, sign in the box using an input device.

Note: You can click Clear if you need to re-sign. This button is unavailable if the consent form has been 
saved with a signature (even the slightest mark registers as a signature) or no signature has been added yet. 
Once the form is saved the signature and name cannot be changed.

5.	 Click Save.

6.	 To print the consent form, click Print.

1
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Editing and Deleting Procedures
You can edit or delete existing treatment-planned procedures that are not in history.

To edit or delete a treatment-planned procedure

1.	 In the Treatment Planner, on the Treatment Plan 
panel, from the Treatment Plan Case Setup section, 
expand the appropriate case by clicking the plus sign 
(+), and then double-click a procedure.

The Edit or Delete Procedure dialog 
box appears.

2.	 Do one of the following:

•	 Make any necessary changes, and 
then click OK. For information 
about the options that are 
available for editing, see “Entering 
Treatment” in Chapter 4: Patient 
Chart.

•	 Click Delete and then OK to delete 
the procedure. The treatment-
planned procedure is removed from 
the Treatment Planner, Patient 
Chart, and Ledger-Treatment Plan.

Tip: To delete multiple procedures at the 
same time, in the Treatment Plan Case 
Setup section, while pressing the Ctrl 
key, click the procedures you want to 
delete. Next, right-click one of the selected procedures, and then click Delete Procedure(s). Then, on the 
confirmation message that appears, click Yes.

Posting Completed Procedures
After you complete procedures, you can post those procedures from the Treatment Planner.

To post a completed procedure

In the Treatment Planner, on the Treatment Plan panel, 
from the Treatment Plan Case Setup section, expand 
the appropriate case by clicking the plus sign (+), right-
click the procedure you want to complete, and then 
click Set Complete. In the case details, a blue check 
mark appears next to any completed procedures.

Tips:

•	 To complete multiple procedures at the same time, in the Treatment Plan Case Setup section, while 
pressing the Ctrl key, click the procedures that you want to complete. Next, right-click one of the selected 
procedures, and then click Set Complete.

•	 To set all the procedures in a selected case complete at the same time, click the Update Case Status 
button  on the Treatment Plan Case Setup section’s toolbar, and then click Completed.

1
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Updating Treatment Plan Fees
To maintain the integrity of treatment plan estimates, Dentrix Enterprise does not automatically update the 
fees for procedures assigned to a treatment plan. If your fees have changed since the time a treatment plan 
was given to a patient, that treatment plan can be manually updated for that patient from the Treatment 
Planner to reflect any fee schedule changes if certain criteria you specify for the procedures are met. You can 
also update treatment plan fees for all patients with treatment-planned procedures matching the criteria you 
specify.

To update treatment plan fees

1.	 In the Treatment Planner, from the Edit menu, click Update 
Treatment Plan Fees.

The Update Treatment Plan Fees dialog box appears.

2.	 Set up the following options:

•	 Update Treatment Plan Fees For – To update the fees for 
the currently selected patient only, select “Current Patient.” 
To update the fees for all patients with treatment plans, 
select “All Patients.”

•	 Procedure Information – This tab 
provides the following options for 
updating treatment plan fees:

•	 Procedure Code(s) – Select 
the procedure or range of the 
procedures to update for From and 
To. To update all procedures, leave 
From “<All>” To “<All>”selected.

•	 Procedure Date Before – Select the 
cut-off date to use for updating fees 
for treatment-planned procedures. 
Only treatment-planned procedures 
dated on or before the selected date 
will be updated with the new fees.

•	 Tx Clinics – To update treatment-
planned procedures performed in 
specific clinics, select the desired 
clinics (to select multiple clinics, while pressing the Ctrl key, click each clinic), or leave All 
selected to update procedures for all clinics.

•	 Tx Provider – To update treatment-planned procedures performed by a specific provider, select 
the providers (to select multiple providers, while pressing the Ctrl key, click each provider), or 
leave All selected to update procedures for all providers.

•	 Billing Type for Patient’s Guarantor – If you are updating treatment plan fees for all patients, 
to update treatment-planned procedures for patients with specific billing types, select the billing 
types (to select multiple billing types, while pressing the Ctrl key, click each billing type), or leave 
All selected to update procedures for patients with any billing type.

1

2
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•	 Case Information – This tab provides the following options for updating treatment plan fees:

•	 Current Status – To update treatment-
planned procedures in cases with 
specific statuses, select the case 
statuses, or leave All selected to update 
treatment-planned procedures in cases 
with any status.

•	 Case Financing Flag – To update 
treatment-planned procedures in cases 
with specific financing flags, select the 
financing types, or leave All selected to 
update treatment-planned procedures 
in cases with any financing flag.

•	 Severity – To update treatment-
planned procedures in cases with 
specific case severities, select the 
severity levels, or leave All selected to 
update treatment-planned procedures 
in cases with any severity.

•	 Exclude Default Treatment Plan – To exclude all procedures added to a default treatment plan, 
select this option.

•	 Estimate Expiration Date Before – To update fees for procedures in cases created prior to but 
not on the date specified, select this option, and then select a cut-off date.

3.	 Click Update.

Important: Depending upon which fee schedule is assigned to the patient, the fee for the patient’s 
treatment-planned procedures might not have been updated or not updated with the fee you might have 
expected. For more information about fee schedule hierarchy, see the “Updating treatment plan fees” 
topic in the Dentrix Enterprise Help.

3
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Generating Treatment Planner Reports
You can print the following Treatment Planner reports:

•	 Treatment Case Report – To report on a specific case.

•	 Patient Treatment Case Report – To report on the current patient.

•	 Practice Treatment Case Report – To report on the whole practice.

You can customize the data that prints on each of these reports.

To generate a Treatment Planner report

1.	 In the Treatment Planner, on the Treatment Plan panel, from the Treatment Plan Case Setup section, 
select a case.

2.	 From the File menu, point to Print, and then click the report you want to generate.

3.	 Set up the report options. The options for each report are explained in the sections that follow.

4.	 Click OK.

Treatment Case Report Options
From the Print Treatment Case dialog box, set up any of the following options:

•	 Print – Select the information you 
want to include.

•	 Insurance – Select the insurance 
information you want to exclude. 
To include the amount of any 
deductibles applied, select Use 
Dental Plan Maximums and 
Deductibles.

•	 Patient Privacy – Select the 
patient information you want to 
exclude.

•	 Case Procedure Options

•	 Type a visit or range of visits 
(for example, 1, 3, 5-7) you 
want to include on the report 
in the Select Visits field, or 
leave “<ALL>” entered to 
include all visits.

•	 Select the visit-specific information you want to include.

•	 To include a comparison of the current fee schedule to a selected fee schedule, select the Compare to 
Fee Schedule search button , and select a fee schedule.

Tips:

•	 To save the current report settings as a set for the next time you run this report, click Save Options.

•	 To preview the report before printing it, select Print Preview.
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Patient Treatment Case Report Options
From the Patient Treatment Case Report dialog box, set up any of the following options:

•	 Procedure Code Date Range – Enter a 
date or date range of treatment-planned 
procedures posted in the range to include. 
To include all dates, select All Dates for 
From and To.

•	 Case Fee Expiration Date Range – 
Enter a date or date range of cases with 
an expiration date within that range to 
include. To include all dates, select All 
Dates for From and To.

•	 Select Provider – To select a provider 
or range of providers for the patient’s 
treatment-planned procedures to include, 
click the From and To search buttons 

, and select the providers. To include 
all providers, leave From “<ALL>” To 
“<ALL>” entered.

•	 Report Options

•	 Select the options that correspond to 
the information you want to include.

•	 To include a comparison of the current 
fee schedule to a selected fee schedule, select the Compare to Fee Schedule search button , and 
select a fee schedule.

•	 Include Cases With – Select the case statuses that you want to include, or select All to include all 
statuses. Also, select the case severities that you want to include, or select All to include all severity levels.

•	 Patient Privacy – Select the options that correspond to the patient information you want to exclude.

Tips:

•	 To save the current report settings as a set for the next time you run this report, select Save as Default.

•	 To preview the report before printing it, select Print Preview.
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Practice Treatment Case Report Options
From the Practice Treatment Case Report dialog box, set up any of the following options:

•	 Select Patient – To select a patient or 
range of patients with treatment-planned 
procedures within the range to include, 
click the From and To search buttons , 
and select the patient(s). You can also type 
names or partial last names (for example, 
From “a” To “c”) in the fields. To include 
all patients, leave From “<ALL>” To 
“<ALL>” entered.

•	 Procedure Code Date Range – Enter a 
date or date range of treatment-planned 
procedures posted in the range to include. 
To include all dates, select All Dates for 
From and To. Also, select whether you 
want to include procedures by Entry Date 
or Procedure Date.

•	 Case Fee Expiration Date Range – 
Enter a date or date range of cases with 
an expiration date within that range to 
include. To include all dates, select All 
Dates for From and To.

•	 Select Provider – To select a provider 
or range of providers for the patients’ 
treatment-planned procedures to include, 
click the From and To search buttons 
, and select the provider(s). To include 
all providers, leave From “<ALL>” To 
“<ALL>” entered. 

•	 Select Billing Type – To select a billing type or range of billing types of patients with treatment-planned 
procedures to include, click the From and To search buttons , and select the billing type(s).

•	 Report Options – Select the information you want to include.

•	 Include Cases With – Select the case statuses that you want to include, or select All to include all 
statuses. Also, select the case severities that you want to include, or select All to include all severity levels.

•	 Patient Privacy – Select the patient information you want to exclude.

Tips:

•	 To save the current report settings as a set for the next time you run this report, select Save as Default.

•	 To preview the report before printing it, select Print Preview.
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Chapter 7: Ledger
The Dentrix Enterprise Ledger displays a wealth of information in an easy-to-read format. Also, from the 
Ledger, you can enter payments, file claims, print statements, and much more.

This chapter covers the following topics about using the Ledger:

•	 Using the Ledger Window

•	 Selecting Ledger Views

•	 Changing an Account’s Billing Type

•	 Entering Transactions

•	 Editing Current Transactions

•	 Deleting Current Transactions

•	 Invalidating Transactions in History

•	 Processing Dental Insurance Claims

•	 Working with Treatment Plans

•	 Generating Ledger Reports

•	 Using Fast Checkout

•	 Posting Batch Guarantor Payments

•	 Posting Batch Insurance Payments

•	 Searching for Payments

•	 Working with Payment Agreements

•	 Working with Notes in the Ledger

•	 Performing Month-end Routines



172     Chapter 7: Ledger

Dentrix Enterprise 8.0.5 User’s Guide

Using the Ledger Window
The Ledger window consists of the menu bar, toolbar, transaction log, and various sections containing 
financial information.

Transaction log

Aged balancesAccount information

Today’s 
charges

Payment 
agreement 
summary

Future due 
payment 
plan 
summary

This section covers the following topics to help you understand how to use the Ledger window:

•	 Using the Ledger Toolbar

•	 Viewing the Transaction Log

•	 Viewing Aged Balances

•	 Viewing Account Information

•	 Viewing Today’s Charges

•	 Viewing Payment Agreement Information

•	 Viewing Future Due Payment Plan Information
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Using the Ledger Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Ledger are explained in the following table.

Click the Patient Financing button to go to the Citi website to sign up and manage patient 
financing options.

Click the Select Patient button to select a patient whose record you want to view in the Ledger.

Click the Billing/Payment Agreement button to view and add payment agreements and change 
account billing types.
Click the Guarantor Notes button to enter notes for an account and/or that account’s billing 
statements.

Click the Enter Payment button to enter patient payments.

Click the Enter Procedure button to post procedures to a patient’s Ledger.

Click the Ins. Today’s Proc button to create and then display and/or batch (according to the setup 
options selected) an insurance claim for any procedures posted on the current system date.
Click the Ins. Selected Proc. button to create and then display and/or batch (according to the setup 
options selected) an insurance claim for the selected procedures.
Click the Print Walkout button to display and/or batch (according to the setup options selected) a 
family walkout statement.
Click the Print Statement button to display and/or batch (according to the setup options selected) a 
billing statement.
Click the Print Family Ledger button to display and/or batch (according to the setup options 
selected) a family ledger report.

Click the Fast Checkout button to perform a fast checkout (according to the setup options selected).

Click the Patient Alerts button to enter or manage the alerts for the patient currently being viewed 
in the Ledger.
Click the Clinical Notes button to manage clinical notes regarding the treatments for the patient 
currently being viewed in the Ledger.
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Viewing the Transaction Log
The transaction log is a written record of all transactions posted to a patient/family’s account. For each 
transaction, the date, patient or guarantor name, tooth number and surface (when applicable), procedure code 
or type, a description, amount, provider, and clinic are shown and whether or not insurance has been billed is 
indicated.

Each column provides useful information about a financial transaction or procedure:

•	 Date – The date of the transaction or procedure.

•	 Entry Date – The date that the transaction or procedure was entered. This may be different than the 
Date; for example, if you backdated or postdated the transaction or procedure.

•	 Name (Patient Name) – The name of the patient associated with the transaction or procedure. For a 
financial transaction (payment, adjustment, and so forth), if it has been applied to the family, “<Family>” 
appears, or if it has been applied to the guarantor, the guarantor’s name appears.

•	 Surface (Tooth Surface(s)) – The surface associated with the procedure.

•	 Tooth (Tooth Number) – The tooth associated with the procedure.

•	 Check # – The check number associated with the payment.

•	 Code (Procedure/Transaction Code) – The associated procedure code, financial transaction type 
(payment, adjustment, or so forth), or “Ins” for claims.

•	 * (Transaction Flags) – In this column, any of the following symbols may appear:

* – An asterisk indicates that the transaction has been moved to history. History transactions cannot 
be edited or deleted.

+ – A plus sign indicates that the procedure has been invalidated. Invalidated procedures still show on 
the Ledger but no longer display in the Patient Chart.

^ – A carat indicates that the procedure has been back dated to a month that has been closed out. 
When the procedure is moved to history, the carat will change to an asterisk.

•	 Description – The description of the transaction or procedure.

•	 N (Has Note) – A musical note in this column indicates that there is a note attached to the procedure.

•	 R (Has Referral by) – A letter R in this column indicates that a referral is attached to the procedure.

•	 D (Has Diagnosis) – A letter D in this column indicates that the procedure has been cross coded with a 
dental diagnostic code.

•	 M (Has Medical Cross Coding) – A triangle (appearance varies) in this column indicates that a certain 
stage of medical cross coding has been done for the procedure.

•	 S (Payment Contains Suspended amount) – A letter S in this column indicates that the payment has a 
suspended amount.

•	 Amount – The amount of the transaction.

•	 Provider – The provider associated with the transaction.

•	 Clinic – The clinic associated with the transaction.
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•	 Ins (Insurance Claim Created) – Any of the following may appear:

X – An X in the Ins column indicates that the procedure is flagged as “Do Not Bill To Insurance.”

No – A No in the Ins column indicates that the procedure is not attached to a claim.

•	 AP (Approval) – If you are viewing the Ledger-Treatment Plan view, an approval status associated with 
the treatment-planned procedure may appear.

•	 Balance (Running Balance) – The patient’s or family’s running balance (depending on the Ledger view). 
This column only shows amounts if the transaction log is being sorted chronologically (in ascending 
order) by the Date column.

Viewing Aged Balances
The aged balances and the total balances for the current patient and family are displayed. Any suspended 
amounts are also shown.

Viewing Account Information
The account information displayed includes the billing type, amount and date of the last guarantor payment, 
amount and date of last insurance payment, date of the last statement, total amount of all outstanding claims, 
estimated amount insurance will pay, and estimated amount of the patient portion.

Viewing Today’s Charges
For the current system date, the total of all transactions, the estimated amount that dental insurance will pay 
according to the coverage setup in the Family File, and the estimated amount the patient owes according to 
the coverage setup in the Family File are displayed.

Viewing Payment Agreement Information
If a payment agreement exists for the account, the current status of the agreement is shown. For information 
about setting up payment agreements, see “Creating Payment Agreements” in this chapter.
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Viewing Future Due Payment Plan 
Information
If a future due payment plan exists for the account, the current status of the payment plan is shown. For 
information about setting up future due payment plans, see “Creating Future Due Payment Plans” in this 
chapter.

Selecting Ledger Views
While in the Ledger, you can choose to display account information in several different ways.

To switch between the Ledger views

•	 Options – In the Ledger, with a patient selected, from the Options menu, select a view option. The 
option with a check mark is the view currently being used. The Ledger title bar also indicates the current 
view.

•	 Ledger – When first opened, the Ledger displays all transactions posted during the current month for 
the selected patient.

•	 Ledger + History – You can see all transactions for the selected patient, including history 
transactions.

•	 Treatment Plan – You can view and work with a patient’s treatment plan.

•	 View – In the Ledger, with a patient selected, from the View menu, select a view option. The checked 
option is the view currently being used.

•	 Show Transaction Links – When the transaction for which you want to find links is selected, 
you can see all of the procedures that are linked to an insurance claim and all of the payments and 
adjustments that are linked to a procedure.

•	 All With Running Balance – You can view transactions for the entire family. In addition, a column 
is added to the right side of the transaction log that displays a running balance for the account.

•	 Family Members – You can quickly switch to any family member’s ledger by selecting that family 
member.
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Changing an Account’s Billing Type
You can change the billing type associated with an account or family at any time (for instance, when the 
account has been sent to collections). The billing type is used on many of the Dentrix Enterprise reports to 
filter for the data you want to appear on a given report. You can change the billing type from the Family File 
or Ledger.

To change an account’s billing type

1.	 In the Ledger, with a patient selected, from the File menu, click 
Billing/Payment Agreement.

The Billing/Payment Agreement Information dialog box appears.

2.	 Select a Billing Type.

Tip: To add a note about the change 
in the billing type, click Guarantor 
Notes.

3.	 Click OK.

1

2

3

Entering Transactions
This sections covers the following topics about posting transactions in the Ledger:

•	 Posting Procedures

•	 Posting Payments

•	 Applying Suspended Credits

•	 Posting Adjustments

•	 Posting Finance and Late Charges
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Posting Procedures
All charges listed on an account will be posted through the use of a procedure code. Typically, the procedure 
code used will be one of the ADA codes that come pre-loaded with Dentrix Enterprise. However, dental 
offices often perform procedures or assess charges that don’t have a standard procedure code (sometimes 
referred to as “administrative codes”). These charges need to be added and assigned a procedure code. For 
information about procedure codes, see “Editing Procedure Codes” in Chapter 1: Introduction and Initial 
Setup.

To post a procedure

1.	 In the Ledger, with a patient selected, from the Transaction menu, 
click Enter Procedure. (This option is not available if the selected 
patient has been archived or if you are viewing the running balance 
for all family members.)

The Enter Procedure(s) dialog box appears.

2.	 Enter the procedure information:

•	 Date – To change the date 
assigned to a procedure, click 
in the field, delete the existing 
date, and then type the correct 
date.

•	 Clinic – To change the clinic, 
click the search button  to 
select the correct clinic.

•	 Procedure – Type a procedure 
code, or click the search 
button  to select the 
correct code.

•	 Treatment area – Enter the 
treatment area (if applicable): 
for a tooth, type the Tooth 
number; for a surface, click the 
Surface search button  to 
select the correct surface; for a 
quadrant, click the Quadrant 
search button  to select the 
correct quadrant; for an arch, click the Arch search button  to select the correct arch.

•	 Amount – To change the amount charged for the procedure, click in the field, delete the existing 
amount, and the type the correct amount.

•	 Provider – To change the provider attached to the procedure, click the search button  to select the 
correct provider.

•	 Notes – If a default note has been associated with this procedure, the note text appears automatically. 
Make any necessary changes to the note.

•	 Related Referral – To add a related referral to the procedure, click the search button  to select the 
appropriate referral source.

3.	 Click OK/Post. The procedures posted in the Ledger automatically appear in the Patient Chart as well.

1

3

2
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Posting Payments
Dentrix Enterprise uses “line item accounting” to calculate account balances. You can view balances for the 
entire family and for individual patients within the family. When a patient makes a payment, the payment 
can be credited to individual patient charges or to the entire family balance (oldest balance first). Dentrix 
Enterprise also allows for pre-payments and suspended payments that are not immediately allocated to a 
charge.

All payments made by patients are classified as guarantor payments and will be listed under the guarantor’s 
name. Keep in mind that, even though you may have selected a family member other than the guarantor, 
guarantor payments are always displayed in the Ledger view, so you can easily see when the last time a 
payment was made to the account.

To post a payment

1.	 In the Ledger, with a patient selected, from the Transaction menu, 
click Enter Payment.

The Enter Payment dialog box 
appears.

2.	 Set up the following options:

•	 Collecting Clinic – Click 
the search button  to 
select a clinic.

•	 Date – Payments are 
automatically assigned the 
current system date, but 
you can change the date as 
needed.

•	 Type – Select the correct 
payment type. For 
information about how to 
set up payment types, see 
the “Customizing Payment 
Types” topic in the Dentrix 
Enterprise Help.

•	 Amount – Type the dollar 
amount of the payment.

•	 Check # – If the patient is making payment to the office with a check, type the Check # and Bank/
Branch # of the check.

•	 Apply to Pmt Agreement – If the account has a payment agreement set up, the Apply to Pmt 
Agreement option is automatically selected. With this option selected, the payment amount will be 
applied to the outstanding balance on the account’s payment agreement. If this payment is not to be 
applied to the payment agreement balance, clear the option.

•	 Apply to Charges for – Select “<Family>” to list charges for the entire family with the amount owed 
to each provider; or, to list only a specific patient’s charges, select that patient. For information about 
how to set up the Apply to Charges for list default selection, see “Setting Up Program Preferences” 
in Chapter 1: Introduction and Initial Setup.

•	 Note –  Type any unusual circumstances surrounding the payment.

1

3

2
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3.	 When you enter an amount, Dentrix Enterprise will automatically allocate the payment to the oldest 
provider balances, according to the charges listed. The amount applied will be listed in the Applied 
column. You can apply any remaining amount or edit the amount applied. Do one of the following:

•	 To apply a remaining amount, select the correct charges (to select multiple charges, while pressing the 
Ctrl key, click each charge), and then click Apply Remaining. The amount in the Total Remaining 
field will be applied to the selected charges.

If the amount exceeds the guarantor estimate, a dialog box appears. Click Do not apply the 
remaining amount to only apply an amount equal to the guarantor estimate or Apply the 
remaining amount to the balances to apply the remaining amount but not exceed the total charge 
(which can be paid by insurance and will result in overpayment), and then click OK.

•	 To remove the applied amount, click Remove Applied.

•	 To edit the amount applied, double-click the charge, and then type the correct amount to be applied.

•	 To have the credit not be applied to any listed charge, select Do Not Automatically Allocate. When 
you click OK/Post, a message appears and asks if you want to suspend the amount. Click Yes. The 
amount of the payment will be suspended and can be applied at a later time as explained in “Applying 
Suspended Credits” on this page.

4. Click OK/Post.

Applying Suspended Credits
At times, it can be necessary to suspend a payment or credit in cases of pre-payment or overpayment. Once 
charges are posted, the suspended amount can then be applied to those charges.

To apply suspended credits for a patient

1.	 In the Ledger, with a guarantor or patient selected, from the 
Transaction menu, click Apply Suspended Credits.

The Apply Suspended Credits dialog box appears.

2.	 Select the credits to be applied, 
or click Select All to select all 
suspended credits.

Tip: To view or update the 
payment note for a selected 
credit, click Note.

3.	 From the Apply to Charges 
for list, select “<Family>” 
to list charges for the entire 
family with the amount owed 
to each provider; or, to list only 
a specific patient’s charges, select 
that patient. For information 
about how to set up the Apply to 
Charges for list default selection, 
see “Setting Up Program 
Preferences” in Chapter 1: 
Introduction and Initial Setup..

4.	 Click Apply Credit(s).

1

2
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5.	 Click OK/Post.

Tip: To see which charges and credits are linked, select a transaction in the Ledger, and then, from the 
View menu, click Show Transaction Links. All linked transactions will be selected.

Posting Adjustments
Adjustments can be used to change an account’s balance for a variety of reasons. Frequently, an adjustment 
will be used to discount charges or indicate that a patient has been given a refund. Adjustments can also 
be used to correct an account’s balance when a posting error has occurred. Like payments, adjustments can 
be applied to specific charges on the account. For information about setting up adjustment types, see the 
“Customizing Adjustment Types” topic in the Dentrix Enterprise Help.

To post an adjustment

1.	 In the Ledger, with a guarantor or patient selected, from the 
Transaction menu, click Enter Adjustment.

The Select Adjustment Type dialog box appears.

2.	 Select Credit Adjustment (-) if the adjustment reduces the account 
balance or Charge Adjustment (+) if the adjustment increases the 
account balance.

3.	 Click OK. Then, post the adjustment:

For a Credit Adjustment, do the following:

a.	 In the Enter Credit 
Adjustment dialog box, 
set up the following 
options:

•	 Collecting Clinic 
– Click the search 
button  to select a 
clinic.

•	 Date  – Adjustments 
are automatically 
assigned the current 
system date, but you 
can change the date as 
needed.

•	 Type  – Select the 
correct adjustment type.

•	 Amount – Type the 
dollar amount to 
be adjusted off the 
account.

•	 Apply to Charges for – Select “<Family>” to list charges for the entire family with the 
amount owed to each provider; or, to list only a specific patient’s charges, select that patient. For 
information about how to set up the Apply to Charges for list default selection, see “Setting Up 
Program Preferences” in Chapter 1: Introduction and Initial Setup.

•	 Note – Type the reason for the adjustment.

1
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b.	 When you enter an amount, Dentrix Enterprise will automatically allocate the adjustment to the 
oldest provider balances, according to the charges listed. The amount applied will be listed in the 
Applied column. You can apply any remaining amount or edit the amount applied. Do one of the 
following:

•	 To apply a remaining amount, select the correct charges (to select multiple charges, while pressing 
the Ctrl key, click each charge), and click then Apply Remaining. The amount in the Total 
Remaining field will be applied to the selected charges.

If the amount exceeds the guarantor estimate, a dialog box appears. Click Do not apply the 
remaining amount to only apply an amount equal to the guarantor estimate or Apply the 
remaining amount to the balances to apply the remaining amount but not exceed the total 
charge (which can be paid by insurance and will result in overpayment), and then click OK.

•	 To remove the applied amount, click Remove Applied.

•	 To edit the amount applied, double-click the charge, and then type the correct amount to be 
applied.

•	 To have the credit not be applied to any listed charge, select Do Not Automatically Allocate. 
When you click OK/Post, a message appears and asks if you want to suspend the amount. 
Click Yes. The amount of the adjustment will be suspended and can be applied at a later time as 
explained in “Applying Suspended Credits” in this chapter.

c. Click OK/Post.

For a Charge Adjustment, do the following:

a.	 In the Enter Charge Adjustment dialog box, set up the following options:

•	 Clinic  – Click the 
search button  to 
select the appropriate 
clinic.

•	 Date  – Adjustments 
are automatically 
assigned the current 
system date, but you 
can change the date as 
needed.

•	 Type  – Select the correct adjustment type.

•	 Amount – Type the dollar amount to be adjusted onto the account.

•	 Provider – Click the search button  to select the appropriate provider for the adjustment.

•	 Apply to Charges for – Select “<Family>” to list charges for the entire family with the amount 
owed to each provider; or, to list only a specific patient’s charges, select that patient. For 
information about how to set up the Apply to Charges for list default selection, see “Setting Up 
Program Preferences” in Chapter 1: Introduction and Initial Setup.

•	 Note – Type the reason for the adjustment

b.	 Click OK/Post.

b

a
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Posting Finance and Late Charges
Finance and late charges are always applied to the account balance and are listed with the guarantor’s name. 
Current finance and late charges are displayed in the Ledger regardless of which family member is selected.

To post a finance or late charge

1.	 In the Ledger, with a guarantor or patient selected, from the 
Transaction menu, click Enter Finance Charge or Late Charge.

The Enter Finance Charge or Late Charge dialog box appears.

2.	 Set up the following options:

•	 Clinic – Click the search 
button  to select the 
correct clinic.

•	 Date – Adjustments are 
automatically assigned the 
current system date, but 
you can change the date as 
needed.

•	 Amount – Type the dollar amount to be charged to the account

•	 Provider – Click the search button  to select the appropriate provider for the charge if the charge 
is to be attached to a provider other than the guarantor’s primary provider.

•	 Type – Select the correct type of charge: Finance Charge or Late Charge.

•	 Apply to Charges for – Select “<Family>” to list charges for the entire family with the amount owed 
to each provider; or, to list only a specific patient’s charges, select that patient. For information about 
how to set up the Apply to Charges for list default selection, see “Setting Up Program Preferences” 
in Chapter 1: Introduction and Initial Setup.

•	 Note – Type an explanation for a finance or late charge.

3.	 Click OK/Post.

1
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Editing Current Transactions
From time to time, a posting mistake will be made. If a transaction posted in the Ledger or Patient Chart has 
not been moved to history (the previous month has not been closed), you can edit that transaction:

Procedures attached to an insurance claim cannot be edited until the claim has been deleted. For information 
about how to delete a claim, see “Deleting Dental Insurance Claims” in this chapter.

To edit a current transaction

1.	 In the Ledger, with a 
patient selected, 
double-click the 
transaction you want 
to edit.

The Edit Or Delete 
Procedure dialog box appears.

2.	 Make any necessary 
changes to the transaction. 
For an explanation of the 
options available for editing 
transactions, see “Editing 
Treatment” in Chapter 4: 
Patient Chart.

3.	 Click OK.

1
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Deleting Current Transactions
If a transaction posted in the Ledger or Patient Chart has not been moved to history (the previous month has 
not been closed), you can delete that transaction.

To delete a current transaction

1.	 In the Ledger, with a 
patient selected, 
double-click the 
transaction you want 
to delete.

The Edit Or Delete 
Procedure dialog box appears.

2.	 Click Delete in the lower-left 
corner of the dialog box. On 
the confirmation message that 
appears, click OK.

1

2

Invalidating Transactions in History
Dentrix Enterprise locks out changes to a transaction once the transaction has been moved to history (when 
the month is closed). Posting errors in the Ledger should be corrected using an adjustment. Invalidating a 
procedure removes it from the Patient Chart but leaves it in the Ledger.

To invalidate a history transaction

1.	 In the Ledger, with a 
patient selected, 
double-click the 
transaction you want 
to invalidate.

The Validate/Invalidate Procedure in 
History dialog box appears.

2.	 Under Validate/Invalidate Procedure, 
click Invalidate Procedure.

3.	 Click OK.

In the transaction log, a plus sign (+) 
appears in front of the procedure’s 
description to indicate that the procedure 
has been invalidated.

Important: Post a credit adjustment for the 
entire amount of the invalidated procedure, 
and then post the procedure again with 
the same date and amount as those of the 
invalidated procedure. This process must 
be done in case the procedure needs to be 
resubmitted on an insurance claim.

1
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Processing Dental Insurance Claims
Managing insurance claims is a big part of the practice management routine. However, billing dental 
insurance can be a complicated operation because of the inconsistent way different insurance carriers handle 
claims. Fortunately, Dentrix Enterprise has the tools to handle most insurance situations.

This section covers the following topics about processing dental insurance claims:

•	 Understanding Insurance in the Ledger

•	 Creating Primary Dental Insurance Claims

•	 Changing Dental Claim Information

•	 Including Attachments with Dental Insurance Claims

•	 Reprinting Dental Insurance Claims

•	 Deleting Dental Insurance Claims

•	 Posting Dental Insurance Payments

•	 Creating Secondary Dental Insurance Claims

•	 Editing or Deleting Dental Insurance Payments

•	 Indicating Dental Insurance Benefits Used and Deductibles Met

Understanding Insurance in the Ledger
The Ledger module provides substantial insurance information at a glance:

•	 Insurance coverage – You can easily tell if a patient has insurance coverage by looking at the Ledger 
menu bar. The Insurance option is available if a patient has been assigned insurance in the Family File. If 
the Insurance option is unavailable but the selected patient has insurance, on the View menu, make sure 
that “All (with running balance)” does not have a check mark.

•	 Procedure or claim status – From the transaction log, you can quickly see the status of a procedure or 
claim. The Ins column indicates whether or not a procedure has been billed to insurance: if the column 
is empty, the listed procedure has been attached to an insurance claim; if the column displays “No,” an 
insurance claim has not been created for the procedure.

•	 Claim amounts – Once a dental insurance claim has been created, the Outstanding Billed to Insurance, 
Expected from Dental Insurance, and Guarantor Portion of Total Balance amounts will change to 
reflect the amount of the procedures on the claim and the insurance coverage percentages.

The insurance estimates in the Ledger and on billing statements only include procedures that have been 
billed to dental insurance. The entire procedure cost is allocated to the Guarantor Portion of Total 
Balance until a dental claim is created for the procedure.

•	 Pre-treatment estimate status – Pre-treatment estimates can be created from the Ledger-Treatment 
Plan view. In addition to indicating whether a pre-treatment estimate has been created, the Ins column 
indicates the status of an estimate: an “Acc” indicates that the procedure has been pre-authorized; an “Rej” 
indicates that the procedure has been rejected.

•	 Submission status – An insurance claim or pre-treatment estimate will have “Not Sent,” “Sent,” or 
“Received” as part of its description in the transaction log. A claim is considered “Not Sent” until it is 
sent to the Batch Processor or printed. A claim is considered “Sent” once it has been sent to the Batch 
Processor or printed. The claim is considered “Received” when a payment or pre-authorization is entered.
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Creating Primary Dental Insurance Claims
You will create an insurance claim each time an insured patient receives treatment. You can create a claim 
immediately after a patient checks out, or you can create a batch of insurance claims at the end of the day. 
This section explains how to create a claim as the patient checks out.

To create a claim

1.	 In the Ledger, with a patient selected, do one of the following:

•	 Today’s procedures – This option is the simplest way to 
create a claim. Use this method for creating insurance claims 
immediately after procedures have been posted:

a.	 In the Ledger, with a patient selected, from the 
Insurance menu, click Today’s Procedures, Today’s Procedures - Direct Print, or Today’s 
Procedures - Batch, or click the Ins. Today’s Proc. button  on the toolbar. Dentrix Enterprise 
creates a claim that includes all procedures posted on the current date and sends it to the Batch 
Processor or prints it immediately, or the Claim Information window appears.

•	 Specific procedures – Use this method to create a claim for a procedures posted on another date:

a.	 In the Ledger, with a patient selected, select the procedures for which you want to create a claim 
(to select multiple procedures, while pressing the Ctrl key, click the appropriate procedures).

b.	 From the Insurance menu, click Selected Procedures, Selected Procedures - Direct Print, or 
Selected Procedures - Batch, or click the Ins. Selected Proc. button  on the toolbar. Dentrix 
Enterprise creates a claim that includes all selected procedures and sends it to the Batch Processor 
or prints it immediately, or the Claim Information window appears.

For information about how to set the printing default for the Ins. Today’s Proc. button and Ins. Selected 
Proc. button, see “Setting Up Direct Print Options” in Chapter:1 Introduction and Initial Setup.

2.	 If, from the Insurance menu, you select Today’s Procedures or Selected Procedures to create a claim, 
before the claim is sent, the Insurance Claim 
window appears, allowing you to edit the claim 
information. If not, ignore the steps that follow. 
You only need to edit a claim when it requires 
special handling, such as to attach X-rays. Make any 
necessary changes to the claim as explained in 
“Changing Dental Claim Information” in this chapter.

3.	 On the menu bar, click Print.

The Insurance Claim Print dialog box appears.

4.	 If you are not including any attachments, clear the 
Attachment(s) check box.

5.	 Click Send to Batch to send the claim to the Batch Processor, Send 
Electronically to send the claim through electronic filing, or Print to print the 
claim now.

Important: If you click Cancel, the claim will be created, but the status will be “Not Sent.” This is not 
recommended.

1
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Changing Dental Claim Information
When an insurance claim is created, a standard set of information is used to fill out the claim. If you need 
to add non-standard information to a claim, you can edit the claim information from the Insurance Claim 
window. You can access the Insurance Claim window from the Ledger, with a patient selected, using one of 
the following methods:

•	 Double-click an existing claim in the Ledger transaction log.

•	 If you have not yet created a claim for procedures posted today, from the Insurance menu, click Today’s 
Procedures.

•	 If you have not yet created a claim for procedures posted on a day other than the current system date, 
select the procedures, and then, from the Insurance menu, click Selected Procedures.

The Insurance Claim window is made up of the following boxes called “blocks”: Subscriber Information, 
Billing Provider, Rendering Provider, Pay-To Provider, Claim Information, Diagnostic Codes, Procedure 
Information, Payment Information, Claim Status, and Insurance Plan Notes.

Subscriber Information 

Providers 

Claim Information 

Procedure 
Information 

Payment 
and 
Adjustment 
Information

Claim Status Insurance Plan Notes

Diagnostic Codes

To edit the information in any of these blocks, double-click the appropriate block. Each block is explained in 
the sections that follow.
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Editing Patient and Subscriber Information
The Subscriber Information block displays the patient name, subscriber name, employer, insurance carrier 
name, and the group plan name. From this block, you can edit the signature options for the claim, the 
subscriber ID, and the benefits used and deductible met amounts.

To edit subscriber information for the claim

1.	 Double-click the Subscriber Information 
block.

The Patient/Insurance Information dialog 
box appears.

2.	 Edit the following information:

•	 Signature on File – Whatever options 
are selected in the patient’s Family File are the defaults for 
all insurance claims created for the patient. Changes made 
to the Signature on File options in the Patient/Insurance 
Information dialog box affect only the corresponding claim.

•	 Release of Information – Select this option to indicate 
to the insurance carrier that the patient has signed release 
forms authorizing the office to submit information on 
the patient’s behalf. The patient will not have to sign box 
19 on the ADA claim form.

•	 Assignment of Benefits – Select this option to indicate 
to the insurance carrier that the patient has signed 
release forms authorizing the insurance carrier to send 
reimbursement to the office rather than the patient. The 
patient will not have to sign box 20 on the ADA claim 
form.

•	 ID Number (SS#) – The subscriber’s ID number from the Family File (usually the Social Security 
number) appears in this field. If necessary, change the subscriber ID that will appear on this claim.

•	 Deductible and Benefits – The maximum benefits and deductibles for the carrier and the benefits 
used and deductible met amounts from the Family File appear in this dialog box. If necessary, edit the 
deductibles met and benefits applied in the appropriate fields. Dentrix Enterprise will use the updated 
information for calculating all future insurance estimates for the patient or family.

•	 Update Secondary – If the secondary (or tertiary or quaternary) insurance information was entered 
after the primary claim was created, in the lower-left corner of the dialog box, an Update Secondary 
Insurance (or Tertiary or Quaternary Insurance) check box appears. Dentrix Enterprise will not use 
the new secondary (or tertiary or quaternary) insurance information until this check box has been 
selected.

3.	 Click OK.

1
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Changing Providers
The Providers blocks display the billing, rendering, and pay-to providers for the claim. From these blocks, you 
can change any of those providers for the claim. For information about setting up the default providers for 
these blocks, see “Setting Up Practice Defaults” in Chapter 1: Introduction and Initial Setup.

To change a provider for the claim

1.	 Double-click the Billing Provider, Rendering 
Provider, or Pay-To Provider block.

The Select Provider dialog box appears.

2.	 Search for and select the appropriate provider.

3.	 Click OK.
1
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Editing Claim Information
The Claim Information block displays information that is specific to the patient and the insurance claim. The 
standard information will appear on a standard ADA insurance claim form unless it has been edited.

This block displays “Standard” unless the information has been changed; in which case, “Non-Standard” 
appears.

Note: When claim information is entered or cleared from the Insurance Claim window, the changes apply 
only to the claim currently being displayed and to any associated dental claim (primary, secondary, tertiary, or 
quaternary) or medical claim. When a new claim is created, Dentrix Enterprise uses the defaults for a patient 
in the Appointment Book for the new claim. For information about how to set up claim defaults, see the 
“Scheduling - comprehensive” topic in the Dentrix Enterprise Help.

To change claim information for this claim

1.	 Double-click the Claim Information block.

The Insurance Claim Information dialog box appears.

2.	 Edit the following information:

•	 Place of Treatment – To indicate where the treatment 
for this claim was performed, select Office, Hosp, 
ECF, or Other. If you 
select Other, type the 
appropriate code.

•	 Pre-Authorization 
Number – If a treatment 
pre-authorization 
was approved for this 
claim, type the pre-
authorization number.

•	 First Visit Date Current 
Series – If this claim is 
for treatment that is part 
of a multi-visit treatment, 
type the first date of 
service for this series of 
treatments.

•	 Original Reference 
Number (#) – For a 
voided or resubmitted 
Medicaid claim, type 
the original reference 
number.

•	 Student Status – If the patient is enrolled in school (college, university, and so forth), select Part-
Time or Full-Time, and then type the school and city.

•	 Attachments – To add, edit, or remove claim attachments, select or clear the appropriate option. 
For more information about claim attachments, see “Including Attachments with Dental Insurance 
Claims” in this chapter.

•	 Disabled – Select this option if the patient is disabled (work-related or not).

1
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•	 Occupational Illness or Injury – If the treatment for this claim became necessary due to a work-
related injury or illness, select this option, and then type the date and description of the injury or 
illness.

•	 Auto Accident – If the treatment for this claim became necessary due to an automobile accident, 
select this option, and then type the date and description of the accident.

•	 Other Accident – If the treatment for this claim became necessary due to an accident that was not 
automobile-related or work-related, select this option, and then type the date and description of the 
accident (the fields are not available if the check box is not selected).

•	 Prosthesis – To indicate that a prosthetic device is required for the treatment for this claim, 
select Initial or Replacement. If you select Initial, type the relevant Date Ordered. If you select 
Replacement because a new prosthesis is required, type the Replace Reason, Prior Date, and Date 
Ordered. Also, if the date in the Prior Date field for the placement of a prosthesis done previously is 
an estimate, select the Estimated check box.

•	 For Special/Medicaid Claims – If necessary for a special or Medicaid claim, enter the referring 
doctor, a reason for the pre-authorization, an exception code, and other options that apply to the 
claim.

Tip: If a pre-authorization has been received and entered into Dentrix Enterprise, the pre-
authorization number will automatically appear on the insurance claim. If there is more than one pre-
authorization number for the procedures on the claim, create a claim for each set of procedures with a 
different pre-authorization number.

•	 Referring Physician – To specify a referring provider and the ID, such as the UPIN, of that provider, 
click the Referred search button to select a provider. Next, select the ID Number Type, such as 
“UPIN,” and type the ID Number. To specify a second ID for the selected referring provider, select 
the 2nd ID Number Type, and type the 2nd ID Number.

Notes:

•	 By default, the options are populated automatically with the referring doctor’s information 
entered for a procedure on the claim, using the provider’s UPIN from the Provider Information 
dialog box.

•	 For rendering, billing, and pay-to providers on a claim, you can enter a referring provider’s ID for 
a specific insurance plan in the Provider ID Setup dialog box.

•	 Other Subscriber Information – Specify the following information for secondary claims:

•	 Remaining Patient Liability Amount – Type the amount remaining to be paid by the patient.

•	 Total Non-Covered Amount – Type the total amount that is not covered by insurance.

•	 Primary Claim Adjustment Reason(s) – If this is a secondary claim, to enter, edit, or delete 
reasons for adjustments made to the corresponding primary claim, click this button.

•	 HSN – If the payor ID entered for the insurance plan associated with the claim is “MCMA1,” 
click this button to specify whether the patient has full or partial coverage (and starting coverage 
date), the status of the deductible for the claim, the amount the patient has paid for the 
procedures included on the claim, and the total estimated amount due from the patient for the 
procedures on the claim.

3.	 Click OK.

For comprehensive details about all the options available for changing claim information, see the “Changing 
dental claim information” topic in the Dentrix Enterprise Help.
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Editing Procedure Information
The Procedure Information block lists all of the procedures attached to the claim and shows the tooth, surface, 
description, date, procedure code, fee, and amount insurance has paid or pre-authorized for each procedure. 
The Date column shows the date of completion for insurance claims and the date recommended for pre-
treatment estimate claims (the recommended date does not print on a pre-treatment estimate). 

To edit a procedure amount

1.	 To edit the amount the insurance plan 
will pay for a procedure on this claim, 
double-click that procedure.

The Edit Insurance Payment 
Amount For Procedure dialog box 
appears.

2.	 Type the Insurance Amount (from an EOB, the 
amount that the insurance carrier is paying). For 
information about the applied amount, see the “Posting 
dental insurance payments” topic in the Dentrix 
Enterprise Help.

3.	 Update the payment table, if appropriate.

Important: It is important that you only the payment table only when the payment amount applies to 
all patients covered by a given plan. For example, if the estimated insurance portion is different from the 
payment amount because money is being withheld toward a deductible, do not update the payment table. 
Similarly, if a patient has exceeded his or her maximum benefit, do not update the payment table.

4.	 Click OK.
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Editing Payment and Estimate Information
The Payment/Estimate Information block displays the total charges for procedures on the claim; estimated 
insurance portion; total payment or authorized amount; total of the itemized payments or estimates; date, 
amount, and check number of payments or pre-estimates received; and amount applied to the deductible.

To edit or delete a payment or pre-estimate

1.	 Double-click the appropriate 
payment or pre-estimate.

The Edit or Delete Insurance 
Payment dialog box appears.

2.	 Make any necessary changes, 
and then click OK/Post to apply 
the changes. For information 
about the options available for 
insurance payments, see “Posting 
Dental Insurance Payments” in 
this chapter.

Updating Claim Statuses
The Claim Status block displays the dates the claim was created, sent, traced, placed on hold, re-sent and/or 
voided. From this block, you can modify these dates as needed.

To manually change a status and date for the claim

1.	 Double-click the Claim Status block.

The Insurance Claim Status dialog box appears.

2.	 Select a Status: Claim Sent, Tracer Sent, On Hold, Re-Sent, 
or Voided; and then type or change the Date. You can also 
change the Create Date.

3.	 Click OK.
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Editing Dental Insurance Plan Notes
The Insurance Plan Note block displays any notes that have been entered for an insurance plan from the 
Family File of any patient with that insurance plan. From this block, you can add, edit, or delete the notes for 
all patients covered by the same insurance plan.

The insurance plan note does not print on the insurance claim. For information about how to include a note 
on the claim, see “Adding Dental Insurance Claim Notes” in this chapter.

To edit an insurance plan note

1.	 Double-click the Insurance Plan Note block.

The Insurance Plan Note dialog box appears.

2.	 Type or edit the notes for the insurance plan.

3.	 Click OK.

Adding Dental Insurance Claim Notes
You can add a narrative to your claim to document and/or explain treatment.

To add a note that will print on the claim

1.	 On the Insurance Claim window menu bar, click Note.

The Insurance Claim Note dialog box appears.

2.	 Type any notes regarding the claim that you want to have 
appear on the claim.

3.	 Click OK.
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Including Attachments with Dental Insurance 
Claims
You can attach radiographs, images, models, documents, and perio charts to insurance claims.

To include attachments with a claim

1.	 In the Ledger, with a patient selected, 
open the Insurance Claim window 
using one of the following methods:

•	 Double-click an existing claim in 
the Ledger transaction log.

•	 If you have not yet created a claim 
for procedures posted today, from 
the Insurance menu, click Today’s 
Procedures.

•	 If you have not yet created a claim 
for procedures posted on a day 
other than the current system 
date, select the procedures, and then, from the 
Insurance menu, click Selected Procedures.

2.	 Double-click the Claim Information block.

The Insurance Claim Information dialog box appears.

3.	 Select whether you are attaching radiographs, oral 
images, models, and/or other, and then type the 
number of items being attached in the appropriate 
How Many? fields.

4.	 Click Include 
Attachment(s).

The Include 
Attachments dialog box 
appears.

5.	 Under Attach 
From, click a 
button to import 
any document 
from the 
Document Center, 
any saved periodontal 
examination, any digital 
images stored in Image, 
or any file with an .RTF 
or .TXT extension.

6.	 For a printed (not 
electronic) claim, if you 
will be including an 
attachment of another type, click Non-Electronic. In the Attachment Information dialog box, type an 
Attachment Note, select an Attachment Type and Transmission Code, type a Control Number, and 
then click OK to save the information and return to the Include Attachments dialog box.
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7.	 If you want to view or add attachment information for a selected attachment, click Attachment 
Information. In the Attachment Information dialog box, type an Attachment Note, select an 
Attachment Type and Transmission Code, type a Control Number, and then click OK to save the 
information and return to the Include Attachments dialog box.

8.	 Click Close to return to the Insurance Claim Information dialog box.

9.	 Click OK.

Reprinting Dental Insurance Claims
If you have edited an insurance claim, you can reprint it.

To reprint a claim

1.	 In the Ledger, with a patient selected, 
double-click an existing claim in the 
transaction log.

The Insurance Claim window appears.

2.	 On the menu bar, click Print. The 
Insurance Claim Print dialog box 
appears.

3.	 If you are not including any attachments, clear the 
Attachment(s) check box.

4.	 Click Send to Batch to send the claim to the Batch 
Processor, Send Electronically to send the claim through 
electronic filing, or Print to print the claim now.
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Deleting Dental Insurance Claims
You can delete a claim after it has been created. If a secondary claim has been created, you must delete the 
secondary claim before you can delete the corresponding primary claim. If a claim has been paid and is in 
history, you cannot delete it.

For information about how to delete a payment for a claim without deleting the claim, see “Editing or 
Deleting Dental Insurance Payments” in this chapter.

To delete an insurance claim

1.	 In the Ledger, with a patient selected, 
double-click an existing claim in the 
transaction log.

The Insurance Claim window appears.

2.	 From the File menu, click Delete. 
On the confirmation message that 
appears and cautions you that deleting 
the claim will also delete any attached 
payments and adjustments, click OK.

Posting Dental Insurance Payments
When posting an insurance payment, Dentrix Enterprise will automatically itemize the payment for each 
procedure according to the insurance estimate. You can edit or remove the applied amount, as well as add 
the amount to the insurance payment table. Insurance payments will be calculated when a deductible is to be 
applied. You can also write off an amount (make an adjustment) while posting an insurance payment.

Tip: For new offices, if the claim for which you are posting payments was not created using Dentrix 
Enterprise, post the insurance payment as a guarantor payment. For information about how to add a 
payment type, such as “Insurance Payment,” to distinguish these payments from patient payments, see the 
“Customizing Payment Types” topic in the Dentrix Enterprise Help.

To post an insurance payment

1.	 In the Ledger, with a patient selected, 
double-click an existing claim in the 
transaction log.

The Insurance Claim window appears.

2.	 On the menu bar, click Enter Payment.

The Enter Insurance Payment dialog box appears.

3.	 Set up the following options:

•	 Collecting Clinic – Click 
the search button  to 
select the clinic that is 
collecting the payment. The 
Claim Clinic (the clinic 
where the claim was created) 
appears for your reference.
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•	 Date – Dentrix Enterprise automatically assigns the current system date to the payment, but you can 
change the date as needed.

•	 Amount – Dentrix Enterprise automatically inserts the estimated insurance portion in this field, but 
you can change the dollar amount of the payment as needed.

•	 Check # – If the patient is making payment to the office with a check, type the Check # and Bank/
Branch # of the check. 

•	 Adjust YTD Benefits/Deductible – Leave this check box selected if you want Dentrix Enterprise to 
adjust the patient’s year-to-date benefits and any applied deductible accordingly.

•	 Deductible Applied For Claim – If money has been withheld toward a deductible, type the withheld 
amount in the appropriate field(s): Standard, Preventative, and/or Other.

4.	 In cases where your practice does not bill the patient, such as with some preferred provider (PPO) 
plans, to quickly create an adjustment to offset any remaining balance, under Enter Adjustment, select 
Write-Off, and then select whether you are adjusting off a dollar amount or a percentage of the claim’s 
remaining balance. Next, do one of the following:

•	 If you selected $, the unpaid balance for the claim appears in the Total Amount field, but you can 
change the adjustment amount as needed.

•	 If you selected %, the unpaid balance for the claim appears in the of field. Type the percentage to be 
adjusted in the % field, and Dentrix Enterprise will calculate the adjustment amount and populate 
the = field.

5.	 When you enter an amount, Dentrix Enterprise will automatically allocate the payment to the oldest 
provider balances, according to the charges listed. The amount applied will be listed in the Applied 
column. You can apply any remaining amount or edit the amount applied. Do one of the following:

•	 To apply a remaining amount, select the correct charges (to select multiple charges, while pressing the 
Ctrl key, click each charge), and then click Apply Remaining. The amount in the Total Remaining 
field will be applied to the selected charges.

If the amount exceeds the insurance estimate, a dialog box appears. Do one of the following:

•	 Select Do not apply the remaining amount to apply only an amount equal to the insurance 
estimate, and then click OK.

•	 Select Apply the remaining amount to and Exceed insurance estimates to apply the remaining 
amount but not exceed the total charge (which will result in an overpayment), and then click 
OK.

•	 If at least one of the selected procedures has a non-insurance credit amount (Guar Cr column) 
that can be suspended or re-allocated and one or more non-insurance credits have not been 
placed in history, select Apply the remaining amount to and Change guarantor credit 
allocations to suspend the non-insurance credit amount but apply the insurance payment, and 
then click OK.

Tip: You can use the Change guarantor credit allocations option in cases where you have 
a primary claim with a pending secondary claim and paying the balance might result in a 
remaining balance that is less than what will be paid by the secondary insurance carrier. However, 
it is more practical to deal with that possibility when the secondary claim is paid rather than with 
the payment for the primary claim.

•	 To remove the applied amount, click Remove Applied.

•	 To edit the amount applied, double-click the procedure, and then type the correct amount to be 
applied.
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•	 To save the paid amount as a reference for future estimates, double-click the procedure (or right-click 
the procedure, and click Edit Ins Payment Amount). In the Edit Insurance Payment Amount for 
Procedure dialog box, type the insurance amount from the insurance EOB, and then, if appropriate, 
you can update the payment table. If the applied amount exceeds the amount of the procedure, a 
message appears and asks if you want to automatically adjust the applied amount to the amount of 
the procedure or return to edit the applied amount.

The next time any patient with this insurance plan has the same procedure recommended or 
completed, Dentrix Enterprise will use the payment amount as the insurance estimate.

Important: It is important that you update the payment table only when the payment amount 
applies to all patients covered by that plan. For example, if the estimated insurance portion is different 
from the payment amount because money is being withheld toward a deductible, do not update the 
payment table. Similarly, if a patient has exceeded his or her maximum benefit, do not update the 
payment table.

6.	 Click OK/Post.

If Write-Off was selected, the Enter Credit Adjustment for Insurance Claim dialog box appears. Make 
any necessary changes to the adjustment type, provider, and amount, and then click OK to post the 
insurance payment and corresponding adjustment.

If the patient has secondary insurance or medical coverage, a message appears and reminds you to create 
a secondary or medical claim. Click OK, and then click Create Secondary or Create Medical on the 
Insurance Claim window’s menu bar.

At times, an insurance carrier will send partial payment for an insurance claim while waiting for more 
information on certain procedures. In this situation, Dentrix Enterprise provides the following methods for 
posting two separate payments to the claim:

•	 Splitting an existing dental claim into two separate claims

•	 Posting multiple payments to one dental claim

For information about how to perform these tasks, see the “Posting partial dental insurance payments” topic 
in the Dentrix Enterprise Help.
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Creating Secondary Dental Insurance Claims
With Dentrix Enterprise, you can create secondary, tertiary, and quaternary insurance claims. This section 
explains how to create a secondary claim.

To create a secondary claim

1.	 In the Ledger, with a patient selected, 
double-click the primary insurance 
claim for which you want to enter a 
payment. The Insurance Claim 
window appears.

2.	 If secondary insurance information 
has been changed in the patient’s Family 
File since the primary claim was created, 
to update Dentrix Enterprise to use the 
new insurance information for creating 
the secondary claim, double-click the 
Subscriber Information block, select 
Update Secondary, and then click OK.

3.	 From the Claim menu, click Create Secondary. Dentrix Enterprise creates the additional claim, and the 
Insurance Claim window displays that secondary claim.

Tip: To switch back to the primary insurance claim, from the Claims menu, click View Primary Dental.

4.	 While viewing the secondary claim, on the menu bar, click Print. In the dialog box that appears, click 
Print to print the claim immediately or Send to Batch to send the claim to the Batch Processor in the 
Office Manager.
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Editing or Deleting Dental Insurance 
Payments
You can correct a mistake that was made when posting an insurance payment. However, you cannot change or 
delete an insurance payment in history.

To edit or delete an insurance payment

1.	 In the Ledger, with a patient selected, double-click an insurance payment in the transaction log. The Edit 
or Delete Insurance Payment dialog box appears.

2.	 Edit the payment amount 
or applied amounts 
as necessary, and then 
click OK/Post. Or, to 
delete the payment, click 
Delete, click OK on the 
confirmation message 
that appears, and then, 
when the Insurance Claim 
window appears, re-post 
the payment correctly.
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Indicating Dental Insurance Benefits Used 
and Deductibles Met
Typically, you will indicate deductibles met when posting an insurance payment, and Dentrix Enterprise 
will automatically track benefits used and deductibles met for patients. However, on occasion, you can have 
patients who come to your practice mid-year. These patients might have met part or all of their deductible for 
the year or used part or all of the maximum benefits.

To enter benefits used and deductibles met

1.	 In the Ledger, with a patient selected, 
double-click a pending/sent claim in 
the transaction log.

The Insurance Claim window appears.

Tip: If an insurance claim for this 
patient has not yet been created, you 
can post “dummy” procedures and create a 
“fake” claim and then delete them once the 
deductible information has been entered.

2.	 Double-click the Subscriber Information 
block. The Patient/Insurance Information dialog box 
appears.

3.	 The maximum benefits and deductibles for the carrier 
and the benefits used and deductible met amounts from 
the Family File appear in this dialog box. If necessary, 
edit the deductibles met and benefits applied in the 
appropriate fields. Dentrix Enterprise will use the updated 
information for calculating all future insurance estimates 
for the patient or family.

4.	 Click OK.
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Working with Treatment Plans
Treatment Plans play an important part in generating and sustaining revenue for most dental offices. This 
section covers the following topics about the Ledger features that can help you manage patient treatment 
plans:

•	 Posting Treatment-planned Procedures

•	 Creating Dental Pre-treatment Estimates

•	 Entering Pre-treatment Estimate Authorizations

•	 Completing Treatment-Planned Procedures

Posting Treatment-planned Procedures
Posting procedures to a patient’s treatment plan is accomplished in almost the same manner as posting 
procedures to the patient’s Ledger. The biggest (and most important) difference is that you enter treatment-
planned procedures from the Treatment Plan view rather than the Ledger view.

To add a procedure to a patient’s treatment plan

1.	 In the Ledger, with a patient selected, from the Options menu, 
click Treatment Plan to switch to the Treatment Plan view.

2.	 From the Transaction menu, click Enter Procedure.

The Enter Procedure(s) dialog box appears.

3.	 Enter the procedure information as explained in “Posting 
Procedures” in this chapter with the following exception: under 
Chart Status, leave 
Treatment Plan selected, 
and then select an Approval 
Status. For information 
about how to set up approval 
statuses, see the “Customizing 
Approval Status” topic in the 
Dentrix Enterprise Help.

Note: When a procedure is 
completed, the last approval 
status selected before the 
procedure was set complete 
appears next to the procedure 
in the AP column of the 
Ledger, Ledger-Treatment 
Plan, and Patient Chart.

4.	 OK/Post.
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Creating Dental Pre-treatment Estimates
You can create a pre-treatment estimate when a pre-authorization for treatment is required or when an insured 
patient requests a pre-determination of benefits for recommended treatment. The process is similar to creating 
dental insurance claims except you do it from the Treatment Plan view rather than the Ledger view.

To create a pre-treatment estimate

1.	 In the Ledger, with a patient selected, from the Options menu, 
click Treatment Plan to switch to the Treatment Plan view.

2.	 Do one of the following:

•	 Today’s procedures – This option is the simplest way 
to create a pre-estimate. Use this method for creating 
insurance pre-estimates immediately after treatment-
planned procedures have been posted:

a.	 From the Insurance menu, click Today’s 
Procedures, Today’s Procedures - Direct Print, or Today’s Procedures - Batch; or click the Ins. 
Today’s Proc. button  on the toolbar. A pre-estimate that includes all procedures posted on 
the current system date is created and sent to the Batch Processor or printed immediately, or the 
Pretreatment Estimate window appears.

•	 Specific procedures – Use this method to create a pre-estimate for treatment-planned procedures 
posted on another date:

a.	 Select the procedures for which you want to create a claim (to select multiple procedures, while 
pressing the Ctrl key, click the appropriate procedures).

b.	 From the Insurance menu, click Selected Procedures, Selected Procedures - Direct Print, or 
Selected Procedures - Batch, or click the Ins. Selected Proc. button  on the toolbar. A pre-
estimate that includes all selected procedures is created and sent to the Batch Processor or printed 
immediately, or the Pretreatment Estimate window appears.

3.	 If, from the Insurance menu, you select Today’s Procedures or Selected Procedures to create a pre-
estimate, before the pre-estimate is sent, the Pretreatment Estimate window appears. Make any necessary 
changes to the patient or 
subscriber information, 
providers, claim 
information, claim statuses, 
and/or insurance plan notes as 
explained in “Changing Dental 
Claim Information” in this 
chapter. You can also add 
attachments to the pre-
treatment estimate.

4.	 On the menu bar, click Print.

The Pre-Estimate Print dialog 
box appears.

5.	 If you are not including 
any attachments, clear the 
Attachment(s) check box.
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6.	 Click Send to Batch to send the pre-estimate to the Batch Processor, Send Electronically to send the 
pre-estimate through electronic filing, or Print to print the pre-estimate now.

Important: If you click Cancel, the pre-estimate will be created, but the status will be “Not Sent.” This is 
not recommended.

Entering Pre-treatment Estimate 
Authorizations
When a pre-estimate has been received back from an insurance carrier, you can enter the authorization in 
Dentrix Enterprise.

To enter a pre-treatment estimate authorization

1.	 In the Ledger, with a patient selected, from the Options menu, 
click Treatment Plan to switch to the 
Treatment Plan view.

2.	 Double-click the authorized pre-
estimate on the transaction log.

The Pretreatment Estimate window 
appears.

3.	 From the Enter Estimate menu, select 
one of the following options:

•	 Total Estimate Only – To open the Total Insurance Pre-
Estimate dialog box. Skip to step 5.

•	 Itemize by Procedure – To open the Pre-Treatment 
Estimate Update dialog box.

4.	 Do one of the following:

•	 Dentrix Enterprise automatically inserts the estimated 
insurance portion in the Estimate Amount field. If the amount is correct, click OK.

•	 If the procedure was rejected, under Procedure Status, select Rejected, and then click OK.

•	 If the estimate amount is different from what appears, type the correct amount in the Estimate 
Amount field. To save the estimate amount as a reference for future estimates, under Update 
Payment Table, click Yes, and then, click OK so that the next time a patient with this plan has the 
same procedure recommended or completed, Dentrix Enterprise will use the new estimate amount.

Important: It is important that you update the payment table only when the payment amount 
applies to all patients covered by that plan. For example, if the estimated insurance portion is 
different from the payment amount because money is being withheld toward a deductible, do not 
update the payment table. Similarly, if a patient has exceeded their maximum benefit, do not update 
the payment table.

Repeat this step for all the other procedures attached to the estimate. Once all procedures have been 
entered, the Total Insurance Estimate dialog box appears.
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5.	 Type the Pre-Auth Number.

6.	 If you did not itemize payments, type the authorized amount in 
the Total Estimate field.

7.	 Click OK/Post.

Completing Treatment-Planned Procedures
When a recommended treatment has been finished, you can set the procedure complete in the Ledger-
Treatment Plan. Setting a procedure complete removes it from the Ledger-Treatment Plan and posts it in the 
Ledger with the appropriate charge and insurance coverage information, including any pre-authorizations 
received.

To set a treatment-planned procedure complete

1.	 In the Ledger, with a patient selected, from the Options menu, click Treatment Plan to switch to the 
Treatment Plan view.

2.	 Select the procedures you want to complete. To select multiple procedures, while pressing the Ctrl key, 
click each procedure.

3.	 From the Transaction menu, click Set Procedures Complete.

Generating Ledger Reports
You can print the following reports from the Ledger:

•	 Walkout Statement

•	 Single Billing Statement

•	 Family Ledger Report

•	 Patient Ledger Report
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Walkout Statement
A walkout statement is generally given to a patient as a receipt of charges posted and payments made on the 
day of treatment. Dentrix Enterprise provides you with several options when printing a walkout statement.

To print a walkout statement

1.	 In the Ledger, with a patient selected, do one of the following:

•	 If you have set up your walkout statement defaults, click the Print Walkout button  on the toolbar. 
Ignore the steps that follow.

•	 To override the walkout default options to print a 
different type of walkout for the patient. From the 
Print menu, click Walkout. The Print Report dialog 
box appears.

2.	 Set up the following options:

•	 Select Report Types – Select the report types 
that you want to print:

•	 Family Walkout – The family walkout 
statement shows all completed procedures, 
guarantor payments, and adjustments 
posted to the account on the date of 
the walkout. The walkout then totals all 
charges and credits for the day to indicate a 
total balance, estimated insurance portion 
(for procedures that are attached to claims 
or not; for procedures that are not, the estimated insurance portion is based on the corresponding 
patient’s primary insurance), and a “Please Pay” amount. In addition, as a reminder, Dentrix 
Enterprise prints the next future appointment at the bottom of the statement.

•	 Walkout/Doctor’s Statement – If your office does not handle insurance for patients, use the 
doctor’s statement for the patient to use in place of an insurance claim. The doctor’s statement 
shows all procedures for the selected patient but does not include payments. A signature line 
appears at the bottom of the statement for the doctor’s signature. To include adjustments on the 
statement, select Print Adjustments.

•	 Appointment Card – This is a 4" x 6" reminder card that lists the next appointment for the 
patient.

•	 Print Doctor Recommendations – With this check box selected, if you have added recommendation 
notes to your procedure codes, these notes appear on the family walkout statement. For information 
about adding recommendation notes, see “Editing Procedure Codes” in Chapter 1: Introduction and 
Initial Setup.

•	 Print YTD Finance Charges, Late Charges, and Payments – Select this option if you want to add 
a row to the family walkout statement that shows the year-to-date account totals for finance charges, 
late charges, insurance payments, and guarantor payments.

•	 Print Adjustments – For a walkout/doctor’s statement, if you want adjustments in addition to 
procedures to appear on the statement, select Print Adjustments.

•	 Message – If you have a standard message that you want to print on all walkout statements by 
default, type the note.

3.	 If you are not doing a one-time override of the default options, select Save as Default to store your 
settings as the default options for the next time you print walkout statements.

4.	 Click Send to Batch or Print.
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Single Billing Statement
You can generate a single billing statement for a selected account from the Ledger. Also, you can generate 
billing statements for a range of accounts from the Office Manager.

To print a single billing statement

1.	 In the Ledger, with a patient selected, from the Print menu, 
click Statement.

2.	 Click Send to batch or Print.

Dentrix Enterprise generates the billing statement according 
to the options you have selected from the billing statement options set up 
in the Office Manager. The Balance Forward date on the statement is one 
month prior to the current date unless you change that default setting for 
the billing statement from the Office Manager. For details about the billing 
statement options, see “Generating Billing Statements” in Chapter 8: Office 
Manager.

Family Ledger Report
The Family Ledger Report shows an account history that includes all procedures, payments, adjustments, and 
service charges posted to the Ledger. You can also generate this report for a range of accounts from the Office 
Manager.

To print the Family Ledger Report for the family being viewed in the Ledger

1.	 In the Ledger, with a patient selected, do one of the following:

•	 If you only want current transactions (transactions posted since the month was closed out) on the 
report, click the Print Family Ledger button  on the toolbar. Ignore the steps that follow.

•	 If you want to include more transactions than the 
current transactions on the report, from the Print 
menu, click Family Ledger. The Family Ledger Report 
dialog box appears.

2.	 In the First Transaction Date field, type the date from 
which you want to print all transactions that have been 
posted.

3.	 Click Send to batch or Print.
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Patient Ledger Report
The Patient Ledger Report is very similar to the Family Ledger Report; however, instead of printing 
transactions for all family members, it shows transactions for the selected patient only. You can also generate 
this report for a range of patients from the Office Manager.

To print the Patient Ledger Report for one patient

1.	 In the Ledger, with a patient selected, from the Print 
menu, click Patient Ledger.

2.	 Type a First Transaction Date. All transactions posted 
after the entered date will be included on the report.

3.	 Click Print to print the report now or Send to batch to send the report 
to the Batch Processor to be printed at a later time.

Using Fast Checkout
The Fast Checkout button combines the three tasks that are typically completed as a patient checks out 
after a visit. All at one time, you can collect a payment, generate an insurance claim, and print a receipt. For 
information about how to customize the Fast Checkout button to meet the needs of your office, see “Setting 
Up Checkout Options” in Chapter 1: Introduction and Initial Setup.

To use Fast Checkout

In the Ledger, with a patient selected, if you have not already done so, post the completed procedures for the 
day for the patient. Then, on the toolbar, click the Fast Checkout button .

Depending on the setup of the Fast Checkout button, any of the following may occur:

•	 The Checkout Options dialog box appears. Select the desired options, and then click OK.

•	 The Enter Payment dialog box appears. Enter the payment information, and then click OK.

•	 Dentrix Enterprise creates an insurance claim.

•	 Dentrix Enterprise prints or batches a walkout statement.
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Posting Batch Guarantor Payments
With Dentrix Enterprise, you can quickly enter a stack of checks and payments from patients and/or 
guarantors, saving you valuable time.

To post a batch of guarantor payments

1.	 In the Ledger, from the File menu, click Enter Batch Payments. The 
Batch Payment Entry dialog box appears.

2.	 Click the Patient Name search 
button  to search for and 
select a patient.

3.	 In the Enter Payment dialog 
box that appears, enter the 
payment information. For details 
about the options available for 
entering a payment, see “Posting 
Payments” in this chapter.

4.	 Click OK/Post to post the 
payment to the Ledger and return to 
the Batch Payment Entry dialog box, 
where the payment now appears.

Repeat steps 2 – 4 for all other 
guarantor payments you want to 
enter. When you are finished making 
payment entries, compare the number 
of entries made to the number of 
payments in hand.

5.	 Click Close.
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Posting Batch Insurance Payments
When an insurance carrier sends your office one check or electronic funds transfer (EFT) to cover multiple 
claims for multiple patients, with Dentrix Enterprise, you can post the large insurance check to multiple 
patients without having to switch back and forth between different accounts and insurance claims.

Similarly, when an insurance carrier sends your office an electronic EOB (eEOB) to cover multiple claims for 
multiple patients, you can import the eEOB and post payments. This feature must be purchased separately.

To post a batch of insurance payments manually

1.	 In the Ledger, from the File menu, click Enter Batch Ins. Payment.

The Batch Insurance Payment Entry dialog box appears.

2.	 Set up the following options:

•	 Pmt Type – Select Check if a check was mailed to the office or Electronic if payment was received 
through an EFT.

•	 Collect. Clinic – Click the search button  to select the clinic that is collecting the payment.

•	 Ins Type – Select the appropriate type of insurance: Dental or Medical.

•	 Amount – Type the amount of the check or EFT.

•	 Check # – Type the check number.

•	 Bank/Branch # – Type the bank or branch number.

3.	 Under Pending Claims, click the Patient Name or Insurance Carrier Name search button , select 
the correct patients or carriers, and then click OK. 

A list of all outstanding insurance claims for that carrier or patient appears.
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4.	 For each claim listed under Pending Claims, select the claim, and then do any of the following:

•	 Under Enter Payment, for each of the procedures listed, type the amount to be Applied to the 
procedure, type the amount of the deductible (Deduct) to be applied to the procedure, and if 
applicable, select Update if you want to update the payment table for the procedure (only if a 
deductible is not being applied and if the maximum benefit has not been exceeded).

•	 To enter an adjustment, under Enter Adjustment, from the Adj list, select Write-Off or Refund; 
select the Type of adjustment to use; and then, in the Adj Amount field, type the amount of the 
adjustment.

•	 To modify the deductibles being applied for the claim, under Deductible Applied for Claim, change 
the values for Standard, Preventative, and/or Other as needed.

5.	 Click Post Claim.

Then, repeat steps 3 – 5 until all of the insurance payments from a single check or EFT have been 
entered. When you are finished attaching claims to one payment, the Paid Amt Posted under Posted 
Claims should equal the check or EFT Amount under Insurance Payment.

If you attempt to close the Batch Insurance Payment Entry dialog box while these two amounts differ, 
a message appears. If you want to return and correct the difference, click Cancel; if you want to save 
the batch session entry and return later to complete it, click Yes; or if you want to end the batch session 
without saving, click No.

Tips:

•	 To resume a saved batch entry, in the Ledger, from the File menu, click Batch Ins. Payments 
(Pending) to reopen the session.

•	 Closing the Ledger window before returning to a saved batch session or not saving a batch session will 
end the session. However, all payments posted prior to closing the Batch Insurance Payment Entry 
dialog box remain posted to the individual accounts.

6.	 To post the payments from another check or EFT,  click Next Check.

For comprehensive information about batch insurance payments, see the “Posting a batch of insurance 
payments manually” topic in the Dentrix Enterprise Help.

For information about how to post batch insurance payments from eEOBs, see the “Posting a batch of 
insurance payments from eEOBs” topic in the Dentrix Enterprise Help.
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Searching for Payments
In Dentrix Enterprise, you can search for payments by check or bank number, amount, payment date, 
payment type, clinic, patient, or insurance name. Also, you can print a report that lists the payments found by 
the search. Use this feature when you want to search for (and print a list of ) insurance payments entered in a 
batch.

To search for payments

1.	 In the Ledger, from the File menu, click Search Payments.

The Search Payments dialog box appears.

2.	 Set up the following search options:

•	 Select Date – Select your 
date range criteria.

•	 By Date Type – Select 
whether you want to search 
by the date a payment was 
entered or by the date of a 
payment.

•	 Select Insurance Carrier – 
Select your insurance carrier 
criteria.

•	 Check Information – Type 
the Check # and Bank/
Branch #.

•	 Amount – Type the amount 
range by which you want to 
search in the From and To fields, or leave From <ALL> To <ALL> entered to search for any amount.

•	 Select Patient – Click the search button  to select the patient whose payments you want to search 
for, or leave <ALL> selected to include all patients in the search.

•	 Clinic Selection – Select whether you want to search by Collecting Clinic or Rendering Clinic. 
Then, click the search button  to select the desired clinics, or select All to search in all clinics.

•	 Select Payment Types – Select the types of payments you want to search for , or select All to include 
all payment types.

•	 Include History Payments – Select this check box to include payments that are in history.

3.	 Click Search to begin your search.

The search results appear in the list box in the bottom portion of the dialog box.

4.	 To print a copy of the search results, click Print. On the message that appears, click Yes.

5.	 To view a payment in the corresponding patient’s Ledger, select that payment, and then click OK.

For comprehensive instructions on searching for payments, see the “Searching for payments” topic in the 
Dentrix Enterprise Help.
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Working with Payment Agreements
Use payment agreements when treatment has been completed and the balance will be paid over time. You set 
up payment agreements by account not by patient. Dentrix Enterprise allows one payment agreement per 
account. You can set up payment agreements from not only the Ledger but the Billing/Payment Agreement 
Information block in the Family File.

This section covers the following topics about payment agreements:

•	 Creating Payment Agreements

•	 Posting Payments to Payment Agreements

•	 Printing Payment Agreement Documents

Creating Payment Agreements
You can create a payment agreement with clients from the Ledger.

To create a payment agreement

1.	 In the Ledger, with a patient (or any one of that patient’s family 
members) selected, from the File menu, click Billing/Payment 
Agreement. The Billing/Payment Agreement Information dialog box 
appears.

2.	 Under Payment Agreement 
(PA), the current system Date 
appears by default, but you 
can change it as needed.

3.	 Set up the payment 
agreement terms:

a.	 Click Terms. The 
Payment Agreement 
Terms dialog box 
appears.

b.	 Do one of the 
following:

•	 To select a payment 
agreement template, 
click Select Type. For 
details about setting up 
payment agreement types, see the “Adding and editing payment 
agreement types” in the Dentrix Enterprise Help. The terms 
for the selected type populate the fields. As needed, modify the 
terms to fit the needs of the account.

•	 Enter specific payment agreement terms.

c.	 Click OK.

Note: You cannot change the terms once the agreement has been saved.

4.	 Select the appropriate payment Interval.
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5.	 By default Dentrix Enterprise inserts the guarantor portion of the account’s balance in the Balance for PA 
field. If necessary, type the amount of the balance that the account will pay off with the agreement.

6.	 Set up the following options:

•	 First Pmt Due – Type the date the first payment will be due.

•	 Payment Amt – Type the amount the account will pay at each interval to have Dentrix Enterprise 
calculate the Total # of Payments, or type the Total # of Payments to have Dentrix Enterprise 
calculate the Payment Amt.

7.	 Under Payment Agreement Note, type any notes pertaining to the payment agreement.

8.	 Click OK.

Posting Payments to Payment Agreements
You can credit a payment toward a payment agreement balance.

To post a payment agreement payment

1.	 In the Ledger, with a patient selected, from the Transaction menu, 
click Enter Payment. The Enter Payment dialog box appears.

2.	 Enter the payment information. 
For details on posting payments, 
see “Posting Payments” in this 
chapter.

3.	 Verify that the Apply to 
Pmt Agreement check box is 
selected.

4.	 Click OK/Post.
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Printing Payment Agreement Documents
You can print payment agreement documents to give to a patient or guarantor.

To print payment agreement documents

1.	 In the Ledger, with a patient selected, from the File menu, click Billing/
Payment Agreement. The Billing/Payment Agreement Information 
dialog box appears.

2.	 Click Print. The Print for Payment 
Agreement dialog box appears.

3.	 Select the documents you want to give 
to the patient/guarantor:

•	 Truth in Lending Disclosure 
Statement – Discloses the terms 
of the agreement. It includes 
the annual percentage rate, the 
finance charge amount, the total 
amount financed, and the total 
amount paid at the end of the 
agreement.

•	 Amortization of Payments and 
Finance Charges – Prints a schedule listing the interest 
accrued on the balance amount for each payment interval.

•	 Coupon Book for Scheduled Payments – Prints payment 
remittance coupons for the patient.

4.	 Click Print or Send to batch.

Working with Future Due Payment 
Plans
Use future due payment plans when treatment will be completed over time and you want to charge an 
account monthly while the work is in progress, such as for orthodontics.

This section covers the following topics about future due payment agreements:

•	 Creating Future Due Payment Plans

•	 Posting Manual Charges to Future Due Payment Plans
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Creating Future Due Payment Plans
You can set up future due payment plans for individual patients.

To create a future due payment plan

1.	 In the Ledger, with a patient selected, from the Transaction 
menu, click Process Future Due Payment Plan.

The Select Payment Plan dialog box appears and lists any 
previously created plans.

2.	 Click New Plan.

The Create Payment Plan dialog box appears.

3.	 Set up the plan options:

•	 Provider and Clinic – Dentrix Enterprise automatically 
displays the patient’s primary Provider and the current 
Clinic. To change the provider and/or clinic, click the search 
buttons , and then select the appropriate provider and/or 
clinic.

•	 Note – Type details or 
clarification for the payment 
plan in the Note field.

•	 Initial Agreement 
Information

•	 Date of Agreement 
– Dentrix Enterprise 
automatically inserts 
the current date as the 
date of the agreement. If 
necessary, you can change 
the date.

•	 Total Plan Amount – 
Type the total amount to 
be charged over time.

•	 Down Pay Charge – If 
a down payment will be 
charged, type the amount.

•	 Down Pay Proc Code – Type the procedure code for the down payment charge, or click the 
search button  to select the code.

•	 Insurance Estimates – Patient and insurance portions for the total amount and the down payment 
are displayed.

•	 Monthly Charge Information

•	 Charge Proc Code – Type the procedure code, or click the search button  to select the 
procedure code you want to use to post the monthly charge. If there is not an ADA code for 
the type of charge you need to post, you can create one. For details about procedure codes, see 
“Editing Procedure Codes” in Chapter 1: Introduction and Initial Setup.

•	 # of Charges – Type the # of Charges to have Dentrix Enterprise calculate the Charge Amount, 
or type the Charge Amount to have Dentrix Enterprise calculate the # of Charges.
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•	 Auto Charge – To have a charge posted to the account automatically when updating future due 
payment plans each month, select this option. If this option is cleared, no charges will be posted 
to the account unless done manually.

•	 Auto Ins Claim Options

•	 Auto Pri Ins Claim – To have a primary insurance claim generated, select this option. Next, 
select Monthly to have insurance claims created monthly when the charges are posted; or select 
Recur every, and then select the number of months to set a schedule for the insurance billing. 
Dentrix Enterprise will generate an insurance only if the specified number of months has elapsed 
since the last claim was generated for the future due payment plan.

•	 Additional Proc. Code to Include – Type an additional procedure code, or click the search 
button  to select a procedure code to include on the claim.

•	 Mark Claims as Orthodontic Treatment – If the payment plan is being used for orthodontic 
work, select this option. When Dentrix Enterprise generates the automatic insurance claim, the 
orthodontic treatment information for the insurance claim information will be completed using 
the information entered for the payment plan.

•	 Benefits Applied for Other Treatment – The patient’s used benefits for primary and secondary 
insurance before the payment plan is posted appear. The insurance estimates for the payment plan 
will be calculated using the amounts in the Primary Ins and Secondary Ins fields. You can change 
these amounts if necessary.

•	 Current Plan Status – Information for the current payment plan appears, including remaining 
balance and number of monthly charges, patient and insurance estimates, date and amount of the 
down payment, date and amount of the last charge, and date of the last claim created for the payment 
plan. You can change the values of the total amount being charged and number of monthly charges, 
last amount charged and remaining, and date of the last claim.

•	 Print Options – To provide the patient with a payment or coupon book, select Print Payment 
Book. Next, type the # of Months to print, the Monthly Amount, and the First Pay Due Date.

•	 Manual Charge Entry –  If an amount has been entered in the Down Pay Charge field, to post a 
down payment charge, click Down Payment. In the Down Payment Charge dialog box, if necessary, 
edit the Date, and then click Post Charge.

4.	 Click OK.

Tip: During your month-end processes, run the utility for processing the future due payment plans to 
post charges to individual accounts all at the same time as explained in “Processing Future Due Payment 
Plans” in this chapter.

5.	 If you had the option to print a payment book selected, the Payment 
Book dialog box appears. Click Print or Send to Batch.

5
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Posting Manual Charges to Future Due 
Payment Plans
At times it may be necessary to manually add a payment plan charge to a patient’s Ledger.

To post a manual future due payment plan charge

1.	 In the Ledger, with a patient selected, from the Transaction menu, 
click Process Future Due Payment Plan. The Select Payment 
Plan dialog box appears.

2.	 Double-click a payment plan. The Payment Plan dialog box 
appears.

3.	 Under Manual Charge Entry, 
click Monthly. The Monthly 
Charge dialog box appears.

4.	 If necessary, edit the Date of the 
transaction.

5.	 Click Post Charge.
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Working with Notes in the Ledger
Dentrix Enterprise can store important account and transaction information. The Ledger provides the 
following types of notes:

•	 Guarantor Notes

•	 Billing Statement Notes

•	 Transaction Notes

•	 Procedure Notes
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Guarantor Notes
Guarantor notes are notes attached to an account. These notes are available not only from the Ledger but also 
from the Family File and Appointment Book. The guarantor note will usually contain information specific to 
the financial situation of an account.

To add a guarantor note

1.	 In the Ledger, with a patient (or any of the patient’s family members) 
selected, from the File menu, click Guarantor Notes.

The Guarantor Notes dialog box appears.

2.	 Click Insert Dateline to insert the current 
date at the position of the text cursor to 
record when the note is being input.

3.	 In the Account Note field, type any 
relevant account notes.

4.	 Click OK.

Billing Statement Notes
You can enter account-specific information that prints automatically on an account’s billing statement. These 
notes can be anything from payment reminders to congratulations on a new baby.

To add or clear a billing statement note

1.	 In the Ledger, with a patient (or any of the patient’s family members) 
selected, from the File menu, click Guarantor Notes.

The Guarantor Notes dialog box appears.

2.	 In the Billing Statement Note field, type 
a statement note. This note will be seen 
by patients, so grammar and spelling are 
important.

3.	 Many notes are only relevant for a certain 
length of time. To have Dentrix Enterprise 
clear a time-sensitive note, type a Print 
on Statement until date. After the date 
entered passes, Dentrix Enterprise will 
no longer print the note on the account’s 
statements. By default, the date is one 
month in the future.

4.	 Click OK.
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Transaction Notes
Each transaction type in the Ledger includes a note field, allowing you to add clarification to any type of 
entry. You can enter notes while posting a transaction or editing an existing current transaction. For details 
about entering a note when adding a transaction, see “Entering Transactions” in this chapter.

To add a note to an existing transaction

1.	 In the Ledger, with a patient selected, double-click a transaction.

2.	 In the edit or delete dialog box that appears, type a Note, and then click OK.

Procedure Notes
With a procedure note, you can add clarification to a completed procedure. Ledger procedure notes are 
directly linked to the Patient Chart procedure notes and consequently are generally used to note clinical 
information about the procedure rather than financial data. For details about procedure notes, see the “Adding 
and editing ADA-CDT dental codes” topic in the Dentrix Enterprise Help.

Performing Month-end Routines
Dentrix Enterprise provides several utilities that you can run on a monthly basis to keep your accounts in 
good order. To avoid data corruption, all users are required to exit Dentrix Enterprise before running any of 
these utilities. This section covers the following topics about month-end processes:

•	 Applying Finance Charges

•	 Applying Late Charges

•	 Processing Future Due Payment Plans

•	 Running the Month-end Update
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Applying Finance Charges
Dentrix Enterprise can apply finance charges to accounts with and without payment agreements at the same 
time. If Dentrix Enterprise determines that a finance charge should be assessed for an account with a payment 
agreement set up, it will use the payment agreement terms to calculate the charge.

Note: Apply finance charges on a monthly basis. While you can run the utility at any time during the month, 
it is important to run it consistently and at approximately the same time each month.

For information about how to post a finance charge to an individual account manually, see “Posting Finance 
and Late Charges” in this chapter.

To apply finance charges

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup 
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable 
single-user mode (as explained in “Changing the Database Mode” in Chapter 8: Office Manager.

1.	 In the Ledger, from the Month End menu, click Finance Charge.

The Apply Finance Charges dialog box appears.

2.	 Set up the following options:

•	 Finance Charge Date – Dentrix Enterprise calculates 
finance charges according to the aged balance for 
each family account as of the finance charge date. By 
default, Dentrix Enterprise inserts the current system 
date as the Finance Charge Date, which will become 
the transaction date for each finance charge entry, but 
you can change the date as needed.

•	 Minimum Balance to Charge – Dentrix Enterprise 
compares the minimum balance to each aged account 
balance and applies a finance charge only to those 
accounts with an aged balance greater than the 
minimum. By default, the Minimum Balance to 
Charge is $10.00, but you can change the amount as 
needed.

•	 Minimum Finance Charge – Dentrix Enterprise 
charges the minimum finance charge to accounts 
when the calculated finance charge is less than the 
amount entered. By default, the Minimum Finance 
Charge is $.50, but you can change the amount as 
needed.

•	 Past Due Days to Charge – Dentrix Enterprise calculates finance charges on the portion of each 
account balance that is past due according to the Past Due Days to Charge option selected and the 
aging of the account as of the Finance Charge Date. By default, Dentrix Enterprise assumes charges 
are due to be paid when they are incurred, so the Past Due Days to Charge is Over 0 days, but if 
you do not want to charge finance charges to current accounts, select a different option.
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•	 Finance Charge – Dentrix Enterprise uses the finance charge percent to calculate the finance charge 
amount. Type the Percent to you want to charge, and then select Monthly or Yearly. Dentrix 
Enterprise always calculates finance charges on a monthly basis, so if you are using the Yearly option, 
Dentrix Enterprise will divide the percentage entered by 12 months (for example, your charge 18% 
yearly, Dentrix Enterprise will apply 1.5% to accounts each time you apply finance charges with this 
utility).

•	 Apply as Adjustment Type – To have Dentrix Enterprise post the finance charge as a charge 
adjustment, select this option, and then click the search button  to select an adjustment type.

•	 Clinics – Select the clinics with patients to whom you want to apply finance charges, or select All 
Clinics to include all clinics.

•	 Primary Providers – Select the primary providers of patients to whom you want to apply finance 
charges, or select All Providers to include all providers.

•	 Billing Types – Select the billing types of patients to whom you want to apply finance charges, or 
select All Types to apply finance charges to all accounts regardless of billing type.

Tip: If you do not want to charge finance charges to billing types that are labeled “No Finance 
Charges,” you must clear All Types and then select only the billing types that should receive finance 
charges.

3.	 If you want to save the current settings for the next time you run this utility, select Save as Default.

4.	 Click OK. On the confirmation message that appears, click OK.

Note: A progress bar appears and displays a count as each account is processed. You can click Abort if you 
need to stop applying finance charges, but any finance charges that have already been calculated before 
the button was clicked will still be applied. So, after aborting the process, you may want to print the 
Finance Charge Report from DXOne Reporting, open each guarantor’s Ledger that appears on the report, 
and edit or delete the charges; or you can restore the backup of your Dentrix Enterprise database from 
immediately before you ran the utility.
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Applying Late Charges
Dentrix Enterprise applies late charges to accounts with payment agreements that have failed to make a 
payment within the grace period of their payment due date.

Note: Run this utility on a monthly basis. While you can run the utility at any time during the month, it is 
important to run it consistently and at approximately the same time each month.

For information about how to apply late charges to an individual account manually, see “Posting Finance and 
Late Charges” in this chapter.

To apply late charges

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup 
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable 
single-user mode (as explained in “Changing the Database Mode” in Chapter 8: Office Manager.

1.	 In the Ledger, from the Month End menu, click Late Charge.

The Apply Late Charges dialog box appears.

2.	 Set up the following options:

•	 Charge Date – By default, Dentrix Enterprise inserts 
the current system date as the Charge Date, which will 
become the transaction date for each late charge entry, 
but you can change the date as needed.

•	 Select Clinic – Select the clinics with patients to whom you want to 
apply late charges, or select All Clinics to include all clinics.

•	 Primary Providers – Select the primary providers of patients to 
whom you want to apply late charges (only primary providers are 
listed), or select All Providers to include all providers.

•	 Billing Types – Select the billing types of patients to whom you 
want to apply late charges, or select All Types to apply late charges 
to all accounts regardless of billing type.

Tip: If you do not want to charge late charges to billing types that 
are labeled “No Finance Charges,” you must clear All Types and 
then select only the billing types that should receive finance charges.

3.	 Click OK. On the confirmation message that appears, click OK.

Note: A progress bar appears and displays a count as each account is 
processed. You can click Abort if you need to stop applying late charges, but any late charges that have 
already been calculated before the button was clicked will still be applied. So, after aborting the process, 
you may want to print the Late Charge Report from DXOne Reporting, open each guarantor’s Ledger 
that appears on the report, and edit or delete the charges; or you can restore the backup of your Dentrix 
Enterprise database from immediately before you ran the utility.
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Processing Future Due Payment Plans
You can post charges due on all accounts with a future due payment plan.

Note: Run this utility on a monthly basis. While you can run the utility at any time during the month, it is 
important to run it consistently and at approximately the same time each month.

To process future due payment plans

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup 
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable 
single-user mode (as explained in “Changing the Database Mode” in Chapter 8: Office Manager.

1.	 In the Ledger, from the Month End menu, click Future Due Payment Plan.

The Future Due Payment Plan Update dialog box 
appears.

2.	 Set up the following options:

•	 Charge Date – By default, Dentrix Enterprise inserts 
the current system date as the Charge Date, which will 
become the transaction date for each payment plan charge entry, but 
you can change the date as needed. 

•	 Select Clinic – Select the clinics with patients to whom you want 
to apply payment plan charges, or select All Clinics to include all 
clinics.

•	 Primary Providers – Select the primary provider of patients to 
whom you want to apply payment plan charges (only primary 
providers are listed), or select All Providers to include all providers.

•	 Billing Types – Select the billing types of patients to whom you want 
to apply payment plan charges, or select All Types to apply payment 
plan charges to all accounts regardless of billing type.

•	 Create Insurance Claims – To have Dentrix Enterprise create 
insurance claims for the payment plan charges posted, select this 
option.

3.	 Click OK.
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Running the Month-end Update
Running the month-end update is a crucial management routine. Perform this update each month to 
complete many maintenance tasks that are important for getting accurate patient data quickly:

•	 Aging account balances – Account balances will not remain current on your aging reports.

•	 Moving procedures to history – All procedures posted during the month being closed will be moved 
into history, locking out changes and deletions.

•	 Creating totals records – To speed report generation, Dentrix Enterprise creates a monthly totals record 
each time a month is closed. Without this monthly record, Dentrix Enterprise must calculate analysis 
information each time a report is generated, which can greatly slow the report generation process.

•	 Resetting insurance benefits (optional) – For all patients who have dental insurance coverage that resets 
during the month being updated, the benefits used and deductible applied amounts will be reset.

You cannot close out the current month. You must wait until the first day of the next month before Dentrix 
Enterprise will allow you to close out the previous month (for example, you cannot close out the month of 
June until the first day of July).

To run the month-end update

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup 
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable 
single-user mode as explained in “Changing the Database Mode” in Chapter 8: Office Manager (remember to 
disable single-user mode after the month-end update is complete).

1.	 In the Ledger, from the Month End menu, click 
Update. The Close Out Month dialog box appears.

Dentrix Enterprise requires that months be closed out in 
chronological order. Dentrix Enterprise will display the 
correct month to be closed out in the Close Out Month 
field. You cannot edit this date.

2.	 To have Dentrix Enterprise reset all dental insurance plans 
whose benefit renewal month is the month following the 
Close Out Month, select Reset Insurance Benefits for 
[month].

3.	 To speed up the month end process, select Disable Audit 
Triggers During Month End Proc.

4.	 Click OK.

Note: The amount of time required to run the update depends on many factors, including the processor 
speed of your server. However, a very important factor in the speed of the utility is the amount of 
information already in history. If you wait to close out the month, leaving two to three months current at 
a time, the update has more data to process and will take more time to run. Running the update monthly 
will reduce the time required considerably, as Dentrix Enterprise has less data to process.
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Chapter 8: Office Manager
The Dentrix Enterprise Office Manager provides powerful tools to enhance the management processes of your 
practice. This chapter covers the following topics:

•	 Using the Office Manager Window

•	 Changing Fee Schedules Automatically

•	 Changing the Database Mode

•	 Maintaining Employers

•	 Maintaining Insurance Carriers

•	 Analyzing Referrals

•	 Purging Appointments

•	 Purging Dental Insurance Benefits Used

•	 Generating Office Manager Reports

•	 Generating Billing Statements

•	 Printing Blank ADA Claim Forms

•	 Creating Letters

•	 Creating a Batch of Primary Insurance Claims

•	 Submitting Electronic Claims

•	 Sending Statements with QuickBill

•	 Signing Mulitple Clincal Notes

Using the Office Manager Window
The Office Manager window consists of a menu bar, toolbar, and Batch Processor.

Batch Processor

This section covers the following topics to help you understand how to use the Office Manager window:

•	 Using the Office Manager Toolbar

•	 Understanding the Batch Processor

•	 Previewing Reports

•	 Printing Reports

•	 Deleting Reports
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Using the Office Manager Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Office Manager are explained in the following table.
Click the Electronic Billing Submission button to send billing statements and/or a batch of billing 
statements to a clearinghouse to have them mailed for you.
Click the Electronic Claim Submission button to submit dental and/or medical insurance claims 
electronically.
Click the Create Batch Primary Ins Claims button to generate multiple claims for procedures 
posted within a specified date range

Click the Print Preview button to display the report selected in the Batch Processor.

Click the Print Report(s) button to send the reports selected in the Batch Processor to the printer 
set up for use by the Office Manager.

Click the Delete Report(s) button to delete all or certain reports.

Click the Refresh/Clear Selection button to deselect any reports that are selected in the Batch 
Processor.

Click the Day Sheet Report button to generate a day sheet.

Click the Operator Day Sheet Report button to send the operator day sheet to the Batch Processor.

Click the Referral Analysis button to monitor referrals or enter gratuities.

Click the Collections Manager button to view and manage collections information to help you as 
you contact patients regarding their accounts.

Click the DXOne Reports button to generate and manage reports.

Click the Signature Manager button to sign multiple clinical notes at one time.

Understanding the Batch Processor
The Batch Processor is a report management tool that allows you to print and/or preview reports generated 
and sent to the Batch Processor.

For each report listed, the Batch Processor displays the date the report was generated, a brief description of the 
report, and a status that indicates if the report has been printed, displayed, or sent (for claims and pre-estimates).

Tip: Since the Batch Processor can easily become crowded with reports from every clinic, you can specify the 
reports you want to have displayed in the Batch Processor and the sort order of those reports. For information  
about setting up the view of the Batch Processor, see the “Setting up the Office Manager view” topic in the 
Dentrix Enterprise Help.
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Previewing Reports
You can preview a report before printing it. You can preview one or two pages at a time, zoom out to see more 
of the page, zoom in to see more detail, and easily navigate between reports and pages of the current report. 
While you are previewing a report, the report appears in a format as close to the printed report as possible.

To preview a report

1.	 In the Office Manager, 
from the Batch Processor, 
select the reports you want to 
preview.

2.	 From the File menu, click Print 
Preview. The Print Preview 
window appears.

3.	 Do any of the following for the report you are previewing:

•	 Print Report –  To print the report being displayed or all reports in the preview session, from the File 
menu, click Print Report.

•	 Report Title – Select a report from the list to view that report (if you are previewing multiple 
reports).

•	 View One Page / Two Page – To switch between viewing one or two pages (displayed side by side), 
from the Options menu, click View One Page or View Two Pages.

•	 Zoom – To increase or decrease the zoom percentage (from 10% to 200%), from the Options menu, 
point to Zoom, and then click the appropriate percentage.

•	 Previous / Next Page – To advance to the next page in a multi-page report, click the right arrow 
button. To go to a previous page of a multi-page report, click the left arrow button.

4.	 To close the Print Preview window, from the File menu, click Exit.
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Printing Reports
If you do not want to preview a report, you can send it directly to the Office Manager printer.

Tip : To print certain pages of a report or to print more than one copy of a report, you must print that report 
from the Print Preview window so that you can enter the page range and the number of copies.

To print a report from the Batch Processor

1.	 In the Office Manager, 
from the Batch Processor, 
select the reports that you 
want to print.

Tips:

•	 To select multiple reports, 
while pressing the Ctrl key, 
click each report.

•	 To deselect a report in the 
Batch Processor, from the 
File menu, click Clear; or select a different report.

2.	 With reports selected, from the File menu, click Print. Dentrix Enterprise sends the report to the printer 
set up for the Office Manager.

Deleting Reports
You can delete any report from the Batch Processor that is not being previewed.

Note: Do not try to delete a report that is currently being previewed. A report being previewed may have 
“Displayed” or “Schd” (followed by a number) in the Status column.

To delete a report from the Batch Processor

1.	 In the Office Manager, 
from the Batch Processor, 
select the reports that you 
want to delete.

2.	 From the File menu, click 
Delete.

The Delete Options dialog box 
appears.

3.	 Select one of the following 
options:

•	 Selected Reports – To delete the reports selected in the Batch Processor

•	 Printed Reports – To delete all printed and displayed reports listed in the 
Batch Processor

•	 Sent Reports – To delete all sent claims listed in the Batch Processor (used 
with electronic claims)

•	 All Reports – To delete all reports listed in the Batch Processor

4.	 Click OK.
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Changing Fee Schedules Automatically
When you are logged in to the Central clinic, you can make changes to an entire fee schedule, or specific 
segments of a fee schedule, without having to manually enter each amount for a procedure.

To make automatic fee schedule changes

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Fee Schedule Maintenance. (This 
option is available only if you are logged in to the Central clinic.)

The Fee Schedule Maintenance dialog box appears.

2.	 Select the fee schedule that you want to update.

3.	 Click Auto Changes.

The Automatic Fee Schedule Changes dialog box appears.

4.	 To select the procedure code range for which you want to 
change the fee schedule, under Select Procedure  Code, 
click the From and To search buttons  to select the first 
and last procedure code in the desired range. Or, leave From 
<ALL> To <ALL> selected to include all procedures.

5.	 To specify a condition that a procedure’s fee must meet for that 
procedure to get updated, under Where, select the Current 
Amount check box. Select greater than (>), greater than or 
equal to (>=), less than (<), less than or equal to (<=), or equals 
(=). Type the amount ($).

6.	 Under Change Fee Schedule, set up the following options:

•	 Change Amount – Type how much you want to increase 
or decrease the fee by (depending on the Change Type 
selection, this is a dollar amount ($) or a percentage (%).

•	 Change Type – Select how you want to increase or decrease 
the fees: Increase by %, Increase by $, Decrease by %, or 
Decrease by $.

•	 Round To – Select whether you want to round the new fees to the nearest Dollar, Dime, or Penny 
(the default selection is controlled by a Central clinic setting).

•	 Minimum Amount To Increase – Type the minimum amount required for a fee in the fee schedule 
to be changed.

7.	 Click OK.

Once Dentrix Enterprise has processed the changes, it will display the entire fee schedule for you to 
review in the Fee Schedule Change Results dialog box.
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8.	 Do any of the following:

•	 To change a procedure code’s amount (as 
displayed in the BEFORE column), click 
that procedure code’s fee in the AFTER 
column, and then type the new amount. 
The background color of the AFTER cell 
changes to yellow, and the Difference 
between the original and the new fee 
appears with a green background (for 
an increase) or a red background (for a 
decrease). Repeat this process as needed to 
change other amounts.

Tip: To help you quickly find a procedure 
code, begin typing a procedure code in 
the Find Procedure Code field. The first 
matching code is selected.

•	 To replace all the amounts in this fee 
schedule with those from another fee schedule, click Copy From, and then search for and select the 
desired fee schedule.

•	 To replace amounts in this fee schedule with those from a .csv, .xls, or .xlsx file, click Import, and 
then search for and select the desired file.

•	 To change all amounts to zeros, click Clear, click Clear only the fee amounts, and then click Yes.

•	 To change all amounts to zeros and clear the Fee Schedule Name field, click Clear, click Clear only 
the fee amounts, and then click Yes.

•	 To copy the data (procedure codes, before amounts, after amounts, and differences) as text to the 
Windows Clipboard, click Clipboard, and then click Copy to Clipboard - tab delimited or Copy 
to Clipboard - comma delimited. You can paste the Clipboard contents into another program.

Tip: You can use the contents of a copied fee schedule comparison to create a .csv, .xls, or .xlsx file 
that you can import into Dentrix Enterprise to create a new fee schedule. 

•	 To export the data (procedure codes, before amounts, after amounts, and differences) as text to a 
comma-delimited or tab-delimited file, click Export to specify a name, a file type (.csv or .txt), and a 
location for the .csv or .txt file.

Tip: You can use the contents of an exported fee schedule comparison to create a .csv, .xls, or .xlsx file 
that you can import into Dentrix Enterprise to create a new fee schedule. 

9.	 Click Save.
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Changing the Database Mode
You can turn on single-user mode for operations that require that Dentrix Enterprise be closed on all but one 
computer. After those operations have been completed, you must turn off single-user mode.

To turn on singe-user mode

In the Office Manager, from the Maintenance menu, point to Practice Setup > Database Mode Setup, and 
then click Enable Single User Mode. On the confirmation message that appears, click Yes.

To turn off single-user mode

In the Office Manager, from the Maintenance menu, point to Practice Setup > Database Mode Setup, and 
then click Disable Single User Mode. On the confirmation message that appears, click Yes.

Maintaining Employers
With the Employer Maintenance utility, you can add, edit, and delete employers without selecting a patient. 
Additionally, you can join and purge duplicate employers. For information about adding and editing 
employers from the Office Manager, see the “Adding and editing employers” topic in the Dentrix Enterprise 
Help.

This section covers the following topics about employers:

•	 Joining Employers

•	 Purging Employers

Joining Employers
You can combine duplicate employers.

Tip: You do not need to enable single-user mode when running this utility, but run it outside of peak office times.

To join employers

1.	 In the Office Manager, from the Maintenance menu, point to 
Reference, and then click Employer Maintenance.

The Employer Maintenance dialog box appears.

2.	 Click Join Employers.

The Join Employers dialog box appears.

3.	 Click the Source Employer search button  to select 
the employer that you want to merge into another.

4.	 Click the Destination Employer search button  to 
select the employer that you want the source employer 
to be changed to.

5.	 Click Join. On the confirmation message that appears, 
click Yes. Then, another message appears and states that 
the employers have been joined, so click OK.

The source employer is now the destination employer. 
All patients with the source employer now have the 
destination employer attached to their records in the Family File.

1

2
3

4

5



236     Chapter 8: Office Manager

Dentrix Enterprise 8.0.5 User’s Guide

Purging Employers
You can purge employers from Dentrix Enterprise that are no longer attached to any patients.

To purge an employer

1.	 In the Office Manager, from the Maintenance menu, point to 
Reference, and then click Employer Maintenance.

The Employer Maintenance dialog box appears.

2.	 Click Purge. The Purge Employers dialog box appears and 
lists all employers that are not attached to any patients.

Tip: If an employer you want to delete is not listed, the 
employer is attached to at least one patient. You must clear 
that employer from those patients in the Family File before it 
can be deleted. To find patients with a certain employer, print 
the Employers and Employed Patients Report for that 
employer from the DXOne Reporting module. For 
information about this report, see “Reference Reports” 
in Chapter 9: DXOne Reporting.

3.	 To delete all employers listed, click Delete All; or, to 
delete a certain employer, select that employer, and 
then click Delete.

4.	 Click Close.

Maintaining Insurance Carriers
With the Insurance Maintenance utility, you can add, edit, and delete insurance plans without selecting a 
patient. Additionally, you can join and purge duplicate insurance plans. For information about adding and 
editing insurance plans from the Office Manager, see the “Adding and editing insurance plans” topic in the 
Dentrix Enterprise Help.

This section covers the following topics about insurance:

•	 Joining Insurance Plans

•	 Purging Insurance Plans
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Joining Insurance Plans
You can combine duplicate insurance plans without moving subscribers one by one to another plan. Joining 
plans does not delete the old, unused insurance plan; it only moves the subscribers to a new plan so that the 
old plan can be purged.

Tip: It is not necessary to be in single-user mode when joining insurance plans, but do not use this utility 
during peak office times.

To join insurance plans

1.	 In the Office Manager, from the Maintenance menu, point to 
Reference, and then click Insurance Maintenance.

The Insurance Maintenance dialog box appears.

2.	 Click Join Plans.

The Join Insurance Plans dialog box appears.

3.	 Select one of the following join criteria:

•	 Employer-based – To move all subscribers 
attached to one particular insurance plan linked 
to a specific employer to another insurance 
plan that is linked to the same employer. Then, 
select the Subscriber’s Employer must match 
Insurance Plan Employer Field check box 
if you want to move only subscribers who are 
assigned the same employer in the Family File.

•	 Plan-to-Plan – To join insurance plans regardless of 
employers.

4.	 Click the Source Insurance Plan search button  to 
select the plan you want to join with another.

5.	 Click the Destination Insurance Plan search button  
to select the plan you want the Source Insurance Plan to 
be transferred to.

6.	 Click Join. On the confirmation message that appears, 
click OK. Then, another message appears and states that 
the plans have been joined, so click OK.

The source plan is now the destination plan. All patients 
with the source plan now have the destination plan 
attached to their records in the Family File.
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Purging Insurance Plans
You can purge insurance plans from Dentrix Enterprise that are not attached to any outstanding insurance 
claims.

To purge an insurance plan

1.	 In the Office Manager, from the Maintenance menu, point to 
Reference, and then click Insurance Maintenance.

The Insurance Maintenance dialog box appears.

2.	 Click Purge.

The Purge Insurance dialog box appears.

Tip: If an insurance plan you want to delete is 
not listed, the plan is attached to at least one 
outstanding claim. Those claims must be paid before 
the plan can be deleted. To find outstanding claims 
for a certain carrier, print the Insurance Claim Aging 
Report for that carrier from the DXOne Reporting 
module. For information about this report, see 
“Ledger Reports” in Chapter 9: DXOne Reporting.

3.	 To delete all insurance plans listed, click Delete 
All; or, to delete a certain plan, select that plan, and 
then click Delete. On the confirmation message that 
appears, click OK.

4.	 Click Close.

Analyzing Referrals
You can use the Dentrix Enterprise analysis tool to view referral production and manage gratuities.

To analyze the production of a referral source

1.	 In the Office Manager, from the Maintenance menu, point to 
Reference, and then click Referral Maintenance.

The Referral Maintenance dialog box appears.

2.	 Select the referral you want to analyze.

3.	 Click Analysis.

The Referral Analysis dialog box appears. The dialog box 
lists the number of  Total Referrals Made to/by this referral 
source.
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4.	 Set up the following options:

•	 Referral Date Span – From the list, select a date span. 
All patients who have been referred to/by the referral 
source within the date span appear in the list box.

•	 Production Date Span – For referral sources only, 
from the list, select a date span. The production for 
the specified date span of each referral appears in the 
Production column of the list box. Also, the total 
production generated by the listed referrals for the 
production date span appears in the Production field.

5.	 To enter a gratuity given to a referral source, click New 
Gratuity. In the New Gratuity dialog box, type the date 
the gratuity was given and the amount of the gratuity, 
select the type of gratuity sent, and then click OK.

Tips:

•	 To add a new gratuity type in the New Gratuity 
dialog box, from the Type list, select “<Add Gratuity 
Type>,” type a new type and amount, and then click Add.

•	 To record the gratuity in each referred patient’s Office Journal, in the New Gratuity dialog box, select 
Add Journal, and then click the Provider search button  to select the provider for whom you also 
want to record the Office Journal entries.

6.	 To view an analysis of the gratuities given to a referral, click Gratuity Analysis.

The Gratuity Analysis dialog box appears. This dialog box 
lists all gratuities and the total value of each.

7.	 Click Close to return to the Referral Analysis dialog box.

8.	 Click OK.
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Purging Appointments
If you are logged in to the Central clinic, you can purge appointments in the Appointment Book before a 
certain date for all clinics.

Tip: You can purge appointments for only the clinic you are logged in to from the Appointment Book.

To purge appointments

1.	 In the Office Manager, from the Maintenance menu, point to 
Reference, and then click Purge Appointment.

The Delete Appointments for All Clinics dialog box appears.

2.	 Type a Cut off date. All appointments in all clinics prior the date 
entered will be purged.

3.	 Click OK. On the confirmation message that appears, click OK.

Purging Dental Insurance 
Benefits Used
With the Purge Insurance Benefits Used utility, you can selectively zero out insurance coverage benefits used. 
Purging used benefits will clear all of the current year’s benefits for the insurance plans that have the previous 
year’s benefits cleared.

To purge used insurance benefits

1.	 In the Office Manager, from the Maintenance menu, point to 
Reference, and then click Purge Dental Ins Benefits Used.

The Purge Dental Insurance Benefits Used dialog box appears.

2.	 Select one of the following options:

•	 Insurance Plans with Renewal Month of  – 
To clear used benefits (reset them to $0) for 
insurance plans with benefits that renew on 
a specific month, select this option, and then 
select the appropriate month from the list.

•	 Selected Insurance Plan – To clear used 
benefits from a specific insurance plan, select 
this option, and then click the search button  to select the appropriate insurance plan.

3.	 Click OK.

Tip: During the month-end update, Dentrix Enterprise will automatically purge benefits used for those 
insurance companies that renew their benefits the next calendar month.
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Generating Office Manager Reports
Dentrix Enterprise provides many reports that you can use to gather information from your database. While 
some reports can be printed from the Ledger, the Patient Chart, the Appointment Book, the Family File, or 
DXOne Reporting, the Office Manager has the following categories of reports you can generate:

•	 Reference reports

•	 Management reports

•	 Billing statements

•	 Ledger reports

•	 List reports

•	 Blank ADA claim forms

All reports you generate from the Office Manager will appear in the Batch Processor.

For a comprehensive explanation of all the options for running these reports, see the “Generating Office 
Manager reports” topic and its subtopics in the Dentrix Enterprise Help. Also, to see samples of and read an 
explanation of what appears on each report, refer to the Dentrix Enterprise 8.0.5 Reports Reference.

Reference Reports
In the Office Manager, from the Reports menu, point to Reference, and then click a reference report option:

•	 Procedure Code List – The Procedure Code List is a list of procedure codes, including the procedure 
code number, description, abbreviated procedure codes, time allotted for each procedure, appointment 
type, paint type, and treatment area.

•	 Dental Diagnostic Code List – The Dental Diagnostic Code List is a list of all dental diagnostic codes 
that have been entered.

•	 Medical Code List – The Medical Code List is a list of all medical procedure codes entered. Codes are 
grouped by code type (AMA, ICD, modifier, place of service, and type of service).

•	 Multi Code List – The Multi-Code List is a list of all multi-codes or a range of multi-codes.

•	 Standard Coverage Table Report – The Standard Coverage Tables Report lists the coverage tables that 
are set up in the Office Manager. The report includes the coverage percentage, co-payment, and pre-
authorization flag for each range of procedures.

•	 Insurance Coverage Tables Report – The Insurance Coverage Tables Report lists the coverage tables that 
have been set up for each selected insurance plan.

•	 Updated Dental Insurance Payment Tables Report – The Updated Dental Insurance Payment Tables 
Report lists all procedures and the covered dollar amount for procedures listed in the payment table for 
the selected dental insurance carriers.

•	 Custom Practice Information Report – The Custom Practice Information Report lists information that 
can be customized in Practice Definitions: billing types, payment types, adjustment types, custom notes, 
medical alerts, appointment status types, and appointment check list.

•	 Registration Information Report – The Registration Information Report lists the practice information 
and serial number of your Dentrix Enterprise software.
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Management Reports
In the Office Manager, from the Reports menu, point to Management, and then click a management report 
option: 

•	 Day sheet (charges and receipts) – The day sheet is a report designed to help you keep track of your 
daily production and collection figures. It lists all transactions posted during the day (or date range 
specified) including procedures, payments, adjustments, and finance charges. The day sheet can be 
customized to include or exclude specified information, and can be printed in a variety of formats.

•	 Referred To Doctor Report – The Referred TO Doctor Report lists the number of patients who have 
been referred to another practice during a specified time period. Depending on report settings, this report 
also lists the name and referral date of each referred patient. The report is organized by referral. You can 
also create mailing labels for those doctors to whom your patients have been referred.

•	 Referred By Doctor/Other Report – The Referred BY Doctor/Other Report lists each referring doctor 
or non-person referral source (for example, an advertisement) that has referred a patient to your practice 
within a specified date range. For each referring doctor/other listed, a list of referred patients is included 
with patient information and details regarding production generated by the referral. You can also print 
mailing labels for each referral source.

•	 Referred By Patient Report – The Referred BY Patient Report lists each patient who has referred another 
patient to your practice within a specified date range. For each referring patient listed, there is a list of 
patients that have been referred, including production details resulting from that referral. You can also 
print mailing labels for each referral source.

Ledger Reports
In the Office Manager, from the Reports menu, point to Ledger, and then click a ledger report option:

•	 Family Ledger Report – The Family Ledger report includes all transactions for all patients in the family 
posted since the beginning date specified. The date of treatment, tooth number, description, patient, 
charges, payments and a running balance are included on the report. Depending on report settings, the 
current balance of each patient in the family is also displayed on the report.

•	 Patient’s Ledger Report – The Patient’s Ledger report includes all transactions for a patient(s) posted 
since the beginning date specified. The date of treatment, tooth number, description, patient, charges, 
payments, and a running balance are also included on the report.

•	 Payment Agreement Report – The Payment Agreement Report displays analysis and management 
information for monitoring payment agreements. The report includes information on the agreement 
terms, the remaining balance for the payment agreement, and missed payments, and the last payment 
date and amount.

•	 Future Due Payment Plan Report – The Future Due Payment Plan Report displays payments that can 
be expected based on established payment plans by month. You can also run the Monthly Totals Report.

•	 Referral Recap Report – The Referral Recap Report lists completed and treatment-planned work for 
each referral source that appears on the report. Each referred patient will appear on a separate page.
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List Reports
In the Office Manager, from the Reports menu, point to Lists, and then click a list reports option:

•	 Daily Appointment List – The Daily Appointment List consists of three separate reports:

•	 Operatory Appointment List – This report lists all appointments for a selected range of dates and 
by the selected providers and operatory ranges. The list includes the appointment date, status, time, 
patient name, provider and operatory, appointment reason, and appointment duration.

•	 Patient Route Slips – Patient route slips can be printed for all patients scheduled within the date 
range. The route slip provides comprehensive account and treatment information for the scheduled 
patient.

•	 Daily Appointment List – This report gives the same information as the Operatory List, but in a 
different format, and includes the patient phone numbers.

•	 Unscheduled Appointment List – The Unscheduled Appointment List displays patient appointments 
that have been broken (and not rescheduled) or placed on the wait/will call list during a specified time 
period. This list can aid your office in rescheduling those appointments.

•	 Unscheduled Treatment Plans Report – The Unscheduled Treatment Plans Report displays patients for 
whom there has not been an appointment scheduled for their treatment-planned procedures.

•	 Treatment Plan Approval Report – The Treatment Plan Approval Report lists pre-treatment estimate 
insurance claims that have been received and accepted. The treatment plan, estimate amount, and 
whether the pre-treatment was accepted or rejected are also included on the report.

•	 Treatment Plan Approval Status Report – The Treatment Plan Approval Status Report lists treatment-
planned procedures for selected approval statuses, along with relevant patient and procedure information.

•	 Insurance Eligibility Report – The Insurance Eligibility Report lists insurance carriers and the patients 
eligible for coverage under each carrier and includes information such as the patient’s eligibility date, 
subscriber’s name and ID, insurance carrier’s address, group plan number, and patient’s next appointment.

•	 Perio Exam List – The Perio Exam Lists is a list of patients who have had a periodontal exam created 
within a specified date range.

•	 New Patient List – The New Patient List is a list of all patients in the practice whose first visit dates fall 
within a specified date range. You can also print mailing and chart labels for this list of patients. The list 
includes each patient’s name, address and first visit date.

•	 Patient Notes Report – The Patient Notes Report displays any notes you have entered for a patient. You 
can indicate which patients to print based on name, provider, or billing type, and you can select which 
types of notes to include.
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Generating Billing Statements
Billing statements provide guarantors with a record of their financial transactions with the practice.

Printer-generated billing statements can save you the cost of pre-printed forms without losing the professional 
look of pre-printed forms. However, if you intend to use pre-printed forms, be sure to purchase forms that are 
supported by Dentrix Enterprise.

For information about where to specify the billing statement form that you want to use, see “Setting Up 
Practice Defaults” in Chapter 1: Introduction and Initial Setup. Also, for information about how to set up 
billing statements to include the central office, clinic, or provider information, see “Setting Up Clinics” in 
Chapter 1: Introduction and Initial Setup.

To generate billing statements

1.	 In the Office Manager, from the Reports menu, click Billing.

The Billing Statements dialog box appears.

2.	 Set up the following options:

•	 Statement Date – Type a cutoff date. 
The statements will include procedures 
up to and including the date entered, and 
all statement calculations will be as of 
that date.

•	 Balance Forward Date – Type a balance 
forward date. Dentrix Enterprise will 
calculate the total of all outstanding 
procedures posted up to the date entered 
and give the total balance forward 
amount on the statements rather than an 
itemization of procedures.

•	 Select Guarantor – Click the search 
buttons  to select the range of 
guarantors for whom you want to generate 
statements, or leave From <ALL> To 
<ALL> selected to include all guarantors.

•	 Run Report – Select how you want to 
generate statements:

•	 By Provider – To generate statements by provider, select this option, and then click the search 
buttons  to select a range of providers to generate statements for those providers’ patients; or 
leave From <ALL> To <ALL> selected to include patients for all providers.

•	 By Clinic – To generate statements by clinic, select this option, and then click the search button 
 to select the clinic that has the patients for whom you want to generate statements.

•	 Select Billing Type – Click the search buttons  to select the range of billing types of patients 
for whom you want to generate statements, or leave From <ALL> To <ALL> selected to include all 
billing types.

•	 Minimum Balance to Bill – Dentrix Enterprise will generate statements for patients who have a 
balance equal to or greater than the amount entered. For example, if you enter 20, Dentrix Enterprise 
will generate statements for patients who have a balance of at least $20.

•	 Include Credit Balances? –To generate statements for patients who have a credit balance, select this 
option.

1
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•	 Statement Message – Type the message you want to have appear at the bottom of each statement, 
such as “Brush and floss regularly,” or “All payments are due on or before the 5th day of the month.”

Tip: For information about entering a customized billing statement note for any individual 
guarantor, see “Billing Statement Notes” in Chapter 7: Ledger.

•	 Options – Select the options you want to use to determine which accounts will receive a bill and 
what to include on the statements:

•	 Skip Accounts with Claim Pending – To skip an account if the patient has any outstanding 
claims for which the guarantor portion of the balance is less than the dollar amount you specify 
in the If Patient Portion Less Than field.

•	 Procedures With Claims Pending
•	 Current – To include procedures posted in the current month for which a claim has been 

created and is still pending (not received).
•	 All – To include all procedures posted for which a claim has been created and is still pending 

(not received).
•	 None – To exclude all procedures for which there is still a claim pending.

•	 Print Insurance Estimate – To include the estimated amount that dental insurance will pay on 
pending claims.

•	 Print Agreed Payment – To have a box labeled “Please Pay This Amount,” which reflects the 
patient portion of the balance or the payment amount required for a payment agreement set up 
previously, appear on statements.

To have the “Please Pay” amount exclude the entire amount that has been billed to insurance on a 
pending claim, even if some of it is a patient portion, select Exclude Outstanding to Insurance.

•	 Print Practice Information – If your default billing statement is not the Full Form/Download 
Form, and if you are using a pre-printed form without your practice information already printed 
on it, select this option.

•	 Print Account Aging – If your default billing statement is the Full Form/Download Form, to 
include an aging summary on the statements that are formatted to allow report aging, select this 
option.

•	 Allow Credit Card Payment – If your default billing statement is the Full Form/Download 
Form, to include credit card payment options on the statement, select this option.

•	 If Not Billed Since – To skip patients for whom a billing statement has already been printed 
since the date you specify. (The last statement date appears in each account’s Ledger.)

Tip: This option works well for practices that print billing statements from the Ledger when 
an insurance payment is received for an account. You can use cyclical billing as statements are 
printed for individual accounts throughout the month and then printed from the Office Manager 
in a batch to ensure that each account has received a statement for the month.

•	 Only Bill Accounts Aging – To generate statements for patients whose balance has aged at least 
as much as the aging bracket you select: Over 30, Over 60, or Over 90.

•	 Select Report Types – Select the desired report types:

•	 Billing Statement – To print statements for all guarantors who fall within the specified parameters.

•	 Mailing Labels – To print mailing labels with the guarantor’s name and address. Be sure to enter 
the number of Columns of labels your label sheets have on them.

•	 Save As Default – To save the current settings for the next time you generate statements from this 
computer.

3.	 Click OK to send the billing statements to the Batch Processor.
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Printing Blank ADA Claim Forms
There may be a circumstance when you need to print a blank ADA claim form.

To generate a blank ADA claim form

1.	  In the Office Manager, from the Reports menu, click Blank 
ADA Form.

The Dentrix Reports dialog box appears.

2.	 Select the claim form that you want to print.

3.	 Click Yes.

Creating Letters
With Dentrix Enterprise, you can create custom 
reports and letters as Microsoft Word documents 
or as data files for use in spreadsheet programs, 
such as Microsoft Excel.

Dentrix Enterprise provides an interface between your patient database and Microsoft Word (if installed) that 
allows you to create any letters that are applicable to the success and development of your practice. You can 
have Dentrix Enterprise merge information from patient records into your letters, based on various ranges, 
parameters, and filters that you establish.

Dentrix Enterprise comes complete with pre-defined letter templates in seven categories that you can use and 
modify in conjunction with your patient database. For information about how to customize any letter from 
Microsoft Word, see the “Customizing Dentrix Enterprise letters” topic in the Dentrix Enterprise Help. For 
information about how to create your own letters and add them to any of the categories for future use, see the 
“Creating custom letters” and “Adding letters to categories” topics in the Dentrix Enterprise Help.

This section covers the following topics about letter merges:

•	 Merging Dentrix Enterprise Letters

•	 Creating Appointment Reminder Cards

•	 Creating Cards for Patients Without Appointments

1
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Merging Dentrix Enterprise Letters
You can create letters by merging information from Dentrix Enterprise into Microsoft Word documents. This 
section covers the pre-defined templates installed with Dentrix Enterprise.

To merge a Dentrix Enterprise letter

1.	 Open and minimize Microsoft Word.

2.	 In the Office Manager, click Letters on the menu bar.

The Letters window appears.

3.	 Click the category button of the letter type you want to create:

•	 Birthday – Birthday letters for patients with a birth date in a 
specified range.

•	 Continuing Care – Continuing care (recall or recare) notices to patients 
within a recall date range.

•	 Referral – Referral letters for anyone who has referred or to whom you are 
referring patients within a specified range of first visit dates or referral dates.

•	 Collection – Collection notices for patients within a specified range of last 
payment dates.

•	 Inactive Patient – Notices for patients within a specified range of last visit 
dates.

•	 Welcome – “Welcome to the Practice” letters for patients within a specified range of first visit dates.

•	 Misc – Custom letters for specific patients in your database. You will probably put many of the 
custom letters you create in this category.

4.	 In the dialog box that appears, select a letter, set up a 
date range (if applicable), and then click Create/Merge. 
The Create/Merge Options dialog box appears.

5.	 Select Create Data File and Merge Letters.

For details about the Create Data File ONLY and 
Merge Letters using existing data file options, see the 
“Other create and merge options” topic in the Dentrix 
Enterprise Help.

6.	 If you want Dentrix Enterprise to add an entry to each 
patient’s Office Journal, indicating that a letter was sent 
to that patient, select Add to Journal.

7.	 Click OK.

When the merge is complete, in Microsoft Word, you can print the 
letters. Then, close Microsoft Word without saving the changes to 
the document.

Warning: If you save the changes to the document, patient 
information will be permanently saved in the letter template, 
rendering the template unusable.
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Creating Appointment Reminder Cards
You can create reminder cards to send to patients with upcoming appointments.

To create appointment reminder cards

1.	 Open and minimize Microsoft Word.

2.	 In the Office Manager, click Letters on the menu bar.

The Letters window appears.

3.	 Click Continuing Care.

The Continuing Care Letters dialog box appears.

4.	 Select Continuing Care -- With Appt.

Note: This is the default for the letter template name 
when Dentrix Enterprise is initially installed, but the 
name might have been changed.

5.	 Click Edit.

The Patient Report View dialog box appears.

6.	 In the Merge Letter Template field, type one of the 
following template document names, based on the 
type of cards you are using:

•	 dtxlm29.doc – 2-wide, laser cards.

•	 dtxlm24.doc – Single-wide, dot matrix cards.

•	 dtxlm27.doc – 2-wide, dot matrix cards.
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7.	 Set up the continuing care filter:

a.	 Click the Continuing Care search button .

The Select Continuing Care Ranges dialog box appears.

b.	 Under Due Date and Prior Treatment Date, leave From 
and To blank.

c.	 Under Include, select With Attached Appointment.

d.	 Under Continuing Care Type, select the appropriate 
continuing care type.

e.	 Click OK.

8.	 Set up the appointment filter:

a.	 Click the Appointments search button.

The Select Appointment Ranges dialog box appears.

b.	 Under Search, select Existing patients with appointment in 
date range.

c.	 Under Appointment Date Range, type the Beginning and 
Ending dates of the range of appointments for which you are 
printing cards.

d.	 Click OK.

9.	 Click OK to return to the Select Continuing Care Ranges dialog box.

10.	With Continuing Care -- With Appt still selected, click Create/Merge.

The Create/Merge Options dialog box appears.

11.	Select Create Data File and Merge Letters, and Add to Journal (if 
desired), and then click OK.

When the merge is complete, in Microsoft Word, you can print the 
cards. Then, close Microsoft Word without saving the changes to the 
document.

Warning: If you save the changes to the document, patient 
information will be permanently saved in the letter template, rendering the template unusable.

11
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Creating Cards for Patients Without 
Appointments
You can create reminder cards to send to patients without appointments who need to schedule a return visit.

To create cards for patients without appointments

1.	 Open and minimize Microsoft Word.

2.	 In the Office Manager, click Letters on the menu bar.

The Letters window appears.

3.	 Click Continuing Care.

The Continuing Care Letters dialog box appears.

4.	 Select Continuing Care -- W/O Appt.

Note: This is the default for the letter template name 
when Dentrix Enterprise is initially installed, but the 
name might have been changed.

5.	 Click Edit.

The Patient Report View dialog box appears.

6.	 In the Merge Letter Template field, type one of the 
following template document names, based on the 
type of cards you are using:
•	 dtxlm26.doc – 2-wide, laser cards.
•	 dtxlm23.doc – Single-wide, dot matrix cards.
•	 dtxlm28.doc – 2-wide, dot matrix cards.
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7.	 Set up the continuing care filter:

a.	 Click the Continuing Care search button .

The Select Continuing Care Ranges dialog box appears.

b.	 Under Due Date, type the Beginning and Ending dates of 
the range for which you want to print cards.

c.	 Under Include, select Without Attached Appointment.

d.	 Under Continuing Care Type, select the appropriate 
continuing care type.

e.	 Click OK.

8.	 Click OK to return to the Select Continuing Care Ranges 
dialog box.

9.	 With Continuing Care -- W/O Appt still selected, click Create/Merge.

The Create/Merge Options dialog box appears.

10.	Select Create Data File and Merge Letters, and Add to Journal (if 
desired), and then click OK.

When the merge is complete, in Microsoft Word, you can print the 
cards. Then, close Microsoft Word without saving the changes to the 
document.

Warning: If you save the changes to the document, patient information will be permanently saved in the 
letter template, rendering the template unusable.

10
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Creating a Batch of Primary Insurance 
Claims
In the Office Manage, you can create and batch, create and print, or create and send electronically all 
insurance claims for all procedure codes that are not currently attached to a primary insurance claim, are not 
flagged as “Do not bill to insurance,” and fall within a specified date range. You can create batch insurance 
claims for multiple clinics only if you are logged in to the Central clinic; otherwise, you can create batch 
insurance claims for only the clinic that you are logged in to.

To create a batch of primary insurance claims

1.	 In the Office Manager, from the File menu, click Batch Ins 
Claims.

The Create Batch Primary Insurance Claims dialog box appears.

2.	 Set up the following options:

•	 Clinic Selection – Click the search button  to 
select the clinics you want to include on the report, 
or leave All selected to include all clinics.

•	 Provider Selection – Click the search button  
to select the providers you want to include on the 
report, or leave All selected to include all providers.

•	 Billing Type Selection – Click the search button  
to select the billing types you want to include on the 
report, or leave All selected to include all billing 
types.

•	 Select Date Range – The date range defaults to the 
current system date. If necessary, in the From and 
To fields, type the date range for which you want 
to generate insurance claims. Also, select whether 
to search for procedures on primary insurance 
claims by Entry Date or Procedure Date.

•	 Create Primary Dental Claims – Select this option to include all primary dental insurance claims in 
the specified date range.

•	 Create Primary Medical Claims – Select this option to include all primary medical insurance claims 
in the specified date range.

•	 Save as Default – Select this option to save the current settings for the next time you create batch 
insurance claims.

3.	 Click Print to print the primary insurance claims, Send to Batch to send the primary insurance claims 
to the Batch Processor, or Send Electronically to send the primary insurance claims electronically to the 
clearinghouse. On the message that appears and displays the total number of primary dental and medical 
claims that will be created, click OK.
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Submitting Electronic Claims
eTrans is an add-on program that you can use to transmit insurance claims electronically from Dentrix 
Enterprise to insurance carriers. You must first register your practice if you want to use this service. Talk to 
your trainer, or contact eServices Customer Support at (800) 734-5561 for more information on how to 
purchase and install eTrans.

Note: You can send electronic claims only from a computer with an Internet connection.

To submit electronic claims with eTrans

1.	 Create insurance claims, sending them to the Batch Processor.

2.	 In the Office Manager, do one of the following:

•	 To submit all or some of the batched claims, from the File menu, click ECS.

•	 To submit specific claims, select the appropriate claims in the Batch Processor, and then, from the 
File menu, click ECS.

For more information on sending and editing electronic claims, setting up eTrans, and viewing reports 
regarding your electronic claims, refer to the eTrans User’s Guide, which is available for download from the 
Resource Center at www.DentrixEnterprise.com.

Sending Statements with QuickBill
If you have purchased, installed, and properly configured QuickBill, you can send billing statements 
electronically to a clearinghouse where they are professionally printed, folded, and mailed to guarantors.

For information on setting up QuickBill, refer to the QuickBill User’s Guide, which is available for download 
from the Resource Center at www.DentrixEnterprise.com.

To send statements electronically

1.	 Generate billing statements, sending them to the Batch Processor.

2.	 In the Office Manager, select the appropriate billing statements and/or a batch of statements in the Batch 
Processor.

3.	 From the File menu, click EBS. On the confirmation message that appears, click Yes.



254     Chapter 8: Office Manager

Dentrix Enterprise 8.0.5 User’s Guide

Signing Mulitple Clincal Notes
You can sign multiple clinical notes at one time from the Office Manager.

To sign multiple clinical notes

1.	 While logged in to Dentrix 
Enterprise as the user who needs to 
sign clinical notes, in the Office 
Manager, click the Signature 
Manager button .

The Signature Manager dialog box 
appears.

2.	 Set up the following 
Filters as needed:

•	 Date Range 
Selection – Select 
one of the following 
options:

•	 Previous – To 
view clinical 
notes for 
the specified 
number of days 
prior to today’s 
date. Enter the 
number of days.

•	 Date Range – To view clinical notes within the specified date range. Select the starting and 
ending dates of the range.

•	 Any Date – To view clinical notes for any date.

•	 Clinic Selection – Select one of the following options:

•	 Current Clinic – To view clinical notes for the clinic that you are currently logged in to.

•	 Other – To view clinical notes for specific clinics or all clinics. Either click the search button  
to select the clinics whose clinical notes you want to view, or select the All check box to include 
all clinics’ clinical notes.

•	 Provider Selection – Click the search button  to select the providers whose clinical notes you want 
to view, or select the All check box to include all providers’ clinical notes.

•	 Status Selection – Select whether you want to view all, unsigned, or signed clinical notes.

3.	 Click the Refresh button  to apply the specified filters.

Only the clinical notes that match the specified criteria appear in the list.

4.	 Click each clinical note to review it. Then, select the clinical notes that you want to sign. To select 
multiple notes, while holding down the Ctrl key, click each note; or, while holding down the Shift key, 
click the first and last notes to select those notes and all notes in between them.
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5.	 Click the Sign button .

The Clinical Notes, Approve dialog box appears.

6.	 Type your password, and then click OK.

The Sign Clinical Note dialog box appears.

7.	 Sign, and then click OK.
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Chapter 9: DXOne Reporting
The DXOne Reporting module provides you with reports that will assist you in analyzing your practice. 
You can schedule these reports to be generated automatically on a daily, weekly, monthly, or one-time basis. 
Additionally, you can send reports generated in DXOne Reporting as an email attachment to the Central 
clinic, a consultant, or an accountant.

This chapter covers the following topics:

•	 Opening DXOne Reporting

•	 Using the DXOne Reporting Window

•	 Selecting a DXOne Reporting Printer

•	 Setting Up Report Security

•	 Generating DXOne Reporting Reports

•	 Working with Previewed Reports

•	 Using Report Templates

Opening DXOne Reporting
You can open the DXOne Reporting module from the Office Manager.

To open DXOne Reporting

In the Office Manager, click the DXOne Reports button  on the toolbar.
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Using the DXOne Reporting Window
The DXOne Reporting window consists of the menu bar, toolbar, report category list, and report list.

Report 
categories

Reports

This section covers the following topics to help you understand how to use the DXOne Reporting window:

•	 Using the DXOne Reporting Toolbar

•	 Selecting a Report

Using the DXOne Reporting Toolbar
The toolbar contains several buttons that you can click to access certain areas of Dentrix Enterprise and 
DXOne Reporting.

The function of the buttons specific to DXOne Reporting are explained in the following table.

Click the Open Report button to view a saved report.

Click the Select Printer button to select the default printer you want to use to print reports from 
the DXOne Reporting module.

Click the Security button to assign rights to allow only certain users to access specific reports.

Selecting a Report
Reports are organized by category to help you find a report easily.

To select a report

1.	 From the Select Report Category list box, select a report 
category.

2.	 A list of available reports for the selected category appears 
in the Double Click to Launch Report Options list box. 
To set up the filters for generating a report, double-click 
that report.

1
2
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Selecting a DXOne Reporting Printer
When printing from DXOne Reporting, Dentrix Enterprise will automatically send reports to the Windows 
default printer, but you can have reports sent to another printer.

To select a printer for DXOne Reporting

1.	 In DXOne Reporting, from the File menu, click Select 
Printer. The Printer Selection dialog box appears.

2.	 Select a printer.

3.	 Click OK.

1
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Setting Up Report Security
In DXOne Reporting, you can control which reports can be generated by which users.

To set up user rights and security for DXOne Reporting

1.	 In DXOne Reporting, from the menu bar, click 
Security. The Report Security dialog box appears.

2.	 Under User List, select a user.

3.	 Select the report for which you want 
to Set Security, or leave <General> 
selected to assign rights the same 
rights for all reports for the selected 
user. If you have set up rights 
previously for any report, selecting 
this option will override those rights.

4.	 Set up the following options:

•	 Rights – Select the rights you 
want this user to have, or 
select Select All.

Tip: If you have multiple 
employees with the same level 
of security, click Copy User 
Security to select the user from 
which you want to copy settings.

•	 Clinics – Select the clinics for which the user can generate reports, or select Select All.

•	 Provider/Staff – Select the providers and staff members for whom this user will have rights to 
generate reports, or select Select All.

Tip: To select the user selected under User List, click Highlight Selected User.

5.	 Click Save.

If necessary, repeat steps 3 – 5 for each report the selected user will have access to. Then, repeat steps 2 – 5 
for each user.

6.	 Click Close.

1

2
3

4

5 6



260     Chapter 9: DXOne Reporting

Dentrix Enterprise 8.0.5 User’s Guide

Generating DXOne Reporting Reports
The reports in the DXOne Reporting window are grouped into the following categories:

•	 Reference Reports

•	 Management Reports

•	 Ledger Reports

•	 Analysis Reports

•	 List Reports

•	 Audit Reports

•	 UDS Reports

•	 Custom Reports

The sections that follow provide a description of each available report. For a comprehensive explanation of all 
the options for running these reports see the “Generating DXOne Reporting reports” topic and its subtopics 
in the Dentrix Enterprise Help. Also, to see samples of and read an explanation of what appears on each 
report, refer to the Dentrix Enterprise 8.0.5 Reports Reference.

Reference Reports
In DXOne Reporting, select Reference, and then double-click a reference report:

•	 Employers and Employed Patients Report – The Employers and Employed Patients Report is a list of all 
employers, including name, address, and phone number. You may also select to include employed patients 
with each employer.

•	 Fee Schedule Report – The Fee Schedule Report is a list of procedure codes and the associated fees. Lab 
and material expenses associated with each procedure are also included.

•	 Insurance Carrier List – The Insurance Carrier List is a list of carrier names, addresses, phone numbers, 
contact names, and all related insurance information. You can also include the insured subscribers for 
each insurance plan.

•	 Patient Health Assessment Report – The Patient Health Assessment Report displays health information 
entered for a range of patients in specified clinics. The blood pressure, pulse rate, age, height, weight, and 
body mass index (BMI) of each patient appears on the report.

•	 Practice Organization List – The Practice Organization List is a list of the primary and secondary 
providers and staff members that have been set up for your practice. The report includes the 
corresponding provider or staff information.

•	 Provider IDs List – The Provider IDs List is a report of providers and relevant information.

•	 RVU Schedule Report – The RVU Schedule is a list of the procedure codes and the associated RVU fees. 
Lab and material expenses associated with each procedure are also included.
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Management Reports
In DXOne Reporting, select Management, and then double-click a management report:

•	 Analysis Summary Report – The Analysis Summary Report displays the transaction totals that are 
normally shown at the bottom of a day sheet, by provider, or by date, for a specific provider and date 
range.

•	 Appointment Statistics Report – The Appointment Statistics Report provides an overview of the 
productivity and efficiency of your practice regarding patient visits. This report displays statistics for late 
appointments, on-time appointments, wait/will call appointments, broken appointments, appointments 
that remained in specified statuses for a specified length of time, and appointment durations based on 
specified statuses.

•	 Assigned Rights Report – The Assigned Rights Report lists the current security rights assigned to each 
selected user and clinic.

•	 Day sheet – The day sheet lists all transactions for the day (alphabetically or chronologically), according 
to the providers and billing types selected.

•	 Day sheet - adjustments – The day sheet - adjustments lists all adjustment transactions for the day.

•	 Day sheet - deposit slip – The day sheet - deposit slip lists all payment transactions for the day in a 
format suitable for a bank deposit slip.

•	 Day sheet - receipts – The day sheet - receipts report lists all payment transactions for the day.

•	 Dental Encounters Report – The Dental Encounters Report lists procedures posted during a specified 
date range (each procedure must be attached to a claim to appear on the report), along with the amount 
that is expected to be paid by insurance. For each procedure, the date of service, name of the patient who 
received treatment, the subscriber ID (Beneficiary ID) of the subscriber of the patient’s insurance plan, 
and the appropriate NPI numbers are shown.

•	 Finance / Late Charge Report – The Finance / Late Charge Report lists accounts that received finance 
or late charges, according to the parameters set. The report lists the date of the charge, guarantor’s name, 
amount of the charge, billing type, and guarantor’s primary provider. A total of finance and late charges 
are calculated and listed at the bottom of the report.

•	 Insurance Carrier Production Report – The Insurance Carrier Production Report lists insurance 
plans’ production amounts, payments, and adjustments. The report can also include details about each 
procedure and insurance plan totals. The summary report and the full report will give you grand totals.

•	 Practice Statistics Report – The Practice Statistics Report provides a detailed cross-section of the 
practice’s patient base, including demographic, age, and continuing care information.

•	 Provider Accounts Receivable Totals Report – The Provider A/R Totals Report lists each provider’s 
accounts receivables totals for a date range or lists a daily total for each day in the range. Suspended 
credits are not included on this report except when Initial Provider is selected under Group By; in which 
case, the full credit is always shown.

•	 RVU day sheet – The RVU day sheet is a list of RVU production items. The report also displays the total 
RVU and net RVU.

•	 RVU Production Summary Report – The RVU Production Summary Report is a summary of RVU 
production. The report also displays the Quantity, Total, Average, Percent, and Net RVU.

•	 RVU Utilization Report – The RVU Utilization Report lists insurance carriers and, for each carrier, the 
relevant RVU production items along with details about the procedure.
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Ledger Reports
In DXOne Reporting, select Ledger, and then double-click a ledger:

•	 Aging / Credit Balance Report – The Aging/Credit Balance Report displays the guarantor’s name, phone 
number, billing type, last payment amount, last statement date, agreed payment amount and balances per 
aging period, insurance estimates, guarantor portion, and total account balance or credit. The report also 
provides totals and payments for each amount.

•	 Insurance Claim Aging Report – The Insurance Claim Aging Report displays each insurance carrier with 
outstanding claims, including the insurance plan name, group plan name, insurance phone number, and 
group number, and each outstanding insurance claim.

The insurance claim information will include a notation of primary or secondary, the date the claim was 
sent, the date a tracer was sent, the date the claim was placed on hold, the date the claim was re-sent, 
the patient name, patient birthday, the subscriber name, subscriber ID number, the estimated insurance 
payment, and the amount billed to insurance. The amount billed to insurance will be placed in the 
current, 31 – 60, 61 – 90, or > 180 column, based on how long ago the claim was sent and whether the 
Age Insurance Estimate instead of Total Billed figure check box is selected. The primary and secondary 
claim amounts will each be totaled and printed, and a combined total will appear at the bottom of the 
report.

•	 Insurance Claims Not Sent Report – The Insurance Claims Not Sent Report shows all insurance claims 
that have been created in the Ledger but not sent to the Batch Processor, printed, or sent electronically. 
This report includes the range of patients, providers, and carriers to be included. The report includes the 
claim date, type of claim (primary or secondary) patient name, insurance company name, claim amount 
and expiration date. A total of the amounts for primary claims and secondary claims and a combined total 
prints at the end of the report.

•	 Pre-Estimate Aging Report – The Pre-Estimate Aging Report shows when pre-treatment estimates were 
sent to insurance carriers. You can specify the range of patients, providers, and carriers to be included.

•	 Pre-Estimates Not Sent Report – The Pre-Estimates Not Sent Report lists pre-estimates that have been 
created in the Ledger but not sent to the Batch Processor, printed, or sent electronically. This report 
includes the range of patients, providers, and carriers you specify. The report includes the claim date, 
type (primary/secondary), patient name, insurance company name, amount, and expiration date. A total 
amounts for primary and secondary claims and a combined total appear at the end of the report.

•	 Procedures Not Attached To Insurance Report – The Procedures Not Attached To Insurance Report 
shows insured patients with completed procedures that have not had an insurance claim created from 
the Ledger. This report includes the range of patients and providers you specify. The report includes 
the patient name, each procedure with the date of the procedure, tooth number, procedure code and 
description, amount, and claim expiration date. The total amount of unattached procedures is calculated 
for each patient. A grand total is provided, as well.

•	 Provider Revenue Report – The Provider Revenue Report lists credits allocated to charges that have been 
posted to each provider.

•	 Secondary Insurance Claims Not Created Report – The Secondary Insurance Claims Not Created 
Report creates a list of primary insurance claims for patients with secondary insurance claims that have 
not yet been created. The report includes the primary claim date, patient name, secondary insurance 
company, claim account, and date the primary claim expires. The report is sorted by the expiration date 
and indicates the total of the claims accounts.

When primary insurance claims are evaluated for this report, they are only included if the patient had 
secondary insurance in the Family File at the time the primary insurance claim was created, and no 
secondary insurance claim was created.
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•	 Secondary Pre-Treatment Estimates Not Created Report – The Secondary Pre-Treatment Estimates 
Not Created Report is a list of primary pre-treatment estimates for patients with secondary pre-treatment 
estimates that have not yet been created. The report includes the primary pre-estimate date, patient name, 
secondary insurance company, claim account, and date the primary pre-treatment expires. The report is 
sorted by the expiration date and indicates the total of the claims accounts.

•	 Suspended Credits Report – The Suspended Credits Report lists any payments or credits that have been 
suspended including the guarantor of the account, date and description of the credit, amount of credit 
and the amount suspended, the balance on the ledger, and the collecting clinic.

•	 Utilization Report – The Utilization Report is designed for use with managed care insurance plans. 
The report lists all procedures that have been completed under selected insurance plans for selected date 
ranges. In addition, you can monitor co-payments versus the practice’s regular fees.

Analysis Reports
In DXOne Reporting, select Analysis, and then double-click an analysis report:

•	 Adjustment Summary Report – With the Adjustment Summary Report, you can review the account 
adjustments applied during a date range in both a numeric and graphic format.

•	 Payment Summary Report – With the Payment Summary Report, you can review the guarantor and 
insurance payments applied during a date range in both a numeric and graphic format.

•	 Practice Analysis Report – The Practice Analysis Report details production and receivable information as 
well as financial agreements and an activity analysis of the patients in your practice.

•	 Production Summary Report – With the Production Summary Report, you can review production by 
procedure code categories for a date range.

•	 Referral Analysis Report – The Referral Analysis Report shows the production, number of patients, 
and percentage of totals associated with a particular referral and includes a breakdown by clinic. Use this 
report to analyze the effectiveness of your advertising dollars by running a single report.

List Reports
In DXOne Reporting, select Lists, and then double-click a list report:

•	 As Soon As Possible (ASAP) List – The ASAP List shows patients that have requested an appointment 
as soon as possible. Select the providers and appointment date to be covered. This is useful for helping to 
keep the appointment list full in case of cancellations. The list includes patient’s name appointment dates, 
time and status, provider, appointment reason, duration of appointment, and the patient’s phone number.

•	 Birthday List – A Birthday List for a selected period can be printed with this report. You can select the 
range of patients and providers to be included and choose to print mailing labels.

•	 Caries Prevalence and Periodontal Index Report – The Caries Prevalence and Periodontal Index Report 
indicates, for various age ranges, how many patients have caries and how many do not, the number of 
patients with certain conditions, and patients’ perio measurements (for example, pocket depths and loss of 
attachment).

•	 Clinical Notes Report – The Clinical Notes Report lists clinical notes for patients. You can also print 
clinical notes from the Clinical Notes window.
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•	 Initial Health History Report – The Initial Health History Report displays the percentage of new oral 
health patients who have a First Visit Date in the Family File that is within a specified time frame and 
who had an initial health history entered into their electronic records during the same time frame. The 
Numerator and Denominator on the report are determined by the ADA and/or condition codes you 
specify.

For example, you may want to track new patients who received a comprehensive oral exam (ADA code 
D0150)—the denominator code—and who have a history of smoking or tobacco use (a condition code; 
for example, 15995)—the numerator code.

•	 Oral Health Education Report – The Oral Health Education Report displays the percentage of oral 
health patients who received oral health education at least once during a specified time frame. The 
Numerator and Denominator on the report are determined by the ADA and/or condition codes you 
specify.

For example, you may want to track patients who received a comprehensive oral exam (ADA code 
D0150) or a periodic recall oral evaluation (ADA code D0120)—the denominator codes—and then 
received oral hygiene instructions (ADA code D1330) or tobacco counseling (ADA code D1320)—the 
numerator codes.

•	 Patient and Inactive Patient List – The Patient/Inactive Patient List displays patients that have been 
entered into Dentrix Enterprise and information about each patient. You can filter the report to include 
patients with no continuing care date and no future appointments, a last visit before a specified date, and 
a specified status.

•	 Periodontal Exam Report – The Periodontal Exam Report displays the percentage of oral health 
patients who received a periodontal exam at least once during a specified time frame. The Numerator and 
Denominator on the report are determined by the ADA and/or condition codes you specify.

For example, you may want to track patients who received a comprehensive oral exam (ADA code 
D0150) or a periodic recall oral evaluation (ADA code D0120)—the denominator codes—and then 
received a periodontal exam (ADA code D0180)—the numerator code.

Audit Reports
In DXOne Reporting, select Audit, and then double-click an audit report:

•	 Audit - Appointments Report – The Audit - Appointments Report details changes made to 
appointments.

•	 Audit - Assigned Rights Report – The Audit - Assigned Rights Report lists any changes made to a user’s 
assigned password rights as well as the user that made the changes.

•	 Audit - Clinics Report – The Audit - Clinics Report lists clinic information that has been inserted, 
modified, and/or deleted.

•	 Audit - Patients Report – The Audit - Patients Report lists patient and medical consultation information 
that has been inserted, modified, and/or deleted.

•	 Audit - Providers and Staff Report – The Audit - Providers/Staff Report lists provider and staff 
information that has been inserted, modified, and/or deleted.

•	 Audit - Transactions Report – The Audit - Transaction Report lists all transaction entries that have been 
changed, deleted, or inserted. Appointment changes and limited patient changes are also included.
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•	 Patient Information Accessed Report – The Patient Information Accessed Report helps you track when 
any patient’s record has been viewed. A patient record is considered to have been viewed in the following 
situations:

•	 When you select a patient in the Select Patient dialog box and then click OK.

•	 When you select a patient in the Select Patient dialog box and then click More Patient Information.

•	 When you double-click a patient’s appointment and then click Patient Info.

•	 When you switch from one module to another (patient-specific modules only) with a patient selected. 
For example, if you open a patient’s Patient Chart and then switch to that patient’s Family File record, 
Dentrix Enterprise logs two entries for the report.

•	 When accessing the same patient record later in the day (in the same module, at the same clinic, on 
the same date, and by the same user after a specified number of minutes has elapsed since the last 
time that patient’s record was accessed).

Each entry on the report provides the date and time when the patient information was accessed, the 
module from which it was accessed, the clinic from which it was accessed, the user who accessed it, and 
the name and chart number of the patient whose record it was.

UDS Reports
In DXOne Reporting, select Audit, and then double-click a UDS (Uniform Data System) report:

•	 UDS - Age / Gender Report – The UDS - Age/Gender Report lists the total of each gender for each age 
group.

•	 UDS - Encounter and User Statistics Report – The UDS - Encounter/User Statistics Report lists the 
number of encounters by provider and procedure code.

•	 UDS - Insurance Financial Class Report (2012 and Prior) – The UDS - Insurance Financial Class 
Report lists the total number of users per financial class type or self-pay (no insurance).

•	 UDS - Insurance Financial Class Report (2013) – The UDS - Insurance Financial Class Report (2013) 
lists the total number of patients who have completed procedures in their records within a specified date 
range.

•	 UDS - Patient Status Report – The UDS - Patient Status Report displays the total the number of 
patients who have completed procedures within a specified date range and who have specified statuses 
(language, race, homeless status, poverty level, religion, and/or worker status) attached to their Family File 
records. The report can also display patient information for the patients on the report.
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Custom Reports
In DXOne Reporting, select Custom, and then double-click a custom report:

•	 Visits by reports – The Visits By reports display the number of visits to an office or clinic by community, 
dentist and facility, and tribal membership. All the procedure(s) for a given patient on a given day in 
the Ledger are counted as one visit. On the report, the first visit, revisit, broken appointment, and PTC 
(planned treatment completed) values are calculated from the IHS condition codes and sometimes the 
ADA codes set up from the Office Manager.

•	 RVU by Provider Report – The RVU by Provider Report indicates, for each provider,  the number of 
services and RVUs (Relative Value Units) at each given level. A total of all providers is also shown at the 
bottom of the report.

•	 OHSS Report – The OHSS Report indicates, for various age ranges, how many patients have caries and 
how many do not, the number of patients with certain conditions, and patients’ perio measurements (for 
example, pocket depths and loss of attachment).

•	 Dentist Activity reports – The Dentist Activity reports display the number of patients seen by each 
provider and the types of treatment given. Also, the report displays the RVUs (relative value units) and 
RVU percentages for the treatment provided. The values on the report are calculated using the IHS 
custom codes and ADA codes set up from the Office Manager.

•	 Dental Hygienists Activity reports – The Dental Hygienists Activity reports display the number of 
patients seen by each secondary provider and the types of treatment given. Also, the report displays the 
RVUs (relative value units) and RVU percentages for the treatment provided. The values on the report are 
calculated using the IHS custom codes and ADA codes set up from the Office Manager.

•	 Endodontic Tooth Access Report – The Endodontic Tooth Access Report displays, for each provider, 
the number of teeth accessed, accessed and completed, accessed and extracted, accessed and restored, and 
accessed and crowned in a specified date range.

The sections that follow explain in more detail how to run these custom reports.

Visits by reports

1.	 Do the first or any of the following:

•	 Click the Job Name search button  if you want to select a job name from a list of available jobs 
and templates to apply the corresponding settings. You can leave the settings that are applied or 
change any of them as needed.
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•	 Select how you want to run the report:

•	 Community – The report will include visits by patients according to the community entered 
in the Current Community field of the Addtional Info dialog box, which can be opened by 
clicking the Additional Info button in the Family File.

•	 The communities will be listed on the report alphabetically; visits for patients without a 
community entered in the Family File will be given as well.

•	 Facility and Dentist – The report will include visits by patients according to the provider and 
clinic assigned to a procedure in the Ledger.

•	 The dentists and clinics will be listed on the report alphabetically.

•	 Tribal Mambership – The report will include visits by patients according to the tribe entered 
in the Tribe of Membership field of the Addtional Info dialog box, which can be opened by 
clicking the Additional Info button in the Family File.

The tribes will be listed on the report alphabetically; visits for patients without a tribe entered in 
the Family File will be given as well.

•	 Set up the following options:

•	 Clinic Selection – Click the search button  to select a clinic(s) from a list of available clinics, 
or select All to include all clinics. 

•	 Provider/Staff Selection – Click the search  button to select a provider(s)/staff from a list of 
available personnel, or select All to include all providers and staff members.

•	 Select Date Range – Select Date Range, and then type a date range in the From and To fields; 
or select Relative Date Range, and then select a date range. The report uses the procedure date of 
Ledger transactions.

Note: Using a relative date range is ideal when saving your report settings as default. Then, you 
don’t have to manually enter a date range each time you run the report.

2.	 Do any of the following:

•	 To save these settings for future uses of this report, click Save as Default.

•	 To schedule the report to run at a later time or on a recurring basis, click Schedule.

•	 To clear any changes you have made to the settings and start over, click Clear Defaults.

3.	 Click OK to preview the report.
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RVU by Provider Report

1.	 Do the first, both, or either of the following:

•	 Click the Job Name search button  to select a job name from a list of available jobs and templates 
to apply the corresponding settings. You can leave the settings that are applied or change any of them 
as needed.

•	 Set up the following options:

•	 Clinic Selection – Click the search button  to select a clinic(s) from a list of available clinics, 
or select All to include all clinics. 

•	 Provider/Staff Selection – Click the search  button to select a provider(s)/staff from a list of 
available personnel, or select All to include all providers and staff members.

•	 Select Date Range – Select Date Range, and then type a date range in the From and To fields; 
or select Relative Date Range, and then select a date range. The report uses the procedure date of 
Ledger transactions.

Note: Using a relative date range is ideal when saving your report settings as default. Then, you 
don’t have to manually enter a date range each time you run the report.

2.	 Do any of the following:

•	 To save these settings for future uses of this report, click Save as Default.

•	 To schedule the report to run at a later time or on a recurring basis, click Schedule.

•	 To clear any changes you have made to the settings and start over, click Clear Defaults.

3.	 Click OK to preview the report.
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OHSS Report

1.	 Do the first, both, or either of the following:

•	 Click the Job Name search button  if you want to select a job name from a list of available jobs 
and templates to apply the corresponding settings. You can leave the settings that are applied or 
change any of them as needed.

•	 Set up the following options:

•	 Survey Code Selection – Click the search  button to select a survey code. These codes are 
supplied by the Department of Health (DOH).

•	 Clinic Selection – Click the search button  to select a clinic(s) from a list of available clinics, 
or select All to include all clinics.

2.	 Do any of the following:

•	 To save these settings for future uses of this report, click Save as Default.

•	 To schedule the report to run at a later time or on a recurring basis, click Schedule.

•	 To clear any changes you have made to the settings and start over, click Clear Defaults.

3.	 Click OK to preview the report. This report prints on three pages with statistics for five age groups:

•	 The age group 2 - 5 years is on the first page.

•	 The age groups 6 - 14 years and 15 - 19 years are on the second page.

•	 The age groups 35 - 44 years and 55 years and older are on the third page.

Be familiar with the following terms before reading this report:

•	 Caries Free – No decayed, missing, or filled teeth

•	 CPITN – Community Periodontal Index of Treatment Needs

•	 Dmfs – Decayed, missing, or filled surfaces on primary teeth

•	 DMFS – Decayed, missing, or filled surfaces on permanent teeth

•	 Dmft – Decayed, missing, or filled primary teeth

•	 DMFT – Decayed, missing, or filled permanent teeth

•	 Dentate – Having teeth (i.e. a patient who does not have a full set of dentures)

•	 Fluorosis – An abnormal condition of the tooth enamel caused by excessive exposure to fluoride

Notes:

•	 The report considers a condition in its calculations only if that condition is marked as existing, existing 
other, or completed. Invalidated conditions are not considered.

•	 The reports is based on the procedure date.

•	 The report considers a patient in its calculations only if that patient has a valid survey code posted on the 
same date. Age group counts are based on patients that have a valid survey code posted.
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Preschool children (2-5 years)

•	 dmfs – The sum of the following:

•	 The total number of primary tooth surfaces with one or more untreated caries conditions (15104, 
15105, 15106, 15107) for every patient in this age group.

•	 The total number of primary tooth surfaces with a restorative code posted for that tooth (D1352, 
D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) for every 
patient in this age group.

The maximum number of filled surfaces per tooth for codes D2930, D2932, D2933, D2934 are as 
follows: 4 surfaces for anterior teeth (c – h, m – r), and 5 surfaces for posterior teeth (a,b,i,j,k,l,s,t).

•	 The total number of primary tooth surfaces that have missing teeth conditions (15100, 15101, 15204 
– 15211) or extraction codes (D7111 – D7250) for every patient in this age group.

The maximum number of surfaces per tooth for missing teeth and extractions are as follows: 4 
surfaces for anterior deciduous teeth (c – h, m – r), and 5 surfaces for posterior deciduous teeth 
(a,b,i,j,k,l,s,t).

Each patient, tooth, and surface combination is counted only once.

•	 dmft – The sum of the following:

•	 The total number of primary teeth with one or more untreated caries conditions (15104, 15105, 
15106, 15107) for every patient in this age group.

•	 The total number of primary teeth with a restorative code posted for that tooth (D1352, D2000 – 
D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) for every patient in 
this age group.

•	 The total number of primary teeth that have missing teeth conditions (15100, 15101, 15204 – 
15211) or extraction codes (D7111 – D7250) for every patient in this age group.

Each patient and tooth combination is counted only once. If a particular patient has both a caries code as 
well as a restorative code for the same tooth, the caries code takes precedence.

•	 Mean dmfs for Max. Incisors & Posterior teeth – The dmfs of primary maxillary incisors (c – h) and 
primary posterior teeth (a, b, i, j, k, l, s, t) for all patients in this age group divided by the number of 
patients in this age group. A surface with an untreated caries code that has been fixed later is counted only 
once. An untreated caries is a surface with an untreated caries code that has not had either a procedure 
that covers the same surface posted after the caries code was
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•	 Percent with history of decay on anterior and posterior teeth and both

•	 History of decay on anterior teeth – The total number of patients with a caries code (15104, 
15105, 15106, or 15107), a missing due to caries code (15204), or restorative code (D1352, D2000 
– D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) on any primary 
anterior tooth (c – h, m – r) divided by the total number of patients in this age group.

Each patient is counted only once.

•	 History of decay on posterior teeth – The total number of patients with a caries code (15104, 
15105, 15106, or 15107), a missing due to caries code (15204), or restorative code (D1352, D2000 
– D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) on any primary 
posterior tooth (a, b, i, j, k, l, s, t) divided by the total number of patients in this age group.

Each patient is counted only once.

•	 History of decay on both anterior and posterior teeth – The total number of patients with a caries 
code (15104, 15105, 15106, or 15107), a missing due to caries code (15204), or restorative code 
(D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) 
on any primary anterior tooth (c – h, m – r) and on any primary posterior tooth (a, b, i, j, k, l, s, t) 
divided by the total number of patients in this age group.

Each patient is counted only once.

•	 Percent with caries history on ≥ 1 maxillary incisors – The total number of patients with a caries code 
(15104, 15105, 15106, or 15107), a missing due to caries  code (15204), or restorative code (D1352, 
D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) on one or more 
primary maxillary incisors (c – h) divided by the total number of patients in this age group.

Each patient is counted only once.

•	 Percent with caries history on ≥ 2 maxillary incisors – The total number of patients with a caries code 
(15104, 15105, 15106, or 15107), a missing due to caries  code (15204), or restorative code (D1352, 
D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999)  on two or more 
primary maxillary incisors (c – h) divided by the total number of patients in this age group.

•	 Percent with caries history on ≥ 1 maxillary incisors OR dmft ≥ 6 (severe ECC) – The total number 
of patients with either of the following: a caries code (15104, 15105, 15106, or 15107), a missing due to 
caries code (15204), or restorative code (D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, 
D6100, D6199 – D7259, D7999) on primary maxillary incisors; or a dmft ≥ 6 divided by the total 
number of patients in this age group.

Each patient is counted only once.

•	 Percent caries free children by individual ages and age cohorts – For each age group (2, 3, 4, 5, 2 – 4, 
3 – 5, 2 – 5), the total number of patients without caries conditions (15104, 15105, 15106, 15107), 
restorative codes (D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, 
D7999), missing teeth conditions (15100, 15101, 15204-15211) or extraction codes (D7111-D7250) 
posted on any primary teeth.

•	 Percent with dmfs > 0

•	 Maxillary incisor decay only – The total number of patients with a caries code (15104, 15105, 
15106, or 15107) on any primary maxillary incisor (c – h) divided by the number of patients in this 
age group.

Each patient is counted only once.

•	 Posterior decay only – The total number of patients with a caries code (15104, 15105, 15106, or 
15107) on any primary posterior tooth (a, b, i, j, k, l, s, t) divided by the number of patients in this 
age group.

Each patient is counted only once.



274     Chapter 9: DXOne Reporting

Dentrix Enterprise 8.0.5 User’s Guide

•	 Posterior and incisor decay – The total number of patients with a caries code (15104, 15105, 
15106, or 15107) on any primary posterior tooth (a,b,i,j,k,l,s,t) or primary maxillary incisor (c – h, 
m – r).

Each patient is counted only once.

Ages 6-14 Years

•	 Percent Caries Free – For each age or age group (6, 7, 8, 9 , 10, 11, 12, 13, 14, 6 – 8, 9 – 11, 12 – 14, 
6 – 14), the following percentages appear:

•	 Primary & Permanent Teeth – The total number of patients without caries conditions (15104, 
15105, 15106, 15107), restorative codes (D1352, D2000 – D4276, D4910, D4999, D6000 – 
D6079, D6100, D6199 – D7259, D7999), missing teeth conditions (15100, 15101, 15204-15211) 
or extraction codes (D7111-D7250) posted on any primary (a – t) and permanent teeth (2 – 15, 18 
– 31) divided by the number of patients in the age group.

Each patient is counted only once.

•	 Permanent Teeth Only – The total number of patients without caries conditions (15104, 15105, 
15106, 15107), restorative codes (D1352, D2000 – D4276, D4910, D4999, D6000 – D6079, 
D6100, D6199 – D7259, D7999), missing teeth conditions (15100, 15101, 15204-15211) or 
extraction codes (D7111-D7250) posted on any permanent teeth (2 – 15, 18 – 31) divided by the 
number of patients in the age group.

Each patient is counted only once.

•	 Percent with  – For each age or age group (6, 7, 8, 9 , 10, 11, 12, 13, 14, 6 – 8, 9 – 11, 12 – 14, 6 – 14), 
the following percentages appear:

•	 Untreated Decay Primary & Permanent Teeth – The total number of patients that have a caries 
condition (15104, 15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, 
D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for 
both for primary and permanent teeth in the age group divided by the number of patients in the age 
group.

Each patient is counted only once.

•	 Untreated Decay Permanent Teeth – The total number of patients with a caries condition (15104, 
15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, D4910, D4999, D6000 
– D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for permanent teeth in the 
age group divided by the number of patients in the age group.

Each patient is counted only once.

•	 Using Tobacco – The total number of patients with a condition code 15203 Tobacco Use in the age 
group divided by the total number of patients in the age group.

Each patient is counted only once.
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•	 Dental Fluorosis – The total number of patients with a condition code 15200 Dental Fluorosis in 
the age group divided by the total number of patients in the age group.

Each patient is counted only once.

•	 Sealants – The total number of patients with a sealant code (D1351) divided by the number of 
patients in the age group.

Each patient is counted only once.

•	 Sealants on 1st Molars – The number of patients with a sealant code (D1351) on tooth numbers 3, 
14, 19, or 30 in the age group divided by the total number of patients in the age group.

Each patient is counted only once.

•	 Sealants on 2nd Molars – The total number of patients with a sealant code (D1351) on tooth 
numbers 2, 15, 18, or 31 in the age group divided by the total number of patients in the age group.

Each patient is counted only once.

•	 Percent with Sealants 1st or 2nd Molars – The total number of patients with a sealant code 
(D1351) on tooth numbers 2, 3, 14, 15, 18, 19, 30, or 31 in the age group divided by the total 
number of patients in the age group.

Each patient is counted only once.

•	 Mean Number of Sealed Teeth – The total number of teeth with a sealant code (D1351) for patients 
in the age group divided by the total number of patients in that age group.

Each patient is counted only once.

•	 Mean dmft/DMFT – The dmft/DMFT of primary/permanent teeth for all patients in the age group 
divided by the total number of patients in the age group.

Each patient and tooth combination is counted only once. If a particular patient has both a caries 
code as well as a restorative code for the same tooth, the caries code takes precedence.

Ages 15-19 Years

•	 Percent with – For each age or age group (6, 7, 8, 9 , 10, 11, 12, 13, 14, 6 – 8, 9 – 11, 12 – 14, 6 – 14), 
the following percentages appear:
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•	 Untreated Decay Primary & Permanent Teeth – The total number of patients that have a caries 
condition (15104, 15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, 
D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for 
both for primary and permanent teeth in the age group divided by the number of patients in the age 
group.

Each patient is counted only once.

•	 Untreated Decay Permanent Teeth – The total number of patients with a caries condition (15104, 
15105, 15106, 15107) but not a restorative code (D1352, D2000 – D4276, D4910, D4999, D6000 
– D6079, D6100, D6199 – D7259, D7999) posted on the same tooth for permanent teeth in the 
age group divided by the number of patients in the age group.

Each patient is counted only once.

•	 Using Tobacco – The total number of patients with a condition code 15203 Tobacco Use in the age 
group divided by the total number of patients in the age group.

Each patient is counted only once.

•	 Dental Fluorosis – The total number of patients with a condition code 15200 Dental Fluorosis in 
the age group divided by the total number of patients in the age group.

Each patient is counted only once.

•	 Sealants – The total number of patients with a sealant code (D1351) divided by the number of 
patients in the age group.

Each patient is counted only once.

•	 Sealants on 1st Molars – The number of patients with a sealant code (D1351) on tooth numbers 3, 
14, 19, or 30 in the age group divided by the total number of patients in the age group.

Each patient is counted only once.

•	 Sealants on 2nd Molars – The total number of patients with a sealant code (D1351) on tooth 
numbers 2, 15, 18, or 31 in the age group divided by the total number of patients in the age group.

Each patient is counted only once.

•	 Percent with Sealants 1st or 2nd Molars – The total number of patients with a sealant code 
(D1351) on tooth numbers 2, 3, 14, 15, 18, 19, 30, or 31 in the age group divided by the total 
number of patients in the age group.

Each patient is counted only once.

•	 Mean Number of Sealed Teeth – The total number of teeth with a sealant code (D1351) for patients 
in the age group divided by the total number of patients in that age group.

Each patient is counted only once.

•	 Mean DMFT – The DMFT of permanent teeth for all patients in the age group divided by the total 
number of patients in the age group.

Each patient and tooth combination is counted only once. If a particular patient has both a caries 
code as well as a restorative code for the same tooth, the caries code takes precedence.

•	 Perio Pockets < 4 mm – The total number of patients with a probing depth (PD or Pocket Depth) 
less than 4 mm for any tooth in the age group divided by the total number of patients in the age 
group.

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted.
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•	 Perio Pockets ≥ 4 mm and < 6 mm – The total number of patients with a probing depth (PD or 
Pocket Depth) greater or equal to 4 mm and less than 6 mm for any tooth in the age group divided 
by the total number of patients in the age group.

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted.

•	 Perio Pockets > 3 mm and < 6 mm – The total number of patients with a probing depth (PD or 
Pocket Depth) greater than 3 mm and less than 6 mm for any tooth in the age group divided by the 
total number of patients in the age group.

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted.

•	 Perio Pockets ≥ 6 mm – The total number of patients with a probing depth (PD or Pocket Depth) 
for any tooth higher than 6 mm in the age group divided by the total number of patients in the age 
group.

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted.

•	 Loss of Attachment < 3 mm – The total number of patients with a clinical attachment level of less 
than 3 mm in the age group divided by the total number of patients in the age group.

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted.

•	 Loss of Attachment ≥ 3 and < 5 mm – The total number of patients with a clinical attachment level 
greater than or equal to 3 mm and less than 5 mm in the age group divided by the total number of 
patients in the age group.

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted.

•	 Loss of Attachment ≥ 5 mm – The total number of patients with a clinical attachment level greater 
than or equal to 5 mm in the age group divided by the total number of patients in the age group.

To be included, a patient must have a perio exam on the same date the selected survey code for the 
report was posted.

•	 Percent with Highest CPITN of 0, 1, 2, 3, 4 –  For each category, the percentage of patients in the 
age groupe that fall into that category divided by the total number of patients in theage group. Which 
category a patient corresponds to comes from his or her perio exam, using the following criteria:

•	 A patient with a probing depth (PD or Pocket Depth) for any tooth higher than 6 mm pertain to 
category 4.

•	 A patient with a probing depth (PD or Pocket Depth) for any tooth of 4 – 6 mm pertain to category 
3.

•	 A patient marked as having only calculus (not set to “0 – None”) and a probing depth (PD or Pocket 
Depth) less than 4 mm for any tooth pertain to category 2.

•	 A patient marked as having only bleeding for any tooth pertain to category 1.

•	 Any remaining patients pertain to category 0.

To be included, a patient must have a perio exam on the same date the selected survey code for the report 
was posted.
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Ages 35-44 & 55+ Years

This section has the same columns as for 15 – 19 year olds plus the following:

•	 Percent with diabetes – The total number of patients with a code 15201 Diabetes in the age group 
divided by the number of patients in the age group for the report. 

Each patient is counted only once.

•	 Percent need biopsy – The total number of patients with the code 15202 Needs Biopsy or biopsy code 
(D7255 – D7258) in the age group divided by the number of patients in the age group.

Each patient is counted only once.

•	 Percent with all 28 teeth – The total number of patients without extractions (existing, existing other, or 
completed) or with extraction codes (D7111 – D7250) for teeth other than wisdom teeth (1, 16, 17, 32), 
and without condition codes (15100 Missing Tooth > 1 year or 15101 Missing tooth) in the age group 
divided by the number of patients in the age group.

Each patient is counted only once.

•	 Percent with 20 or more teeth – The total number of patients with 8 or less missing teeth (not counting 
wisdom teeth) in the age group divided by the number of patients in the age group. A missing tooth 
(15100, 15101) can be posted as an extraction, a condition, or an existing/existing other code.

Each patient is counted only once.

•	 Percent with no natural teeth – The total number of patients missing all 32 teeth int he age group 
divided by the number of patients in the age group. A missing tooth (15100, 15101) can be posted as an 
extraction, a condition, or an existing/existing other code.

Each patient is counted only once.

•	 Percent of dentate adults with untreated decay – The total number of patients who do not have the 
denture codes D5110 and D5120 posted and have untreated decay (any condition code 15104 – 15107) 
in the age group divided by the number or patients in the age group.
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Each patient is counted only once. All teeth are considered.

•	 Percent of dentate adults with root caries – The total number of patients who have the deep dentinal/
cemental caries condition code 15104 posted in the age groupg divided by the number of patients in the 
age group.

Each patient is counted only once. All teeth are considered.

Dentist Activity reports

1.	 Do the first or any of the following:

•	 Click the Job Name search button  to select a job name from a list of available jobs and templates 
to apply the corresponding settings. You can leave the settings that are applied or change any of them 
as needed.

•	 Set up the following options:

•	 Clinic Selection – Click the search button  to select a clinic(s) from a list of available clinics, 
or select All to include all clinics. 

•	 Provider Selection – Click the search  button to select a provider(s) from a list of available 
providers, or select All to include all providers.

•	 Time Periods – Select any of the following to indicate the time periods for which you want to 
run the report:

•	 Monthly – Select a month, and then type a year. The number of services and the RVUs for 
the selected month of the specified year will appear on the report.

•	 Quarterly – Select a quarter, and then type a year. The number of services and the RVUs for 
each month of the selected quarter for the specified year will appear on the report.

•	 Yearly – Type a year. The number of services and the RVUs for each quarter of the specified 
year will appear on the report.

Each selected item will produce a separate report.

2.	 Do any of the following:

•	 To save these settings for future uses of this report, click Save as Default.

•	 To schedule the report to run at a later time or on a recurring basis, click Schedule.

•	 To clear any changes you have made to the settings and start over, click Clear Defaults.
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3.	 Click OK to preview the report. Each report provides the following details for the specified time period:

•	 Services – MTD / Month 1, Month 2, Month 3 / QTR 1, QTR 2, QTR 3, QTR 4

•	 For each provider listed, services performed by that provider are listed under the corresponding 
procedure code categories.

•	 For each service, the number of times that service was performed is given.

•	 For each procedure code category, the number of times all listed services in that category were 
performed is given.

•	 For each provider, the number of times all listed services in all listed categories were performed is 
given.

•	 RVUs

•	 For each provider listed, services performed by that provider are listed under the corresponding 
procedure code categories.

•	 For each service, the number of RVUs is given.

•	 For each procedure code category, the number of RVUs for all listed services in that category is 
given.

•	 For each provider, the number of RVUs for all listed services in all listed categories is given.

•	 Percent RVUs

For each provider listed, the RVU percentage for a procedure code category and for all procedure 
code categories are given:

•	 For each procedure code category, the RVU percentage for all listed services in that category is 
calculated by dividing the number of RVUs in that category by the total number of RVUs for all 
categories with services performed by that provider.

•	 For each provider, the RVU percentage will always equal 100% (it is the sum of the RVU 
percentages of each category for that provider).
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Dental Hygienists Activity reports

1.	 Do the first or any of the following:

•	 Click the Job Name search button  to select a job name from a list of available jobs and templates 
to apply the corresponding settings. You can leave the settings that are applied or change any of them 
as needed.

•	 Set up the following options:

•	 Clinic Selection – Click the search button  to select a clinic(s) from a list of available clinics, 
or select All to include all clinics. 

•	 Provider Selection – Click the search  button to select a provider(s) from a list of available 
providers, or select All to include all providers.

•	 Time Periods – Select any of the following to indicate the time periods for which you want to 
run the report:

•	 Monthly – Select a month, and then type a year. The number of services and the RVUs for 
the selected month of the specified year will appear on the report.

•	 Quarterly – Select a quarter, and then type a year. The number of services and the RVUs for 
each month of the selected quarter for the specified year will appear on the report.

•	 Yearly – Type a year. The number of services and the RVUs for each quarter of the specified 
year will appear on the report.

2.	 Do any of the following:

•	 To save these settings for future uses of this report, click Save as Default.

•	 To schedule the report to run at a later time or on a recurring basis, click Schedule.

•	 To clear any changes you have made to the settings and start over, click Clear Defaults.

3.	 Click OK to preview the report. Each report provides the following details for the specified time period:

•	 Services – MTD / Month 1, Month 2, Month 3 / QTR 1, QTR 2, QTR 3, QTR 4

•	 For each secondary provider listed, services performed by that provider are listed under the 
corresponding procedure code categories.

•	 For each service, the number of times that service was performed is given.

•	 For each procedure code category, the number of times all listed services in that category were 
performed is given.

•	 For each secondary provider, the number of times all listed services in all listed categories were 
performed is given.
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•	 RVUs

•	 For each secondary provider listed, services performed by that provider are listed under the 
corresponding procedure code categories.

•	 For each service, the number of RVUs is given.

•	 For each procedure code category, the number of RVUs for all listed services in that category is 
given.

•	 For each secondary provider, the number of RVUs for all listed services in all listed categories is 
given.

•	 Percent RVUs

For each provider listed, the RVU percentage for a procedure code category and for all procedure 
code categories are given:

•	 For each procedure code category, the RVU percentage for all listed services in that category is 
calculated by dividing the number of RVUs in that category by the total number of RVUs for all 
categories with services performed by that provider.

•	 For each secondary provider, the RVU percentage will always equal 100% (it is the sum of the 
RVU percentages of each category for that provider).
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Endodontic Tooth Access Report

1.	 Do the first, both, or either of the following:

•	 Click the Job Name search button  to select a job name from a list of available jobs and templates 
to apply the corresponding settings. You can leave the settings that are applied or change any of them 
as needed.

•	 Set up the following options:

•	 Clinic Selection – Click the search button  to select a clinic(s) from a list of available clinics, 
or select All to include all clinics. 

•	 Provider/Staff Selection – Click the search  button to select a provider(s)/staff from a list of 
available personnel, or select All to include all providers and staff members.

•	 Select Date Range – Select Date Range, and then type a date range in the From and To fields; 
or select Relative Date Range, and then select a date range. The report uses the procedure date of 
Ledger transactions.

Note: Using a relative date range is ideal when saving your report settings as default. Then, you 
don’t have to manually enter a date range each time you run the report.

2.	 Do any of the following:

•	 To save these settings for future uses of this report, click Save as Default.

•	 To schedule the report to run at a later time or on a recurring basis, click Schedule.

•	 To clear any changes you have made to the settings and start over, click Clear Defaults.

3.	 Click OK to preview the report. The report provides the following details for the specified time period:

•	 For each provider, the tooth categories are listed: anterior teeth for teeth 6 – 11, 22 – 27; first molars 
for teeth 3, 14, 19, 30; other molars for teeth 1, 2, 15 – 18, 31, 32; and premolars for teeth 4, 5, 12, 
13, 20, 21, 28, 29.

•	 For each tooth category, the following statistics are given:

•	 Total Accessed – The number of teeth on which a pulpal debridement has been performed. A 
tooth is counted as accessed if the ADA code D3321 has been posted on that tooth.

•	 Accessed Completed – The number of teeth on which a pulpal dedridement and endodontic 
therapy have been performed. A tooth is counted as accessed and completed if the ADA code 
D3321 and any of the following ADA codes have been posted on that tooth: D3310, D3320, or 
D3330.
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•	 Extracted – The number of teeth on which a pulpal debridement and an extraction have been 
performed. A tooth is counted as accessed and extracted if the ADA code D3321 and any of 
the following ADA extraction codes have been posted on that tooth: D7111, D7140, D7210, 
D7220, D7230, D7240, D7241, D7250.

•	 Restored – The number of teeth on which a pulpal debridement and a restoration have been 
performed. A tooth is counted as accessed and restored if the ADA code D3321 and any 
restorative ADA code that is not a crown procedure included under “Accessed plus Crowned” 
have been posted on that tooth.

•	 Crowned – The number of teeth on which a pulpal debridement and a crown placement has 
been performed. A tooth is counted as accessed and crowned if the ADA code D3321 and any 
of the following ADA codes have been posted on that tooth: D2390, D2710, D2720, D2721, 
D2722, D2740, D2750, D2751, D2752, D2790, D2791, D2792, D2794, D2799, D6058, 
D6059, D6060, D6061, D6062, D6063, D6064, D6094, D6710, D6720, D6721, D6722, 
D6740, D6750, D6751, D6752, D6790, D6791, D6792, D6794, or D6793.

Example scenarios

The following examples explain a few ways tooth counts are calculated for the columns on the report:

•	 The date range of the report is February 1 through February 28. A provider has performed a D3221 on 
tooth 11 on the 2nd and then extracted that same tooth on the 20th. On the report, tooth 11 will be 
counted once in the Total Accessed column and once in the Extracted column.

•	 The date range of the report is February 1 through February 20. A provider has performed a D3221 
on tooth 11 on the 2nd and then a performed a D3310 on the same tooth on the 27th. On the report, 
tooth 11 will be counted once in the Total Accessed column but not in the Accessed Completed column 
because the D3310 code was posted outside of the date range of the report.

•	 The date range of the report is February 1 through February 20. Provider #1 has performed a D3221 on 
tooth 11 on the 2nd, and then Provider #2 performed a D3310 on the same tooth on the 20th. On the 
report, the D3221 will be counted once in the Total Accessed column for Provider #1, and the D3310 
will be counted once in the Accesed Completed column for Provider #2.
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Working with Previewed Reports
When you generate a report from DXOne Reporting, the report appears in the Report Preview window.

You can do any of the following with the report being previewed:

•	 Print reports – To print the displayed report, click the Print Report(s) button on the toolbar. 
The report will be sent directly to the DXOne Reporting printer.

To select a different printer, from the File menu, click Select Printer, select the desired printer, and 
then click Print.

•	 Change the zoom – To change the zoom percentage of the report, from the Zoom list, 
select the desired percentage (the default is 100%).

•	 Navigate between pages – Click the Navigation arrow buttons (Go to First Page, Go to Previous Page, 
Go to Next Page, and Go to Last Page) to navigate 
through a multi-page report.

•	 Search for text – Click the Search Text button to search the report for a string of text.

•	 Save the report – To save the report, from the File menu, click Save Report, type the name you want 
to save it as, browse to and select the desired location, and then click Save.
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Using Report Templates
You can have multiple templates for the custom IHS reports. For eachof these reports, you can select a 
template (a Job Name) to run that report without having to change the options for filtering the report 
when certain variations of the report are frequently required. Also, if an existing scheduled job or template is 
changed, it can be saved as a different template or job while preserving the original.

Creating a Report Job Template
You can create a template for running a custom IHS report.

To create a report job template

1.	 On the Office Manager toolbar, click the DXOne Reports button .

The DXOne Reporting window appears.

2.	 In the Select Report Category list box, select Custom.

The custom reports appear in the right list box.

3.	 Double-click the report for which you want to create a template.

The corresponding report dialog box appears.

4.	 Set up the options for filtering the report results.

5.	 Click Save as Default to save the current settings for future uses of the report.
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6.	 Click Schedule.

The Scheduling Report dialog box appears.

7.	 Under Recurrence pattern, select Template Only to indicate that the report job will serve as a template.

8.	 Type a Job Name for the report job (up to 50 characters in length). The job name will be visible for the 
scheduled report job in the Manage Scheduled Jobs dialog box.

9.	 Click Schedule to save the report job as a template and schedule the report job. The report job will 
appear in the Manage Scheduled Jobs dialog box.

Scheduling a Report Job from a Template
You can schedule a report job from a template for an IHS custom report.

To schedule a report job from a template

1.	 On the Office Manager toolbar, click the DXOne Reports button .

The DXOne Reporting window appears.

2.	 In the Select Report Category list box, select Custom.

The custom reports appear in the right list box.
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3.	 Double-click the report you want to schedule from a template.

The corresponding report dialog box appears.

4.	 Select a template:

a.	 Click the Job Name search button. The search button is only enabled if templates have been created 
or jobs have been schedule for this report.

The Select Template/Job dialog box appears. Any existing templates/jobs that have been created for 
the report by the user you are currently logged on as are shown in the list box.

b.	 Select List Jobs for all users if you want to view templates for all users for this report. If this option is 
selected, a User ID column appears to the left of the Job Name column and displays the user ID for 
each job/template. The List Jobs for all users check box is available only if the current user has the 
“Scheduled Jobs – Manage All Users” DXOne Reporting security right enabled; in other words, the 
current user has rights to view reports or jobs for other users.

c.	 The templates are listed alphabetically in ascending order by default. To reverse the order, click the 
Job Name column header of the list box. Then, to change the order from descending to ascending, 
click the list box’s Job Name column header again.
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d.	 Select the appropriate report job template in the list box (if more templates exist than can be 
displayed at one time in the list box, you might have to click and drag the list box’s scroll bar slider 
down to find the template). Or, type all or part of the template name for which you want to search in 
the Enter Job Name field, click the search button to show the closest matching template(s) in the list 
box, and then select the appropriate report job template.

e.	 Click OK to assign the selected template to the report job. The filter options associated with the 
selected template are applied to the report job.

5.	 Click Save as Default to save the current settings for the next time the report options are accessed. The 
current job name will not be saved as the deafult.

6.	 Click OK to schedule the report. The report job will appear in the Manage Scheduled Jobs dialog box.

Editing a Report Job Template
You can edit a report job template for an IHS custom report.

To edit a report job template

1.	 From the Office Manager toolbar, click the DXOne Reports Module button .

The DXOne Reporting window appears.

2.	 In the Select Report Category list box, select Custom.

The custom reports appear in the right list box.

3.	 Double-click the report you want to schedule from a template.

The corresponding report dialog box appears.
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4.	 Select a template:

a.	 Click the Job Name search button. The search button is only enabled if templates have been created 
or jobs have been schedule for this report. The Select Template/Job dialog box appears. Any existing 
templates/jobs that have been created for the report by the user you are currently logged on as are 
shown in the list box.

b.	 Select List Jobs for all users if you want to view templates for all users for this report. If this option is 
selected, a User ID column appears to the left of the Job Name column and displays the user ID for 
each job/template. The List Jobs for all users check box is available only if the current user has the 
“Scheduled Jobs – Manage All Users” DXOne Reporting security right enabled; in other words, the 
current user has rights to view reports or jobs for other users.

c.	 The templates are listed alphabetically in ascending order by default. To reverse the order, click the 
Job Name column header of the list box. Then, to change the order from descending to ascending, 
click the list box’s Job Name column header again.

d.	 Select the appropriate report job template in the list box (if more templates exist than can be 
displayed at one time in the list box, you might have to click and drag the list box’s scroll bar slider 
down to find the template). Or, type all or part of the template name for which you want to search in 
the Enter Job Name field, click the search button to show the closest matching template(s) in the list 
box, and then select the appropriate report job template.

e.	 Click OK to assign the selected template to the report job. The filter options associated with the 
selected template are applied to the report job.

5.	 Edit the options for filtering the report results as necessary.

6.	 Click Save as Default to save the current settings for the next time the report options are accessed. The 
current job name will not be saved as the deafult.

7.	 Click Schedule. The Schedule Report - Edit dialog box appears.
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8.	 Edit the Job Name.

9.	 Do one of the following:

•	 Click Save to save any changes to the template (its job name and report filters).

•	 Click Schedule New to save the changes as a new report job that will appear in the Manage 
Scheduled Jobs dialog while preserving the original template (its job name and report filters). The 
new job name must be different than the original to add the template as a new template.
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Chapter 10: Document Center
The Document Center can help your office become paperless. You can scan, capture, and import documents 
(such as patient letters, EOBs, and referral letters) and images (such as patient pictures and X-rays). You can 
then attach these documents to patients, providers, employers, insurance plans, and referral sources. Also, 
these documents can be printed, emailed, or sent electronically (for claims).

A document in the Document Center can be a document file type (TXT, RTF, DOC, DOCX, and PDF), an 
image file type (BMP, GIF, JPG, PNG, and TIF), a slide show presentation file type (PPT), or a spreadsheet 
file type (XLS or XLSX).

This chapter covers the following topics:

•	 Opening the Document Center

•	 Using the Document Center Window

•	 Setting up the Document Center

•	 Acquiring Documents and Images

•	 Using the Document Center Printer Driver

•	 Importing Unfiled Documents

•	 Entering Document Information

•	 Working with Documents

•	 Signing Documents

•	 Signing Consent Forms

•	 Printing and Exporting Documents

Opening the Document Center
You can open the Document Center from the Family File, Ledger, Chart, Appointment Book, Treatment 
Planner, Collections Manager, and Office Manager.

To open the Document Center

In a Dentrix Enterprise module, from the File menu, click Document Center. (In the Treatment Planner, 
from the File menu, point to Switch To, and then click Document Center.)

When opened from the Family File, Ledger, Chart, Appointment Book, Treatment Planner, or Collections 
Manager, the Document Center displays the selected patient’s attached documents. When opened from the 
Office Manager, the Document Center gives you the option to select a provider to view his or her attached 
documents.
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Using the Document Center Window
The Document Center window consists of a menu bar, toolbars, a document tree, a document thumbnails 
pane, a document preview area, and a document notes pane.

Document Thumbnails Document Preview Area

Document Tree Document Notes

Menu Bar Toolbars

This section covers the following topics to help you understand how to use the Document Center window:

•	 Using the Document Tree

•	 Using the Document Thumbnails

•	 Using the Document Preview Area

•	 Using the Document Center Toolbars

•	 Viewing Documents

Using the Document Tree
The document tree displays the document source (patient, provider/
staff, employer, referral, or insurance), the document types in use under 
that source, and the documents associated with each of those types. 
The plus (+) or minus (-) sign next to a document type folder indicates 
whether the list item is expanded or collapsed. Click the plus sign to 
view the contents of the document type folder. Click the minus sign to 
hide the contents of the document type folder. The document tree is 
where you will select documents for viewing, editing, printing, and so 
forth.
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Using the Document Thumbnails
For a selected document, thumbnails (miniature images) may appear for each page of the 
imported document. Click any of the thumbnails to preview the corresponding page. If you 
want to view an OLE document (one that has been imported using Object Linking and 
Embedding), you must have the appropriate program or viewer installed on the computer 
(for example, Microsoft Word is required to view a DOC file).

Using the Document Preview Area
The document preview area displays the document selected 
in the document tree. If the document has multiple pages, 
the Document Center displays the first page initially, but 
depending on the type of document or image, you can 
view the other pages by clicking a thumbnail, by clicking 
the Previous Page and Next Page buttons on the preview 
toolbar, or by scrolling.

Using the Document Center Toolbars
The Document Center includes toolbars with buttons to access certain areas or features of Dentrix Enterprise. 
The toolbars specific to the Document Center and some of the available buttons are explained in the following 
table.

Patient Information Toolbar

Click the Select Patient button to open the Select Patient dialog box and select a patient to 
view in the Document Center.

Acquire Toolbar

Click the From Device button to acquire documents from a WIA- or TWAIN-compliant 
device, such as a digital camera or scanner.  You can also click the down arrow to select the 
acquisition source.

Click the Import From File button to copy a file from your computer’s hard drive, removable 
media, or another computer on the network into the Document Center.

Click the Paste From Clipboard button to create a document from text and/or graphics on the 
Windows Clipboard.

Click the Unfiled Documents button to import an unfiled document to the Document Center 
of the patient, provider, employer, referral, or insurance plan currently being viewed.
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Document Toolbar

Click the Print Document(s) button to send the selected documents to a printer.

Click the Send Document(s) button to compose an email message to send to a patient, 
provider, employer, referral, or insurance plan with any selected documents included as 
attachments.
Click the Export Document(s) button to save a copy of the selected documents in an alternate 
location (for example, a USB drive).
Click the Document Information button to view or change the date, type, description, or 
notes of the selected document.
Click the Modify Document Attachments button to change the source to which the selected 
document is attached.

Click the Sign Document button to sign the selected document.

Click the Modify Document button to change the color of, crop, rotate, or add a page to the 
selected document.

Click the Delete Selected Document(s) button to delete the selected documents.

View Toolbar

Click the Expand List button to expand all the document type folders to view their contents in 
the document tree.

Click the Collapse List button to hide all the document type folders in the document tree.

Click the By Single button to view documents of the selected patient, provider, employer, 
referral, or insurance plan.

Click the By Family button to view documents of the selected patient’s family. This button is 
available only if a patient is selected.

Click the Filters button to filter the types of documents being viewed and to view documents 
within a specified date range.

Click the Show Preview button to show and hide document preview area.

Click the By Patient button to view the documents of a patient you select.

Click the By Provider/Staff to view the documents of a provider you select.
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Viewing Documents
In the Document Center, you can view documents by patients, family, providers/staff, employers, referrals, 
and insurance plans. You can also apply filters to view documents acquired within a certain date range and 
assigned a certain document type.

To change the view

In the Document Center, from the View menu, click one of the 
following options:

•	 By Patient – A dialog box appears, allowing you to select a patient.

•	 By Provider/Staff – A dialog box appears, allowing you to select a 
provider or staff member.

•	 By Employer – A dialog box appears, allowing you to select an employer.

•	 By Referred BY – A dialog box appears, allowing you to select a referral.

•	 By Referred TO – A dialog box appears, allowing you to select a referral.

•	 By Dental Insurance Plan – A dialog box appears, allowing you to select a plan.

•	 By Medical Insurance Plan – A dialog box appears, allowing you to select a plan.

•	 By Single – To view documents of the selected patient, provider, employer, referral, or insurance plan.

•	 By Family – To view documents of the selected patient’s family. This option is available only if a patient is 
selected.

To filter the list in the document tree

1.	 From the View menu, click Filters.

The View By [Source] Filter (the name varies, depending on 
the selected view) dialog box appears.

2.	 Set up the following options:

•	 Select Document Types – Select the document 
types you want to view, or select All Document 
Types to view all types.

•	 Include Documents Attached To – Select the 
sources for which you want to view attached 
documents.

•	 Reference Date – Enter a date range in the 
From and To fields to view documents that were 
acquired during the specified range; select All 
Dates for both From and To to view documents 
regardless of the acquisition date; or enter a date 
for either From or To, and select All Dates for the 
other option to use an open-ended date range.

•	 Save as default – To save the current filter settings 
for the next time you open the Document Center, 
select this check box.

3.	 Click OK.

1

2

3
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Setting up the Document Center
This section covers the following topics about what to set up before you start using the Document Center:

•	 Selecting a Document Center Printer

•	 Customizing Document Types

Selecting a Document Center Printer
You can print documents, images, and the Document Center List. Select the printer you want to use for 
printing from the Document Center.

To select a printer

1.	 In the Document Center, from the Setup menu, click 
Printer.

The Printer Setup dialog box appears.

2.	 Set up the following options:

•	 Select Printer – From the list, select the printer you 
want to use.

•	 Picture Scaling – Select how you want the Document 
Center to scale images when printing:

•	 Fit to Page – To fit the image on a single page.

•	 1/3 Page – To have the image scaled to fit on 1/3 of 
a page.

•	 Actual Size – To print the image in the actual size 
that it was imported.

•	 Include Footers – To include footers on a printed page, 
select this check box. The information in the footer will vary slightly based on the Document Center 
source selected (patient, provider/staff, employer insurance plan, or referral) but may include the 
reference date, the patient’s last name, first name, middle initial, preferred name, and chart number, 
and the page number.

3.	 Click OK.

1

2

3
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Customizing Document Types
All documents in the Document Center must be assigned to a document type. These types are used to 
categorize as well as describe the type of document. You can add, edit, and delete document types as needed if 
the pre-set ones do not meet your practice’s needs.

To customize a document type

1.	 In the Document Center, from the Setup menu, click 
Document Types.

The Document Types Setup dialog box appears.

2.	 Perform any of the following functions:

•	 Add – Type a unique description for the type you 
want to add, and then click Add.

•	 Change – Select the type you want to change, 
type a new description, and then click Change.

•	 Delete – Select the type you want to delete (it 
cannot be assigned to a signed document), and 
then click Delete.

3.	 Click Close.

Acquiring Documents and Images
You can acquire documents or images from various sources:

•	 A device – You can acquire documents and images from WIA- or TWAIN-compliant scanners and 
cameras.

•	 A file – You can import documents and images of the following file types: PDF, DOC, DOCX, XLS, 
XLSX, PPT, BMP, GIF, JPG, PNG, TIF, TXT, and RTF.

When you import from a file, the Document Center will create a single-page document. For instructions 
on how to add pages to a document, see “Modifying Documents” in this chapter.

•	 The Windows Clipboard – You can save the most recent contents of the Windows Clipboard as a 
document in the Document Center.

To acquire a document or image

In the Document Center, from the Acquire menu, do one of the 
following:

•	 Point to From Device, and then click the appropriate device. The 
corresponding third-party program opens. Select the documents or 
images you want to acquire, and follow the program’s instructions 
for acquiring the document or image. The specific steps to 
complete this process depend on the device that you are using.

•	 Click Import from File. The Import dialog appears. Locate the directory where the file is stored, select 
the desired file, and then click Open.

•	 Click Paste from Clipboard. If nothing is on the Windows Clipboard, this option is not available.

When the acquisition is complete, the Document Information dialog box appears. Enter the appropriate 
document information as explained in “Entering Document Information” in this chapter.

1

3

2
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Using the Document Center Printer 
Driver
The Document Center printer driver is installed automatically with Dentrix Enterprise. This printer driver 
allows you to save a PDF copy of a document from another program on the computer without having any 
Dentrix Enterprise modules open. For instance, you can save the contents of a Web page as a PDF in the 
Document Center.

To print to the Document Center

1.	 Use the “Print” option from a program that allows printing 
(for example, in your browser, with a Web page being viewed, 
right-click anywhere on that page, and then click Print).

A Print dialog box appears (the look and 
functionality may vary).

2.	 From the list of available printers, select Send 
to Dentrix Document Center, and set up any 
other options as needed.

3.	 Click Print. If you are not already logged in to 
Dentrix Enterprise, a login dialog box appears.

4.	 Enter your credentials, and then click Sign In.

When the acquisition is complete, the Document 
Information dialog box appears. Enter the appropriate 

document information as explained in “Entering Document Information” in this chapter.

1

2

3
4
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Importing Unfiled Documents
You can acquire documents and images, add them to the Document Center as unfiled documents, and then 
assign them to patients, providers, referrals, employers, and/or insurance plans at a later time. While you can 
import a single document as an unfiled document, this feature is intended to allow you to import batches of 
documents and multi-page image documents.

A document becomes unfiled in the following scenarios:

•	 If you print with the Document Center Printer Driver from another program without attaching the 
document by clicking Modify Attachments.

•	 If you acquire a new document from a file, a device, or the Windows Clipboard while in the Document 
Center Unfiled Documents window.

•	 If you remove all attachments from a document.

To import an unfiled document

1.	 In the Document Center, from the Acquire menu, click 
Unfiled Documents.

The Document Center Unfiled Documents window appears.

For information about the features of the Document Center 
Unfiled Documents window, see the “Working with unfiled 
documents” topic in the Dentrix Enterprise Help.

2.	 Drag a document from the Document Center Unfiled Documents 
window to the document tree in the Document Center for the selected 
patient, provider/staff, employer, referral, or insurance plan.

When the acquisition is complete, the Document Information dialog 
box appears. Enter the appropriate document information as explained in 
“Entering Document Information,” which follows.

1

2
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Entering Document Information
Once the document has been captured, scanned, imported, or pasted into the Document Center, the 
Document Information dialog box appears so that you can attach information and categorize the document.

To enter the document information

1.	 In the Document Information dialog box, set up the following options:

•	 Reference Date – By default, the 
date of the document is the current 
system date, but you can change 
it as needed. This date will appear 
for this document in the document 
tree and when it is printed. 

•	 Document Type – Select the type 
you want to assign the document.

•	 Description – Type a description 
for the document. This description 
will appear for this document in 
the document tree and be used 
as a file name for the document 
when the document is exported or 
attached to an email message.

•	 Note – Type any pertinent notes 
regarding the document. The note 
text will be appended automatically 
to the text of an email message with this document attached, and you can view the note when 
previewing this document.

•	 Modify Attachments – To associate the document with a patient, provider/staff, employer, insurance 
plan, and/or referral other than the current patient, provider/staff, employer, insurance plan, or 
referral currently being viewed in the Document Center, click this button. For more information 
about document sources, see “Modifying Document Attachments” in this chapter.

Note: If you are acquiring from the Document Center printer driver or the Document Center 
Unfiled Documents window, by default, the document does not have any attachments associated with 
it.

2.	 Click OK.

Working with Documents
This section covers the following topics about working with documents:

•	 Editing Document Information

•	 Modifying Document Attachments

•	 Deleting Documents

•	 Modifying Documents

1

2
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Editing Document Information
You can edit the date, type, description, note, attachments, and signatures assigned to a document as long as 
the document has not been signed. Once a document has been signed, you cannot change that document’s 
date, type, description, or note, but you can attach more sources to it.

To edit document information

1.	 In the Document Center document tree, select the 
document that has information you want to edit.

2.	 From the Edit menu, click Document Information.

The Document Information dialog box appears.

3.	 Make the 
necessary changes 
to any of the 
options. For 
details about each 
available option, 
see “Entering 
Document 
Information” in 
this chapter.

4.	 Click OK.

1

2

4
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Modifying Document Attachments
You can modify attachment sources for a specific document. You can associate a document with a patient, 
provider/staff, employer, dental insurance plan, medical insurance plan, inbound referral, and/or outbound 
referral. Also, you can assign additional sources to a document that has been signed.

To modify a document’s attachments

1.	 In the Document Center document tree, select a document.

2.	 From the Edit menu, click Modify Document Attachments.

The Modify Document Attachments dialog box appears.

3.	 Make the necessary changes:

•	 Attach Document By – Click the search button  next to each 
source to which you want to attach the document. In the dialog box 
that appears, make a selection. For example, if you click the Patient 
search button, the Select Patient dialog box appears, so you can 
select a patient. You can have only one selection per source.

•	 Remove Attachment – To remove an attachment source, select it in 
the Document Attachments list box, 
and then click Remove Attachment.

Tip: To view the signatures attached to a 
document, click Document Signatures. 
This button is available only if the 
document has one or more electronic 
signatures.

4.	 Click Close.

1

2

4

3 OR 3

Deleting Documents
You can delete a document that has not been signed. Dentrix Enterprise will not delete the original document 
from the computer but will remove it from the Document Center.

To remove a document

1.	 In the Document Center document tree, select the document you 
want to delete.

2.	 From the Edit menu, click Delete Selected Document(s).

Do one of the following:

•	 If the document has multiple attachment sources, a dialog box 
appears. Select whether you want to delete the document for only the 
current attachment source being viewed in the Document Center or 
delete the document for all attachment sources, and then click OK.

•	 If the document is attached to only the source being viewed in the 
Document Center, a confirmation message appears. Click OK.

1

2
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Modifying Documents
With the Document Center, you can add pages to, make color adjustments to, crop, sharpen, rotate, and 
assign an orientation to a document being previewed. You can make these modifications only to unsigned 
documents of an image file type (BMP, GIF, JPG, PNG, or TIF).

To modify a document

1.	 In the Document Center document tree, select the document you 
want to modify.

2.	 From the Edit menu, click Modify Document (the icon next to 
this menu item is highlighted if the document is already in modify 
mode).

The Modify Document toolbar appears at the top of the preview area.

3.	 If the document being previewed has multiple pages, select the page 
you want to edit.

Tip: You can click the Previous Page or Next Page button on the 
Preview toolbar to navigate between the pages of a multi-page 
document.

4.	 Make any necessary changes to the document. The function of each button on the Modify Document 
toolbar is explained in the following table.

Click the Add Page button to import an image as another page of the image being previewed.

Click the Delete Page button to delete the selected page of the image being previewed.

Click the Image Adjustments button to adjust the sharpness, saturation, contrast, and/or 
brightness of the image being previewed.

Click the Crop Image button to crop the image being previewed to the area you select.

Click the Invert Colors button to invert the colors of the image being previewed.

1

2

4

3
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Click the Convert To Grayscale button to change the image being previewed to a grayscale 
image.

Click the Remove Spots button to sharpen the image being previewed.

Click the Rotate button to rotate or flip the image being previewed.

Click the Orientation button to specify the point of view used to acquire the image being 
previewed. Click <None>, No Orientation, Right Side of Mouth, Left Side of 
Mouth, Entire Mouth, Inner, or Outer. A watermark appears in the lower-right 
corner of the document to indicate the orientation of the document: R for right 
side, L for left side, M for mouth, I for inner, O for outer. 

Click the Undo button to undo the last operation performed on the image being modified.

Click the Undo All button to undo all edits made to the image being modified since the last 
time it was saved.

Signing Documents
You can apply signatures to a document attached only to patients, providers, and/or staff. You can apply a 
signature to a document for each patient, provider, or staff member attached to the document.

Important: Once a document has been signed, you cannot change the document information, but you can 
attach the document to additional sources.

To sign a document

1.	 In the Document Center document tree, select the document you 
want to sign.

2.	 From the Edit menu, click Sign Document. (This option reads, “View 
Signatures,” if the selected document already has at least one signature.)

The Sign Document dialog box appears.

3.	 The Name field automatically displays the patient, provider, or staff 
member selected in the Document Center, but you can change the name 
as needed.

4.	 Use a mouse or other supported device to add your signature in the 
Signature box. If you need to erase 
the signature so that you can re-sign, 
click Clear.

5.	 Click OK.

1
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Signing Consent Forms
If you are viewing the Document Center of a patient who has consent forms in the Treatment Planner, the 
“Treatment Planner Consent Form” document type folder appears in the document tree.

The patient and/or provider can sign a consent form from the Document Center. Also, as with other 
document types, you can only edit unsigned consent forms.

To sign a consent form

1.	 In the Document Center document tree, select the consent 
form you want to sign.

2.	 From the Edit menu, click Modify Document.

3.	 Type the name of the patient and provider or staff member 
in the appropriate Name fields.

4.	 Use a mouse or other supported device to add the 
signatures in the Signature boxes. If you need to erase a 
signature so that you can re-sign, click Clear.

5.	 From the Edit menu, click Modify Document to save the 
signatures.

1
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Printing and Exporting Documents
The Document Center provides the following ways to print or export documents:

•	 Print the Document Center List – The Document Center List consists of the contents in the document 
tree for the current view. It will list all attached documents, according to the filters selected. In the 
Document Center, from the File menu, point to Print, and then click Document Center List.

•	 Print documents – You can print a specific document or multiple documents. In the Document Center 
document tree, select the documents you want to print. Then, from the File menu, point to Print, and 
then click Print Document(s).

•	 Send documents – You can send a document or multiple documents electronically as email attachments. 
In the Document Center document tree, select the documents you want to send. Then, from the File 
menu, click Send Document(s).

Tip: HIPAA constraints make it unwise for you to include patient information and provider/practice 
information within the same message for security/privacy. Be mindful of this when sending documents 
through email.

•	 Export documents – You can export documents to your computer’s hard drive, a shared network 
location, or any removable media or hard drive. In the Document Center document tree, select the 
documents you want to export. Then, from the File menu, click Export Document(s).

•	 Attach documents to insurance claims – For instruction on how to attach Document Center documents 
to a dental insurance claim, see “Including Attachments with Dental Insurance Claims” in Chapter 7: 
Ledger.



Chapter 11: Other Features    315

Dentrix Enterprise 8.0.5 User’s Guide

Chapter 11: Other Features
Dentrix Enterprise provides the following additional features:

•	 Sending Email Messages

•	 Quick Labels

•	 Quick Letters

•	 Continuing Care

•	 Patient Questionnaire

•	 Prescriptions

•	 Patient Alerts

•	 Office Journal

•	 Collections Manager

Sending Email Messages
If you have email access, you can create and send email messages to patients quickly.

To send an email message to a patient

Do one of the following:

•	 In the Family File, with a patient selected, from the File menu, click Send Message.

•	 In the Appointment Book, with a patient’s appointment selected, from the File menu, click Send 
Message.

•	 In the Document Center, with a patient selected, from the File menu, click Send Document(s).

•	 In the Treatment Planner, with a patient selected, point to Switch To, and then click Send Message.

Your email program opens so that you can compose and send a message.

Note: The patient’s email address, if one has been entered in the Family File, appears in the To field. However, 
if no email address has been added for the patient, you can type an address in the To field.
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Quick Labels
With Quick Labels, you can take advantage of the integration of Dentrix Enterprise with Microsoft Word to 
quickly create a label for a single patient.

To print a quick label

1.	 In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Quick Labels. The Quick Labels dialog 
box appears.

2.	 Select the label you want to print:

•	 Patient Mailing Label – A mailing label for the selected 
patient.

•	 Guarantor Mailing Label – A mailing label for the 
selected patient’s head-of-house.

•	 Patient Chart Label – A chart label for the selected 
patient, including his or her name, chart number, home 
phone, work phone, and address.

•	 Abbreviated Chart Label – A chart label for the selected 
patient, including his or her name (in large, bold letters), 
SS#, date of birth, first visit date, chart number, home 
phone, and work phone in a condensed format.

•	 Detailed Chart Label – A chart label for the selected 
patient, including his or her name (in large, bold letters), SS#, date of birth, primary provider, chart 
number, first visit date, marital status, gender, address, home phone, work phone, employer, primary 
insurance, and secondary insurance.

•	 Primary Dental Insurance Label – A mailing label addressed to the patient’s primary dental 
insurance plan (if set up in the Family File).

•	 Secondary Dental Insurance Label – A mailing label addressed to the patient’s secondary dental 
insurance plan (if set up in the Family File).

•	 Primary Medical Insurance Label – A mailing label addressed to the patient’s primary medical 
insurance plan (if set up in the Family File).

•	 Secondary Medical Insurance Label – A mailing label addressed to the patient’s secondary medical 
insurance plan (if set up in the Family File).

•	 Referring Patient Label – A mailing label addressed to the patient who referred the patient to the 
practice (if set up in the Family File).

•	 Referred By Dr/Other Label – A mailing label addressed to the doctor who referred the patient to 
the practice (if set up in the Family File).

•	 Referred To Doctor Label – A mailing label addressed to the doctor that the patient has been 
referred to (if set up in the Family File).

•	 Appointment Reminder Label – A reminder label listing the patient’s next appointment date and 
time.

3.	 Click Print to print the selected label. For information about setting up a label printer for labels, see 
“Setting Up Default Printers” in Chapter 1: Introduction and Initial Setup.

1

2
3



Chapter 11: Other Features    317

Dentrix Enterprise 8.0.5 User’s Guide

Quick Letters
With Quick Letters, you can take advantage of the integration of Dentrix Enterprise with Microsoft Word to 
quickly create a letter for a single patient.

To merge a quick letter

1.	 Open and minimize Microsoft Word.

2.	 In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Quick Letters. The Quick Letters dialog 
box appears.

3.	 Select the letter you want to merge:

•	 Address On Envelope (Form Feed) – An 
envelope for the selected patient.

•	 Blank Letter Form –A blank letter for the 
selected patient with his or her name, address 
and greeting.

•	 Collection Notification – A 90 Day Past Due 
letter for the selected patient.

•	 Congratulations – Graduation – A 
congratulations letter for a new graduate.

•	 Congratulations – Marriage – A 
congratulations letter for a newly married 
patient.

•	 Congratulations – New Baby – A congratulations letter for a new parent.

•	 New Patient Welcome – A welcome letter for a new patient.

•	 Patient Information – Consent – A patient information form with some patient information pre-
entered.

•	 Referred by Doctor – A thank you letter for a doctor who referred the patient.

•	 Referred by Patient – A thank you letter for a patient who referred the selected patient.

•	 Referred to Doctor – A referral information letter for the doctor to whom the selected patient has 
been referred.

4.	 Do one of the following:

•	 To create and print the letter without reviewing it, click Print.

•	 To create and review the letter in Microsoft Word prior to printing it, click Build/View.

Note: Dentrix Enterprise adds an entry in the Office Journal that indicates a letter has been sent to the 
patient.
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Continuing Care
The Continuing Care module in Dentrix Enterprise is an up-to-date, flexible, and powerful means for 
monitoring your patients’ pending dental care (recall or recare). The following is a short list of the advantages 
the continuing care system can bring to your office:

•	 Multiple Recall Types – You can create as many continuing care types as needed.

•	 Continuing Care Cards – You can efficiently create continuing care reminder cards for patients with and 
without appointments to maintain communication with your patients.

•	 Individualized Continuing Care – Each patient can have specific continuing care defaults, such as 
intervals and providers.

•	 Simplicity of Scheduling – Dentrix Enterprise helps you schedule continuing care for patients. By 
attaching the appropriate continuing care type to an appointment, the appointment automatically has the 
correct provider and amount of time needed.

•	 Increased Tracking Ability – You can use continuing care to track not only exams and cleanings but 
patient statuses or activities, such as treatment plans. For example, you enter a treatment plan and assign 
it a continuing care type, which has a call back date. If the patient has not completed the treatment plan 
when the call back interval has lapsed, he or she appears on the continuing care list so that you can follow 
up with that patient to get an appointment scheduled.

The continuing care system is quite powerful, but there are two keys to using it effectively:

•	 Knowledge – Because the continuing care system is so flexible, it will require you to learn how it works to 
make it work for you.

•	 Time – It will take time to set up the continuing care system. Take the time now to get the system in 
place, and the benefits down the road will be well worth the effort.

This section covers the following topics about the Continuing Care module:

•	 Getting Started with Continuing Care

•	 Opening Continuing Care

•	 Using the Continuing Care List

•	 Printing from Continuing Care
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Getting Started with Continuing Care
Before you start using the Dentrix Enterprise continuing care system, you must do some setup to get your 
continuing care program up and running.

To get started with continuing care

1.	 Set up the continuing care type defaults.

Take some time to sit down as an office and define what is to be tracked. Then, add or modify existing 
continuing care types to meet the needs of your practice. For details about continuing care types, see 
“Setting Up Continuing Care Types” in Chapter 1: Introduction and Initial Setup.

2.	 Assign continuing care types to procedures.

Dentrix Enterprise can automatically assign continuing care types to patients when they have certain 
procedures completed. Additionally, Dentrix Enterprise will automatically update continuing care 
due dates when those procedures are completed. You will need to assign continuing care types to the 
procedures you want to use in this manner. For details about procedure codes, see “Editing Procedure 
Codes” in Chapter 1: Introduction and Initial Setup.

3.	 Customize your Continuing Care view.

Your practice will have a specific way to organize or sort your list of continuing care patients. You can set 
up Continuing Care views to create many different ways of looking at the continuing care information. 
For details about Continuing Care views, see the “Managing Continuing Care views” topic in the Dentrix 
Enterprise Help.

4.	 Customize patient continuing care defaults.

For the next few months, when a patient schedules a continuing care appointment, take a minute to set 
up his or her continuing care defaults in the Family File. Theoretically, within six months, you will have 
set the continuing care defaults for every active patient in your continuing care program. For details about 
assigning continuing care to patients, see “Assigning Continuing Care” in Chapter 2: Family File, and see 
the “Overriding continuing care defaults” topic in the Dentrix Enterprise Help.

5.	 Attach continuing care to appointments.

From this point forward, when a patient schedules a continuing care appointment, make sure you attach 
the appropriate continuing care type to the appointment. For details about continuing care appointments, 
see “Scheduling Appointments” in Chapter 3: Appointment Book.

Opening Continuing Care
You can open the Continuing Care module from any main module.

Tip: To view the continuing care for all clinics, you must access the Continuing Care module from the 
Appointment Book.

To access Continuing Care

In any module, from the File menu, click Continuing Care. The Continuing Care window appears.

If you open Continuing Care from the Patient Chart, Ledger, or Family File, the list shows continuing care 
information for the selected patient and his or her family members. If Continuing Care is opened from the 
Appointment Book or Office Manager, the list shows continuing care information for the entire patient 
database.
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Using the Continuing Care List
As you go down the Continuing 
Care list, using the phone numbers 
shown, you can call each patient 
to schedule an appointment or 
change the status of the patient’s 
continuing care. For information 
about scheduling a continuing 
care appointment, see “Scheduling 
Appointments” in Chapter 3: 
Appointment Book.

Printing from Continuing Care
From Continuing Care, you can print the following:

•	 Continuing Care List – To print the Continuing Care list for the entire practice, from the File menu, 
click Print.

•	 Continuing Care Labels – To quickly print mailing labels, from the File menu, point to Print Mailing 
Labels, and then click the option that corresponds to the number of columns on your sheet of labels.

Tips:

•	 For instructions on how to create continuing care cards for patients who have already scheduled their 
continuing care visit, see “Creating Appointment Reminder Cards” in Chapter 8: Office Manager.

•	 For instructions on how to create continuing care cards for patients who have not yet scheduled their 
continuing care visit, see “Creating Cards for Patients Without Appointments” in Chapter 8: Office 
Manager.

Patient Questionnaire
Patient Questionnaire is designed to replace the new patient forms, health history update, and other forms 
used in your office to collect information from patients. With Patient Questionnaire, you can create a custom 
set of questions that can be printed for your patients to answer. Once the patient completes the questionnaire, 
the answers can be input into Dentrix Enterprise so that you have an electronic copy of the information.

For those offices moving toward the “paperless office,” Patient Questionnaire is a way to computerize 
information that otherwise would be stored in a paper chart. Best of all, when the information needs to be 
reviewed for accuracy, a new copy with the previous answers can be generated; the patient only has to modify 
those items that have changed since the last visit.

This section covers the following topics about questionnaires:

•	 Setting Up Questionnaires

•	 Printing Questionnaires

•	 Entering Questionnaire Responses
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Setting Up Questionnaires
You can create and edit patient questionnaires to collect information from patients. Questions ask a patient 
to provide information. Statements provide a patient with information, such as instructions for completing a 
form.

To create or edit a questionnaire

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Patient Questionnaire Setup.

The Patient Questionnaires dialog box appears.

2.	 Click New to create a new questionnaire; or 
select an existing questionnaire, and then 
click Edit to edit that questionnaire. The 
Questionnaire Setup dialog box appears.

3.	 Type or change the Questionnaire Title.

4.	 Do any of the following:

•	 Add – To add a statement or question, 
Click New. In the Statement/Question 
for Questionnaire dialog box that 
appears, type the text for 
a statement or question as 
you want it to appear on the 
patient questionnaire form, 
select the appropriate text 
type, and then click OK.

•	 Edit – To edit a statement or 
question, select that statement 
or question, and then click 
Edit.

•	 Delete – To delete a statement 
or question, select that 
statement or question, and 
then click Delete. On the 
confirmation message that 
appears, click Yes.

Warning: If you delete a 
statement/question on a 
questionnaire assigned to a patient, Dentrix Enterprise also deletes the patient’s responses.

Tips:

•	 To change the type of statement or question (for example, from a “Note/Explanation” to a 
“Date”), delete the statement/question, and then re-enter it.

•	 To arrange the order of statements and questions for your questionnaire, select an item, and then 
click Move Up or Move Down until the desired position is reached.

5.	 Click OK to save the questionnaire and return to the Patient Questionnaires dialog box.

6.	 Click Close.
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Printing Questionnaires
You can print a questionnaire when a patient arrives for an appointment. The printed questionnaire lists 
information that has been previously entered, including patient information, referral information, spouse or 
guarantor information, employment information, insurance information, and any answers that have been 
entered in the Patient Questionnaire module for a patient. The patient can then correct those entries that are 
inaccurate and add any information not currently known.

You can print a questionnaire from any module except the Office Manager. For a new patient with an 
appointment who does not yet have a Family File record, you must create a Family File record before you can 
print a questionnaire for him or her.

To print a questionnaire

1.	 In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Patient Questionnaire.

The Patient Questionnaire History dialog box appears.

2.	 From the Select Questionnaire list, select the questionnaire you 
want to print for the patient.

3.	 Click New.

The selected questionnaire opens.

4.	 Click a print button:

•	 Print – To print the questionnaire. 
The questionnaire has two pages: 
the first page contains basic patient 
information, such as name, address, 
employer, insurance information, 
and referral sources; the second 
page contains your customized 
questions. Any information 
previously entered into Dentrix 
Enterprise prints on the form. 
The patient will fill in the blanks 
and make corrections as needed.

•	 Print Questions – To print a 
summary of patient information 
and your customized questions.

1

2
3

4



Chapter 11: Other Features    323

Dentrix Enterprise 8.0.5 User’s Guide

Entering Questionnaire Responses
Once a patient has completed a questionnaire, you can store the responses in Dentrix Enterprise.

To input questionnaire responses from a patient

1.	 In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Patient Questionnaire.

The Patient Questionnaire History dialog box appears.

2.	 Do one of the following:

•	 From the Select Questionnaire list, 
select the questionnaire you want the 
patient to fill out, and then click New 
to add the questionnaire.

•	 Select an existing questionnaire for the 
patient, and then click Edit to edit 
that questionnaire.

The Patient Questionnaire dialog box 
appears.

3.	 Double-click the first question 
listed.

The Patient Questionnaire 
Response dialog box appears.

4.	 Select or type the appropriate 
patient response, and then click 
Next to advance to the next 
question. Repeat this until all 
questions are answered.

5.	 Click OK to save the patient 
responses and return to the 
Patient Questionnaire dialog 
box.

6.	 Click Close to close the Patient 
Questionnaire dialog box.

7.	 Click Close to close the Patient 
Questionnaire History dialog box.

1

OR2 2

7

3

6

5

4



324     Chapter 11: Other Features

Dentrix Enterprise 8.0.5 User’s Guide

Prescriptions
The Prescriptions module can help you quickly create and accurately track medicines prescribed to your 
patients. This section covers the following topics about using the Prescriptions module:

•	 Setting Up Prescription Types

•	 Setting Up Prescription Printer Defaults

•	 Entering Prescriptions

•	 Re-printing Prescriptions

Setting Up Prescription Types
Prescription types are the default prescription settings. The act as templates to help you quickly enter 
prescriptions into Dentrix Enterprise. You can add and edit these defaults at any time.

To add or edit a prescription type

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Prescriptions Setup.

The Prescriptions Setup dialog box 
appears.

2.	 Do one of the following:

•	 Click New to add a prescription. The 
New Standard Prescription dialog 
box appears.

•	 Select an existing prescription, 
and then click Edit to edit 
that prescription. The Edit 
Standard Prescription dialog 
box appears.

3.	 Set up the following options:

•	 Description – Type a description for the prescription. This does not appear on the prescription.

•	 Drug Name – 
Type the drug 
information.

•	 Sig – Type the 
dosage interval 
and any 
instructions 
that you 
want to have 
print on the 
prescription.

•	 Disp – Type 
the number or 
amount of the 
medication to 
dispense.

1

OR

2

2

3

4



Chapter 11: Other Features    325

Dentrix Enterprise 8.0.5 User’s Guide

•	 Refills – If the prescription may be refilled, type the number of refills allowed.

•	 Drug substitution

•	 Dispense as Written – Select this option if the pharmacy may only use the drug named on the 
prescription.

•	 Generic Substitution Permitted – Select this option if the pharmacy may fill the prescription with 
a generic drug.

•	 Notes – Type any instructions regarding the prescribed medication for the patient. The notes will 
print below the prescription.

4.	 Click OK.

For a comprehensive explanation of all the available options for prescription types, see the “Adding and 
editing prescription types” topic in the Dentrix Enterprise Help.

Setting Up Prescription Printer Defaults
You can customize the printer defaults for prescriptions printed from the Prescriptions module.

To set up a prescription printer

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Prescription Setup.

The Prescription Setup dialog box appears.

2.	 Click Print Setup.

The Print Setup dialog box appears.

3.	 Set up the following printer options:

•	 Printer – Select the printer you want 
to use to print prescriptions.

•	 Form – If your state requires a 
specific format for prescriptions, 
select the correct form.

•	 Using preprinted paper – If you 
will be using preprinted paper when 
creating prescriptions, select this 
option.

•	 Print number for “Disp” as a word – To list the 
number or amount of the medication to dispense as a 
word (for example, “four” instead of “4”), select this 
option.

•	 Print Gender – To print a patient’s gender, select this 
option.

•	 Print Chart # – To print a patient’s chart number, 
select this option.

•	 Disable Printing – If you will be using the 
Prescriptions module to record prescription information but will not be printing prescriptions, select 
this option.

4.	 Click OK to save the changes and return to the Prescriptions Setup dialog box.
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Entering Prescriptions
In Dentrix Enterprise, you can add a prescription you are prescribing to a patient.

To add a prescription

1.	 In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Prescriptions.

The Patient Prescription dialog box appears.

2.	 Click the New Prescription button .

The New Patient Prescription dialog box appears.

3.	 Click the Description search button  to select a 
prescription type.

4.	 Customize the prescription information for the 
patient as needed:

•	 Dosage – The 
amount of 
the drug that 
can be taken 
at one time 
(for example, 
1 Capsule).

•	 Sig – The 
dosage 
interval and 
instructions.

•	 Drug 
Administered 
During Visit 
Only – The 
drug was 
administered 
to the patient 
during his or her visit.

•	 Duration – The number of days, weeks, or months from the issued date that this prescription is 
valid.

•	 Disp and Disp Unit – The amount of the drug to dispense and the unit it is dispensed as.

•	 Refills – The refill amount.

•	 Drug substitution – Must be dispensed as written, or a generic drug substitution is allowed.

•	 Notes – Instructions for the patient.

5.	 If necessary, click the Prescriber search button  to select the provider who is prescribing the drug.

6.	 Click Print to print the prescription.

7.	 Click OK to save the prescription.
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Re-printing Prescriptions
You can re-print any prescription that has been added to a patient’s record.

To re-print a prescription

1.	 In the Family File, Ledger, or Patient Chart, with a patient selected 
(in the Appointment Book, with a patient’s appointment selected), 
from the File menu, click Prescriptions.

The Patient Prescription dialog box appears.

2.	 Select the prescription that you want to re-print.

3.	 Click the View Prescription button .

The Edit Patient Prescription dialog box appears.

4.	 Click Print.

5.	 Click Cancel to return to the Patient 
Prescription dialog box.
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Patient Alerts
Patient alerts are customizable alerts that can be attached to patients when you want a flag for certain 
conditions. This alert will appear whenever information for a flagged patient is accessed, and a symbol is 
visible on the flagged patient’s appointments. There is also the option to include a patient’s aged balance in an 
alert for easy reference. Patient alerts are also essential in respecting patient’s requests for privacy and disclosure 
of information. Patient alerts are accessible from any patient-specific module, including the Family File, 
Patient Chart, Ledger, and Appointment Book. This section covers the following topics about patient alerts:

•	 Creating Patient Alerts

•	 Suspending Patient Alerts

•	 Suspending Patient Alerts Temporarily

Creating Patient Alerts
You can create up to 10 alerts for any patient.

To create a patient alert

1.	 In any patient-specific module (for example, the Family File), with a 
patient selected, from the File menu, click Patient Alerts.

If any patient alerts exist for the patient, the Patient Alert dialog box 
appears. However, if the patient does not have any patient 
alerts, the Create Patient Alerts dialog box appears; skip 
to step 3.

2.	 Click New.

The Create Patient Alert dialog box appears.

3.	 Set up the following options:

•	 Select Date – In the Start and End fields, type the 
date range for which you want the patient alert to 
appear in the specified areas, or select Always to 
always display the patient alert when information 
about the patient is accessed and/or to always 
display an icon on the patient’s appointments.

•	 Description – Type a description for the 
patient alert (for example “Collections” or “Pre-
Medicate”).

•	 Patient Alert should display for the patient in 
the following areas – In the list box, select all 
areas of Dentrix Enterprise in which you want the 
patient alert to appear, or select All to have the 
patient alert appear in all areas.
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•	 Options

•	 Show Symbol on Appointment – To have a flag symbol show in the upper-right corner of 
appointments for the patient, select this option.

•	 Display Aged Balance with Note – To have the patient’s account balance information show with 
the alert, select this option.

•	 Note – Type a detailed description of the alert.

4.	 Click OK.

Suspending Patient Alerts
You can suspend all patient alerts on a specific computer. When this option is enabled, the workstation will 
ignore all patient alerts for all patients.

To suspend patient alerts on a computer

1.	 In the Office Manager, from the Maintenance menu, point to 
Practice Setup, and then click Preferences.

The Preferences dialog box 
appears.

2.	 Under Additional Options, select 
Suspend Patient Alerts to disable 
patient alerts on this computer.

3.	 Click OK.
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Suspending Patient Alerts Temporarily
When a patient alert appears for a patient, you can 
select the Do Not Show This Alert Again Today 
check box, and then click OK. That alert for that 
patient will not appear on any of the computers in 
the office for that day.
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Office Journal
Like a journal of your daily activities, the Office Journal has two main functions: to keep a record of past 
events and to remind you of events in the future. The Office Journal helps you keep a comprehensive record of 
contact made between your office and your patients.

Also, Dentrix Enterprise automatically adds entries for appointments, billing statements, letters, payment 
agreement notes, payments, and privacy requests:

•	 Appointments – The Office Journal will record the following appointments:

•	 Scheduled appointments – The date, time, appointment provider, and appointment reason.

•	 Purged appointments – The original date, time, reason, and provider for the purged appointment.

•	 Broken appointments – The original appointment date, time, reason, and provider.

•	 Billing statements – The Office Journal will record the date, “Please Pay” amount, and account balance 
of billing statements generated.

•	 HIPAA privacy – The Office Journal will record when any privacy requests are made through the Family 
File.

•	 Letters – The Office Journal will record the date, provider, and the name of any letters generated for 
patients, using either Quick Letters or Letters from the Office Manager.

•	 Payment agreement notes – The Office Journal will record the date, provider, and notes of any payment 
agreements entered.

•	 Payments – The Office Journal will record the date, provider, and amount of any insurance and patient 
payments. You can view guarantor transactions when viewing a guarantor or an entire family in the Office 
Journal.

This section covers the following topics about using the Office Journal:

•	 Opening the Office Journal

•	 Using the Office Journal Window

•	 Adding Manual Journal Entries

•	 Creating Daily Reminders

Opening the Office Journal
You can open the Office Journal from any module, the ASAP List, the Unscheduled List, Continuing Care, 
and the Collections Manager.

To open a patient’s Office Journal

In any patient-specific module (for example, the Ledger), with a patient selected, from the File menu, click 
Office Journal.

Tip: From the Office Manager, you cannot select a patient, but you can still open the Office Journal. From 
the File menu, click Office Journal; cancel the dialog box that prompts you to select a provider or staff 
member; from the View menu, click By Patient; and then select a patient.
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Using the Office Journal Window
The Office Journal window consists of a menu bar, toolbar, list of entries, and details pane.

Entries

Details

Menu Bar

Toolbar

This section covers the following topics to help you understand how to use the Office Journal window:

•	 Using the Office Journal Toolbar

•	 Changing the Office Journal View

Using the Office Journal Toolbar
The Office Journal includes a toolbar with buttons to access features of this module.

Each button on the toolbar is explained in the following table.

Click the Close Office Journal button to close the Office Journal module.

Click the Add Journal Entry button to add an entry for the selected patient.

Click the Select button to select a patient, provider, staff member, or referral.

Click the Patient Alerts button to view and manage the selected patient’s alerts or add new alerts.

Click the Expand button to expand the list of entry dates to see more information.

Click the Collapse button to collapse the list of entries to see only the entry dates.

Click the Journal button to switch between viewing entries by patient and family.

Click the Info button to show or hide the additional details for the selected entry.
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Changing the Office Journal View
You can specify whether you want to view journal entries by patient or family, provider or staff, and by 
referral. You can also filter the list of entries that appear in the Office Journal according to criteria you specify.

To change the view

•	 Patient or Family – If you are not viewing the Office Journal by a patient name, to view entries for a 
certain patient, from the View menu, click By Patient, and then select a patient.

To view entries for an entire account, while viewing a patient’s entries, from the View menu, click Family.

Note: When viewing a family member who is not the guarantor, the Office Journal does not display 
entries for billing statements and guarantor payments. These items appear only when viewing the family’s 
guarantor.

•	 Provider/Staff – If you are not viewing the Office Journal by a provider or staff member, to view entries 
for a certain provider or staff member, from the View menu, click By Provider/Staff, and then select a 
provider or staff member.

•	 Referred BY or Referred TO – If you are not viewing the Office Journal by a referral, from the View 
menu, to view entries for a certain referral, click By Referral By or By Referred To, and then select a 
referral.

To customize the view

1.	 In the Office Journal, from the View menu, click Filters.

A dialog box of filters appears (the name depends on the current view).

2.	 Set up the filter options for the current view:

•	 Patient or Family

•	 Select Journal Entry Types – Select the 
entry types you want to view, or select All 
Journal Entry Types to include all types.

•	 Filter By – Select This Clinic to view 
entries from the current clinic or All 
Clinics to include all clinics.

•	 Entries Dated After – To view only items 
after a certain date, type a cut-off date.

•	 Provider/Staff

•	 Select Journal Entry Types – Select the 
entry types you want to view. For Phone 
Calls, Reminders, Miscellaneous, and HIPAA Privacy, select the accompanying Include Patient 
Entries check box to include all patient entries for any of the selected types too.

•	 Entries Dated After – To view only items after a certain date, type a cut-off date.

•	 Referral BY or Referred TO

•	 Select Journal Entry Types – Select the entry types you want to view, or select All Journal Entry 
Types to include all types.

•	 Select Provider/Staff – Select the providers and/or staff you want to view, or select For All Prov/
Staff to include all providers and staff.

•	 Entries Dated After – To view only items after a certain date, type a cut-off date.

3.	 Select Save as Default to save the current settings for the next time you open the Office Journal.
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4.	 Click OK to return to the Office Journal with the selected view settings.

Adding Manual Journal Entries
You can manually add four types journal entries into the Office Journal: Phone Call, Reminder, Misc, and 
HIPAA. These entries will include the date, time (except for reminders), and provider/staff members, and you 
can add a note.

To add a manual entry

1.	 In the Office Journal, from the Edit menu, click Add.

The Add Journal Entry dialog box appears.

2.	 Set up the following options:

•	 Type – Select a type:

•	 Phone Call – Use when making 
a phone call to a patient. Record 
information regarding the 
conversation.

•	 Reminder – Use with a future 
date as a reminder about a contact 
with a patient.

•	 Miscellaneous – Use for any other 
contact with the patient for which 
you want to keep a record.

•	 HIPAA Privacy – Use to track 
patient information disclosure 
history and other privacy related 
notes for patients, providers, staff, 
and referrals.

•	 Prov/Staff – Click the search button  to select a provider or staff member to assign to the journal 
entry.

•	 Description – Type a short description for the journal entry.

•	 Note – Type a longer description of the journal entry.

•	 Date – If needed, change the date of the journal entry.

•	 Time – If needed, change the time of the journal entry.

3.	 Click OK to save the entry.

Notes:

•	 Automatic entries (for appointments, billing statements, and so forth) cannot be edited, but you can edit 
manual journal entries.

•	 Payment, appointment, and payment agreement note entries cannot be deleted from the Office Journal, 
but you can delete manual journal entries.
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Collections Manager
With the Collections Manager module you can increase your practice’s revenue by decreasing your account 
receivables. The Collections Manager displays a list of overdue accounts that need to be contacted, based 
on aged balances, payment dates, and other information you select. From this list, you have access to all the 
relevant information for an account to make decisions about collections.

Also, with the Collections Manager, you can merge a letter, dial a phone number, and send an email message. 
Once the patient is contacted, you can make notes regarding the contact, set up a payment agreement, 
or change a billing type. Pulling all of this information and functionality into one window can make the 
collections process smoother, more efficient, and more productive.

This section covers the following topics about using the Collections Manager:

•	 Opening the Collections Manager

•	 Setting Up a View

•	 Using the Collections Manager Window

•	 Contacting Patients

•	 Removing Accounts from the List

•	 Adding Office Journal Entries

•	 Adding Guarantor Notes

•	 Setting up Payment Agreements

•	 Printing from the Collections Manager

Creating Daily Reminders
You can use the Office Journal to remind you of activities that need to be completed in the future.

To create a reminder

1.	 Do one of the following:

•	 Add a reminder by patient – In the Office Journal, with a patient 
selected, from the Edit menu, click Add.

•	 Add a reminder by provider or staff member –  In the Office 
Journal with a provider selected, from 
the Edit menu, click Add.

The Add Journal Entry dialog box 
appears.

2.	 Enter the information for the reminder, 
and, from the Type list, select Reminder.

3.	 Click OK.
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Opening the Collections Manager
You can open the Collections Manager from the Office Manager.

To open the Collections Manager

In the Office Manager, from the Analysis menu, click Collections Manager.

If a view has never been set up for the Collections Manager, the Collections Manager View dialog box 
appears so that you can set up a view for the Collections Manager before you can use the module; otherwise, 
the Collections Manager window appears and loads the view according to the filters set up previously.

Setting Up a View
The first time you try to use the Collections Manager, you must first set up a view. Setting up a view allows 
you to filter out certain accounts so that only the accounts you want to contact appear. Once you have 
selected your view options, you can choose what account information you want to have appear in the list.

To set up a view

1.	 Do one of the following:

•	 In the Office Manager, from the Analysis menu, click 
Collections Manager. If a view has never been set up for the 
Collections Manager, the Collections Manager View dialog 
box appears.

•	 In the Collections Manager, click View Setup on the menu 
bar. The Collections Manager View dialog box appears.

2.	 Set up the following filters:

•	 Select Guarantor – Click 
the From and To search 
buttons  to select a 
range of guarantors to 
include, or select All 
Guarantors to view all 
guarantors that meet the 
search criteria.

Tip: If you have a very 
large patient base and 
want to limit the length 
of the list for ease of use, 
you can use A – J names 
one week, K – S names 
the next week, and so on.

•	 Select Billing Type – 
Select up to 10 billing types for accounts you want to include (to select multiple items, while pressing 
the Ctrl key on your keyboard, click each item), or select All Billing Types to include accounts with 
any billing type.

Tip: If you want the view to include more than 10 billing types, view the list by all billing types or in 
groups of 10.
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•	 Skip Accounts With Claim Pending – If your office waits for insurance to pay before collecting 
from an account, select this option. Dentrix Enterprise will exclude accounts that have insurance 
claims outstanding as long as the guarantor portion of the balance is less than the specified amount in 
the If Patient Portion Less Than field.

•	 For Payment Agreement (PA) & Future Due Payment Plans (FD) – Select All to include all 
accounts regardless of whether or not a payment agreement or future due payment plan has been set 
up for an account, or select one of the options in the list box to limit the view to only certain types of 
accounts. An account will be included if it matches at least one of the selected criteria.

•	 List Accounts

•	 By Provider – Click the search button  to select the primary providers of the guarantors you 
want to include, or select All to include all providers.

•	 By Clinic – Click the search button  to select the clinics of the accounts you want to include, 
or select All to include all clinics.

•	 Minimum Days Past Due – Select a minimum number of days past due to include only accounts 
with the specified minimum aged balance or older.

•	 Ins Min Days Past Due – Select a minimum number of days past due to include only accounts with 
outstanding insurance claims that have the specified minimum aged balance or older.

•	 # of Pmts Missed – Select a number of payments missed to include accounts that have missed a 
certain number of payments toward a payment agreement.

Tip: If you do not want to use this filter, select 0 or more.

•	 Show Totals – To display the total amounts for all the guarantors included, select this check box.

•	 Min Balance – Type an amount to exclude accounts with a balance less than that amount, or enter 
0.00 to include accounts with any balance.

•	 Accounts with Suspended Amount – Type an amount to include accounts with a suspended amount 
equal to or greater than that amount, or enter 0.00 to include accounts with any suspended amount.

•	 Last Pmt Before –To exclude guarantors who are making regular payments toward their account 
balances, select this check box, and then type the latest date a payment must have been posted. For 
example, if you allow guarantors 30 days to make a payment, enter a date that is one month prior to 
today’s date.

•	 If Not Billed Since – To exclude accounts that have recently received a billing statement, select this 
check box, and then type the latest date an account a billing statement must have been sent. For 
example, if you want to include accounts that have received a billing statement over two weeks ago, 
enter a date that is two weeks prior to today’s date.

•	 Last Visit Before – To exclude accounts with patients who have been seen recently, select this check 
box, and then type the latest date a family member must have been seen.

•	 Previous Office Journal Entry Before – To exclude accounts based on the last manual entry in 
the Office Journal, select this check box, and then type the latest date a guarantor must have had a 
manual Office Journal entry entered.

•	 Show Columns – To specify what information you want to display, click Show Columns. There will 
be a column for each item you choose to show.

3.	 Click OK to open the Collections Manager with the selected view options.
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Using the Collections Manager Window
The Collection Manager window consists of a menu bar, a toolbar, and the list of guarantors that meet the view criteria 
you specify.

This section covers the following topics to help you understand how to use the Collections Manager window:

•	 Using the Collections Manager Toolbar

•	 Adjusting Column Widths

•	 Sorting the List

Using the Collections Manager Toolbar
The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Collections Manager are explained in the following table.

Click the Send Message button to compose and send an email to the selected patient.

Click the Office Journal button to record any communications with the selected guarantor.

Click the Document Center button to attach a document, picture, or letters to the selected 
guarantor’s record.

Click the Patient Alerts button to enter an alert for the selected guarantor.

Click the Billing/Payment Agreement button to add a payment agreement or change the billing 
type for the selected account.

Click the Guarantor Notes button to enter notes for the selected account.

Click the Print button to print the list of accounts being viewed. You have the option to include 
account notes on the printed list.
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Adjusting Column Widths
To make viewing and editing the Collections Manager list easier, you can adjust the width of each individual 
column.

To adjust the size of a column

Click the right column border of the column header you want to resize, and 
then drag it to the left to decrease the size of the column or to the right to 
increase the size of the column.

Sorting the List
To sort the list by any of the columns being displayed, click the desired column header.

Contacting Patients
Once you have generated a list of accounts that need to be contacted, the Collections Manager provides ways 
for you to quickly contact each patient. This section covers the following topics about contacting patients:

•	 Sending Collection Letters

•	 Sending Collection Email Messages

Sending Collection Letters
From the Collections Manager, you can quickly create a collection letter using any of your pre-written letter 
templates.

To create a collection letter for a guarantor

1.	 With a guarantor selected in the Collections Manager, from the File menu, 
click Quick Letters.

The Quick Letters dialog box appears.

2.	 Select the letter you want to merge.

3.	 Click Build/View to merge the letter in Microsoft 
Word. For more information about Quick Letters, see 
“Quick Letters” in this chapter.

Sending Collection Email 
Messages
From the Collections Manager, you can quickly contact 
your patients through email.

To send an email message

With a guarantor selected in the Collections Manager, from the File menu, click Send Message to compose 
an send an email message. For more information about this email feature, see “Sending Email Messages” in 
this chapter
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Removing Accounts from the List
You can temporarily remove an account from the Collections Manager list. If no information has changed 
when the list is generated again, the account will reappear on the list.

To remove a guarantor from the list

With a guarantor selected in the Collections Manager, right-click that guarantor, and then click Hide 
Account. The selected account is removed from the list for the current viewing session.

Adding Office Journal Entries
After you have attempted to contact or have successfully contacted a patient, you can enter notes regarding 
the attempted or successful contact as an Office Journal entry.

To add an Office Journal entry

1.	 With a guarantor selected in the Collections Manager, from the File menu, 
click Office Journal.

The Office Journal opens.

2.	 Add a journal entry as 
explained in “Adding 
Manual Journal Entries” in 
this chapter.

3.	 Close the Office Journal to 
return to the Collections 
Manager.
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Setting up Payment Agreements
From the Collections Manager, you can set up a payment agreement for a patient you have contacted.

To set up a payment agreement

1.	 In the Collections Manager, double-click a guarantor.

If a previous payment agreement exists for the account, the Billing /
Payment Agreement dialog box appears; otherwise, a message appears and 
asks if you want to create a payment agreement, so click Yes to open the 
Billing /Payment Agreement dialog box.

2.	 Set up the payment 
agreement for information 
about payment agreements, 
see “Creating Payment 
Agreements” in Chapter 7: 
Ledger.

3.	 Click OK.
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Adding Guarantor Notes
After you have contacted a guarantor, you can add notes regarding the account from the Collections Manager.

To add an account and/or billing statement note

1.	 With a guarantor selected in the Collections Manager, from the File menu, 
click Guarantor Note.

The Guarantor Notes dialog box appears.

2.	 Type an account note and/or billing 
statement note. For information about 
guarantor notes, see “Working with Notes 
in the Ledger” in Chapter 7: Ledger.

3.	 Click OK.
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Printing from the Collections Manager
From the Collections Manager, you can print the following:

•	 Collections Manager List

•	 Mailing Labels

For instructions on how to export the Collections Manager list to a spreadsheet program, such as Microsoft 
Excel, see the “Analyzing collections information” topic in the Dentrix Enterprise Help.

Collections Manager List
You can print all the accounts and the information for each, including guarantor notes, being viewed in the 
Collections Manager.

To print the Collections Manager List

1.	 In Collection Manager, from the Print menu, click Collections List.

A dialog box appears.

2.	 If you want to include Guarantor Notes for each account on the 
list, select Include Guarantor Account Notes.

3.	 Click Yes. The list prints from the default printer for the Office 
Manager.

Mailing Labels
You can print mailing labels for all guarantors being viewed in the Collections Manager.

To print mailing labels

In the Collections Manager, from the Print menu, point to Mailing Labels, 
and then click the option that corresponds to the correct number of columns 
to print on the sheet of labels you are using. On the confirmation message 
that appears, click Yes. The labels print from the default printer for the Office 
Manager.
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